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A

 

bout online Help

 

A

 

dobe Systems, Inc. provides complete documentation in the Adobe PDF Help system. 
The Help system includes information on all the tools, commands, and features for both 
Windows and Mac OS. The PDF format is designed for easy navigation online, and support 
for third-party screen readers compatible with Windows. The Help can also be printed as a 
desktop reference.

 

N

 

avigating in Help

 

T

 

he Help will open in an Acrobat window with the bookmark pane open. If the bookmark 
pane is not open choose Window > Bookmarks. You can also navigate using the 
navigation bar, the index, or search the document.

At the top and bottom of each page is a navigation bar. Click Using Help to return to this 
introduction. Clicking Contents, or Index will take you to that section.

The Next Page  and the Previous Page  arrows let you move through the pages 
sequentially. Click Back to return to the last page you viewed. You can also use the 
navigation arrows in the Acrobat toolbar. 

 

U

 

sing bookmarks, the table of contents, the index, and Find

 

T

 

he contents of Help are shown as bookmarks in the bookmark pane. To view subtopics, 
click the plus sign next to a bookmark. Each bookmark is a hyperlink to the associated 
section of the Help document. 

To go to the information, click its bookmark. As the information is displayed in the 
document pane, its bookmark is highlighted.

You can turn highlighting on or off by selecting the Highlight Current Bookmark option 
from the bookmark pane menu.

 

T

 

o find a topic using the table of contents:

1  

 

C

 

lick Contents in the navigation bar at the top or bottom of any page.

 

2

 

  

 

C

 

lick a topic on the Contents page to move to the first page of that topic.

 

3

 

  

 

In the b

 

ookmark pane, expand the topic to see its subtopics.

 

T

 

o find a topic using the index:

1  

 

C

 

lick Index in the navigation bar at the top or bottom of any page.

 

2

 

  

 

C

 

lick the appropriate letter at the top of the page.

You can also expand the Index bookmark, and click the letter in the bookmark pane.

 

3

 

  

 

L

 

ocate your entry, and click the page number link to view the information.

 

4

 

  

 

T

 

o view multiple entries, click Back to return to the same place in the index.
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T

 

o find a topic using the Find command:

1  

 

C

 

hoose Edit > Find.

 

2

 

  

 

En

 

ter a word or a phrase in the text box, and click OK.

Acrobat will search the document, starting from the current page, and display the first 
occurrence of the word or phrase you are searching for. 

 

3

 

  

 

T

 

o find the next occurrence, choose Edit > Find Again.

 

P

 

rinting the Help file

 

A

 

lthough the Help has been optimized for on-screen viewing, you can print pages you 
select, or the entire file.

To print, choose Print from the File menu, or click the printer icon in the Acrobat toolbar.
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Effects included with After Effects 34

3D Channel effects (Pro only) 35

Adjust effects 39

Audio effects 46

Blur & Sharpen effects 51

Channel effects 55

Distort effects 68

Expression Controls effects 89

Image Control effects 90

Keying effects 101

Matte Tools effects (Pro only) 113

Noise effects 115

Paint effects (Pro only) 123

Perspective effects 138

Render effects 142

Simulation effects 168

Stylize effects 208

Text effects 219

Time effects 228

Transition effects 234

Video effects 241

Legal Notices 243
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lery of effects

 

3D C

 

hannel effects

 

“3D C

 

hannel Extract (Pro only)” on page 35

 

 Or

 

iginal (left), with Texture UV selected, and then used 
with the Set Matte effect as a Luminance matte (right) 

“Depth Matte (Pro only)” on page 36 Original (left) and with two different depths selected (center 
and right)

“Depth of Field (Pro only)” on page 36 Original (left) and with variations of Depth of Field applied 
(center and right)

“Fog 3D (Pro only)” on page 37 Original (left), Gradient Layer (center), and with Fog 3D applied 
(right)
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“ID Matte (Pro only)” on page 38 Original (left), with ID Matte applied using the near alien as the 
ID Selection (center), and composited over a new background (right)

Adjust effects

“Brightness & Contrast” on page 39 Original (left) and with variations of Brightness & Contrast 
applied (center and right)

“Channel Mixer” on page 39 Original (left) and with variations of Channel Mixer applied (center 
and right)

“Color Balance” on page 40 Original (left) and with variations of Color Balance applied (center and 
right)

“Curves” on page 41 Original (left) and with variations of Curves applied (center and right)
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“Hue/Saturation” on page 42 Original (left) and with variations of Hue/Saturation applied (center 
and right)

“Levels” on page 44 Original (left) and with variations of Levels applied (center and right) 

“Levels (Individual Controls)” on page 45 Original (left) and with variations of Levels (Individual 
Controls) applied (center and right)

“Posterize” on page 45 Original (left) and with variations of Posterize applied (center and right)

“Threshold” on page 45 Original (left) and with variations of Threshold applied (center and right)
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Blur and Sharpen effects

“Channel Blur” on page 51 Original (left) and with variations of Channel Blur applied (center and 
right)

“Compound Blur” on page 51 Original (left), with Compound Blur applied (center), and with 
Compound Blur applied and the cloud layer made invisible (right)

“Directional Blur” on page 52 Original (left) and with variations of Directional Blur applied (center 
and right)

“Fast Blur” on page 52 Original (left) and with variations of Fast Blur applied (center and right)

“Gaussian Blur” on page 53 Original (left) and with variations of Gaussian Blur applied (center and 
right)
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“Radial Blur” on page 53 Original (left) and with variations of Radial Blur applied (center and right)

“Sharpen” on page 53 Original (left) and with Sharpen applied (right)

“Unsharp Mask” on page 54 Original (left) and with Unsharp Mask applied (right)

Channel effects

“3D Glasses” on page 55 Two variations of 3D Glasses

“Alpha Levels (Pro only)” on page 57 Original (left) and with variations of Alpha Levels applied 
(center and right)
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“Arithmetic” on page 58 Original (left) and with variations of Arithmetic applied (center and right)

“Blend” on page 58 Originals (left and center) and with Blend applied (right)

“Calculations” on page 59 Originals (left and center) and with Calculations applied (right)

“Channel Combiner” on page 60 Original (left) and with variations of Channel Combiner applied 
(center and right) 

“Compound Arithmetic” on page 62 Originals (left and center) and with Compound Arithmetic 
applied (right)
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“Invert” on page 63 Original (left) and with variations of Invert applied (center and right)

“Minimax” on page 64 Original (left) and with variations of Minimax applied (center and right)

“Remove Color Matting” on page 64 Top: Remove Color Matting used to remove a halo (center) 
from imported text (left) with the result (right)  Bottom: Two source layers combined (left and center) 
and Remove Color Matting used to refine the result (right)

“Set Channels” on page 65 Original (left) and with variations of Set Channels applied (center and 
right)
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“Set Matte” on page 66 Original (left) and with variations of Set Matte applied (center and right)

“Shift Channels” on page 67 Original (left) and with variations of Shift Channels applied (center 
and right)

“Solid Composite” on page 67 Original (left) and with variations of Solid Composite applied (center 
and right)

Distort effects

“Bezier Warp (Pro only)” on page 68 Original (left), with Bezier Warp applied and Bezier curve 
highlighted (center), and resulting layer (right)

“Bulge (Pro only)” on page 69 Original (left) and with variations of Bulge applied (center and right)
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“Corner Pin (Pro only)” on page 70 Original (left) and with variations of Corner Pin applied (center 
and right)

“Displacement Map (Pro only)” on page 70 Original (left), displacement map (center), and with 
Displacement Map applied (right) 

“Liquify” on page 71 Original (left) and with variations of Liquify applied (center and right)

“Magnify” on page 73 Original (left) and with variations of Magnify applied (center and right)

“Mesh Warp (Pro only)” on page 74 Original (left), warp grid (center), and resulting layer (right)
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“Mirror” on page 75 Original (left) and with variations of Mirror applied (center and right)

“Offset” on page 75 Original (left) and with variations of Offset applied (center and right)

“Optics Compensation (Pro only)” on page 76 Original (left) with Optics Compensation applied to 
correct the image (center), and exaggerates lens distortion (right)

“Polar Coordinates” on page 77 Original (left) and with variations of Polar Coordinates applied 
(center and right) 

“Reshape (Pro only)” on page 78 Original with masks selected (left) and with variations of Reshape 
applied (center and right) 
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“Ripple” on page 80 Rippling a layer

“Smear” on page 81 Original with masks selected (left) and with variations of Smear applied (center 
and right) 

“Spherize” on page 83 Original (left) and with variations of Spherize applied (center and right)

“Transform” on page 83 Original (left) and with variations of Transform applied (center and right)

“Turbulent Displace” on page 84 Original (left) and with variations of Turbulent Displace applied 
(center and right)
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“Twirl” on page 86 Original (left) and with variations of Twirl applied (center and right)

“Warp” on page 87 Original (left) and with variations of Warp applied (center and right) 

“Wave Warp” on page 87 Original (left) and with variations of Wave Warp applied (center and right)

Image Control effects

“Change Color” on page 90 Original (left) and with variations of Change Color applied (center and 
right)

“Change to Color (formerly Change Color HLS)” on page 91 Original (left), with Correction Matte 
(center), and with Change to Color applied (right)
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“Color Balance (HLS)” on page 92 Original (left) and with variations of Color Balance HLS applied 
(center and right)

“Color Link” on page 92 Original (left) and with variations of Color Link applied (center and right)

“Colorama” on page 94 Original (left) and with variations of Colorama applied (center and right)

“Equalize” on page 98 Original (left) and with variations of Equalize applied (center and right)

“Gamma/Pedestal/Gain” on page 98 Original (left) and with variations of Gamma/Pedestal/Gain 
applied (center and right)
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“Grow Bounds” on page 99 Original (left); the Wave Warp effect is constrained by the dimensions 
of the layer (center); Grow Bounds fixes this problem (right).

“PS Arbitrary Map” on page 99 Original (left), a map created in Photoshop (center), and with PS 
Arbitrary Map applied (right)

“Tint” on page 100 Original (left) and with variations of Tint applied (center and right)

Keying effects

“Color Difference Key (Pro only)” on page 101 Original (left) and background layer (center) are 
combined using Color Difference Key (right).

“Color Key” on page 103 A nonstandard key color (left) and the background (center) are combined 
using Color Key (right).
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“Color Range” on page 104 A poorly lit green screen (left) and a background layer (center) are 
combined using the Color Range Key (right).

“Difference Matte (Pro only)” on page 105 Original (left), Matte Only view of keyed-out subject 
(center), and composite of subject with new background (right)

“Extract (Pro only)” on page 106 Original with glare (left) and background layer (center) are 
combined using Extract (right).

“Inner/Outer Key (Pro only)” on page 107 The original masked layer (left) and the background 
layer (center) are combined using Inner/Outer Key (right).

“Linear Color Key (Pro only)” on page 108 Features such as these eyes (left) that closely match the 
background (center) can become transparent when using keys; Linear Color Key keeps them opaque 
with the Keep This Color control (right).
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“Luma Key” on page 110 A white background of the original (left and center) is removed using 
Luma Key (right).

“Spill Suppressor (Pro only)” on page 111 The original green key (left) leaves a green glow when 
keyed out (center). Spill Suppressor removes the glow (right).

Matte Tools effects

“Matte Choker (Pro only)” on page 113 Original (left) shows areas of unwanted transparency after 
using Color Key (center) that are removed with Matte Choker (right).

“Simple Choker (Pro only)” on page 114 The original (left) contains unwanted edges after keying 
(center) that are removed with Simple Choker (right).
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Noise effects

“Dust & Scratches” on page 115 Scratches (left), enlarged view of scratches (center), and scratches 
removed with loss of clarity (right

“Fractal Noise (Pro only)” on page 115 Original (left) and with variations of Fractal Noise applied 
(center and right)

“Median” on page 119 Original (left) and with variations of Median applied (center and right)

“Noise” on page 120 Original (left) and with variations of Noise applied (center and right)

“Noise Alpha” on page 120 Original (left) and with variations of Noise Alpha applied (center and 
right)
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“Noise HLS, Noise HLS Auto” on page 121 Original Layer (left), Noise HLS (center), and two appli-
cations of Noise HLS with low Saturation values (right)

Paint

“Vector Paint (Pro only)” on page 123 Two strokes in different colors painted on the robot's 
antenna, using three variations of Vector Paint

Perspective effects

“Basic 3D” on page 138 Original (left) and with variations of Basic 3D applied (center and right) 

“Bevel Alpha” on page 139 Original (left) and with variations of Bevel Alpha applied (center and 
right)

“Bevel Edges” on page 139 Original (left), background layer visible (center), and with the Bevel 
Edges applied to the background layer (right)



Using Help | Contents | Index Back 22  

Adobe After Effects Help Gallery of effects 

Using Help | Contents | Index Back 22  

“Drop Shadow” on page 140 Original (left) and with variations of Drop Shadow applied (center and 
right)

“Radial Shadow” on page 140 Original (left), with Radial Shadow applied once (center), and with 
the effect applied twice (right)

Render effects

“4-Color Gradient” on page 142 Original (left) and with variations of 4-Color Gradient applied 
(center and right)

“Advanced Lightning (Pro only)” on page 142 Multiple applications of the effect using the 
Breaking lightning type (center) and the Bouncey lightning type (right)

“Audio Spectrum” on page 145 Original (left) and with variations of Audio Spectrum applied 
(center and right)
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“Audio Waveform” on page 146 Original (left) and with variations of Audio Waveform applied 
(center and right)

“Beam” on page 147 Original (left) and with Beam applied (right)

“Cell Pattern” on page 147 The crystal cell pattern creates a displacement map (center) that is used 
with the Displacement Map effect (right).

“Checkerboard (formerly Checker)” on page 150 Original (left) and with variations of Checker-
board applied (center and right)

“Circle” on page 151 Original (left) and with variations of Circle applied (center and right)
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“Ellipse” on page 152 Original (left), with Ellipse applied once (center), and with Ellipse applied 
multiple times (right)

“Eyedropper Fill (formerly Color Picker)” on page 152 Original (left) and with variations of 
Eyedropper Fill applied (center and right)

“Fill” on page 153 A mask (left) is used with the Fill effect (center); a different mask is used (right).

“Fractal” on page 153 Original (left) and with variations of Fractal applied (center and right)

“Grid” on page 155 Original (left) and with variations of Grid applied (center and right)
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“Lens Flare (Pro only)” on page 156 Original (left) and with variations of Lens Flare applied (center 
and right)

“Lightning” on page 156 Original (left) and with variations of Lightning applied (center and right)

“Paint Bucket (formerly Basic Fill)” on page 158 Original (left) and with variations of Paint Bucket 
applied (center and right)

“Radio Waves” on page 160 Original (left) and with variations of Radio Waves applied (center and 
right)

“Ramp” on page 163 Original (left) and with variations of Ramp applied (center and right)
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“Scribble” on page 163 Original with masks (left) and with variations of Scribble applied (center 
and right)

“Stroke” on page 165 Original (left), with mask (center), and with Stroke applied (right)

“Vegas” on page 165 Original (left) and with variations of Vegas applied (center and right)

Simulation effects

“Card Dance” on page 168 Top: Original (left) and with Card Dance applied using different rotations 
(center and right) Bottom: Original (left), gradient layer (center), and with Card Dance applied using 
the gradient layer (right)



Using Help | Contents | Index Back 27  

Adobe After Effects Help Gallery of effects 

Using Help | Contents | Index Back 27  

“Caustics” on page 172 Bottom layer (left), water layer (center), and with Caustic applied (right)

“Foam” on page 175 Original (left), with Foam applied (center), and with a robot layer used as the 
Bubble Texture Layer (right)

“Particle Playground (Pro only)” on page 180 Effect with variations of Canon (left), Particle 
Exploder (center), and Layer Exploder (right)

“Shatter” on page 197 Original (left) and with Shatter applied over time to reveal another layer 
(center and right)
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“Wave World” on page 204 Top: Wireframe view (left), Height Map view (center), and the resulting 
image used as the water surface of the Caustics effect (right) Bottom: Wireframe view (left), Height 
Map view (center), and the resulting image used with the Colorama effect (right)

Stylize effects

“Brush Strokes” on page 208 Original (left) and with variations of Brush Strokes applied (center 
and right)

“Color Emboss” on page 209 Original (left) and with variations of Color Emboss applied (center and 
right)

“Emboss” on page 209 Original (left) and with variations of Emboss applied (center and right)

“Find Edges” on page 209 Original (left) and with variations of Find Edges applied (center and 
right)
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“Glow (Pro only)” on page 210 Original (left) and with variations of Glow applied (center and right) 

“Leave Color” on page 212 Original (left) and with variations of Leave Color applied (center and 
right)

“Mosaic” on page 212 Original (left) and with variations of Mosaic applied (center and right)

“Motion Tile” on page 213 Original (left) and with variations of Motion Tile applied (center and 
right)

“Roughen Edges” on page 214 Original (left) and Edge Type set to Roughen (center) and Rusty 
Color (right) with all controls set to maximum values
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“Scatter (Pro only)” on page 216 Original (left), after applying Scatter (center), and then applying 
the Noise effect (right)

“Strobe Light” on page 216 This effect is difficult to illustrate. See the online Effects Help for infor-
mation on using this effect.

“Texturize” on page 217 Original (left), a layer used to create texture (center), and the texture 
applied to background layer (right)

“Write-on” on page 217 Three strokes are animated through time (left, center, and right).

Text effects

“Basic Text” on page 219 Original (left) and with variations of Basic Text applied (center and right)

“Numbers” on page 220 Original (left) and with variations of Numbers applied (center and right)
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“Path Text” on page 222 Original (left) and with variations of Path Text applied (center and right)

Time effects

“Echo” on page 228 Three subsequent frames showing echo effect

“Posterize Time” on page 229 This effect is difficult to illustrate. See the online Effects Help for 
information on using this effect.

“Time Difference” on page 230 This effect is difficult to illustrate. See the online Effects Help for 
information on using this effect.

“Time Displacement (Pro only)” on page 231 Original (left), a layer used to displace the image as 
time progresses (center), and the result (right)

Transition effects

“Block Dissolve” on page 234 Original (left) and with variations of Block Dissolve applied (center 
and right)



Using Help | Contents | Index Back 32  

Adobe After Effects Help Gallery of effects 

Using Help | Contents | Index Back 32  

“Card Wipe” on page 234 Original (left) and with variations of Card Wipe applied (center and right)

“Gradient Wipe” on page 238 Original (left) and with variations of Gradient Wipe applied (center 
and right)

“Iris Wipe” on page 239 Original (left) and with variations of Iris Wipe applied (center and right)

“Linear Wipe” on page 239 Original (left) and with variations of Linear Wipe applied (center and 
right)

“Radial Wipe” on page 239 Original (left) and with variations of Radial Wipe applied (center and 
right)
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“Venetian Blinds” on page 240 Original (left) and with variations of Venetian Blinds applied (center 
and right)

Video effects
“Broadcast Colors” on page 241 This effect is difficult to illustrate. See the online Effects Help for 
information on using this effect.

“Reduce Interlace Flicker” on page 242 This effect is difficult to illustrate. See the online Effects 
Help for information on using this effect.

“Timecode” on page 242 Original (left) and with variations of Timecode applied (center and right)



Using Help | Contents | Index Back 34  

Adobe After Effects Help Effects included with After Effects 

Using Help | Contents | Index Back 34  

Effects included with After 
Effects

Standard effects
Adobe® After Effects includes an array of visual and audio effects. And, because of the 
After Effects plug-in technology, you can use additional effects from other Adobe plug-in–
compatible applications, such as Adobe Photoshop. When you register your copy of After 
Effects, you can download the following effects from the After Effects product section on 
Adobe’s Web site: Card Dance, Card Wipe, Caustics, Foam, and Wave World.

To see which effects are included within each effect category, see the table of contents in 
the online Effects Help. 

Note: If an effect is 16 bit, its icon in the Effects palette is denoted with a “16” . All other 
effects are denoted with the standard effects icon .

What you get with the Professional edition
The Professional Edition of After Effects includes all of the effects available in the Standard 
Edition, as well as the following effects:

Adjust Color Stabilizer

3D Channel 3D Channel Extract, Depth Matte, Depth of Field, Fog 3D, and ID Matte

Audio Flange & Chorus, High-Low Pass, Modulator, Parametric EQ, Reverb, and Tone

Channel Alpha Levels

Distort Bezier Warp, Bulge, Corner Pin, Displacement Map, Mesh Warp, Optics Compen-
sation, and Reshape

Keying Color Difference Key, Difference Matte, Extract, Inner/Outer Key, Linear Color Key, 
and Spill Suppressor

Matte Tools Matte Choker and Simple Choker

Noise Fractal Noise

Paint Vector Paint

Render Advanced Lightning

Simulation Particle Playground

Stylize Glow and Scatter

Time Time Displacement
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3D Channel effects (Pro only)

Overview
The After Effects Professional Edition provides tools to integrate 3D scenes into 2D 
composites, and to make changes to those 3D scenes. You can import 3D channel image 
files saved in RLA, RPF, Softimage PIC/ZPIC, and Electric Image EI/EIZ formats. For PIC and 
EI files, the 3D channel information is in the ZPIC or EIZ files, respectively. You don’t 
actually import ZPIC and EIZ files, but as long as they’re stored in the same folder with the 
PIC and EI files, you have access to their 3D channels using the 3D Channel effects. The 3D 
Channel effects don’t affect other types of files.

3D Channel effects read and manipulate the additional channels of information, including 
z-depth, surface normals, object ID, texture coordinates, background color, unclamped 
RGB, and material ID. You can layer 3D elements along a z axis, insert other elements in a 
3D scene, blur areas in a 3D scene, isolate 3D elements, apply a foggy effect with depth, 
and extract 3D channel information for use as parameters in other effects. 

Note: Apply 3D Channel effects to 2D layers that have the auxiliary information. If you 
convert a layer to 3D and view it from anywhere else but the front and center, it doesn’t 
appear as expected.

3D Channel Extract (Pro only)
The 3D Channel Extract effect makes auxiliary channels visible as either grayscale or multi-
channel color images. You can then use the resulting layer as parameters for other effects. 
For example, extract the z-depth information in a 3D channel image file and then use it as 
an influence map in the Particle Playground effect, or extract values from the Unclamped 
RGB channel to produce a matte that generates glowing highlights.

Original (left), duplicate of original with 3D Channel Extract applied using Texture UV (center), and 
original combined with duplicate using the Luminosity blending mode (right)

Adjust the following controls for the 3D Channel Extract effect:

3D Channel Specifies the channel that you want to extract from the 3D channel image 
file. 

White Point, Black Point Specify the value that is mapped to white or black.
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Depth Matte (Pro only)
The Depth Matte effect reads the z-depth information in a 3D channel image file and can 
slice the image anywhere along that z axis. Use this effect to create a matte for everything 
in front of or behind the value you specify. For example, remove a background in a 3D 
scene, or insert objects into a 3D scene. Simply create two layers with the 3D channel 
image file; then, in one layer, position everything behind a certain point. In the other layer, 
position everything in front of that same point, so that the two layers together make up 
the original image; then insert a layer between them with the object that you want to 
composite into the scene.

Original (left), with Depth Matte applied to two different depth specifications (center and right)

Adjust the following controls for the Depth Matte effect:

Depth Specifies the depth of the z axis where you want to slice the image.

Feather Specifies the amount of feather along the slice.

Invert Inverts the feather.

Depth of Field (Pro only)
The Depth of Field effect simulates a camera that’s focusing in on one area in a 3D scene 
(along the z axis) while allowing other areas to blur.

Original (left), and with Depth of Field applied using different Focal Plane settings (center and right)

Adjust the following controls for the Depth of Field effect:

Focal Plane Specifies the specific distance, or plane, along the z axis that you want to 
focus on in the 3D scene. Identify this distance by clicking different parts of the 3D scene 
in the Composition window, while keeping an eye on the z-axis values that appear in the 
Info palette. Note that you must select the effect in the Effect Controls window before you 
click.

Maximum Radius Describes how much blur is applied to objects outside this plane.

Focal Plane Thickness Determines the depth of the region that’s in focus.
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Focal Bias Sets the speed with which the out-of-focus elements lose focus. This value 
works like a gamma correction: the higher the value, the more quickly elements drop out 
of focus.

Fog 3D (Pro only)
The Fog 3D effect applies fog along the z axis, so the distant parts of a 3D scene look hazier 
or disappear behind the fog. Fog 3D simulates fog by behaving as though there is a 
scattering medium in the air that makes objects look more and more diffuse as they get 
more distant along the z axis.

Original (left), Gradient Layer (center), and with Fog 3D applied (right) 

Adjust the following controls for the Fog 3D effect:

Fog Color Specifies the color of the fog.

Fog Start Depth Determines where along the z axis the diffuse scattering begins. To 
specify this point, first select different elements in the 3D scene, and note their z depth in 
the Info palette.

Fog End Depth Determines where the most diffuse area appears along the z axis.

Fog Opacity Determines the opacity of the fog.

Scattering Density Determines how quickly the scattering occurs. This value works like a 
gamma correction: the higher the value, the more dense the fog appears from its starting 
point.

Foggy Background Creates a foggy background and is selected by default. Deselect this 
control to create transparency at the back of the 3D scene for compositing on top of 
another image or scene.

Gradient Layer Specifies a grayscale layer to use as medium for increasing or decreasing 
the fog density. After Effects reads the luminance value in the grayscale image and applies 
it as the scattering medium. You could, for example, create a gradient layer from a swirling, 
drifting texture to create a more atmospheric fog effect. For best results, make sure that 
the dimensions of the gradient layer are the same as the footage, not the composition.

Layer Contribution Specifies how much the gradient layer affects the resulting fog.
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ID Matte (Pro only)
The ID Matte effect isolates elements in a 3D channel image file. Many 3D programs tag 
each element in a scene with a unique Object ID. After Effects uses this information to 
create a matte that excludes everything in the scene except the element you want. 
Identify each object’s Object ID by applying the ID Matte effect and then clicking different 
parts of the image in the Composition window as you watch the Info palette. (You can also 
identify Object IDs in the Layer window if you select the effect from the Layer window 
menu first.) If you select Object ID for the Auxiliary Channel parameter in the Effect 
Controls window, the slider automatically reflects the Object ID for each object you select. 
In addition, you can isolate objects based on their Material ID as well.

Original (left), with ID Matte applied using the near alien as the ID Selection (center), and composited 
over a new background (right)

Adjust the following controls for the ID Matte effect:

Aux. Channel Specifies whether you’re isolating elements based on their Object IDs or 
their Material IDs.

ID Selection Identifies the unique ID value assigned to each element in a 3D scene.

Feather Specifies the amount of feather along the matte’s edges.

Invert Inverts the feather.

Use Coverage Creates a cleaner matte by decontaminating the pixels along the edge of 
the matte. It removes the colors stored behind the object from these pixels. This is appli-
cable only if your 3D channel image file contains a coverage channel that stores infor-
mation about the colors behind objects. 
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Adjust effects

Brightness & Contrast
The Brightness & Contrast effect adjusts the brightness and contrast of the entire layer 
(not individual channels). The center point of each slider is neutral and indicates no effect. 
The layer’s quality setting does not affect Brightness & Contrast. Using the Brightness & 
Contrast effect is the easiest way to make simple adjustments to the tonal range of the 
image. It adjusts all pixel values in the image at once—highlights, shadows, and midtones.

Original (left), with background layer’s Brightness decreased and Contrast increased (center), and 
with background layer’s Brightness & Contrast decreased (right)

Channel Mixer
The Channel Mixer effect modifies a color channel using a mix of the current color 
channels. Use it to make creative color adjustments not easily done with the other color 
adjustment tools: Create high-quality grayscale images by choosing the percentage 
contribution from each color channel, create high-quality sepia-tone or other tinted 
images, and swap or duplicate channels. The Constant (-Const) controls specify the base 
amount of the input channel to be added to the output channel. Monochrome applies the 
same settings to all the output channels, creating a color image that contains only gray 
values. This is useful for images that you plan to convert to grayscale. If you select and then 
deselect Monochrome, you can modify the blend of each channel separately, creating a 
hand-tinted appearance.

Original (left), with background layer’s Green and Blue values decreased (center), and with 
background layer’s Red-Blue values increased and Blue-Red values decreased (right)
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Color Balance
The Color Balance effect changes the amount of red, green, and blue color in a layer. The 
center point of each slider is neutral and indicates no change. A setting of –100 removes 
all of the color; a setting of +100 intensifies the color. The layer’s quality setting does not 
affect Color Balance.

The Shadow/Midtone/Hilight channel Balance controls specify the amount of a channel’s 
color in the darker, middle, and lighter color intensity ranges of a layer. Preserve 
Luminosity preserves the average brightness of the image while changing the color. This 
control maintains the tonal balance in the image.

Original (left), with Shadow Red values increased and Shadow Green values decreased (center), and 
with Shadow, Midtone, and Hilight values decreased for red and green (right)

Color Stabilizer (Pro only)
The Color Stabilizer effect samples the exposure of specified areas of a single reference, or 
pivot, frame; it then adjusts the total exposure of all the other frames to maintain the value 
of the selected point in the pivot frame. This is useful to remove flicker from footage and to 
equalize the exposure of footage with color shifts caused by varying lighting situations.

Adjust the following controls for Color Stabilizer: 

Set Frame Specifies the pivot frame. Display the frame that has the area of brightness or 
color that you want to match, and click Set Frame.

Stabilize Specifies the method by which the stabilization is performed. Choose one of 
the following options from the menu:

• Brightness specifies that the brightness is to be stabilized throughout the footage. You 
can sample one point in the pivot frame to specify this value. 

• Levels specifies that black-point and white-point values in the pivot frame are to be 
stabilized throughout the footage.

• Curves specifies that black-point, white-point, and midpoint values in the pivot frame 
are to be stabilized throughout the footage.

The following controls indicate the particular point on the pivot frame that remains 
constant throughout the footage. Place the effect points to select an area for stabilization. 
If you select multiple points, consider that Color Stabilizer is most effective when those 
points vary widely in color and brightness. 

Black Point Specifies a single point that will remain constant, if you choose to stabilize 
brightness only. If you choose to stabilize levels or curves, this control specifies a dark 
point that remains constant. 

Mid Point Specifies a point between two values of color or brightness that will remain 
constant. This control is available only if you choose to stabilize curves. 
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White Point Specifies a light point that will remain constant. This control is available only 
if you choose to stabilize levels or curves. 

Sample Size Specifies the size, in radius of pixels, of the sampled area. 

Curves
The Curves effect adjusts the tonal range of an image. You can also use Levels to do this, 
but Curves gives you more control. Instead of making the adjustments using just three 
controls (highlights, shadows, and midtones) as Levels does, Curves can adjust any point 
along the input scale while keeping up to 15 other values constant.

Original (left); with background layer’s shadows and midtones decreased, adding more contrast in 
highlights (center); and with background layer’s shadows and low midtones increased, highlights 
and mid-highlights decreased, reversing the normal tones (right)

When you apply the Curves effect, After Effects displays a graph in the Effect Controls 
window that you use to specify a curve. 

The horizontal axis of the graph represents the original brightness values of the pixels 
(input levels); the vertical axis represents the new brightness values (output levels). In the 
default diagonal line, all pixels have identical input and output values. Curves displays 
brightness values from 0 to 255 (8 bit) or 32768 (16 bit), with shadows (0) on the left. 

Use Arbitrary Map to draw a tonal curve by dragging. This control helps you create a 
variety of interesting tonal and color effects. In addition, you can import curves and 
arbitrary maps from Adobe Photoshop. Curves supports .amp files (Windows) and 
Photoshop lookup files (Mac OS) created by using the pencil tool, and .acv files (Windows) 
and Photoshop spline files (Mac OS) created by using the graph tool. The Curves effect 
does not support Adobe Photoshop color tables (.act).

Adjust the curve in the graph, and adjust the following control for the Curves effect:

Channel Specifies the color channel or alpha channel to be modified. 

Using the Curves effect
The following procedures provide a basic overview of how to use this effect.

To use the Curves effect:

1  Choose Effect > Adjust > Curves. 

2  If the image has more than one color channel, choose the channel you want to adjust 
from the Channel menu. RGB alters all channels using a single curve. 

3  Select Bezier . 

4  Click the part of the curve you want to adjust.
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5  Click any points on the curve that you want to remain fixed. For example, if you want to 
adjust the midtones while minimizing the effect on the highlights and shadows, click the 
quarter and three-quarter points on the curve. You can add up to 14 points to the curve, 
locking those values. 

6  To remove a fixed point, drag it off the graph.

7  Adjust the curve by dragging it. 

To use Arbitrary Map in the Curves effect:

1  Click the Folder icon to locate and open an existing map, or click the pencil tool to edit 
the default curve. 

2  Draw or edit the curve in the Curves graph.

3  If desired, click Smooth  to smooth the curve or click Line  to reset the curve.

Hue/Saturation
The Hue/Saturation effect adjusts the hue, saturation, and lightness of individual color 
components in an image. This effect is based on the color wheel. Adjusting the hue, or 
color, represents a move around the color wheel. Adjusting the saturation, or purity of the 
color, represents a move across its radius. Use the Colorize control to add color to a 
grayscale image converted to RGB, or to add color to an RGB image. 

Original (left); with background layer’s Master Hue adjusted, Master Saturation increased, and Master 
Lightness decreased (center); and with background layer’s Colorize selected, Hue adjusted, Master 
Saturation at 100, and Master Lightness decreased (right)

Hue/Saturation controls
Adjust the following controls for the Hue/Saturation effect:

Channel Control Specifies the color channel you want to adjust. Choose Master to adjust 
all colors at once.

Channel Range Specifies the definition of the color channel chosen in the Channel 
Control menu. Two color bars represent the colors in their order on the color wheel. The 
upper color bar shows the color before the adjustment; the lower bar shows how the 
adjustment affects all of the hues at full saturation. Use the adjustment slider to edit any 
range of hues. 

Master Hue Specifies the overall hue of the channel chosen in the Channel Control 
menu. Use the dial, which represents the color wheel, to change the overall hue. The 
underlined value displayed above the dial reflects the number of degrees of rotation 
around the wheel from the pixel’s original color. A positive value indicates clockwise 
rotation; a negative value indicates counterclockwise rotation. Values range from –180 to 
+180.
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Master Saturation, Master Lightness Specify the overall saturation and lightness of the 
channel chosen in the Channel Control menu. Values range from –100 to +100. 

Colorize Adds color to a grayscale image converted to RGB, or adds color to an RGB 
image—for example, to make it look like a duotone image by reducing its color values to 
one hue.

Colorize Hue, Colorize Saturation, Colorize Lightness Specify the hue, saturation, and 
lightness of the color range you chose in the Channel Control menu. After Effects displays 
only the sliders for the Channel Control menu choice. 

Using the Hue/Saturation effect
The following procedures provide basic overviews of how to use this effect.

To adjust an image using Hue/Saturation: 

1  Choose Effect > Adjust > Hue/Saturation.

2  From the Channel Control menu, choose which colors to adjust:

• Choose Master to adjust all colors at once. 

• Choose a preset color range for the color you want to adjust, and then use the sliders for 
that color range. 

3  For Hue, type a value or drag the dial.

4  For Saturation, type a value or drag the slider. The color shifts away from or toward the 
center of the color wheel, relative to the beginning color values of the selected pixels. 

5  For Lightness, type a value or drag the slider. 

To colorize an image or create a monotone effect: 

1  Choose Effect > Adjust > Hue/Saturation.

2  Select Colorize. The image is converted to the hue of the current foreground color. The 
lightness value of each pixel does not change.

3  Drag the Colorize Hue dial to select a new color if desired. 

4  Drag the Colorize Saturation and Colorize Lightness sliders. 

To modify the range of an adjustment slider:

1  From the Channel Control menu, choose an individual color. (By default, the range of 
color selected when you choose a color component is 30° wide, with 30° of fall-off on 
either side. Setting the fall-off too low can produce dithering in the image.)

2  Do any of the following:

• Drag one or both of the white triangles to adjust the amount of feather without 
affecting the range. 

• Drag one or both of the vertical white bars to adjust the range. Increasing the range 
decreases the fall-off, and vice versa.
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Levels
The Levels effect remaps the range of input color levels onto a new range of output color 
levels, and changes the gamma correction curve at the same time. The Levels effect is 
useful for basic image quality adjustment. This effect functions the same as the Levels 
adjustment in Photoshop and appears in the same way if monitor calibration is off. (See 
“Levels (Individual Controls)” on page 45.)

Original (left); with background layer’s Input Black increased, Output White decreased, and Gamma 
decreased (center); and with an additional Levels effect applied on top of the first, using default 
values (right)

The gamma of any curve is its slope, expressed as the ratio of the logs of the output to 
input values. For example, a gamma value of 1.0 equals an output-to-input ratio of 1:1. 
Moving the midpoint of the curve up (in an RGB readout) lowers the gamma value; 
moving the midpoint down raises the gamma value. Gamma specifies contrast that affects 
the midtones in a range. 

You can adjust the brightness, contrast, and gamma in an image. Use Levels to adjust the 
gamma to change the brightness values of the middle range of gray tones without 
dramatically altering the shadows and highlights. 

Levels controls
Adjust the following controls for the Levels effect:

Channel Specifies the color channel to be modified.

Histogram Shows how the pixel values are distributed in an image. The horizontal axis of 
the histogram represents the brightness value. The vertical axis represents the number of 
pixels at each brightness level. No pixels can be darker than the output black level, and no 
pixel can be brighter than the output white level. 

Input Black Specifies the threshold of the black value for the input image. Pixels below 
the input black level are mapped as black on the input image. The input black value is 
represented by the upper left triangle below the histogram.

Output Black Specifies the limit of the black value for the output image. The output black 
value is represented by the lower left triangle below the histogram. 

Gamma Specifies the gamma value, which is represented by the middle triangle below 
the histogram. 

Output White Specifies the limit of the white value for the output image. The output 
white value is represented by the lower right triangle below the histogram.

Input White Specifies the threshold of the white value for the input image. Pixels below 
the input white level are mapped as white on the input image. The input white value is 
represented by the upper right triangle below the histogram.
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Levels (Individual Controls)
The Levels (Individual Controls) effect functions like the Levels effect but allows you to 
adjust the individual color values for each channel. This allows you to add expressions to 
individual properties or keyframe one property independently of the others. To see each 
control individually, click the arrow next to the channel color to expand it. (See “Levels” on 
page 44.)

Original (left), with background layer’s Blue Input Black increased (center), and with an additional 
Levels effect applied with the same values as the first (right)

Posterize
The Posterize effect lets you specify the number of tonal levels (or brightness values) for 
each channel in an image. Posterize then maps pixels to the closest matching level. For 
example, choosing two tonal levels in an RGB image gives you two tones for red, two 
tones for green, and two tones for blue. Values range from 2 to 255. Although the results of 
this effect are most evident when you reduce the number of gray levels in a grayscale 
image, Posterize also produces interesting effects in color images.

Use Level to adjust the number of tonal levels for each channel to which Posterize will map 
existing colors.

Original (left), with background layer’s Level set to 5 (center), and with background layer’s Level set 
to 2 (right)

Threshold
The Threshold effect lets you convert grayscale or color images to high-contrast, black-
and-white images. Specify a certain level as a threshold; all pixels lighter than the 
threshold are converted to white and all pixels darker to black.

Original (left), with the Level for the cloud background set to 200 (center), and set to 111 (right)
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Audio effects

About Audio Effects
Audio effects add ambiance to a layer, enhance or correct audio characteristics, and create 
effects. You can apply audio effects to existing audio footage or synthesize just about any 
sound by combining the Tone effect with other audio effects.

Backwards
The Backwards effect reverses an audio footage item by playing it from the last frame to 
the first frame. The frames remain in their original order when viewed in the Timeline 
window.

Bass & Treble
The Bass & Treble effect lets you adjust the amount of boost or cut applied to the low 
frequencies (bass) or the high frequencies (treble) of the audio layer. If you need greater 
control in working with audio tone, use the Parametric Equalization effect in the After 
Effects Professional edition.

Delay
The Delay effect repeats the sounds in the audio layer after a specified amount of time. 
This simulates sound bouncing off a surface, such as a wall some distance away. 

To simulate the acoustic ambience of a room, use the Reverb effect in the After Effects 
Professional edition.

Adjust the following controls for the Delay effect:

Delay Time Specifies the interval of time between the original sound and its echo, in 
milliseconds. Drag the slider to the right to increase the time between the original sound 
and its echo.

Delay Amount Specifies the level of the first delayed audio. Drag the slider to the right to 
increase the amount of the original sound that is sent as echo.

Feedback Specifies the amount of the echo that is fed back into the delay line to create 
subsequent echoes. Drag the slider to the right to increase the amount of echo signal fed 
back into the delay line.

Dry Out, Wet Out Specify the balance of the original (dry) sound to the delayed (wet) 
sound in the final output. Values of 50% are commonly used.
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Flange & Chorus (Pro only)
The Flange & Chorus effect lets you adjust both the Flange and Chorus. Chorus is 
commonly used to add depth and character to audio footage that contains a single 
instrument or voice. Chorus makes one voice sound like many voices.

Flange applies a copy of the sound that is detuned, or played at a frequency slightly offset 
from the original. By experimenting with the voice separation time and the modulation 
depth, you can create a wavy, rushing sound. The default settings apply to Flange alone. 

Adjust the following controls for the Flange & Chorus effect:

Voice Separation Time (ms) Specifies the time in milliseconds that separates each voice. 
Each voice is a delayed version of the original sound. Low values are commonly used for 
flange, and higher values for chorus.

Voices Specifies the number of voices in the processed (wet) audio. Increasing this value 
applies more of a chorus effect.

Modulation Rate Specifies the rate in Hz at which the frequency modulates.

Modulation Depth Specifies the amount of frequency modulation.

Voice Phase Change Specifies the modulation phase difference in degrees between 
each subsequent voice. Invert Phase inverts the phase of the processed (wet) audio, which 
emphasizes more of the high frequencies; not inverting the phase emphasizes more of the 
low frequencies. Stereo Voices alternates each voice between two channels so that the 
first voice appears in the left channel, the second in the right channel, the third in the left, 
and so on. To hear stereo voices, you must preview the audio in stereo or render the movie 
in stereo.

Dry Out, Wet Out Specify the mix of unprocessed (dry) audio to processed (wet) audio in 
the final output. Values of 50% are commonly used.

To apply Chorus without Flange:

1  For Voice Separation Time (ms), specify a value of about 40. For a deeper chorus effect, 
increase this value.

2  For Voices, specify 4.

3  For Modulation Rate, specify a value of about 0.1.

4  For Modulation Depth, specify 50%.

5  For Voice Phase Change, specify 90, and then select Stereo Voices. To quickly find an 
optimal phase change based on the number of voices you have specified, use the formula 
P=360/x, where P is the phase change and x is the number of voices.

6  For Dry Out and Wet Out, specify 50% each. To make voices appear from more than one 
direction and get louder over time, select Stereo Voices, drag the Dry Out slider to 0.0 so 
you hear just the effect, and then set keyframes so that the voices fade in over time.

High-Low Pass (Pro only)
The High-Low Pass effect sets a limit above or below which frequencies can pass. The High 
Pass filter option allows frequencies above the limit and blocks frequencies below. 
Conversely, Low Pass allows frequencies below the limit and blocks frequencies above. 
Use High-Low Pass to do the following:
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• Enhance or attenuate (reduce) a sound. For example, using High Pass can reduce traffic 
noise, which often is concentrated at low frequencies, while minimally affecting a voice 
recording. Using Low Pass can remove high-frequency sounds, such as static and 
buzzing.

• Change the focus from one sound to another over time. For example, in audio that 
contains both music and voice, you can fade out the music while gradually bringing in 
the voice.

• Protect equipment from potentially damaging frequencies.

• Direct certain frequencies to specific equipment. For example, using Low Pass can 
isolate sounds intended for a subwoofer.

Adjust the following controls for the High-Low Pass effect:

Filter Options Specifies whether to apply High Pass or Low Pass. 

Cutoff Frequency  For High Pass, specifies the frequency below which the footage is not 
audible. For Low Pass, specifies the frequency above which the footage is not audible. 

Dry Out, Wet Out Specify the mix of unprocessed (dry) audio to processed (wet) audio in 
the final output. Common values for removing frequencies are 0% for Dry Out and 100% 
for Wet Out.

To remove frequencies using the High-Low Pass effect:

1  Determine if the unwanted sound has predominantly high- or low-frequency content.

2  For Filter Options, choose High Pass if the unwanted sound has low-frequency content; 
otherwise, choose Low Pass.

3  Adjust the cutoff frequency to isolate the unwanted sound from the frequencies you 
want to keep. To help isolate the unwanted sound, apply the Audio Spectrum effect to a 
motion footage layer to see the magnitude of the frequencies in the range you define. 

4  Choose 0% for Dry Out and 100% for Wet Out.

5  To verify that the frequencies you are cutting off are the ones you want to remove, 
switch to the opposite filter and then preview the audio.

6  To identify which cutoff frequencies work best, do one of the following:

• Continue to adjust the cutoff frequency and preview the audio until you reduce or 
remove the unwanted sound while minimally affecting the frequencies you want to 
keep.

• Set keyframes for different cutoff frequencies, and then preview the audio. 

7  Make sure that you have selected the Audio Spectrum effect.

Modulator (Pro only)
The Modulator effect adds both vibrato and tremolo to audio by modulating (varying) the 
frequency and amplitude. Using Modulator, you can create a Doppler effect, such as when 
a train whistle gets higher in pitch as it approaches an observer, and then drops in pitch as 
it passes.

Adjust the following controls for the Modulator effect:

Modulation Type Specifies the type of waveform to use. Sine waves produce the purest 
sounds. Triangle waves produce more distorted sounds.
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Modulation Rate Specifies the rate in Hz at which the frequency modulates.

Modulation Depth Specifies the amount of frequency modulation.

Amplitude Modulation Specifies the amount of amplitude modulation.

Parametric EQ (Pro only)
The Parametric EQ effect either emphasizes or attenuates specific frequency ranges. 
Parametric EQ is useful for enhancing music, such as boosting low frequencies to bring up 
bass. Using this effect, you can enhance up to three different bands of the audio footage. 
As you adjust controls, a Frequency Response graph indicates the combined equalization 
curve you create. On the Frequency Response graph, Band 1 is red, Band 2 is green, and 
Band 3 is blue. You may find it easier to specify controls if you determine in advance the 
frequency-response curve you want.

Adjust the following controls for the Parametric EQ effect:

Band Enabled  Activates an equalization band and its controls.

Frequency  Specifies which frequency to modify. This frequency acts as the peak of the 
effect—the center of the bandwidth you specify.

Bandwidth  Sets the range of frequencies to enhance above and below the frequency 
specified under Frequency. 

Boost/Cut Specifies the amount of boost or cut applied to the amplitude of the 
frequencies inside the specified bandwidth. Positive values boost; negative values cut.

If you have audio with an unwanted sound (such as a beep from a forklift in the 
background), you can isolate and cut the frequency range of the beep to attenuate the 
sound. You may need to experiment with several settings to isolate the frequency range. 
To do this, set keyframes for different Parametric EQ properties, and then preview the 
audio. You can also apply the Audio Spectrum effect to a motion footage layer to see the 
magnitude of the frequencies in the range you define. 

Reverb (Pro only)
The Reverb effect simulates a spacious or acoustically live interior by simulating random 
reflections of a sound off a surface.

Adjust the following controls for the Reverb effect:

Reverb Time (ms) Specifies the average time, in milliseconds, between the original audio 
and the reverberated audio. 

Diffusion Specifies how much the effect scatters the original audio. More diffusion can 
make the audio sound farther from the microphone.

Decay Specifies the amount of time it takes for the effect to subside. A higher value 
simulates a larger space.

Brightness Specifies the amount of detail preserved from the original audio. More 
brightness can simulate a room with live, or highly reflective, acoustics.

Dry Out, Wet Out Specify the mix of the unprocessed (dry) audio to the processed (wet) 
audio in the final output. 
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Stereo Mixer
The Stereo Mixer effect mixes the left and right channels of an audio layer and pans the 
entire signal from one channel to the other. 

Adjust the following controls for the Stereo Mixer effect:

Left Level, Right Level Specify the level of the left or right audio channel of an audio 
layer. A value of 2.00 is full level. 

Left Pan, Right Pan Shift the mixed stereo signal from one audio channel to the other. 
Values of –1.00 for Left pan and +1.00 for Right pan produce an even balance. 

Invert Phase Inverts the phase of both channels of the stereo signal. Use this control to 
prevent two sounds at the same frequency from canceling each other out. 

Tone (Pro only)
The Tone effect synthesizes simple audio tones to create effects such as the low rumble of 
a submarine, a telephone ringing in the background, sirens, or a laser blast. You can add 
up to five tones for each effect to create a chord, for example, in a composition. When you 
apply this effect to audio footage, the dry (unprocessed) audio is ignored, and only the 
tone plays. 

You can also apply the Tone effect to a layer that has no audio, such as an Adobe Illustrator 
object, to synthesize audio. When you render the movie, make sure that you select an 
output format that supports audio, for example, QuickTime or Video for Windows.

Adjust the following controls for the Tone effect:

Waveform Options Specifies the type of waveform to use. Sine waves produce the 
purest tones. Square waves produce the most distorted tones. Triangle waves have 
elements of both sine waves and square waves but are closer to sine waves. Saw waves 
have elements of both sine waves and square waves but are closer to square waves.

Frequency 1...5 Specifies the frequency in Hz of the first through the fifth tones. To turn 
off a tone, set its frequency to 0.0.

Level Changes the amplitude of all tones. If you hear clicking when you preview or play 
the audio, you may have set the Level value too high. To produce a clean sound, use a 
percentage less than or equal to 100 divided by the number of frequencies you use. For 
example, if you use all five frequencies, choose 20%. 

To avoid clicks at the end of a tone, set a keyframe for the desired amplitude level at the 
frame just before the end of the tone, and then set another keyframe for a level of 0.0 at 
the end of the tone. This technique works well for any music you end abruptly.
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Blur & Sharpen effects

Channel Blur
The Channel Blur effect blurs a layer’s red, green, blue, or alpha channels individually. You 
can specify that the blur is horizontal, vertical, or both. At Best quality, the blur is smooth. 
Use this effect for glow effects or if you want a blur that does not become transparent near 
the edges of the layer. Edge Behavior describes how to treat the edges of a blurred image. 
If you deselect it, pixels outside the image are transparent, which makes the edges of the 
blurred image semitransparent. Select Repeat Edge Pixels to repeat the pixels around the 
edges, preventing the edges from darkening and becoming more transparent.

Original (left), with Blue Blurriness and Alpha Blurriness values increased and Blur Dimensions set to 
Horizontal (center), and with Blue Blurriness, Green Blurriness, and Alpha Blurriness values increased 
and Blur Dimensions set to Horizontal and Vertical (right)

Compound Blur 
The Compound Blur effect blurs pixels in the selected layer based on the luminance values 
of a blur layer, also known as a blurring map. The blur layer, which can be any layer that 
contains pixels of different luminance values, is essentially overlaid on top of the selected 
layer, and the pixels of both layers are matched, one to one. Where the blur layer is black, 
no blurring occurs in the same location in the selected layer. The blur layer is used only as a 
map; it is not visible in the composition.

Original (left), with the cloud layer set as the Blur Layer; then inverted (center) and cloud layer’s Video 
switch off (right)
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Blur Layer specifies the layer in the composition to use as the blurring map. Bright values 
in the blur layer correspond to more blurring of the affected layer, while dark values corre-
spond to less blurring. Maximum Blur specifies the maximum amount, in pixels, that any 
part of the affected layer can be blurred. Stretch Map to Fit stretches the blur layer to the 
dimensions of the layer to which it is applied; otherwise, it is centered. Invert Blur inverts 
the values, so areas that were previously more blurred are less blurred, and vice versa.

This effect is useful for simulating smudges and fingerprints, or changes in visibility 
caused by atmospheric conditions such as smoke or heat, especially with animated 
blurring layers. Compound Blur is especially effective in combination with other effects, 
such as Displacement Map. (See “Displacement Map (Pro only)” on page 70.)

Directional Blur
The Directional Blur effect gives a layer the illusion of motion. In previous versions of After 
Effects, this effects was called Motion Blur. At Draft quality, the effect is a blur of the image 
in which each pixel is the unweighted average of its adjacent pixels. At Best quality, the 
effect uses Gaussian weighting, producing a smoother, more graduated blur. The 
Direction control specifies the direction of the blur. The blur is applied equally around a 
pixel’s center; therefore, a setting of 180 degrees and a setting of 0 degrees look the same.

Original (left), with Direction set to 90 degrees and Blur Length set to 9 (center), and with Direction 
set to 315 degrees and Blur Length set to 20 (right)

Fast Blur
The Fast Blur effect blurs an image. Specify whether the blur is horizontal, vertical, or both. 
At Best quality, the Fast Blur effect is a close approximation of a Gaussian Blur, but it blurs 
large areas more quickly. Select Repeat Edge Pixels to blur the contents of the layer while 
keeping the edges of the layer sharp.

Original (left), with Blurriness set to 20 (center), and with Blurriness set to 33 and Blur Dimensions set 
to Vertical (right)
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Gaussian Blur
The Gaussian Blur effect blurs and softens the image and can reduce noise. Specify 
whether the blur is horizontal, vertical, or both. The layer’s quality setting does not affect 
Gaussian Blur.

Original (left), with Blurriness set to 15 (center), and with Blurriness set to 49 and Blur Dimensions set 
to Horizontal (right)

Radial Blur
The Radial Blur effect creates blurs around a specific point in a layer, simulating the effects 
of a zooming or rotating camera. At Draft quality, the blur appears somewhat grainy. You 
may prefer the draft results for special effects, but the grain may flicker on interlaced 
displays.

The Amount control specifies the amount of blur, depending on the choice (Spin or Zoom) 
for Type. For a Spin blur, which applies blurs in circles around the center point, the Amount 
value indicates the degree of rotation. For a Zoom blur, which applies blur that radiates 
out from the center point, the Amount value specifies the degree of radial blurring. You 
can specify the level of anti-aliasing applied at Best quality; no anti-aliasing is applied at 
Draft quality.

Original (left) and with medium amount of Spin blur centered on the alien (center) and with a 
medium amount of Zoom blur centered on the alien (right)

Sharpen
The Sharpen effect increases the contrast where color changes occur. The layer’s quality 
setting does not affect Sharpen.

Original (left) and with Sharpen Amount set to 100 for the cloud layer (right) 
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Unsharp Mask
The Unsharp Mask effect increases the contrast between colors that define an edge. Use 
the Radius control to specify the depth of pixels that will be affected at an edge. If you 
specify a high value, more of the pixels surrounding the edge are adjusted for contrast. If 
you specify a low value, only pixels at the edge are adjusted. Use the Threshold control to 
specify a tolerance to define edges and prevent overall contrast adjustment that might 
generate noise or cause unexpected results. Values define the range of contrast allowed 
between adjacent pixels before contrast is adjusted. A lower value produces a more 
pronounced effect.

Original (left) and with Amount set to 80, Radius set to 24, and Threshold set to 8 for the cloud layer 
(right)
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Channel effects

3D Glasses
The 3D Glasses effect creates a single 3D image by combining a left and right 3D view. You 
can use images from 3D programs or stereoscopic cameras as sources for each view. The 
method you use to create the combined images dictates how you view them. For 
example, you can use 3D Glasses to create an anaglyphic image, which is an image 
containing two slightly different perspectives of the same subject that are tinted 
contrasting colors and superimposed on each other. To create an anaglyphic image, first 
combine views and tint each one a different color. Then, use 3D glasses that have either 
red and green lenses or red and blue lenses, to view the resulting image stereoscopically. 

Balanced Color Red Blue selected (left) and Interlaced Upper L Lower R selected (right)

To avoid problems with flipped views, keep the following guidelines in mind:

• Use the same vertical dimensions for the composition and source images. One pixel 
difference produces the same result as moving the position one pixel vertically. 

• Make sure that the layer’s Position values are whole numbers (such as 240 instead of 
239.7). 

• If your left and right view images are interlaced, deinterlace them before using 3D 
Glasses, to avoid field mismatch. 

• Because 3D Glasses creates interlaced frames, do not select an interlace option in the 
Render Settings dialog box. 

3D Glasses controls
Adjust the following controls for the 3D Glasses effect:

Left View, Right View Specify the layer to use as the left or right view. You only need to 
apply 3D Glasses to only one layer in a composition. If you use a second layer, make sure 
that the two layers are the same size. The second layer does not need to be visible in the 
composition.

Convergence Offset Specifies the amount that the two views are offset. Use this control 
to realign uncalibrated camera views of rendered material. Photos or images rendered 
from 3D programs are generally misaligned and require a negative Convergence Offset 
value.If the original footage was shot with correct convergence, there is no need to 
change this value. Keyframing this value may result in erratic animation.
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Swap Left-Right Swaps the left and right views.

3D View Specifies the rendering mode the effect uses to combine the views. 

• Stereo Pair scales both layers to fit side by side within the effect layer’s bounding box. 
Select Swap Left-Right to create cross-eyed vision. Selecting Stereo Pair disables 
Convergence Offset. 

• Interlace Upper L Lower R takes the upper (first) field from the Left View layer, and the 
lower (second) field from the Right View layer, and combines them into a single or a 
sequence of interlaced frames. Use this option if you want to view the results with 
polarized or LCD shutter glasses. Select Swap Left-Right to switch fields. 

• Red Green LR tints the Right View layer red, and the Left View layer green using the 
luminance values of each layer. 

• Red Blue LR tints the Right View layer red and the Left View layer blue using the 
luminance values of each layer.

• Balanced Red Green LR performs the same operation as Red Green LR but also balances 
the colors to reduce shadows or ghosting effects caused by one view showing through 
the other. Setting a high value reduces the overall contrast.

• Balanced Red Blue LR performs the same operation as Red Blue LR but also balances the 
colors in order to reduce shadows or ghosting effects.

• Balanced Colored Red Blue converts the layer into a 3D view using the original layer’s 
RGB channels. This option maintains the layer’s original colors but may produce 
shadows and ghosting effects. To reduce these effects adjust the balance, or desaturate 
the image, and then apply 3D Glasses. If you are using CG images, raise the black level 
of both views before applying the effect.

Balance Specifies the level of balance in a balanced 3D view option. Use this control to 
reduce shadows and ghost effects. The default balance that 3D Glasses sets when you 
select the Balanced Colored Red Blue option is the ideal value: If you set Balance to 0.0, 3D 
Glasses creates no 3D depth, and if you set Balance too high, 3D Glasses produces a highly 
saturated output. 

For more information, see “Understanding red, blue, and green lenses” on page 56 and 
“Understanding ghost effects” on page 56.

Understanding red, blue, and green lenses
When you work with red and blue images, the blue color in glasses with red and blue 
lenses is actually cyan, not blue. Red and cyan are complementary colors, producing the 
best separation because they filter each other out more efficiently. When you work with 
red and green images, it may appear that the green is not as bright as the red. However, 
viewing the images with red and green lenses produces an even result because green has 
a higher luminance value than red.

Understanding ghost effects
Ghost effects occur when the luminance values of one color exceed those of another color 
to such an extent that you can see the first color through the wrong lens of anaglyph 
glasses. For example, an excessive red luminance value becomes visible through the blue 
lens. If you adjust the Balance value, test the results on the final output media. If you set 
the Balance value too high, a reversed shadow may appear.
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Alpha Levels (Pro only)
The Alpha Levels effect increases or decreases the transparency of a matte. Use Alpha 
Levels to adjust pure black or pure white areas of a matte to be semitransparent, or to 
adjust grays (semitransparent areas) to be pure black and white. Alpha values are 
converted using Input limits, Output limits, and the Gamma value. 

Original (left) and effect applied to arches layer with Input Black Level set to 144 and Output White 
Level set to 90 (center), and with Output Black Level set to about 120 and Output White Level set to 
0 (right)

Adjust the following controls for the Alpha Levels effect:

Input limits, Output limits Specify where transparency begins and ends. 

Gamma Affects the range of gray values that are converted. A Gamma value of 1 
produces a gradual (linear) distribution of gray values. A Gamma value of less than 1 
creates darker gray values and more transparency. A gamma value of greater than 1 
creates lighter gray values and less transparency.

To convert grays in the matte to pure black or white:

1  Set the Input Black Level to a gray value. Alpha values at this level or lower become fully 
transparent (black).

2  Set the Input White Level to a gray value. Alpha values at this level or higher become 
fully opaque (white).

3  Leave the Output Black Level set to 0 and the Output White Level set to 255.

4  If necessary, adjust the Gamma value to increase or decrease transparency. 

To convert pure black and white in the matte into gray areas:

1  Leave the Input Black Level at 0 and the Input White Level at 255.

2  Set the Output Black Level slider to a gray value. Alpha values below this value rise to 
this value. 

3  Set the Output White Level to a gray value. Alpha values above this value are lowered to 
this value.
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Arithmetic
The Arithmetic effect performs various simple mathematical operations on an image’s red, 
green, and blue channels. Operator specifies the mathematical operation to perform 
between the value you specify for each channel and the existing value of that channel for 
each pixel in the image: And, Or, and Xor apply bitwise logical combinations of the 
specified value; Add, Subtract, and Difference apply basic math functions using the 
specified value; Max and Min select each pixel in the color channel that is respectively less 
or greater than the specified value and set it at the specified value. Block Above and Block 
Below turn the channel off everywhere that it is respectively greater or less than the 
specified value; Slice turns the channel off where it is below the value specified and turns 
it on where it is above the specified value. 

Clip Result Values prevents all functions from creating color values that exceed the valid 
range. If this option is not selected, some color values may wrap around from on to off, or 
vice versa.

Original (left), with Operator set to Multiply and Red Value set to 255 (center), and with Operator set 
to And and an increased Green Value (right)

Blend
The Blend effect blends two layers using one of five modes. A crossfade is a standard 
transition between two images: the original image fades out while the new image fades 
in.

Original (left), with layers blended using Darken Only Mode and Blend With Original set to 0% 
(center), and with Color Only Mode and Blend With Original set to 50% (right)

Note: You can create blends more easily and quickly using layer modes, but you can’t 
animate layer modes. The advantage of using the Blend effect is that you can animate it.

Blend controls
Adjust the following controls for the Blend effect:

Blend with Layer Specifies the layer to be blended with the original layer. 
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Mode Specifies the Blend mode you want to use. Crossfade fades between the original 
image and the secondary image. Color Only colorizes each pixel in the original image 
based on the color of each corresponding pixel in the secondary image. Tint Only is similar 
to Color Only but tints pixels in the original image only if they are already colored. Darken 
Only darkens each pixel in the original image that is lighter than the corresponding pixel 
in the secondary image. Lighten Only lightens each pixel in the original image that is 
darker than the corresponding pixel in the secondary image. 

Blend with Original Specifies the fading level between the blended image and the 
original image. A setting of 0% shows only the secondary layer (or just the layers specified 
with Blend if you are in Crossfade mode). At 100%, only the first layer is visible. Changing 
this slider linearly over time gives you a standard crossfade. To try the other blending 
modes, set Blend with Original to 0% to see the full effect of each mode.

Note: You can create a crossfade without applying an effect by animating the Opacity 
property of one layer on top of another. However, this doesn’t work if the frontmost layer 
has any transparent portions (which allows the other layer to show through, even when at 
full opacity). The Crossfade mode creates a proper crossfade between two layers, even if 
both have transparent regions.

If Layer Sizes Differ Specifies how to position the layers. The layer’s quality setting affects 
Blend only if Stretch to Fit is selected and if the layers are of different sizes. Stretching at 
Best quality is much smoother.

Using the Blend effect
The following procedure provides a basic overview of how to use this effect.

To use the Blend effect:

1  Make sure that the two source items to blend have been added to your composition. 

2  Apply the Blend effect to one layer (A), and choose the name of the other layer (B) in the 
Blend with Layer pop-up menu.

3  Hide layer B by clicking the Video switch next to the layer in the Audio/Video Features 
column in the Timeline window.

Calculations
The Calculations effect combines the channels of one image with the channels of another. 
Use this effect to quickly and easily produce some of the same results as you get from the 
Shift Channels effect, the Compound Arithmetic effect, and precomposing. 

Original layers (left and center) and with effect applied to arch layer with Input Channel set to Gray, 
Second Source set to cloud layer, and Invert Second Layer selected (right)

Adjust the following controls for the Calculations effect:
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Input Channel Specifies the channel to extract and blend with the original layer. RGBA 
displays all channels normally. Gray shows the luminance of the original RGBA image. Red, 
Green, Blue, or Alpha converts all channels to the value of the specified channel. 

Invert Input Inverts the layer before the effect extracts the specified channel infor-
mation.

Second Layer Specifies the layer with which Calculations blends the original layer. 

Second Layer Channel Specifies the channel to be blended with the input channels. 

Second Layer Opacity Specifies the transparency of the second layer. 

Invert Second Layer Inverts the second layer before the effect extracts the specified 
channel information and calculates the blend. 

Stretch Second Layer to Fit Stretches the second layer’s edges to the original layer’s 
edges before blending. If you don’t select this control, the Calculations effect centers the 
second source layer in the original layer and crops it to fit the effect layer’s boundaries.

Blending Mode Specifies the blend mode used for the blend of the original layer and 
second layer.

Preserve Transparency Ensures that the effect layer’s alpha channel is not modified.

Channel Combiner
The Channel Combiner effect extracts, displays, and adjusts various channels in your 
image.

Original (left); with effect applied to cloud layer, Source Layer set to arch layer, From set to HLS to 
RGB, and To set to Lightness (center); and with From set to Red, and To set to Lightness (right)

Channel Combiner controls
Adjust the following controls for the Channel Combiner effect:

Use 2nd Layer Specifies that the effect uses another layer to retrieve values from. 

Source Layer Specifies which layer you want to retrieve values from. This layer must be in 
the current composition but does not need to be visible.

From Specifies how you want to select values from the source layer. Most are self-explan-
atory; those that aren’t are as follows:

• RGB to YUV, YUV to RGB. YUV colorspace is used in component video. YUV represents 
the Luminance in the Green values, the Luminance Difference between the Red and the 
Green values, and the difference between the Blue and Green values. 

• Straight to Premultiplied converts the alpha channel from Straight to Premultiplied 
alpha, adding the transparency information to each of the visible RGB channels.
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• Saturation Multiplied specifies that the saturation value (including lightness) of an 
image is the source. This option represents the most common view of a pixel’s 
saturation value. Saturation is multiplied by the minimum distance to black or white 
(lightness). For example, a dark or light blue pixel has less saturation than a bright or 
“pure” blue pixel.

• Min RGB and Max RGB specify that the lowest or highest value of the red, green, and 
blue channels of an image is the source. 

To Specifies where the From values are applied. Some options, such as RGB to HLS, do not 
use a To selection. Use Red Only, Green Only, and Blue Only to view selected RGB, HLS, 
alpha, or luminance values in one channel without interference from the others. When you 
select Hue Only, Lightness Only, or Saturation Only, the applied hue value is combined 
with 50% lightness and 100% saturation; the applied lightness value is combined with 0% 
saturation, which then gives the hue no effect; and the applied saturation values are 
combined with 0% hue and 50% lightness.

Invert Inverts the values for the selected From and To options.

Solid Alpha Creates an opaque alpha channel throughout the layer, replacing the 
original alpha channel.

Cineon Converter
The Cineon Converter effect provides a high degree of control over color conversions of 
Cineon frames. In After Effects, you can convert the color in a Cineon file using controls in 
the Interpret Footage dialog box or using the Cineon Converter effect. To use the Cineon 
Converter effect, import a Cineon file and leave it in its default state; After Effects either 
condenses the colors to 8 bit or expands them to 16 bit, depending on the mode you are 
working in. You can then apply the Cineon Converter effect to the file and precisely adjust 
the colors while interactively viewing the results in the Composition window. Set 
keyframes to adjust for changes in tone over time—use keyframe interpolation and ease 
handles to precisely match the most irregular lighting changes, or leave the file in its 
default state and use the converter. 

The 10 bits of data available in each Cineon channel make it easier to enhance an 
important range of tones while preserving overall tonal balance. By carefully specifying 
the range, you can create a version of the image that faithfully resembles the original. 

Cineon Converter controls
Adjust the following controls for the Cineon Converter effect:

Conversion Type Specifies how the Cineon file is converted. Log to Linear converts an 8-
bit logarithmic non-Cineon layer that you plan to render as a Cineon sequence. Linear to 
Log converts a layer containing an 8-bit linear proxy of a Cineon file into an 8-bit 
logarithmic file so that its display characteristics are consistent with the original Cineon 
file. Log to Log detects an 8- or 10-bit logarithmic Cineon file when you plan to render it as 
an 8-bit logarithmic proxy.

Note: Obsolete versions of each option are available for compatibility with projects 
converted from earlier versions of After Effects.

10 Bit Black Point Specifies the black point (minimum density) for converting a 10-bit 
logarithmic Cineon layer. 
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Internal Black Point Specifies the black point used for the layer in After Effects. 

10 Bit White Point Specifies the white point (maximum density) for converting a 10-bit 
logarithmic Cineon layer.

Internal White Point Specifies the white point used for the layer in After Effects. 

Gamma Specifies the value of midtones. 

Highlight Rolloff Specifies the rolloff value used to correct bright highlights.

Controlling the tonal balance of a Cineon file
The following procedure provides a basic overview of how to control the tonal balance of 
a Cineon file.

To control the tonal balance of a Cineon file:

1  Import the Cineon file into After Effects, and add it to a composition.

2  Select the Cineon file layer in the Composition or Timeline window, and choose Effect > 
Cineon Tools > Cineon Converter. 

3  Choose an option from the Conversion Type menu.

4  Adjust the black point by dragging the 10 Bit Black Point slider right or left.

5  Adjust the white point by dragging the 10 Bit White Point slider left or right. (If 
adjusting the brightest areas makes the rest of the image appear too dark, use the 
Highlight Rolloff slider to adjust these bright highlights.) 

6  Adjust midtones by dragging the Gamma slider to the left to darken midtones, or to the 
right to lighten midtones.

7  If highlights appear as white blotches, drag the Highlight Rolloff slider to the right until 
details are visible. An image with high contrast may require a high rolloff value.

Note: Each computer monitor has unique display characteristics that affect your 
perception of color on-screen. For best results when evaluating tonal balance, use the Info 
palette in After Effects to see the true color values of pixels as you move the pointer over 
them.

Compound Arithmetic
The Compound Arithmetic effect mathematically combines the layer to which it is applied 
with another layer. The Compound Arithmetic effect is intended only to provide compati-
bility with projects created in earlier versions of After Effects that use the Compound 
Arithmetic effect. Using layer modes is usually more effective than using the Compound 
Arithmetic effect.

Original (left); with effect applied to arch layer, Operator set to Difference, Operate on Channels set 
to RGB, and Blend with Original set to 8% (center); and with Second Source set to cloud layer, 
Operator set to And, Operate on Channels set to RGB, and Blend with Original set to 50% (right).
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Adjust the following controls for the Compound Arithmetic effect:

Second Source Layer Specifies the layer to use with the current layer in the given 
operation.

Operator Specifies the operation to perform between the two layers.

Operate on Channels Specifies the channels to which the effect is applied.

Overflow Behavior Specifies how pixel values that exceed the allowed range are treated. 
Clip indicates that the values are limited to the allowed range. Wrap indicates that values 
exceeding the allowed range wrap around from full on to full off, and vice versa. Scale 
indicates that the maximum and minimum values are calculated and the results are 
stretched down from that full range to the range of allowable values.

Stretch Second Source to Fit Scales the second layer to match the size (width and 
height) of the current layer. If this option is deselected, the second layer is placed at its 
source’s current size, aligned with the upper left corner of the source layer.

Blend with Original Adjusts the opacity of the second source layer so it blends with the 
original layer.

Invert
The Invert effect inverts the color information of an image.

Original (left) and with effect applied to cloud layer with Channel set to Luminance (center) and Blue 
(right)

Adjust the following controls for the Invert effect:

Channel Specifies which channel or channels to invert. Each group of items operates in a 
particular color space, inverting either the entire image in that color space or just a single 
channel. RGB consists of three additive color channels: red, green, and blue. HLS consists 
of three calculated color channels: hue, lightness, and saturation. YIQ is the NTSC 
luminance and chrominance color space, where Y is the luminance signal, and I and Q are 
the inphase and quadrature chrominance signals. Alpha (not a color space) provides a way 
to invert the alpha channel of the image. 

Blend with Original Combines the inverted image with the original. You can apply a fade 
to the inverted image.
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Minimax
The Minimax effect enlarges or reduces a matte for a specific channel or all channels. It 
assigns each pixel the minimum or maximum pixel value found within a specified radius. 
For example, a white solid layer with a square mask shrinks one pixel on each side using 
Minimum and a radius of 1. The layer’s quality setting does not affect Minimax.

Original (left); with Operation set to Maximum, Channel set to Green, and Direction set to Vertical 
(center); Operation set to Maximum Then Minimum, Radius set to a low value, and Channel set to 
Color (right)

Adjust the following controls for the Minimax effect:

Operation Specifies how the effect processes the matte. Minimum replaces a pixel with 
the smallest pixel value within the radius specified, and Maximum replaces a pixel with the 
largest pixel value within the radius specified. Minimum Then Maximum performs the 
Minimum operation on the layer followed by the Maximum operation using the Radius 
setting, and Maximum Then Minimum does the opposite.

Radius Specifies how many pixels to examine for the Minimum or Maximum operation.

Channel Specifies the channel. Color affects the color channels only. Alpha and Color 
affects all channels. Red, Green, Blue, and Alpha affect only the respective channels.

Direction Specifies the direction of scanning for values. Horizontal & Vertical scans all 
directions for the minimum or maximum pixel. Just Horizontal and Just Vertical scan only 
left and right or up and down, respectively.

Remove Color Matting
The Remove Color Matting effect removes color fringes from layers that are premultiplied 
with a color. It is useful when merging alpha and fill from separate files. If you import 
footage with a premultiplied alpha channel or if you create alpha channels with After 
Effects, you may need to remove halos from an image. Halos are caused by a large contrast 
between the image’s color and the background, or matte, color. Removing or changing 
the color of the matte can remove the halos. (Halos can also be caused by a misinterpre-
tation of an alpha channel’s premultiplied color.)
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Use Background Color to specify the new background color when you want to change the 
color of a matte.

Original premultiplied with black (left), the black halo (center), and after applying the Remove Color 
Matting effect to remove the halo (right) 

Use this effect in conjunction with other effects that let you create alpha channels, to 
achieve more control over the appearance of the alpha channel.

Original (left); with Channel Shift effect applied to create alpha channel from the red channel 
(center); and with Remove Color Matting applied twice: once with cyan selected, once with yellow 
selected (right)

Set Channels
The Set Channels effect copies channels from other layers to the red, green, blue, and 
alpha channels of the current layer. For example, you can take the luminance of one layer 
and put it into the color channel of the selected layer. All source layers are centered in the 
current layer. With Best quality selected, any stretched layers are anti-aliased.

Use Stretch Layers to Fit to resize all other layers to the size of the layer to which Set 
Channels is being applied.

Original (left); with effect applied to arches layer with Source Layer 1 set to cloud layer and Set Red 
To Source 1’s Red (center); and with Set Red To Source 1’s Green, Set Green To Source 1’s Blue, and 
Set Blue To Source 1’s Red. (right)
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Set Matte
The Set Matte effect replaces the alpha channel (matte) of a layer with a channel from 
another layer above it for the creation of traveling matte effects.The Set Matte effect is 
intended only to provide compatibility with projects created in earlier versions of After 
Effects that use the Set Matte effect. 

Original (left) and with saucer used as a matte on the cloud layer (center) and the luminance of the 
saucer layer used as a matte (right) 

To create a traveling matte using the Set Matte effect, set up the motion of the matte layer 
and precompose that layer with all properties. Use the resulting composition as the layer 
from which to take the matte. Although you can use Set Matte for a traveling matte, it is 
easier and faster to create traveling mattes by using a track matte.

Adjust the following controls for the Set Matte effect:

Take Matte From Layer Specifies the layer to use as the replacement matte. You can 
specify any layer in the composition.

Use for Matte Specifies the channel of the specified layer to use for the matte.

Invert Matte Inverts the transparency values of the matte.

Stretch Matte to Fit Scales the selected layer to match the size of the current layer. If 
Stretch Matte to Fit is deselected, the layer designated as the matte is centered in the first 
layer. 

Composite Matte with Original Composites the new matte with the current layer, rather 
than replacing it. The resulting matte allows the image to show through only where the 
current matte and the new matte both have some opacity.

Premultiply Matte Layer Premultiplies the new matte layer with the current layer.
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Shift Channels
The Shift Channels effect replaces red, green, blue, and alpha channels in the image with 
other channels. In Take channel From, specify which channel to use as a source.

Note: You can use this effect to display the alpha channel for a layer if you set the RGB 
channels to Alpha and set the alpha channel to Full.

Original (left); with Take Alpha From set to Blue and Take Red, Green, and Blue set to Alpha (center); 
and with Take Alpha From set to Alpha, Take Red From set to Green, Take Green From set to Lightness, 
and Take Blue From set to Full Off (right)

Solid Composite
The Solid Composite effect offers a quick way to create a composite of a new color solid 
behind the original source layer. You can control the opacity of the source layer, control 
the opacity of the solid, and apply blend modes all within the effect’s controls.

Original (left); with Source Opacity and Opacity set to 50% and Blending Mode set to Difference 
(center); and Source Opacity and Opacity set to 100%, Color sampled from cloud layer, and Blending 
Mode set to Normal (right)

Adjust the following controls for the Solid Composite effect:

Source Opacity  Specifies the transparency of the source layer.

Color Specifies the color of the new solid.

Opacity Specifies the transparency of the solid.

Blending Mode Specifies the blend mode the effect uses to combine the original layer 
and the new solid. These blend modes behave exactly like those in the Timeline window.
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Distort effects

Bezier Warp (Pro only)
The Bezier Warp effect shapes an image using a closed Bezier curve along the boundary of 
a layer. The curve consists of four segments. Each segment has four control points (two 
vertices and two tangents). The vertices control the position of the segments, and the 
tangents control the curvature of the segments. 

Original (left) and with variations of Bezier Warp applied (center and right)

The positions of vertices and tangents determine the size and shape of a curved segment. 
Dragging these points reshapes the curves that form the edge, thus distorting the image. 
For example, you can use Bezier Warp to reshape one image to fit another, as in wrapping 
a label around a jar. Bezier Warp is also useful for correcting lens aberrations, such as the 
fish-eye effect (barrel distortion) that can occur when using a wide-angle lens. Using 
Bezier Warp, you can bend the image back to achieve an undistorted look. By animating 
the effect and choosing a high quality setting, you can create fluid visual effects, such as a 
jiggling gelatin dessert or a fluttering flag.

Bezier Warp controls
Adjust the following controls for the Bezier Warp effect: 

Top Left Vertex Specifies the starting vertex for the top segment or the ending vertex for 
the left segment.

Top Left Tangent, Top Right Tangent Specify the starting and ending tangents for the 
top segment.

Right Top Vertex Specifies the ending vertex for the top segment or the starting vertex 
for the right segment.

Right Top Tangent, Right Bottom Tangent Specify the starting and ending tangents for 
the right segment.

Bottom Right Vertex Specifies the ending vertex for the right segment or the starting 
vertex for the bottom segment.

Bottom Right Tangent, Bottom Left Tangent Specify the ending and starting tangents 
for the bottom segment.

Left Bottom Vertex Specifies the ending vertex for the bottom segment or the starting 
vertex for the left segment.



Using Help | Contents | Index Back 69  

Adobe After Effects Help Distort effects 

Using Help | Contents | Index Back 69  

Left Bottom Tangent, Left Top Tangent Specify the ending and starting tangents for 
the left segment.

Quality Specifies how closely the image follows the shape defined by the curve. The 
higher the quality value, the more closely the image follows the shape. Higher quality 
settings require more rendering time.

Bulge (Pro only)
The Bulge effect distorts an image around a specified point, making the image appear to 
bulge toward or away from the viewer, depending on the options you select.

Original (left) and with variations of Bulge applied (center and right)

Adjust the following controls for the Bulge effect:

Horizontal Radius Sets the width of the bulge, measured in pixels. You can also set the 
radius values by dragging the selection handles in the layer. 

Vertical Radius Sets the length of the bulge, measured in pixels. You can also set the 
radius values by dragging the selection handles in the layer.

Bulge Center Sets the center point from which the bulge is created.

Bulge Height Sets the depth of the bulge. Positive values push the bulge toward the 
viewer. Negative values pull the bulge away from the viewer. A bulge height of 0 produces 
no bulge, which can be useful for setting keyframes so the bulge fades in over time.

Taper Radius Sets the steepness of the sides of the bulge. A taper radius of 0 produces a 
steep, pronounced bulge. Increasing the taper radius produces a more gradual bulge.

Antialiasing Sets the amount of edge smoothing (blending of colors) at the boundaries 
of the bulge. Anti-aliasing is applied only when Best quality is selected for the layer. For 
many layers, Low produces satisfactory results. High produces more smoothing but can 
significantly increase rendering time.

Pin All Edges Prevents the edges of the layer from bulging.
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Corner Pin (Pro only)
The Corner Pin effect distorts an image by repositioning each of its four corners. Use it to 
stretch, shrink, skew, or twist an image or to simulate perspective or movement that pivots 
from the edge of a layer, such as a door opening. You can also use it to attach a layer to a 
moving rectangular region tracked by the Motion Tracker. You can move the corner pins in 
the Composition window or the Effect Controls window.

Original (left) and with two variations of Corner Pin applied (center and right)

Displacement Map (Pro only)
The Displacement Map effect distorts a layer by displacing pixels horizontally and verti-
cally based on the color values of pixels in a second layer, called the displacement map. The 
type of distortion created by the Displacement Map effect can vary greatly, depending on 
the displacement map and options you select.

Original (left), Displacement map (center) and displaced image (right)

The displacement is determined from the color values of the displacement map. The color 
values range from 0 to 255. Each value is converted into a scale ranging from -1 to 1. The 
displacement amount is calculated by multiplying the converted value by the maximum 
displacement amount you specify. A color value of 0 produces maximum negative 
displacement (–1 maximum displacement). A color value of 255 produces maximum 
positive displacement. A color value of 128 produces no displacement. For other values, 
you can calculate the displacement amount, in pixels, using the following equation: 
Displacement amount = maximum_displacement * (2 * (color value – 128)/256)

To displace an image:

1  Select the layer, and choose Effect > Distort > Displacement Map.

2  In the Effect Controls window, choose the layer to use as the displacement map from 
the Displacement Map Layer pop-up menu. After Effects uses the layer in its original form, 
without any masking, effects, or transformations you may have applied. If you want to 
include those alterations, precompose that layer using the Move All Attributes Into the 
New Composition option.

3  Choose the channel to use for horizontal displacement and vertical displacement, and 
enter a maximum displacement value for each in the Effect Controls window.
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4  Choose a behavior from the Displacement Map Behavior pop-up menu:

• Center Map overlays the displacement map over the layer.

• Stretch Map to Fit resizes the displacement map to the layer’s size.

• Tile Map fills the layer with as many copies of the map as can fit.

5  In Edge Behavior deselect Wrap Pixels Around to halt the displacement at the edge of 
the image.

Liquify
The Liquify effect lets you push, pull, rotate, enlarge and shrink areas in a layer. Several 
Liquify tools distort the brush area when you hold down the mouse button or drag. The 
distortion is concentrated at the center of the brush area, and the effect intensifies as you 
hold down the mouse button or repeatedly drag over an area.

You can limit the area of a layer you distort using Freeze Area Mask. Use the Recon-
struction mode to lessen or undo distortions you’ve created. 

Original (left) and with variations of Liquify applied (center and right)

Setting Mask Properties
The Liquify effect uses the mask properties to determine how to affect the image. Use 
Freeze Area Mask, Mask Opacity, and Mask Feather settings to control the Liquify effect:

Freeze Area Mask determines the area of the image in which the distortion is affected by 
mask opacity and feather settings. Areas outside the mask are distorted; areas within the 
mask are distorted according to the mask opacity and feather settings.

Mask Opacity determines how the area within the mask is affected by the distortion. 
When Mask Opacity is set to 100%, the area within the mask is not affected by the 
distortion; when it’s set to 50%, the area within the mask is somewhat affected. If you set 
the opacity to 100%, make sure to feather the mask to prevent jagged edges on the mask.

Mask Feather determines the pixels at the borders of the mask used to blend the 
masked area into the non-masked areas. You can begin with a feather value of 10 pixels 
and then adjust it as appropriate.

Using the Liquify tools
The Liquify tools offer several ways to distort the image:

Warp   pushes pixels forward as you drag.

Turbulence   smoothly scrambles pixels. It is useful for creating fire, clouds, waves, and 
similar effects. 

Twirl clockwise   rotates pixels clockwise as you hold down the mouse button or drag.
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Twirl counterclockwise   rotates pixels counterclockwise as you hold down the mouse 
button or drag.

Pucker  moves pixels toward the center of the brush area as you hold down the mouse 
button or drag.

Bloat   moves pixels away from the center of the brush area as you hold down the 
mouse button or drag. 

Shift pixels   moves pixels perpendicular to the stroke direction.

Reflection   copies pixels to the brush area.

Clone   copies the distortions from around a source location to the current mouse 
location. Select the source location by Alt-clicking (Windows) or Option-clicking (Mac OS) 
the source point.

Reconstruction   reverses distortions or applies them in different ways.

Distorting an image
The following procedure provides a basic overview of how to use the Liquify effect.

To distort an image:

1  Select the layer, and choose Effect > Distort > Liquify.

2  In the Layer window, create a mask to freeze areas of the image and then set mask 
properties. See “Setting Mask Properties” on page 71

3  In the Effect Controls window do the following: 

• Choose the mask you created from the Freeze Area Mask pop-up menu.

• Specify a brush size and brush pressure. A low brush pressure makes changes occur 
more slowly, so it’s easier to stop them at exactly the right moment. 

• Specify a turbulent jitter to control how tightly the turbulence tool scrambles pixels.

• Select View Mesh under the View Options control. 

• Set a distortion mesh offset if desired.

• Drag the Distortion Percentage slider to specify the amount of distortion.

4  Use the tools to distort the preview of the image. (See “Using the Liquify tools” on 
page 71.)

5  Use the reconstruct tool  to fully or partially reverse the distortions or to change the 
image in new ways. (See “Reconstructing distortions” on page 72.)

Reconstructing distortions
Use the reconstruction tool and its modes to reverse distortions or redo them in new ways. 

To restore a preview image to a previous state:

1  Select the reconstruction tool, and then choose a mode from the Reconstruction Mode 
pop-up menu:

• Revert changes unfrozen areas back to their predistorted state.

• Displace reconstructs unfrozen areas to match the displacement at the starting point 
for the reconstruction. You can use Displace to move all or part of the preview image to 
a different location.
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• Amplitwist reconstructs unfrozen areas to match the displacement, rotation, and 
overall scaling that exist at the starting point.

• Affine reconstructs unfrozen areas to match all local distortions that exist at the starting 
point, including displacement, rotation, horizontal and vertical scaling, and skew.

2  Drag the area to restore. The restoration occurs more quickly at the brush center.

Magnify
The Magnify effect enlarges a selected area of a layer. This effect can act like a magnifying 
glass placed over an area of the image, or you can use it to scale the entire image far 
beyond 100% while maintaining resolution.

Original (left) and with variations of Magnify applied (center and right)

Magnify controls
Adjust the following controls for the Magnify effect:

Shape Specifies the shape of the magnified area.

Center Specifies the center point of the magnified area. 

Magnification Specifies the percentage of magnification (or scale) of the area you select. 
The values represent the percentage of the scale.

Link Specifies how the effect links the Size, Magnification, and Feather amounts so that 
they increase or decrease proportionally. None specifies that the Size, Magnification, and 
Feather controls operate separately. Size To Magnification specifies that the size of the 
magnified area increases or decreases proportionally in relation to the magnification 
adjustment. Size & Feather To Magnification specifies that the size and edge feather of the 
magnified area increase or decrease proportionally in relation to the magnification 
adjustment. (Setting the Link control to any setting except None disables the Resize Layer 
control.)

Size Specifies the size of the magnified area, in pixels. (Setting the size larger than your 
original source layer may expand the magnified area outside the composition frame, 
depending upon the location of your center point. However, the effect still retains the 
image resolution.)

Feather Specifies the amount of feather, in pixels, that the effect applies to the edge of 
the magnified area. Higher values soften the edge of the magnified area, and blends the 
edge with the layer behind it. Lower values sharpen the edge of the magnified area.

Opacity Specifies the transparency of the magnified area. The Opacity value for the effect 
layer in the Timeline window represents the 100% setting of this control.
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Scaling Specifies the type of scaling the effect uses to magnify a layer. Standard uses 
standard scaling. This method maintains sharpness in the image but produces pixelated 
edges at higher values. Soft uses spline algorithms. If you scale the image beyond 100%, 
Soft reduces edge pixelation and maintains image quality. Soft works well at large magni-
fication amounts. Scatter creates scatter or noise in the image as the image enlarges.

Blending Mode Specifies the blend mode that the effect uses to combine the magnified 
area with the original layer. Except for None, all of these blend modes behave identically to 
the Timeline window blend modes. The None option displays transparent pixels around 
the magnified area.

Resize Layer If Resize Layer is selected, the effect uses only the composition boundaries 
as the edge of the layer when the magnified area extends beyond the original layer’s 
boundaries. If Resize Layer is deselected, any area of the image outside the original layer’s 
bounding box is cropped by the layer’s boundaries.

Mesh Warp (Pro only)
The Mesh Warp effect applies a grid of Bezier patches (squares in the grid) over a layer, 
which you can manipulate to distort areas of an image. Each corner of a patch includes a 
vertex and two to four tangents (points that control the curvature of the line segment that 
makes up the edge of the patch). The number of tangents depends on whether the vertex 
is in a corner, on an edge, or inside the grid. By moving the vertices and tangents, you can 
manipulate the shape of the curved line segment. The finer the grid, the tighter the adjust-
ments you can make to the area of the image inside the patch.

You can also use Mesh Warp to create smooth transitions between multiple images and 
layers. Using keyframes for effects and opacity, you can animate the transition between 
layers, revealing and distorting layers over time.

Original (left), with distortion mesh (center) and with Mesh Warp applied (right)

To select multiple verticies, Shift-click the verticies.

Adjust the following controls for the Mesh Warp effect:

Rows, Columns Specify up to 127 patches vertically (Rows) or horizontally (Columns). For 
broader distortion, use fewer patches. For finer control, use more. Drag the vertices and 
tangents to change the grid shape. The image follows the grid shape according to the 
elasticity setting and the boundary created by the adjacent patch.

Quality Specifies how closely the image follows the shape defined by the curve. The 
higher the quality value, the more closely the image follows the shape. Higher quality 
settings require more rendering time.
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Distortion Mesh Click the stopwatch to animate the distortion over time. 

Note: Each patch becomes a boundary for the distortion. For example, when you stretch a 
patch, the area of the image in the patch stretches, squishing the area of the image in the 
adjacent patch. The boundary of the adjacent patch protects the image inside it from 
being squished to zero. In other words, you can’t push an image out of its patch.

Mirror
The Mirror effect splits the image along a line and reflects one side onto the other. 
Reflection Center specifies the position of the line.Reflection Angle determines which side 
is reflected and where the reflection appears. An angle of 0 degrees reflects the left side 
onto the right. An angle of 180 degrees reflects the right side onto the left. An angle of 90 
degrees reflects the top onto the bottom. An angle of 270 degrees reflects the bottom 
onto the top. The layer’s quality setting influences the Mirror effect. At Best quality, the 
reflected image is smoother and more accurate.

Original (left) and with variations of Mirror applied (center and right)

Offset
The Offset effect pans the image within a layer. Visual information pushed off one side 
of the image appears on the opposite side. At Best quality, the offset is performed with 
subpixel precision.

Shift Center To specifies the new position of the original image’s center point. Blend with 
Original specifies the amount by which the offset image is blended with the original 
image.

Original (left) and with variations of Offset applied (center and right)
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Optics Compensation (Pro only)
Use the Optics Compensation effect to add or remove camera lens distortion. Elements 
composited with mismatched lens distortion cause anomalies in the animation. For 
example, tracked objects in a distorted scene don’t match the scene area because linear 
objects don’t follow the distortion of the scene.

Original (left) and with variations of Optics Compensation applied (center and right)

Optics Compensation controls
Adjust the following controls for the Optics Compensation effect:

Field of View (FOV) Specifies the field of view of the distorted footage. The FOV is 
relative to the size of the source layer and the selected FOV Orientation. The distortion 
amount is relative to FOV. There is no general rule as to what FOV value applies to different 
lenses. Zooming in reduces the FOV, and zooming out increases it. Consequently, if 
footage includes different zoom values you’ll need to keyframe the FOV value.

Reverse Lens Distortion Reverses the lens distortion. For example, to remove wide-
angle lens distortion, set Field of View to 40.0 and select Reverse Lens Distortion. Selecting 
Reverse Lens Distortion enables the Resize control. 

FOV Orientation Specifies the axis on which the Field of View value is based. This is 
useful when matching computer-generated elements to the rendered view angle.

View Center Specifies an alternate center point of view. This is useful when using custom 
lenses that are not centered. However, in most cases, this control should be left 
untouched.

Optimal Pixels Maintains as much pixel information as possible through the distortion. 
When selected, FOV values are no longer reversible.

Resize Resizes the layer when the applied distortion stretches the layer beyond its 
boundaries. To use this control, first select Reverse Lens Distortion, and then choose an 
option. Off does not resize the layer. Max 2X resizes the layer to a maximum of twice the 
original width and height. Max 4X resizes the layer to a maximum of four times the original 
width and height. Unlimited resizes as far as the layer is stretched. This option may require 
a large amount of memory.

Applying other effects while adjusting FOV
To match FOV values, layers must be the same size. However, if you select Resize, you can 
apply Optics Compensation again and reverse the distortion using the same value 
(reversed). You can then apply another effect between the two instances of Optics 
Compensation.

If you resize a layer using Optics Compensation and then precompose it into a larger 
composition, you cannot reverse the distortion using the same value until you enlarge the 
precomposed layer to accommodate the expanded layer.



Using Help | Contents | Index Back 77  

Adobe After Effects Help Distort effects 

Using Help | Contents | Index Back 77  

Matching FOV with computer graphics
To determine the correct FOV, find an edge or line in the footage that is distorted. Adjust 
the FOV until the edge is straight, and then apply the reverse of that value to computer-
generated material. This process composites the computer-generated element with the 
footage using a matching lens distortion. 

To match computer graphics with a lens distortion:

1  Select the footage layer with the distortion, and choose Effect > Distort > Optics 
Compensation.

2  In the Effect Controls window, adjust the FOV until a distorted edge or line appears 
straight. Note the FOV value.

3  Select the computer graphic layer you want to distort, and apply Optics Compensation 
to it using the FOV value from step 2.

4  Select Reverse Lens Distortion.

5  Remove Optics Compensation from the footage layer.

Polar Coordinates
The Polar Coordinates effect distorts a layer by transposing each pixel in the layer’s x,y 
coordinate system to the corresponding position in the polar coordinate system, or the 
reverse. This effect produces unusual and surprising distortions that can vary greatly 
depending on the image and the controls you select. The standard coordinate system 
specifies points by measuring the horizontal distance (x axis) and the vertical distance (y 
axis) from the origin. Each point is specified as (x,y). The polar coordinate system specifies 
points by measuring the length of a radius from the origin (r) and its angle from the x axis 
(θ). Each point is specified as (r, θ).

Original (left) and with variations of Polar Coordinates applied (center and right)

Adjust the following controls for the Polar Coordinates effect:

Interpolation Specifies the amount of distortion. At 0% there is no distortion.

Type of Conversion Specifies the conversion process to use. Choose one of the following 
options:

• Rect to Polar moves pixels by using x,y coordinates from each pixel as r, θ coordinates. 
For example, an x,y coordinate of 2,3 becomes a polar coordinate with a radius of 2 and 
a degree of 3. Horizontal lines distort into circles, and vertical lines into radial lines.

• Polar to Rect moves pixels by using the r, θ coordinates from each pixel as the x,y coordi-
nates. For example, a polar coordinate of radius 10 and 45 degrees becomes an x,y 
coordinate of 10,45.
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Reshape (Pro only)
The Reshape effect transforms one shape into another shape on the same layer, dragging 
the underlying image with it. The image is distorted to fit the shape of the new area. You 
create or import up to three masks to define the area you want to distort: the source mask, 
the destination mask, and the boundary mask (optional).

Original including three masks (left) and with variations of Reshape applied (center and right)

After Effects assigns the masks a function (source, destination, or boundary) based on the 
order you create or import them. You can also specify different masks. You can create 
masks in the Layer window in After Effects, or use masks created in Adobe Illustrator. Use a 
closed path for each mask. All three masks must be on the same layer as the footage to 
which you will apply the Reshape effect, although you can copy masks from another layer. 

As with the Mesh Warp effect, you can use Reshape to create unusual transitions between 
multiple images and layers. Using keyframes for effects and opacity, you can animate the 
transition between layers, revealing and distorting layers over time.

Reshape controls
Adjust the following controls for the Reshape effect:

Source Mask Specifies the mask that contains the image area you want to reshape. If not 
specified, After Effects uses the second mask created as the Source mask. In the Compo-
sition and Layer windows, a red outline defines the source mask.

Destination Mask Specifies the mask that determines the shape of the final image. If not 
specified, After Effects uses the third mask created as the Destination mask. In the Compo-
sition and Layer windows, a yellow outline defines the destination mask.

Boundary Mask Specifies what part of the image is reshaped. Anything outside the 
boundary is not altered. If not specified, After Effects uses the first mask created as the 
Boundary mask. In the Composition and Layer windows, a blue outline defines the 
boundary mask.

Percent Specifies the percent of the reshape. This value is useful for creating partial 
distortions that grow over time.

Elasticity Specifies how closely the image follows the shape defined by the curve. Stiff 
acts like cold rubber, allowing the image to distort the least amount. Super Fluid acts like 
hot rubber, allowing the image to distort in a fluid fashion. The other settings fall between. 
The more fluid elasticity settings require more rendering time. If the final image doesn’t 
follow the curve as expected, use the following elasticity guidelines:

• In general, use the stiffest setting possible that doesn’t create a polygonal image. Use a 
higher elasticity setting if the final image looks polygonal but the curves are smooth.

• Use Stiff, Less Stiff, or Below Normal if the source and destination masks are similar in 
shape and have low curvature (few curved segments that change direction radically).
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• Use Normal, Absolutely Normal, or Above Average if the source and destination masks 
are dissimilar and have mild curvature. 

• Use Loose, Liquid, or Super Fluid if the masks are very dissimilar and have extreme 
curvature. 

Correspondence Points Specifies the number of points on the source mask that are 
associated with, or mapped to, points on the destination mask. These points appear in the 
Composition window and control the interpolation of the distortion through space. To 
control the precision of the effect, you can add, delete, or move the points on either mask. 
A mask can have an unlimited number of points, but the more points it has, the longer the 
effect takes to render. If the distortion appears twisted, try adding more correspondence 
points at distinguishing points along the masks. (If the arc lengths of the curves between 
correspondence points are too different, twisting may result.)

Interpolation Method Specifies how After Effects determines the distortion of each 
video or animation frame in the interval between keyframes or when no keyframes exist. 

• Discrete requires no keyframes because it calculates the distortion at each frame. 
Discrete produces the most accurate results but requires more rendering time.

• Linear (the default) requires two or more keyframes and performs a straight-line inter-
polation between the keyframes. Linear produces steady changes between keyframes 
and sharp changes at keyframes.

• Smooth requires three or more keyframes and approximates the distortion using cubic 
curves, producing distortions with graceful motion.

Using the Reshape effect
The following procedure provides a basic overview of how to use this effect. 

To apply the Reshape effect:

1  Open the layer in a Layer window.

2  Create or import the source, destination, and boundary masks into the layer.

Name each mask so that you can easily recognize it in the Mask menu in the Effect 
Controls window.

3  In the Timeline window, choose None from the Mode pop-up menu for each mask.

4  Position the boundary mask to specify the area of the image that will remain unaltered. 
(Areas within the boundary mask will be distorted; areas outside the mask will remain 
unaltered. Keep the boundary mask as far away as possible from the source and desti-
nation masks to avoid foldovers.)

5  Scale and position the source mask over the image. 

6  Scale and position the destination mask to indicate the final shape. (Distortions work 
best if the source and destination masks are roughly in the same location.)

7  Make the Composition or Timeline window active, select the layer, and then choose 
Effect > Distort > Reshape. 

8  From the Mask menus, choose the source, destination, and boundary masks.

9  Adjust the Percent control, and choose an option for Elasticity.

10  In the Composition window, add, delete, or move correspondence points on the 
masks to control the distortion:
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• To add a point, Alt-click (Windows) or Option-click (Mac OS) the mask.

• To delete a point, Alt-click or Option-click the point.

• To move a point, drag it to a new location.

• To change the interpolation of a pair of points, Shift-click a point. Smooth interpolation 
works best with round masks, while linear interpolation works best with angular masks. 
You can combine smooth and linear interpolation in the same composition.

11  Choose an interpolation method, and preview the distortion. If Linear or Smooth 
produces undesired results, add more keyframes. If Discrete produces undesired results, 
choose another method.

Ripple
The Ripple effect creates the appearance of ripples in a specified layer, moving away from 
a center point in concentric circles. The effect is similar to dropping a stone in a pond. You 
can also specify that ripples move toward the center point.

Animate ripples at a constant speed using the Wave Speed control. This control does not 
require keyframes for animation. Animate ripples at varying speeds by creating keyframes 
for the Ripple Phase control.

Animated Ripple effect

Ripple controls
Adjust the following controls for the Ripple effect:

Radius Controls the distance the ripples travel from the center point. The Radius value is a 
percentage of the image size. If the center of the ripple is the center of the layer and the 
radius is set to 100, the ripples travel to the edge of the image. A value of 0 produces no 
ripples. Like ripples in water, ripples in the layer become smaller as they travel farther from 
the center. 

To create a single-wave ripple, set Radius to 100, Wave Width between 90 and 100, and 
Wave Height as desired.

Center or Ripple Specifies the center of the effect.

Type of Conversion Specifies how the ripples are created. Asymmetric produces more 
realistic-looking ripples; asymmetric ripples include lateral motion and produce more 
distortion. Symmetric produces motion that travels only outward from the center point; 
symmetric ripples produce less distortion.
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Wave Speed Sets the speed at which the ripples travel outward from the center point. 
When you specify a wave speed, the ripples are automatically animated at a constant 
speed (without keyframes) across the time range. A negative value makes the ripples 
move toward the center, and a value of 0 produces no movement. To vary wave speed 
over time, set this control to 0, and then create a keyframe for the Ripple Phase property of 
the layer.

Wave Width Specifies the distance, in pixels, between wave peaks. Higher values produce 
long, undulating ripples, and low values produce many small ripples.

Wave Height Specifies the height of the ripple wave. Taller waves produce greater 
distortion.

Ripple Phase Specifies the point along the waveform at which a wave cycle begins. The 
default value of 0 degrees starts the wave at the midpoint of its downward slope; 90 
degrees starts it at the lowest point in the trough; 180 degrees starts it at the midpoint of 
the upward slope, and so on.

Smear
Using the Smear effect, you define an area within an image and then move that area to a 
new location, stretching, or smearing, the surrounding part of the image with it. Use masks 
to define the area you want to distort. 

To use Smear, first create or import two masks: the source mask and the boundary mask. 
You can create masks on the layer in After Effects or use masks created in Adobe Illustrator. 
To use a mask created in Illustrator, copy the mask and paste it into a layer in After Effects. 
Masks must be closed to work with Smear; if a mask is an open trace, After Effects closes it 
when you select it. Both masks must be on the same layer as the footage to which you will 
apply the Smear effect, although you can copy masks from another layer. 

Original (left) and with variations of Smear applied (center and right)

When you move the source mask within the image, Smear stretches the portion of the 
image inside the boundary mask to follow the edges of the source mask. The boundary 
mask tries to protect the image outside it from being stretched. Both the original position 
of the source mask (set in the Layer window) and the offset position of the source mask are 
displayed in the Composition window. The first position of the source mask is indicated by 
a light red outline, and the new position is indicated by a dark outline.

Using keyframes, you can animate the position, size, and rotation of the source mask as it 
moves to its offset position. You can also animate the original position of the source mask 
in the Layer window using keyframes. 

Processing can take up to several minutes with certain settings. Computation time 
increases as the source mask gets closer to the boundary mask. Processing is interrupted 
when you click a control.
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Smear controls
Adjust the following controls for the Smear effect:

Source Mask Specifies a mask as the source mask. By default, After Effects selects the 
second mask you create or import for the layer as the source mask. 

Note: You must specify both a boundary mask and a source mask to create a distortion. 

Boundary Mask Specifies a mask as the boundary mask. By default, After Effects selects 
the first mask you create or import as the boundary mask. 

Mask Offset Specifies a destination position for the source mask. The offset is a position 
specified by x and y coordinates, which appear to the right of the Offset button. To set an 
offset location, click the Offset button, and then click the image in the desired location. To 
set the offset position numerically, type a new value for each axis. When you don’t need 
the precision provided by Mask Offset, you can simply drag the source mask offset in the 
Composition window. 

Note: Unwanted undulations may occur if the source mask is close to the boundary mask 
during animation. 

Mask Rotation Rotates the source mask around its center point, between 0 and 360 
degrees. 

Mask Scale Scales the source mask (at its offset position) larger or smaller, in relation to 
its original position. 

Percent Specifies what percent of the smear is actually performed. For example, when 
Percent is set to 50%, Smear performs half of the smear you have specified by moving, 
scaling, and rotating the source mask. This value doesn’t affect the location of the original 
and offset positions of the source mask; it affects only the percent of the effect that is 
performed. 

Elasticity Specifies how closely the image follows the shape defined by the curve. Stiff 
distorts the least, while Super Fluid distorts the most. In general, use the stiffest setting 
possible that doesn’t create polygonal images.

Interpolation Method Specifies a method for the interpolation that Smear performs 
between keyframes. Linear requires two or more keyframes and performs a straight-line 
interpolation between the keyframes. Linear produces robot-like animations in which the 
distortions change at keyframes. Smooth requires three or more keyframes and approxi-
mates the distortion using cubic curves, producing distortions with graceful motion. If you 
need further accuracy in the animation between keyframes, add more keyframes. For 
example, a distortion representing a 90-degree rotation between two keyframes appears 
as a folding of the image. To make this distortion more fluid, add a keyframe for every 10 
degrees.

Using the Smear effect
The following procedure provides a basic overview of how to use this effect.

To use Smear:

1  Open the layer in a Layer window. 

2  Create or paste the masks you will use as the boundary mask and the source mask. 

3  Position the boundary mask to specify the area of the layer you do not want Smear to 
affect. 
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4  Scale and position the source mask over the area you want to move. 

5  Make the Composition window active, and choose Effects > Distort > Smear. 

6  Enter a Percent value to specify the amount of smear applied.

7  In the Composition window, move the source mask to its destination position by 
dragging it or by using the Mask Offset value. 

8  Use the Mask Rotation control to rotate the source mask, and use the Mask Scale 
control to scale it. 

9  Drag the Percent slider as needed, and choose a setting for Elasticity.

Spherize
The Spherize effect distorts a layer by wrapping a region of the image onto a spherical 
shape of variable size. The layer’s quality setting influences the Spherize effect. Best quality 
samples the displaced pixels to subpixel accuracy; Draft quality samples to the nearest 
whole pixel.

The Radius option specifies the radius of the sphere in pixels. You can exceed the highest 
slider value by clicking the Radius value and typing a higher number in the dialog box. 
Center of Sphere specifies the position of the sphere’s center on the layer.

Original (left) and with variations of Spherize applied (center and right)

Transform
The Transform effect applies 2D geometric transformations to the source layer. This effect 
supplements the transform properties available for each layer in the Timeline window. 
Using the Transform effect, you can skew a layer along any axis. Also, if motion blur is 
enabled in the Switches column, you can specify motion blur independently of the 
composition’s shutter angle. Anchor Point, Position, Rotation, and Opacity function the 
same as the layer transform properties in the Timeline window.

Note: This effect is relative to the input layer. Therefore, to make a layer rotate around the 
upper left corner, open the Layer window, choose Transform from the Layer window menu, 
and then move the anchor point and the position to the upper left corner. 

Original (left) and with variations of Transform applied (center and right)
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Adjust the following controls for the Transform effect:

Scale Height Scales height up or down as a percent of the current layer height.

Scale Width Scales width up or down as a percent of the current layer width.

Skew Specifies skew amount. 

Skew Axis Specifies the axis on which the skew is based. Changing the skew axis has no 
effect if Skew is 0.

Use Composition’s Shutter Angle Specifies that the Transform effect uses the shutter 
angle of the composition when performing motion blur. If this control is not selected, the 
Transform effect uses the option for the Shutter Angle control. 

Shutter Angle Determines the amount of motion blur to apply to the layer. (Motion Blur 
must be enabled for the layer.)

Uniform Scale Scales both the width and the height of an image.

Turbulent Displace
The Turbulent Displace effect uses fractal noise to create turbulent distortions in an image. 
This effect is useful for adding distorted movement to a layer. For example, use it to create 
flowing water, funhouse mirrors, and waving flags.

Original (left) and with variations of Turbulent Displace applied (center and right)

Turbulent Displace controls
Adjust the following controls for Turbulent Displace:

Displacement Specifies the type of turbulence used. Turbulent, Bulge, and Twist warp 
the image in slightly different directions. Turbulent Smoother, Bulge Smoother, and Twist 
Smoother each perform the same operation as Turbulent, Bulge, and Twist, except that 
they create smoother warps and may take longer to render. Vertical Displacement warps 
the image vertically only. Horizontal Displacement warps the image horizontally only. 
Cross Displacement warps the image both vertically and horizontally.

Amount Specifies the amount of displacement in the layer. Higher values result in more 
distortion in the layer.

Size Specifies the size or radius of the displaced or distorted areas in the layer. Higher 
values result in larger areas of distortion. 

Offset Specifies the portion of the fractal shape that is present in the Composition 
window, altering the shape of the distortion on your layer. Because the fractal shapes used 
are infinite in all directions, what appears in the Composition window is only a small 
portion of the entire fractal. The Composition window behaves like a fixed viewing area, 
and the Offset control repositions the fractal within that view, which then brings a 
different portion of the fractal into view. This alters the shape of the distortion.
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Complexity Specifies the level of detail in the turbulence. Increasing the Complexity 
value increases the detailed definition in the displacement pattern. Lower values result in 
smoother distortions. 

Evolution Specifies the changes of the turbulence over time.Evolution values are 
progressive, not looping. The image continues to change with each added revolution. The 
appearance of the image when this option is set to 0 is different from that at 1 revolution, 
which, in turn, is different from that at 2 revolutions, and so on. The evolution state 
progresses infinitely at each new value. To force the Evolution setting to return to its 
original state (necessary to create a seamless loop) set the Evolution Options control to 
Cycle Evolution.

Set keyframes for Evolution to determine how much the turbulence evolves over the 
period of time allowed between keyframes. The more revolutions that are made between 
keyframes the more rapidly the turbulence changes. Higher values may result in flashing 
rather than smooth changes.

Evolution Options Specifies how you render the effect’s evolution values. This control is 
useful to create one short seamless evolution cycle (where the last frame matches up to 
the first) to be prerendered and looped as a new source layer in a composition, rather than 
setting Evolution to animate over a greater number of frames. Options include the 
following: 

• Cycle Evolution creates a cycle of evolution that loops over a set amount of time. Cycle 
Evolution returns the evolution state to its starting point to create a smooth, 
progressive, looping animation. Copied and pasted evolution keyframes start and end 
with the same value, and the resulting animation repeats, rather than producing a 
smoothly transitioning cycle.

• Cycle specifies the number of revolutions of the Evolution setting that the fractal noise 
cycles through before it repeats. The amount of time allowed between evolution 
keyframes determines the timing or speed of these evolution cycles. Higher values 
create longer render times. Cycle affects only the state of the fractal, not geometrics or 
other controls. For example, two identical states of the fractal don’t appear the same if 
viewed with different Size or Offset settings.

• Random Seed specifies a unique random value from which to generate the turbulence. 
Animating the random seed value results in flashing from one set of fractal shapes to 
another (within that fractal type). For smooth transition of the turbulence, use the 
Evolution control.

Pinning Specifies how the effect pins the edges of an image so that it remains in its initial 
position. The None option pins no layer edges. Pin All, Pin Horizontal, and Pin Vertical 
minimize the effect of the turbulence on the corresponding layer edges. All Locked 
Options locks the layer edge so that turbulence doesn’t affect it.

Resize Layer Enables the distorted image to expand past the layer’s bounding box.

Antialiasing for Best Quality Specifies the level of anti-aliasing of the displacement 
pattern. This control works best if the layer is set to Best quality in the Timeline window.

Creating a seamless loop
The following procedure provides a basic overview of how to create a seamless loop of 
turbulence.
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To create a seamless loop using Turbulent Displace:

1  Set two keyframes for the Evolution control, using full revolutions only. 

2  Adjust the time allowed between keyframes, and the number of Evolution revolutions 
until you are satisfied with the appearance of the displacement.

3  Under Evolutions Options, select Cycle Evolution.

4  Under Evolutions Options, drag the Cycle slider to set a value for Cycle that either 
matches or is evenly divisible by the number of revolutions you set for Evolution.

5  Move the current-time indicator to the point on the Timeline window where the Cycle 
completes. For example, if the Cycle value is 2, find the frame on the Timeline window 
where the Evolution value is 2 revolutions.

6  Move the current-time indicator back one frame. (Because the cycle begins again at the 
last frame, moving the current-time indicator back prevents a duplicate frame in the 
seamless loop.)

7  Trim the layer’s out point.

8  Prerender this layer, and import it into your project.

9  Set this prerendered footage item to loop. For information on looping footage, see the 
After Effects 6.0 User Guide.

Note: If you set keyframes for any of the other controls, you must return them to their 
initial settings at the point on the Timeline window where the cycle begins to repeat. 
Otherwise, these properties don’t loop. 

Twirl
The Twirl effect twirls the pixels of an image around a specified point at a specified 
amount. Pixels nearer the center point are twirled faster than pixels in outer regions, 
resulting in a whirlpool appearance. Because distortion in this effect is significant, After 
Effects uses special anti-aliasing techniques to produce the highest-quality image. As a 
result, the Twirl effect can be particularly slow to render. 

Twirling a layer

Adjust the following controls for the Twirl effect:

Angle Specifies how far and in which direction to twirl the image around the twirl center. 
Positive angles twirl the image clockwise; negative angles twirl it counterclockwise. To 
animate the twirl as a whirlpool, set keyframes for the angle.

Twirl Radius Specifies how far the twirl extends from the twirl center. This value is based 
on a percentage of the maximum horizontal or vertical distance of the layer, whichever is 
greater. A value of 50, for example, produces a twirl that extends to the edge of the layer.
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Warp
Use Warp to distort or deform After Effects layers. The 15 warp styles work much like the 
Warp effects in Adobe Illustrator and Warp Text in Adobe Photoshop. 

Warping a layer

To apply Warp: 

1  Select an object or group of objects.

2  Choose Effect > Distort > Warp.

3  In the Effect Controls window choose a warp style. 

4  Choose Horizontal or Vertical from the Warp Axis menu to specify which axis the warp 
affects.

5  Drag the Bend slider to specify the amount of bending.

6  Drag the appropriate sliders to specify the amount of horizontal and vertical distortion. 

Wave Warp
The Wave Warp effect produces the appearance of a wave traveling across an image. You 
can produce a variety of different wave shapes, including square, circular, and sine waves. 
The Wave Warp effect is automatically animated at a constant speed across the time range 
(without keyframes). To vary speeds, you need to set keyframes.

Original (left) and with variations of Wave Warp applied (center and right)

First example: Sine wave, small width and height  
second example: Semicircle wave, medium width and height

Wave Warp controls
Adjust the following controls for the Wave Warp effect:

Wave Type Specifies the shape of the wave.

Wave Height Specifies the height of the wave. Taller waves generally produce greater 
distortion.
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Wave Width Specifies the distance, in pixels, between wave peaks. Smaller values 
produce more waves.

Direction Specifies the direction the wave travels across the image. For example, a value 
of 90 degrees makes waves travel from left to right. A value of 180 degrees makes waves 
travel from top to bottom, and a value of 225 degrees makes the waves travel diagonally 
from upper right to lower left.

Wave Speed Sets the speed (cycles per second) at which the waves travel. When you 
specify a wave speed, the ripples are automatically animated at a constant speed across 
the time range (without keyframes). Click the wave speed value to specify negative values 
or values greater than 5. A negative value reverses the wave direction, and a value of 0 
produces no movement. To vary wave speed over time, set this control to 0, and then set 
keyframes for the Phase property of the layer.

Pinning Specifies areas of the image to be excluded from the wave. For example, if All 
Edges is selected, the wave does not travel across the edges of the image.

Phase Specifies the point along the waveform at which a wave cycle begins. The default 
value of 0 degrees starts the wave at the midpoint of its downward slope; 90 degrees 
starts it at the lowest point in the trough; 180 degrees starts it at the midpoint of the 
upward slope, and so on. 

Antialiasing Sets the amount of anti-aliasing, or edge smoothing, to perform on the 
image. Anti-aliasing is applied only when the layer is set to Best quality. In many cases, 
lower settings produce satisfactory results; a high setting can significantly increase 
rendering time.
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Expression Controls effects

About Expression Controls effects
You can use Expression Controls effects to manipulate property values in your expressions. 
By referring to these controls in an expression, you can more easily adjust parameters such 
as layer, color, and angle. For more information about Expression Controls effects, see the 
“Using Expressions” chapter in the online Help or printed guide.
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Image Control effects

Change Color
The Change Color effect adjusts the hue, saturation, and lightness of a range of colors. 
Choose the range by specifying a base color and similarity values. The similarity can be an 
RGB similarity, a hue similarity, or a chroma similarity.

Colors in the original image (left) are replaced with green (center) and yellow (right). 

Controls for the Change Color effect
Adjust the following controls for the Change Color effect:

View Specifies what to view in the composition. Corrected Layer shows the results of the 
Change Color effect. Color Correction Mask shows the areas of the layer that will be 
changed. White areas in the color correction mask are transformed the most, and dark 
areas are transformed the least.

Hue Transform Specifies the amount, in degrees, to adjust the hue of the selected colors.

Lightness Transform Specifies the amount to increase or decrease the lightness of the 
selected colors. Positive values brighten the selected regions; negative values darken 
them.

Saturation Transform Specifies the amount to increase or decrease the saturation of the 
selected colors. Positive values saturate the selected regions (moving toward pure color); 
negative values desaturate the selected regions (moving toward gray).

Color to Change Specifies the color to be changed. Matching Tolerance and Matching 
Softness both use this color as a target for building the color correction mask.

Matching Tolerance Specifies the degree of color matching before the color is affected 
by the color correction. With low tolerances, only colors very similar to the change color 
are added to the color correction mask. Larger tolerances add more of the image to the 
color correction mask.

Matching Softness Specifies the softness of the color correction. This control does not 
always soften the color correction mask geometrically, but it affects the severity of the 
color correction for regions similar to the base color.
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Match Colors Specifies the criterion for determining the similarity of two colors. RGB uses 
the red, green, and blue components. Hue matches colors based on hue. For example, 
bright red, light pink, and burgundy have similar hue values (a hue of red, but differing 
values of saturation and lightness). Chroma uses the two chromatic components to 
determine similarity, ignoring brightness. Chroma matching is therefore sensitive to 
saturation and hue differences, but not to lightness differences.

Invert Color Correction Mask Inverts the mask that determines which colors to affect. If 
selected, all colors will be color-corrected, except those selected by using Color to Change 
and matching controls.

Change to Color (formerly Change Color HLS)
The Change to Color effect changes a color you select in an image to another color using 
hue, lightness, and saturation (HLS) values. Perform color changes either by transforming 
or interpolating into the new color. This filter is useful for quickly changing one selected 
color to another, while leaving other colors in the image unaffected. 

Change to Color offers flexibility and options unavailable in the Change Color effect. These 
options include tolerance sliders for hue, lightness, and saturation for exact color 
matching, and the ability to select the exact RGB values of the target color that you wish to 
change to. 

Original (left), with saturation removed in the planet (center), and with light green changed to yellow 
in the planet (right)

Controls for the Change to Color effect
Adjust the following controls for the Change to Color effect:

From Specifies the color that you wish to change. This selection determines which pixels 
will be affected by the color change.

To Specifies the color that you wish to change to. This control determines the target color 
for selected pixels.

Change Specifies the HLS channels that are affected. Hue affects hue only, leaving the 
original lightness and saturation untouched. Hue and Lightness affects hue and lightness 
only, leaving the original saturation untouched. Hue and Saturation affects hue and 
saturation only, leaving the original lightness untouched. Hue, Lightness, and Saturation 
affects all the channels.

Change by Specifies the color change operation the effect performs. Setting to Color 
performs a direct change of affected pixels to the target color. Transforming to Color trans-
forms affected pixel values towards the target color, using HLS interpolation. The amount 
of transformation depends on how close the selected To pixel color lies to the From color 
and also on the Tolerance value.
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Tolerance Specifies the range of pixels that Change to Color affects. Expand this control 
to reveal separate sliders for Hue, Lightness, and Saturation values. Higher Tolerance 
values expand the range of similar values. Lower Tolerance values reduce the range of 
similar values. 

Note: Use the View Correction Matte option to better identify which pixels are affected. 

Softness Specifies the edge smoothness of the selected change areas. Higher values 
create smoother and more seamless transitions between areas affected by the color 
change and those left unaffected.

View Correction Matte Specifies whether or not you are viewing a grayscale mask of the 
color values. White areas indicate pixels that are affected by the color change. Black areas 
are left unchanged. Gray areas are only slightly affected by the color change.

To animate a color change, first select the initial color you wish to change; then set 
subsequent keyframes only for the To color. 

Color Balance (HLS)
The Color Balance (HLS) effect alters an image’s levels of hue, lightness, and saturation. It is 
intended only to provide compatibility with projects created in earlier versions of After 
Effects that use the Color Balance (HLS) effect. For new projects, use the Hue/Saturation 
effect, which operates the same as the Hue/Saturation command in Adobe Photoshop. 
You can convert a movie to grayscale by setting the Saturation to –100.

Original image (left), with increased hue and saturation (center), and increased saturation only 
(right)

Color Link
The Color Link effect colorizes one layer with the average pixel values of another selected 
layer. This effect is useful for quickly finding a color that matches the color of a background 
layer. 

Original (left), with background color linked to the planet (center), and with background color linked 
to the saucer (right)

Controls for the Color Link effect
Adjust the following controls for Color Link:
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Source Layer Select the layer from which you wish to sample colors. Color Link chooses 
your original layer if None is selected.

Note: If you choose None, Color Link samples from the original layer, taking into account 
any masking or other effects that you have applied. If you choose the original layer’s name 
from the menu, Color Link samples from the source layer before masking or effects are 
applied.

Sample Specifies which values the effect samples from the source layer and subse-
quently applies to the effect layer. 

• Average averages all RGB values from all opaque pixels in the source layer. This is useful 
if you are selecting a specific region of pixels defined with a mask. Median samples the 
pixel value that falls in the middle of all RGB values.

• Brightest samples the brightest RGB value, using lightness, and Darkest samples the 
darkest RGB value, also using lightness.

• Max RGB samples the highest value of the individual RGB channels. Min RGB samples 
the lowest value of the individual RGB channels.

• Average Alpha samples only the average alpha channel value. Median Alpha samples 
the value that falls in the middle of all alpha channel values. Max Alpha samples the 
highest value of the alpha channel. Min Alpha samples the lowest value of the alpha 
channel.

Clip Specifies the percentage of the highest or lowest sampled target values that the 
effect disregards. This is useful for reducing the influence of noisy pixels in an image.

Stencil Original Alpha If this box is checked, the effect places a stencil of the effect 
layer’s original alpha channel over the new value. If this box is unchecked, the effect disre-
gards the original alpha channel and fills the entire effect layer with the average value of 
the source layer. 

Opacity Specifies the transparency of the effect layer. 

Blending Mode Specifies the blending mode that the effect uses to combine the new 
colorized layer with the original layer. These blending modes behave exactly like those in 
the Timeline. (Blending modes are not available when averaging alpha channel values in 
the layer.)
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Colorama
The Colorama effect assigns a custom palette to an element in a layer and then cycles the 
palette. First you colorize an image with a specified palette, and then you cycle the colors 
in that palette—that is, change them smoothly around the Output Cycle palette or color 
wheel. Color cycling is a quick way to animate pulsing colors that follow a gradient path, 
colors that zoom out of a radial gradient, and many other effects.

Original (left), with background cycling through colors (center), and with an inverted alpha mask 
(right)

Colorama works by first converting a specified property to grayscale and then remapping 
the grayscale values to the specified color palette. The current color palette appears on the 
Output Cycle color wheel. 

The grayscale is then “wrapped around” the color wheel. Black pixels are mapped to the 
color at the top of the cycle, while increasingly lighter grays are mapped to successive 
colors going clockwise around the cycle, until this process wraps around to the start again 
at full white. For example, with the default “Hue cycle” palette, pixels corresponding to 
black become red, while pixels that have been converted to 50% gray become cyan. You 
can animate the cycle so that in one revolution, each pixel of the layer travels through the 
complete color cycle.

Customizing a palette with the Colorama effect
You can customize any palette by altering the colors and locations of the triangles around 
the Output Cycle control of the Colorama effect, using any of the following procedures. 

To add a triangle:

Click in or near the color wheel, and select a color from the color picker. 

To duplicate a triangle:

Press Ctrl (Windows) or Command (Mac OS), and drag the triangle to the new position. 

To change the color of a triangle:

Do any of the following:

• Double-click a triangle, and select a color from the color picker. 

• To make a triangle ignore its original color and instead “sample” the color of its new 
location on the color wheel, click the triangle and then press Ctrl (Windows) or 
Command (Mac OS). To avoid deleting the original color, you may want to duplicate the 
triangle first.

• To change the opacity, select a triangle on the color wheel and then drag the attached 
triangle above the opacity slider. Make sure that Modify Alpha is selected if you want 
the opacity information to affect your output.
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To change where the color of a specific triangle appears on the color wheel:

Do any of the following:

• Drag a triangle. 

• Press Shift as you drag to snap the triangles to the 45-degree increments around the 
wheel. 

Note: To snap a triangle to the start or end point of the color wheel, press Shift and move 
the pointer slightly to the right (start point) or left (end point) of the top of the wheel.

To delete a triangle:

Drag it away from the color wheel. 

Adjusting lightness or hue levels using the Colorama effect
The following procedures provide two methods of adjusting the levels of an image:

To adjust hue levels:

1  Expand the Input Phase control, and choose Hue from the Get Phase From menu.

2  Expand the Output Cycle control, and choose Hue Cycle from the Use Preset Palette 
menu. 

3  Expand the Modify control, and choose Hue from the Modify menu.

4  (optional) Animate the Phase Shift control to cycle the hues in the image. 

5  (optional) Choose an animated gradient layer from the Add Phase menu to modulate 
the hue.

To adjust lightness levels:

1  Expand the Input Phase control, and choose Lightness from the Get Phase From menu.

2  Expand the Output Cycle control, and choose Ramp Grey from the Use Preset Palette 
menu.

3  Choose Lightness from the Modify menu.

4  Add a triangle to the Output Cycle at 3 o’clock and another at 9 o’clock, and then drag 
them toward 6 o’clock. This setting expands shadows and highlights while compressing 
the midtones of an image.

Input Phase controls for the Colorama effect
Specify which layer and property are colorized by the Colorama effect:

Get Phase From  Specifies the property to which the Output Cycle is applied. Select Zero 
if you want to use a property from another layer. 

Add Phase  Specifies the layer containing the property that you want to apply to the 
Output Cycle. To use this layer instead of the first layer, select Zero for Get Phase From; 
otherwise, this layer becomes a secondary property to the first property. Add Phase From 
specifies the property to use from the Add Phase layer.

Add Mode  Specifies how Colorama combines properties from two layers. 

• Wrap adds the values of the two properties for each pixel. A pixel cannot be whiter than 
100%, so sum values above 100% are wrapped around the cycle again. For example, a 
sum of 150% wraps back to 50%. 
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• Clamp adds the values up to 100%. The sum of any two pixels that is greater than 100% 
is rounded back down to 100%. 

• Average adds two pixels together and then divides by two. Average values never wrap 
or clamp, making this option the safest choice for predictable output. 

• Screen screens the second layer over the original layer; the brighter areas in the second 
layer brighten the first layer, and the darker areas in the second layer are discarded. 
Screen mode is especially useful for compositing fire, lens flares, and other lighting 
effects.

Phase Shift  Shifts the colors around the color wheel. If you animate Phase Shift, the 
modified pixels cycling among the colors defined in the Output Cycle palette. A positive 
value moves the pixels in a clockwise direction; a negative value moves them counter-
clockwise. 

Animate Phase Shift to cycle the colors around the color wheel. Phase Shift is the 
parameter that is most commonly animated.

Output Cycle controls for the Colorama effect
Specify the colors used to colorize the image:

Use Preset Palette  Specifies the palette for the color cycle. The top palettes are designed 
for quick color-management tasks. The bottom choices offer a variety of built-in color 
effects. 

Output Cycle  Specifies the color palette you are currently working with. The triangles 
specify the location on the color wheel where a specific color occurs. The color between 
triangles is smoothly interpolated, unless Interpolate Palette is off. You can add up to a 
total of 64 triangles per Output Cycle. (See “Customizing a palette with the Colorama 
effect” on page 94.)

Note: When you keyframe the Output Cycle, a triangle’s position and color are interpo-
lated between keyframes. For best results, make sure that all keyframes have the same 
number of Output Cycle triangles.

Cycle Repetitions  Controls how the Output Cycle pixels are applied to the Input Phase. 
The default value of 1 maps the Output Cycle once from Input Phase black to Input Phase 
white. A value of 2 maps the Output Cycle twice, once from 1% to 50%, and again from 
51% to 100%. Use this option to create a simple palette and repeat it many times 
throughout a gradient. For example, you can create running lights, in which one cycle 
repeated 20 times generates 20 lights.

Interpolate  Specifies whether or not colors between triangles are interpolated 
smoothly. When it is not selected, the output is posterized. For example, with Interpolate 
Palette not selected, the default Hue Cycle palette becomes a useful tool for preparing 
custom shatter maps for use with the Shatter effect.
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Modify controls for the Colorama effect
Modify controls specify which properties are modified by the Colorama effect. Once the 
Input Phase pixels are mapped to a color on the Output Cycle, the results are applied to 
the property selected here. You can get a great deal of selective control by choosing the 
same property for the Input Phase and the Modify property, along with an appropriate 
Output Cycle. 

Note: Because the input layer is represented as a grayscale file, the Ramp Grey preset 
palette works well and is most predictable with any Modify setting other than All. 

Modify  Specifies the specific property to be modified.

Modify Alpha  Specifies whether the opacity information in your Output Cycle is applied 
to the output. Selecting Modify Alpha changes the alpha information along with the other 
channels selected from the Modify menu. Modify Alpha works in conjunction with the 
Change Empty Pixels option in determining the final change in opacity.

Note: If you apply Colorama to a layer with an alpha channel, and the Output Cycle does 
not contain alpha information, the anti-aliased edges of the layer may appear pixelated. 
To smooth the edges, deselect Modify Alpha. If Modify Alpha is selected and the Output 
Cycle contains alpha information, the output is affected even if you’ve selected None from 
the Modify menu. This is how you can adjust the levels of just the alpha channel without 
also changing the RGB information.

Change Empty Pixel  Specifies whether you want Colorama’s effects to extend into the 
transparent areas of your layer as well. (This works only when Modify Alpha is selected.)

Pixel Selection, Masking, and other controls for the Colorama 
effect
Adjust the controls to choose which colors in your image you want to affect. 

Pixel Selection For the Matching controls for Pixel Selection to work, Matching Mode 
must be set to anything other than Off.

• Matching Color specifies the specific pixel color to which you want to apply Colorama. 
To select a specific color in the image using the eyedropper tool, turn off the Colorama 
effect temporarily. 

• Matching Tolerance specifies how close a color has to be to the Matching Color option 
before it is affected by Colorama. When Matching Tolerance is 0, only the exact color 
selected for Matching Color is affected by Colorama. When Matching Tolerance is 1, 
Colorama is tolerant of all colors; this value in effect turns the Matching Mode off.

• Matching Softness specifies the softness between the selected and nonselected areas. 
This doesn’t blur the image, but controls how smoothly the Colorama effect blends into 
the rest of the image. For example, if you have an image of a man wearing a red shirt 
and blue jeans, and you want to change the color of the shirt from red to blue, subtly 
adjust Matching Softness to spread the selection from the red in the shirt into the 
shadows of the shirt’s folds. If you adjust it too high, the selection spreads to the 
healthy pink of the man’s skin; if you adjust it even higher, the selection spreads to his 
blue jeans. 

• Matching Mode specifies whether a pixel is close to the Matching Color. Use Matching 
Mode if Matching Tolerance doesn’t increase the selection in the desired areas. In 
general, use RGB for high-contrast graphics and Chroma for photographic images.
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Masking Specifies the pixels you want to change using the luminance or alpha channel 
of another layer. Mask Layer specifies the layer you want to use for your mask. Masking 
Mode specifies the Mask Layer property to use. 

Composite Over Specifies whether you want to see only the selected pixels or the 
selected pixels on top of the original layer (the default).

Blend with Original Specifies the relative percentages of the original layer and the 
affected layer that you see. Use this control to fade out the Colorama effect.

Equalize
The Equalize effect alters an image’s pixel values to produce a more consistent brightness 
or color component distribution. The effect works similarly to the Equalize command in 
Adobe Photoshop. Equalization can be performed using either RGB values or the 
brightness component. Pixels with 0 alpha (completely transparent) values are not 
considered, so masked layers are equalized based on the mask area. Layer quality settings 
do not affect Equalize.

Original (left), and with Equalize applied to the background using brightness in varying amounts 
(center and right)

Equalize Specifies which equalization method to use. RGB equalizes the image based on 
red, green, and blue components. Brightness equalizes the image based on the brightness 
of each pixel. Photoshop Style equalizes by redistributing the brightness values of the 
pixels in an image so that they more evenly represent the entire range of brightness levels.

Amount to Equalize Specifies how much to redistribute the brightness values. At 100%, 
the pixel values are spread as evenly as possible, while lower percentages redistribute 
fewer pixel values.

Gamma/Pedestal/Gain
The Gamma/Pedestal/Gain effect adjusts the response curve independently for each 
channel. For pedestal and gain, a value of 0.0 is completely off, and a value of 1.0 is 
completely on.
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The Black Stretch control remaps the low pixel values of all channels. Large Black Stretch 
values brighten dark areas. The effect is the same in all quality settings. Gamma specifies 
an exponent describing the shape of the intermediate curve. The Pedestal and Gain 
controls specify the lowest and highest attainable output value for a channel.

Original (left) and with varying amounts of Gamma/Pedestal/Gain applied (center and right)

Grow Bounds
The Grow Bounds effect increases the layer size for the effect that directly follows this 
effect. It is most useful with layers with Collapse Transformations/Continuously Rasterize 
enabled, because they render using a buffer that is the size of the composition. For 
example, if you apply Drop Shadow to a Text layer that is partially off the composition, the 
shadow will be clipped because only the portion of the text that is in the composition will 
cast a shadow. Applying the Grow Bounds effect before the Drop Shadow effect prevents 
the shadow from being cut off. The number of pixels you specify increases the height and 
width of the layer’s buffer. 

The Wave Warp effect is constrained by the dimensions of the layer (center); grow bounds fixes this 
problem (right).

PS Arbitrary Map
The PS Arbitrary Map effect applies a Photoshop arbitrary map file to a layer. An arbitrary 
map adjusts the brightness levels of an image, remapping a specified brightness range to 
darker or brighter tones. In the Curves window in Photoshop, you can create an arbitrary 
map file for the entire image or for individual channels. The PS Arbitrary Map effect is 
intended only to provide compatibility with projects created in earlier versions of After 
Effects that use the Arbitrary Map effect. For new work, use the Curves effect. 

An arbitrary map is applied to the background layer (right). 
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When loaded into After Effects, the specified arbitrary map is applied to the layer or to one 
or more channels of the layer, depending on how it was created. If you do not select an 
arbitrary map, After Effects applies the default map (linear distribution of brightness) to 
the layer. For more information on arbitrary maps, see the Adobe Photoshop 7.0 online 
Help topic “Using the Curves dialog box.”

PS Arbitrary Map controls
Adjust the following controls for the PS Arbitrary Map effect:

Phase Cycles through the arbitrary map. Increasing the phase shifts the arbitrary map to 
the right (as viewed in the Curves dialog box); decreasing the phase shifts the map to the 
left.

Apply Phase Map to Alpha Applies the specified map and phase to the layer’s alpha 
channel. If the specified map does not include an alpha channel, After Effects uses the 
default map (linear distribution of brightness) for the alpha channel.

Using the PS Arbitrary Map effect
The following procedures provide a basic overview of how to use this effect.

To apply a Photoshop arbitrary map:

In the Effect Controls window, click Options and then select an arbitrary map file. 

Although you can’t import .avc files or Photoshop spline files into the After Effects PS 
Arbitrary Map effect, you can convert these files in Photoshop to create files that are 
compatible with the After Effects Curves effect.

To convert .avc and Photoshop spline files:

1  In the Curves dialog box in Photoshop, load the .acv file (Windows) or the Photoshop 
spline file (Mac OS). 

2  Click the pencil tool and then save the file as an .amp file (Windows) or a Photoshop 
lookup file.

Tint
The Tint effect alters an image’s color information. For each pixel, the luminance value 
specifies a blend between two colors. Map Black To and Map White To specify the colors to 
which dark and bright pixels are mapped. Intermediate pixels are assigned intermediate 
values. Amount to Tint specifies the intensity of the effect. The layer’s quality setting does 
not affect Tint. For more complex tinting, use the Colorama effect.

Original (left), with white mapped to green for the background (center), and with black mapped to 
dark blue and white mapped to light blue for the foreground (right)
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Keying effects

Color Difference Key (Pro only)
The Color Difference Key effect creates transparency from opposite starting points by 
dividing an image into two mattes, Matte Partial A and Matte Partial B. Matte Partial B 
bases the transparency on the specified key color, and Matte Partial A bases transparency 
on areas of the image that do not contain a second, different color. By combining the two 
mattes into a third matte, called the alpha  matte, the Color Difference Key creates well-
defined transparency values.

The Color Difference Key produces high-quality keying for all well-lit footage items shot 
against a bluescreen or greenscreen and works especially well with images that contain 
transparent or semitransparent areas, such as smoke, shadows, or glass.

Original (left) and background layer (center) are combined using Color Difference Key (right).

Applying the Color Difference Key
The following procedure provides a basic overview of how to apply this effect.

To apply the Color Difference Key:

1  Select the layer you want to make transparent, and then choose Effect > Keying > Color 
Difference Key.

Note: To use any of the eyedroppers in the Layer window, choose Color Difference Key 
from the View pop-up menu in the Layer window.

2  In the Effect Controls window, choose Matte Corrected from the View menu. To view 
and compare the source image, both partial mattes, and the final matte at the same time, 
choose [A, B, Matte] Corrected, Final from the View menu. Other views available in the 
View menu are described in step 10.

3  Select the appropriate key color: To key out a bluescreen, use the default blue color. To 
key out a non-bluescreen, select a key color in one of the following ways:

• Thumbnail eyedropper: Select and then click in the Composition window or the original 
image thumbnail on an appropriate area.

• Key Color eyedropper: Select and then click in the Composition or Layer window on an 
appropriate area.
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• Key Color swatch: Click to select a color from the specified color space.

Note: The eyedropper tools move the sliders accordingly. Use the sliders in step 9 to fine-
tune the keying results.

4  Click the  matte button to display the final combined matte in the matte thumbnail.

5  Select the Black eyedropper, and then click inside the matte thumbnail on the lightest 
area of black to specify transparent regions. The transparency values in the thumbnail and 
Composition window are adjusted.

6  Select the White eyedropper, and then click inside the matte thumbnail on the darkest 
area of white to specify opaque regions. The opaque values in the thumbnail and the 
Composition window are adjusted.

To produce the best possible key, make the black and white areas as different as you 
can so that the image retains as many shades of gray as possible.

7  Select a matching accuracy from the Color Matching Accuracy menu. Choose Faster 
unless you are using a screen that is not a primary color, such as orange. For those screens, 
choose More Accurate, which increases rendering time but produces better results.

8  If you need to further adjust transparency values, repeat steps 5 and 6 for one or both of 
the partial mattes. Click the Partial Matte B button or the Partial Matte A button to select a 
partial matte, and then repeat the steps.

9  Adjust transparency values for each partial matte and for the final matte by dragging 
one or more of the following slider bars in the Matte Controls section:

• Black slider bars adjust the transparency levels of each matte. You can adjust the same 
levels using the Black eyedropper.

• White slider bars adjust the opaque levels of each matte. You can adjust the same levels 
using the White eyedropper.

• Gamma slider bars control how closely the transparency values follow a linear 
progression. At a value of 1 (the default), the progression is linear. Other values produce 
nonlinear progressions for particular adjustments or visual effects.

10  When adjusting individual mattes, you can choose the following views from the View 
menu to compare the mattes with and without adjustments:

• Choose Uncorrected to view a matte without adjustments made by the slider bars in 
step 9.

• Choose Corrected to view a matte with all adjustments made by the slider bars in step 
9.

11  Before closing the Effect Controls window, select Final Output from the View menu. 
Final Output must be selected for After Effects to render the transparency.

To remove traces of reflected key color from the image, apply Spill Suppressor using 
Better for Color Accuracy. If the image still has a lot of color, apply the Simple Choker 

or Matte Choker matte tool. For more information, see “Simple Choker (Pro only)” on 
page 114 or “Matte Choker (Pro only)” on page 113.
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Color Key
The Color Key effect keys out all image pixels that are similar to a specified key color. 
This effect modifies only the alpha channel of a layer. The layer’s quality setting does not 
affect Color Key.

A non-standard green screen (left) and the background (center) are combined with Color Key (right).

When you key out a color value in a layer, that color or range of colors becomes trans-
parent for the entire layer. Control the range of transparent colors by adjusting the 
tolerance level. You can also feather the edges of the transparent area to create a smooth 
transition between the transparent and opaque areas.

To key out a single color:

1  Select the layer.

2  Choose Effect > Keying > Color Key.

3  In the Effect Controls window, specify a key color in one of two ways:

• Click the Key Color swatch to open the Color dialog box and specify a color.

• Click the eyedropper, and then click a color on the screen.

4  Drag the Color Tolerance slider to specify the range of color to key out. Lower values key 
out a smaller range of colors near the key color. Higher values key out a wider range of 
color.

5  Drag the Edge Thin slider to adjust the width of the keyed area’s border. Positive values 
enlarge the mask, increasing the transparent area. Negative values shrink the mask, 
decreasing the transparent area.

6  Drag the Edge Feather slider to specify the softness of the edge. Higher values create a 
softer edge but take longer to render.
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Color Range
The Color Range effect creates transparency by keying out a specified range of colors in 
either the Lab, YUV, or RGB color space. You can use this key on screens that consist of 
more than one color or on bluescreen or greenscreens that have been unevenly lit and 
contain different shades of the same color.

A poorly lit green screen (left) and a background layer (center) are combined using Color Range Key 
(right). 

To apply the Color Range Key:

1  Select the layer you want to make transparent, and then choose Effect > Keying > Color 
Range.

2  Choose the Lab, YUV, or RGB color space from the Color Space menu. If you’re having 
trouble isolating the subject using one color space, try using a different one.

3  Select the Key Color eyedropper, and then click in the matte thumbnail to select the 
area that corresponds to a color in the Composition window you want to make trans-
parent. Typically, this first color is the one that covers the largest area of the image.

Note: To use the eyedroppers in the Layer window, choose Color Range from View pop-up 
menu in the Layer window.

4  Select the Plus eyedropper, and then click other areas in the matte thumbnail to add 
other colors or shades to the range of colors keyed out for transparency.

5  Select the Minus eyedropper, and then click areas in the matte thumbnail to subtract 
other colors or shades from the range of colors keyed out.

6  Drag the Fuzziness slider to soften the edges between transparent and opaque regions. 

7  Use the slider bars in the Min/Max controls to fine-tune the color range you selected 
with the Plus and Minus eyedroppers. The L, Y, R slider bars control the first component of 
the specified color space; the a, U, G slider bars control the second component; and the b, 
V, B slider bars control the third component. Drag Min slider bars to fine-tune the 
beginning of the color range. Drag Max slider bars to fine-tune the end of the color range.
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Difference Matte (Pro only)
The Difference Matte effect creates transparency by comparing a source layer with a 
difference layer, and then keying out pixels in the source layer that match both the 
position and color in the difference layer. Typically, it is used to key out a static background 
behind a moving object, which is then placed on a different background. Often the 
difference layer is simply a frame of background footage (before the moving object has 
entered the scene). For this reason, the Difference Matte Key is best used for scenes that 
have been shot with a stationary camera.

Original (left), Matte Only view of keyed-out subject (center), and composite of subject with new 
background (right)

Applying the Difference Matte
The following procedure provides a basic overview of how to apply this effect.

To apply the Difference Matte:

1  Select a motion footage layer as the source layer.

2  Find a frame in the source layer that consists only of background.

3  Save this background frame as an image file; then import it into After Effects and add it 
to the composition. This is the difference layer. For more information, see “Exporting a 
single frame of a composition” in the After Effects Help. Make sure that the duration of the 
difference layer is at least as long as that of the source layer.

Note: If there is no full-background frame in the shot, you may be able to assemble the full 
background by combining parts of several frames in After Effects or Adobe Photoshop. For 
example, you can use the Photoshop clone stamp tool to take a sample of the background 
in one frame, and then paint the sample over part of the background in another frame.

4  Turn off the display of the difference layer by clicking the Video switch in the Timeline 
window.

5  Make sure that the original source layer is still selected, and then choose Effect > Keying 
> Difference Matte.

6  In the Effect Controls window, choose Final Output or Matte Only from the View menu. 
Use the Matte Only view to check for holes in the transparency. To fill undesired holes after 
you complete the keying process, see “Matte Choker (Pro only)” on page 113.

7  Select the background file from the Difference Layer menu.

8  If the difference layer is not the same size as the source layer, choose one of the 
following controls from the If Layer Sizes Differ menu:

• Center places the difference layer in the center of the source layer. If the difference layer 
is smaller than the source layer, the rest of the layer is filled with black.
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• Stretch to Fit stretches or shrinks the difference layer to the size of the source layer, but 
it may distort background images.

9  Adjust the Matching Tolerance slider to specify the amount of transparency based on 
how closely colors must match between the layers. Lower values produce less trans-
parency; higher values produce more.

10  Adjust the Matching Softness slider to soften the edges between transparent and 
opaque areas. Higher values make matched pixels more transparent, but do not increase 
the number of matching pixels.

11  If there are still extraneous pixels in the matte, adjust the Blur Before Difference slider. 
This option suppresses noise by slightly blurring both layers before making the 
comparison. Note that the blurring occurs only for comparison and does not blur final 
output.

12  Before closing the Effect Controls window, make sure that you have selected Final 
Output from the View menu to ensure that After Effects renders the transparency.

Extract (Pro only)
The Extract effect creates transparency by keying out (or extracting) a specified brightness 
range, based on a histogram of a specified channel. It is best used to create transparency 
in an image shot against a black or white background or against a background that is very 
dark or bright but consists of more than one color. You can also use it to remove shadows 
from a composition.

Original with glare (left) and background layer (center) are combined using Extract (right).

In the Effect Controls window, the Extract effect displays a histogram for a channel 
specified in the Channel menu. The histogram displays a representation of the brightness 
levels in the layer, showing the relative number of pixels at each level. From left to right, 
the histogram extends from the darkest (a value of 0) to the lightest (a value of 255).

Using the transparency control bar beneath the histogram, you can adjust the range of 
pixels that are made transparent. The position and shape of the bar in relation to the 
histogram determine transparency. Pixels corresponding to the area covered by the bar 
remain opaque; pixels corresponding to the areas not covered by the bar are made trans-
parent.

To apply Extract:

1  Select the layer you want to make transparent, and then choose Effect > Keying > 
Extract.

2  If you are keying out bright or dark areas, choose Luminance from the Channel menu. 
To create visual effects, choose Red, Green, Blue, or Alpha.
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3  Adjust the amount of transparency by dragging the transparency control bar in the 
following ways:

• Drag the upper right and/or upper left selection handles to adjust the length of the bar 
and to shorten or lengthen the transparency range. You can also adjust the length by 
moving the White Point and Black Point slider bars. Values above the white point and 
below the black point are made transparent.

• Drag the lower right and lower left selection handles to taper the bar. Tapering the bar 
on the left affects the softness of transparency in the darker areas of the image; 
tapering it on the right affects the softness in the lighter areas. You can also adjust the 
softness levels by adjusting White Softness (lighter areas) and Black Softness (darker 
areas).

Note: To taper the edges of the transparency control bar, you must first shorten the trans-
parency bar.

• Drag the entire bar left or right to position it under the histogram.

Inner/Outer Key (Pro only)
The Inner/Outer Key effect isolates a foreground object from its background. Even objects 
with wispy, intricate, or undefinable edges can be clipped from their backgrounds with 
minimal work. To use the Inner/Outer key, create a mask to define the inside and outside 
edge of the object you want to isolate. The mask can be fairly rough—it does not need to 
fit exactly around the edges of the object. 

In addition to masking a soft-edged object from its background, Inner/Outer Key modifies 
the colors around the border to remove contaminating background colors. This color 
decontamination process determines the background's contribution to the color in each 
border pixel, and removes that contribution—thus removing the halo that can appear if a 
soft-edged object is matted against a new background.

The original masked layer (left) and the background layer (center) are combined using Inner/Outer 
Key (right).

Applying the Inner/Outer key
The following procedure provides a basic overview of how to apply this effect.

To apply the Inner/Outer key:

1  Select the border of the object that you want to extract by doing one of the following:

• Draw a single closed path near the object's border; then select the path from the 
Foreground menu and leave the Background menu set to None. Adjust the Single Mask 
Highlight Radius to control the size of the border around this path. (This method works 
well only on objects with simple edges.)
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• Draw two closed paths: an inner path just inside the object, and outer path just outside 
the object. Make sure that any fuzzy or uncertain areas of the object lie within these 
two paths. Select the inner path from the Foreground menu and the outer path from 
the Background menu. 

Note: Make sure that the mask mode for all paths is set to None.

2  If you want, move the masks around to find the location that provides the best results.

3  To extract more than one object, or to create a hole in an object, draw additional paths 
and then select them from the Additional Foreground and Additional Background menus. 
For example to key out a woman’s hair blowing in the wind against a blue sky, draw the 
inner path inside her head, draw the outer path around the outside edge of her hair, and 
then draw an additional path around the gap in her hair where you can see sky. Select the 
additional path from the Additional Foreground menu to extract the gap and remove the 
background image.

4  Create additional open or closed paths to clean up other areas of the image, and then 
select them from the Cleanup Foreground or Cleanup Background menu. Cleanup 
Foreground paths increase the opacity along the path; Cleanup Background paths 
decrease the opacity along the path. Use the Brush Radius and Brush Pressure options to 
control the size and density of each stroke.

Note: You can select the Background (outer) mask as a Cleanup Background path to clean 
up noise from the background portions of the image. 

5  Set Edge Thin to specify how much of the matte’s border is affected by the key. A 
positive value moves the edge away from the transparent region, increasing the trans-
parent area; Negative values move the edge toward the transparent region and increase 
the size of the foreground area. 

6  Increase the Edge Feather values to soften edges of the keyed area. High Edge Feather 
values take longer to render.

7  Specify the Edge Threshold, which is a soft cutoff for removing low opacity pixels that 
can cause unwanted noise in the image background. 

8  Select Invert Extraction to reverse the foreground and background regions. 

9  Set Blend with Original to specify the amount you want the resulting extracted image 
to blend with the original image.

Linear Color Key (Pro only)
The Linear Color Key effect uses RGB, hue, or chroma information to create transparency 
from a specified key color. In the Effect Controls window, it displays two thumbnails; the 
left thumbnail represents the unaltered source image, and the right thumbnail represents 
the view you’ve selected in the View menu.

You can adjust the key color, the matching tolerance, and the matching softness. The 
matching tolerance specifies how closely pixels must match the key color before they start 
becoming transparent. The matching softness controls the softness of edges between the 
image and the key color. 
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You can also reapply this key to preserve a color that was made transparent by the first 
application of the key. For example, if you are keying out a medium-blue screen, you 
might lose some or all of a light-blue piece of clothing your subject is wearing. You can 
bring back the light-blue color by applying another instance of the Linear Color Key and 
choosing Keep This Color from the Key Operation menu.

Features such as these eyes (left) that closely match the background (center) can become trans-
parent when using keys; Linear Key keeps them opaque with the Keep This Color control (right).

Applying the Linear Color key
The following procedures provide a basic overview of how to use this effect.

To apply the Linear Color Key:

1  Select a layer as the source layer, and then choose Effect > Keying > Linear Color Key.

2  In the Effect Controls window, choose Key Colors from the Key Operation menu.

3  Choose a color space from the Match Colors menu. In most cases, use the default RGB 
setting. If you’re having trouble isolating the subject using one color space, try using a 
different color space. 

4  In the Effect Controls window, choose Final Output from the View menu. The view you 
choose appears in the right thumbnail and in the Composition window. If you need to see 
other results, work in one of the other views:

• Source Only shows the original image without the key applied.

• Matte Only shows the alpha channel matte. Use this view to check for holes in the trans-
parency. To fill undesired holes after you complete the keying process, see “Matte 
Choker (Pro only)” on page 113.

5  Select a key color in one of the following ways:

Note: To use eyedroppers in the Layer window, choose Linear Color Key from the View pop-
up menu in the Layer window.

• Select the Thumbnail eyedropper, and then click an appropriate area in the Compo-
sition window or the original image thumbnail.

• Select the Key Color eyedropper, and then click an appropriate area in the Composition 
or Layer window. 

• To preview transparency for different colors, select the Key Color eyedropper, hold 
down the Alt key (Windows) or Option key (Mac OS), and move the cursor to different 
areas in the Composition window or the original image thumbnail. The transparency of 
the image in the Composition window changes as you move the cursor over different 
colors or shades. Click to select the color.
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• Click the Key Color swatch to select a color from the specified color space. The selected 
color becomes transparent.

Note: The eyedropper tools move the sliders accordingly. Use the sliders in steps 6 and 7 to 
fine-tune the keying results.

6  Adjust matching tolerance in one of the following ways:

• Select the Plus (+) or the Minus (-) eyedropper, and then click a color in the left 
thumbnail. The Plus eyedropper adds the specified color to the key color range, 
increasing the matching tolerance and the level of transparency. The Minus eyedropper 
subtracts the specified color from the key color range, decreasing the matching 
tolerance and the level of transparency. 

• Drag the matching tolerance slider. A value of 0 makes the entire image opaque; a value 
of 100 makes the entire image transparent.

7  Drag the Matching Softness slider bar to soften the matching tolerance by tapering the 
tolerance value. Typically, values under 20% produce the best results.

8  Before closing the Effect Controls window, make sure that you have selected Final 
Output from the View menu to ensure that After Effects renders the transparency.

To preserve a color after applying the Linear Color Key:

1  In the Effect Controls or Timeline window, turn off any current instances of keys or 
matte tools by deselecting the Effect option to the left of the key name or tool name. This 
displays the original image in the Composition window so that you can select a color to 
preserve.

2  Choose Effect > Keying > Linear Color Key. A second set of Linear Color Key controls 
appears in the Effect Controls window below the first set.

3  In the Effect Controls window, choose Keep Colors from the Key Operation menu.

4  Select the color you want to keep.

5  In the first application of the Linear Color Key, choose Final Output from the View menu 
in the Effect Controls window, and then turn other instances of the Linear Color Key back 
on to examine the transparency. You may need to adjust colors or reapply the key a third 
time to find the results you need.

Luma Key
The Luma Key effect keys out all the regions of a layer with a specified luminance or 
brightness. The layer’s quality setting does not influence the Luma Key effect.

A white background of the original (left and center) is removed using Luma Key (right).
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When the object you want to matte has a markedly different luminance value than its 
background, you can make the background value transparent by keying it out. For 
example, if you want to create a matte for musical notes on a white background, you can 
key out the brighter values; the dark musical notes become the only opaque area. 

To key out a luminance value:

1  Select the layer, and choose Effect > Keying > Luma Key.

2  Select a Key Type to specify the range to be keyed out.

3  Drag the Threshold slider on the Effect Controls window to set the luminance value on 
which you want the matte to be based.

4  Drag the Tolerance slider to specify the range of values to be keyed out. Lower values 
key out a smaller range of values near the threshold. Higher values key out a wider range 
of values.

5  Drag the Edge Thin slider to adjust the width of the keyed area’s border. Positive values 
make the mask grow, increasing the transparent area. Negative values shrink the mask.

6  Drag the Edge Feather slider to specify the softness of the edge. Higher values create a 
softer edge but take longer to render.

Spill Suppressor (Pro only)
The Spill Suppressor effect removes traces of the key color from an image with a screen 
that has already been keyed out. Typically, the Spill Suppressor is used to remove key color 
spills from the edges of an image. Spills are caused by light reflecting off the screen and 
onto the subject. 

If you are not satisfied with the results from using the Spill Suppressor, try applying 
the Hue/Saturation effect to a layer after keying, and then decrease the saturation 

value to de-emphasize the key color. (See “Hue/Saturation” on page 42.)

The original green key (left), leaves a green glow when keyed out (center). Spill Suppressor removes 
the glow (right).

To apply the Spill Suppressor:

1  Select the layer and choose Effect > Keying > Spill Suppressor.

2  Choose the color you want to suppress in one of the following ways:

Note: To use the eyedropper in the Layer window, choose Spill Suppressor from the View 
pop-up menu in the Layer window.

• If you have already keyed out the color with a key in the Effects Window, click the Color 
to Suppress eyedropper, and then click the screen color in the key’s Key Color swatch.

• In Spill Suppressor, click the Key Color swatch and choose a color from the color wheel.
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3  In the Color Accuracy menu, choose Faster to suppress blue, green, or red. Choose 
Better to suppress other colors, because After Effects may need to analyze the colors more 
carefully to produce accurate transparency. The Better option may increase rendering 
time.

4  Drag the Suppression slider until the color is adequately suppressed.
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Matte Tools effects (Pro only)

Matte Choker (Pro only)
The Matte Choker effect repeats a sequence of choking and spreading the matte to fill 
undesired holes (transparent areas) in opaque regions. The repetition is necessary 
because the entire matte must be choked and spread; the spreading fills the hole, but the 
edges of the matte must be choked back to preserve the matte shape. 

The sequence of choking and spreading occurs in two stages, each with its own set of 
identical controls. Typically, stage two does the opposite of stage one. After a specified 
number of back-and-forth adjustments (which are handled automatically by Matte 
Choker), the hole is filled and the matte shape is preserved. 

Original (left) shows areas of unwanted transparency after using Color Key (center) that are removed 
with Matte Choker (right).

Using the Matte Choker effect
The following procedure provides a basic overview of how to use this effect.

To close a hole in a matte:

1  Select the layer, and choose Effect > Matte Tools > Matte Choker.

2  Set stage-one controls (the first three sliders) to spread the matte as far as possible 
without altering its shape, as follows:

• Geometric Softness specifies (in pixels) the largest spread or choke.

• Choke sets the amount of choke. Negative values spread the matte; positive values 
choke it.

• Gray Level Softness specifies how soft to make the edges of the matte. At 0%, the matte 
edges contain only fully opaque and fully transparent values. At 100%, the matte edges 
have a full range of gray values, but may appear blurred. 

3  Set stage-two controls (sliders four, five, and six) to choke the matte by the same 
amount you spread it in stage one.

4  (optional) Use the Iterations slider to specify how many times After Effects repeats the 
spread-and-choke sequence. You may need to try a few different settings so that the 
sequence is repeated as many times as necessary to close any unwanted holes.
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Simple Choker (Pro only)
The Simple Choker effect shrinks or expands the edges of a matte in small increments to 
create a cleaner matte. The Final Output view displays the image with the effect applied, 
and the Matte view provides a black-and-white view of the image with black areas 
indicating transparency and white areas indicating opacity. Choke Matte sets the amount 
of choke. Negative values spread the matte; positive values choke it.

The original (left) contains unwanted edges after keying (center) that are removed with Simple 
Choker (right).
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Noise effects

Dust & Scratches
The Dust & Scratches effect reduces noise by changing dissimilar pixels. To achieve a 
balance between sharpness of the image and hiding defects, try various combinations of 
radius and threshold settings. Draft and Best quality settings give the same results. 

Scratches (left), enlarged view of scratches (center), and scratches removed with loss of clarity (right)

To apply Dust & Scratches: 

1  Choose Effect > Noise > Dust & Scratches. 

2  Drag the Radius slider right, or enter a value in the value field from 0 to 255 pixels. (The 
radius determines how far the filter searches for differences among pixels. Adjusting the 
radius makes the image blurry. Stop at the smallest value that eliminates the defects.)

3  Drag the Threshold slider left to 0 to turn off the value, so that all pixels in the selection 
or image can be examined. (The threshold determines how different the pixels’ values 
should be before they are eliminated.)

Note: The Threshold slider gives greater control for values between 0 and 128—the most 
common range for images—than for values between 128 and 255.

4  Increase the threshold gradually by entering a value or by dragging the slider to the 
highest value possible that eliminates defects. 

5  Select the Operate on Alpha Channel checkbox to apply the filter to the alpha channel.

Fractal Noise (Pro only)
The Fractal Noise effect creates textures and objects that cannot be described using 
simple geometric shapes. Use this effect to create organic-looking backgrounds, 
displacement maps, and textures, or simulate things like clouds, lava, or vapor. 
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Evolution creates subtle changes in the shape of the fractal. Animating these controls 
results in smooth changes of the noise over time, creating an effect such as passing clouds 
or flowing water. Evolution uses progressive revolutions that continue to change the 
image with each added revolution, unlike typical revolutions that refer to a setting on the 
dial control that remains constant every 360°. Therefore, the appearance at 0° is different 
from that at 1 revolution, which is different from that at 2 revolutions, and so on. To return 
the Evolution setting to its original state (for example, to create a seamless loop), use the 
Cycle Evolution option.

You can specify how much the fractals evolve over a period of time by setting keyframes 
for Evolution. The more revolutions within a given amount of time, the more rapidly the 
noise changes. Large changes in the Evolution value over a short period of time may result 
in flashing.

To create a seamless loop, use Cycle Evolution, and set Evolution keyframes at full revolu-
tions with no degrees—partially completed revolutions may interrupt the loop.

Fractal noise can resemble ambient fog (left), worm holes in outer space (center), or atomic clouds 
(right).

Controls for the Fractal Noise effect
Adjust the following controls for the Fractal Noise effect:

Fractal Type Specifies the fractal shape you want to use to create the noise.

Noise Type Specifies the type of noise.

Invert Inverts the noise. Select this option to create a negative or inverse of the current 
noise layer. Black areas become white, and white areas become black.

Contrast Adjusts the contrast of the noise layer. The default value is 100. Higher values 
create larger, more sharply defined areas of black and white in the noise, generally 
revealing less subtle detail. Lower values result in more areas of gray, softening or muting 
the noise. A layer’s contrast is also affected by the Overflow option.

Brightness Adjusts the brightness of the noise layer.

Overflow Remaps the values that fall outside of the grayscale range of 0–255 using one 
of the following options: 

• Clip remaps values so that any value above 255 is displayed as pure white, and any 
value below 0 is displayed as pure black. The Contrast value controls how much of the 
image falls outside of this range. Higher values result in a mostly black and/or white 
image with less gray area. Therefore, higher contrast settings display less subtle fractal 
detail. When used as a luma matte, the layer has sharper, better defined areas of trans-
parency.

• Soft Clamp remaps values on an infinite curve so that all values stay in the range. This 
option reduces contrast and makes fractals appear gray with few areas of pure black or 
pure white. When used as a luma matte, the layer contains subtle areas of transparency.
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• Wrap Back remaps triangularly, so that values above 255 or below 0 fall back into the 
range. This option subtle detail when Contrast is set above 100. When used as a luma 
matte, the layer reveals more detailed textured areas of transparency.

Transform, Complexity, Sub Setting See “Transform, Complexity, and Sub Setting 
controls for the Fractal Noise effect” on page 117.

Evolution See “Evolution controls for the Fractal Noise effect” on page 118.

Transform, Complexity, and Sub Setting controls for the Fractal 
Noise effect
Adjust the following settings for the Fractal Noise effect: 

Transform Specifies the size and rotation of the noise.

• Rotation rotates the fractals. Scale specifies the proportional scale of the fractal shapes; 
the default is 100. Uniform Scaling scales the noise uniformly. Scale Width and Scale 
Height specifies the width size and height size individually for the fractal shapes; 
available only when Uniform Scaling is not selected.

• Offset Turbulence specifies the portion of the fractal that is visible in the Composition 
window. Because the fractal shapes are infinite in all directions, only a portion of the 
fractal is visible at any given time. Use this control to reposition the shape in the layer.

• Perspective Offset specifies that the perspective is influenced by the Sub Settings 
control, Sub Scale. This option makes it possible to create a perspective effect when 
animating the Offset Turbulence.

Complexity Adjusts the visible level of detail in the fractal shapes. Lower values result in a 
softer, almost blurred appearance. Higher values result in more distinct fractal shapes.

Note: Increasing Complexity results in longer rendering times. If appropriate, try reducing 
the Size rather than increasing Complexity to achieve similar results and avoid longer 
rendering.

Sub Settings Fractals are generated by repeating instances of a noise function derived 
from the Fractal Type and Noise Type. In each instance, the following controls affect how 
each iteration value is calculated. Complexity determines the number of iterations that are 
calculated.

• Sub Influence determines how much each iteration influences the final image. This 
value also affects any subsequent iterations. At 100%, all iterations have the same 
amount of influence. At 50%, each iteration has half as much influence as the previous 
iteration.

• Sub Scaling scales the coordinates on which the iteration is calculated. When this value 
is set lower than 100%, each iteration adds more refined details. Setting this value at 
50% increases the detail by a factor of two for each iteration—the same way detail 
increases when scaling down an image.

• Sub Rotation rotates each iteration by a degree you set. Sub Offset offsets each iteration 
by an amount you set.

• Center Subscale calculates each iteration from the same point as the previous. This can 
result in the appearance of duplicated layers stacked on top of each other. To avoid this 
type of repetitive fractal look, don’t select this control.
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Evolution controls for the Fractal Noise effect
Adjust the following controls for the Fractal Noise effect:

Evolution Specifies evolution cycles.

Instead of animating Evolution over the entire composition, save rendering time by 
pre-rendering and looping one short evolution cycle for the duration you want.(See 

“Creating a seamless loop” on page 118.)

• Cycle Evolution creates a cycle of evolution that loops over the set amount of time. It 
forces the evolution state to return to its starting point, creating a smooth progressive 
cycle, a nonrepeating cycle, or a loop segment. 

• Cycle (in Revolutions) specifies the number of revolutions that the fractal noise cycles 
through before it repeats. The speed of these Evolution cycles is determined by the 
amount of time between Evolution keyframes. This option affects only the evolution of 
the fractal, not Transform or other controls. For example, if you view two identical states 
of a fractal with different Size or Offset settings, they do not appear the same.

• Random Seed sets a unique random value from which to generate the noise. Animating 
the Random Seed results in flashing from one set of fractal shapes to another (within 
that fractal type). For smooth transition of the fractal shapes use the Evolution option.

To ensure that a cycle completes full revolutions, choose a Cycle value that either matches 
or is evenly divisible by the number of revolutions set for Evolution. 

Note: Cycle is available only when Cycle Evolution is selected.

You can easily create new fractal noise animations by reusing previously created 
Evolution cycles and changing only the Random Seed value. Typing a new Random 

Seed value alters the noise pattern without disturbing the evolution animation. 

Opacity Specifies the opacity of the noise layer.

Blending Mode Specifies an operation between the fractal noise and the original layer. 
These Blending Modes are identical to the ones in the After Effects Modes column, with 
the following three exceptions:

• None renders the fractal only and does not composite with the original layer.

• Hue renders the fractal as hue values instead of grayscale. The Saturation and Lightness 
of the original layer are maintained. If the original layer is grayscale, nothing happens.

• Saturation renders the fractal as saturation values instead of grayscale. The Hue and 
Lightness of the original layer are maintained. If the original layer is grayscale, nothing 
happens.

Creating a seamless loop 
The following procedure provides a basic overview of how to create a seamless loop using 
the Fractal Noise effect.

To create a seamless Loop:

1  Select a layer in the Timeline window, and choose Effect > Render > Fractal Noise.

2  Set two keyframes for Evolution. 

3  Adjust the time between keyframes and the number of Evolution revolutions until you 
are satisfied with the animation of the noise.
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4  Select Cycle Evolution.

5  Set a value for Cycle. (The evolution completes the number of revolutions you specify 
for Cycle in the amount of time determined by the distance between Evolution keyframes. 
Determine the Cycle value by considering how much of this cycle you need to render 
before it repeats. The length of the project and use of the cell pattern created determine 
this. Choose the shortest length appropriate for your project to save rendering time.)

6  Initially, the last frame of a cycle is identical to the first frame. To create a seamless loop, 
skip the last frame by setting the Out point of the layer one frame before the last frame of 
the cycle. 

7  Move the current-time indicator to the point on the timeline where the cycle 
completes. For example, if the Cycle is set to 2, locate the frame on the timeline where the 
Evolution value is 2.

Note: If you set keyframes for other Fractal Noise controls, return them to their initial 
settings where the cycle begins to repeat in the timeline or the controls don’t loop.

8  Move the current-time indicator back one frame.

9  Trim the layer’s Out point at this frame.

10  Prerender this layer, and import it into your project. 

11  Select the file in the Project window, and choose File > Interpret Footage. Then set 
Loop to the number of loops required for the duration of the layer in the project.

Median
The Median effect replaces each pixel with the median pixel value of neighboring pixels 
within a given radius. At low values, this effect is useful for reducing some types of noise. 
At higher values, this effect gives a layer a painterly effect. This effect is the same at both 
Draft and Best quality. Use Radius to specify how many pixels to examine for the Median 
effect. For instance, when Radius is set to 1, the Median is performed on the eight neigh-
boring pixels that are within one pixel of the center pixel.

Original layer (left), with low radius values to reduce noise (center), and with high radius values to 
create a painterly effect (right)
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Noise
The Noise effect randomly changes pixel values throughout the image. The layer’s quality 
setting does not affect Noise.

Color Noise (left); Color Noise and clipped (center); and not clipped (right)

Adjust the following controls for the Noise effect:

Amount of Noise Specifies the amount of noise, and therefore the amount of distortion, 
through random displacement of the pixels. The range is 0% (no effect) to 100% (the 
image may not be recognizable).

Noise Type Randomly changes the red, green, and blue values of the image’s pixels 
individually when Use Color Noise is selected. Otherwise, the same value is added to all 
channels.

Clipping Determines whether the noise causes pixel colors to wrap around. When the 
color of a pixel gets as large as it can, clipping makes it stay at that value. With unclipped 
noise, the color value wraps around or starts again at low values. When Clipping is 
selected, even 100% noise leaves a recognizable image. For a completely randomized 
image, turn off Clipping and turn on Color Noise.

Noise Alpha
The Noise Alpha effect adds uniform or squared noise to the alpha channel of a source 
layer.

Original layer (left), Original Alpha set to Clamp (center), and Noise Alpha combined with Direction 
Blur (right).

Adjust the following controls for the Noise Alpha effect:

Noise Specifies the type of noise the effect uses. Unique Random creates equal amounts 
of black and white noise. Squared Random creates high-contrast noise. Uniform 
Animation creates animated noise, and Squared Animation creates animated contrast.

Amount Specifies the amount of noise that’s added to the layer. 
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Original Alpha Specifies how to apply noise to the alpha channel of a layer. Add 
produces equal amounts of noise in the transparent and opaque areas of the layer. Clamp 
produces noise in the opaque areas only. Scale increases the amount of noise propor-
tionate to the level of opacity and produces no noise in 100% transparent areas. Edges 
produces noise only in partially transparent areas, such as the edge of the alpha channel.

Overflow Specifies how the effect remaps values that fall outside the grayscale range of 
0-255. Clip displays values above 255 as opaque and values below 0 as transparent. Wrap 
Back forces values back into the 0-255 range, creating subtle details. For example, a value 
of 256 wraps back to 254, and a value of -1 wraps back to 1.

Random Seed Specifies a random value for noise. This control is active only if you choose 
Uniform Random or Squared Random. 

To produce flashing noise, animate the Random Seed control. To create smoothly 
animated noise, animate the Noise Phase value.

Noise Phase Specifies the placement of noise. This control is active only if you choose 
Uniform Animation or Squared Animation from the Noise pop-up menu. 

Noise Options (Animation) Specifies how you animate noise. Cycle Noise produces a 
cycle of noise that plays through once in the specified amount of time. Cycle specifies the 
numbers of revolutions of the Noise Phase that the noise cycles through before it 
repeats.(Available only when Cycle Noise is selected.) Alter the timing of the Noise Phase 
keyframes to adjust the speed of the Noise Phase cycles.

To save time animating the Noise Phase value, use the Cycle Noise option to create a 
seamless noise loop. Then, render the layer, and reimport it as a new source footage. 

Noise HLS, Noise HLS Auto
The Noise HLS effect generates static noise in layers that use still or moving source 
footage. The Noise HLS Auto effect automatically creates animated noise. Both effects 
offer various types of noise that can be added to the hue, saturation, or lightness of a layer. 
Controls for these effects are the same except for the final control that determines noise 
animation. 

Original Layer (left); Noise HLS (center); Noise HLS applied twice with low Saturation values (right).

Adjust the following controls for either the Noise HLS effect or the Noise HLS Auto effect:

Noise Specifies the type of noise the effect adds. Uniform produces evenly distributed 
pixel noise. Squared produces sparse, high-contrast noise that is distributed randomly. 
Grain produces grain-like noise that is useful for simulating film. 

Hue  Specifies the amount of colored noise that the effect generates, in proportion to the 
layer’s hue values. 
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Lightness Specifies the amount of grayscale noise that the effect generates, in 
proportion to the layer’s luminance values.

Saturation Specifies the amount of colored and grayscale noise that the effect generates, 
in proportion to the layer’s saturation values.

Grain Size  This control is active only when you choose Grain from the Noise pop-up 
menu.

Noise Phase (Noise HLS only) Specifies the random seed value for the noise.When you 
set keyframes for Noise Phase, the effect cycles through the phases to create animated 
noise. Greater value differences between keyframes increase the speed of the noise 
animation.

Noise Animation Speed (Noise HLS Auto only) Specifies the speed of the noise 
animation. To increase the rate at which the noise effect changes, set the value higher. For 
slower changing noise, set a lower value. To accelerate or decelerate the speed of the 
noise, set keyframes for this control.
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Paint effects (Pro only)

Paint
The Paint effect lets you modify the color and transparency of a layer while leaving the 
source file unaltered. To use this effect, apply the effect or simply select any of the paint 
tools in the Tools palette. You can use the brush tool to create spontaneous-looking 
writing or painting effects by animating paint strokes. You can use the clone stamp tool to 
retouch footage and perform necessary tasks such as wire removal. Since paint strokes are 
applied as effects, you can interleave them with other effects. For more information about 
the Paint effect, see the “Using Paint Tools” chapter in the online Help or printed guide.

Vector Paint (Pro only) 
Vector Paint strokes are made up of many tiny points that create the stroke path. You 
cannot isolate or individually adjust these individual points, but you can affect them using 
Vector Paint features such as Smoothing and Wiggling. The wiggling of a stroke is created 
by manipulating and displacing these points along the stroke path.

Original (left), brushstroke with a selection spline (center), and a second stroke created with Wiggle 
control (right)

Vector Paint strokes are nondestructive, so painting and erasing actions affect only the 
appearances on a layer; they do not alter the original source file of any image on the layer. 
All paint strokes are recorded and stored as they are drawn, so you can make the strokes 
appear in various sequences, such as animated over time or all at once. 

For animated strokes, the exact timing (real time) you used to draw the strokes can be 
played back and rendered. You can also adjust the playback speed to fit the timing you 
want. You can also create new strokes by blending existing strokes, both in space and in 
time.
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Vector Paint supports the Wacom and Creation Station tablets’ pressure-stylus and erase 
functions. 

Note: The Vector Paint options menu contains some unique commands and settings that 
are not otherwise accessible. Open this menu by clicking the Vector Paint toolbar options 
button  when a painting tool is selected.

When you use Vector Paint on a layer, you can start over at any time by deleting all 
strokes or the Vector Paint effect itself. To delete the effect, select Vector Paint in the 

Effect Controls window and press Delete or Backspace.

Using Vector Paint (Pro only)
The following procedure provides a basic overview of how to use this effect:

To paint on a layer:

1  Select the arrow tool  in the After Effects Tools palette.

2  In either the Composition or Timeline window, select the layer on which you want to 
paint.

3  Choose Effect > Paint >Vector Paint. The Vector Paint effect appears and is selected in 
the Effect Controls window, and the Vector Paint toolbar appears on the left side of the 
Composition window.

Note: This toolbar appears only when Vector Paint is selected (highlighted) in the Effect 
Controls window. If the rulers in the Composition window interfere with your view of the 
Vector Paint toolbar, choose View > Hide Rulers.

4  Select the paint tool you want to use from the Vector Paint toolbar.

5  In the Effect Controls window, select the options you want for Brush Settings and 
Composite Paint. 

6  In the Timeline window, move the current-time indicator to the appropriate point in 
time.

7  In the Composition window, drag to draw strokes on the layer.

To quickly set your brush Radius and Feather amounts as you paint, press Control 
(Windows) or Command (Mac OS) and click anywhere in the Composition window; 

then drag in or out to resize the brush.When you release the Control or Command key, you 
can then drag in or out to resize the feather.

Selecting a Vector Paint tool (Pro only)

Vector Paint tools in Composition window
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You can use three tools in the Vector Paint toolbar to work with Vector Paint:

Selection tool  Select a stroke by clicking or dragging across it. You can drag across 
several strokes to select them simultaneously. You select strokes in order to edit or delete 
them.

Paint tool  Paint directly on the layer, using settings defined in the Effect Controls 
window. When you use the paint tool, the pointer appears as a circle (or square) in the 
actual size of the brush.

Eraser tool  Erase areas of the layer, using Brush Type settings defined in the Effect 
Controls window. The Eraser pointer appears as a circle with an X through it. If you are 
using an installed tablet with stylus eraser support, Vector Paint automatically switches to 
eraser mode when you use the stylus eraser.

Clicking the active tool (Selection, Paint, or Brush) in the Vector Paint toolbar deacti-
vates painting and hides the other buttons in the toolbar. You can then drag and scale 

the layer. To reactivate the toolbar, reselect one of the three Vector Paint tool buttons.

Specifying a Brush type (Pro only)
Vector Paint includes three Brush types: Paint, Air, and Square. These brush types define 
the shapes and performance of both the paintbrush tool and the eraser tool. All brush 
types but the Air brush include a Feather setting.

To change brush types:

Do one of the following:

• In the Vector Paint toolbar, select the Paint , Air , or Square  button.

• In the Effect Controls window, click the current Brush type setting (Paint, Air, or Square) 
repeatedly to cycle through the three brushes until the brush you want is selected.

With increased Feather and reduced Opacity settings, Paint brushstrokes may resemble 
Air brushstrokes. However, when you paint a single stroke that crosses itself, the two brush 
types produce different results. Air brushstrokes build up opacity as the stroke crosses 
itself. Paint brushstrokes don’t build up opacity within the same stroke, whether they cross 
themselves or not. To increase opacity with Paint brushstrokes, create multiple strokes 
over the area (like multiple coats of paint).

Note: Each Brush Type is also available for the eraser tool. When the eraser tool is selected 
in the Vector Paint toolbar, the name appears with a -E after it in the Effect Controls 
window. Also, if a tablet is installed and the stylus has eraser support, Vector Paint 
automatically switches to eraser mode when you use the stylus eraser.

Brush Settings controls for the Vector Paint effect (Pro only)
Adjust the following controls for the Vector Paint effect:

Radius Controls the size of the brush or eraser.

If you press Alt (Windows) or Option (Mac OS) when clicking the question mark repre-
senting the Radius value, a Set Value dialog box appears. You can then type a Relative 

Radius, reducing the radius of each stroke by that percentage. The default value is 100%, 
which produces no change in the stroke radii.
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Feather Controls the softness of brush or eraser edges (but does not affect the airbrush).

When you drag to change Radius, Feather, or Opacity values, hold down Control 
(Windows) or Command (Mac OS) to reduce the size of the increments. To change the 

value by larger increments, hold down Shift as you drag.

Opacity Controls the transparency of the paint or erasures.

Brush Type Shows the brush type you selected in the Vector Paint toolbar in the Compo-
sition window. For more information, see “Specifying a Brush type (Pro only)” on page 125.

Color Represents the paint color used to draw strokes. Select a new color by clicking the 
Color swatch and then using the Color Picker, or by using the Eyedropper to sample a 
color from the desktop.

When one or more strokes of the same color are selected, this swatch displays the Color of 
those strokes. You can change the color of the selected strokes. For information about the 
Eyedropper, see “Editing your paint work (Pro only)” on page 127.

Color Clone When Color Clone is turned on, the brush behaves like a combination 
eyedropper and brush. The color of the stroke is determined by the pixels at the position 
where the stroke begins. The Color swatch in the Effect Controls Brush Settings displays 
the new sampled color. When you begin another stroke, a new group of pixels is sampled 
and used to color that stroke.

The Color Clone affects strokes only while you draw; it has no effect on an already 
completed stroke.This is the only Brush Setting you can’t apply after drawing. Clicking 
either the Eyedropper or Color swatch turns off the Color Clone feature.

Selecting and editing Vector Paint strokes (Pro only)
When you select a single stroke or strokes with the same Brush Settings, you can edit the 
enabled Brush Settings in the Effect Controls window. Your changes to the strokes 
immediately appear in the Composition window as you complete them.

When you select multiple strokes that have different Brush Settings, a question mark [-?-] 
appears next to that Brush Setting in the Effect Controls window. If you edit that value, all 
of the selected strokes are reset to the new value. 

To edit a specific paint stroke, select it using the selection tool  on the Vector Paint 
toolbar and click or drag, or choose Select from the Vector Paint options menu. You can 
select and then move, revise attributes, or delete either a paint stroke or erasure stroke.

Use the following commands from the Select option in the Vector Paint toolbar option 
menu to select and edit paint strokes: 

Note: Some options are tied to the current position of the current-time indicator in the 
Timeline window.

All Selects all strokes on a layer.

None Deselects all strokes on a layer (available only if some strokes are selected.)

Visible Selects all strokes visible at the current frame.

Current Time Selects all strokes that were drawn at the current time position. (Playback 
Speed does not affect the original start time of strokes.)

Last Painted Selects the last-painted brush stroke (or erase stroke). If you painted several 
strokes with the Shift key held down, this command selects that group of strokes.
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Similar With one or more strokes selected, this command selects additional strokes with 
similar Brush Settings properties. If strokes with dissimilar properties are initially selected, 
this command selects a broader range of strokes.

Inverse Toggles to a selection of all unselected strokes, leaving the previously selected 
strokes unselected.

After you select one or more strokes, you can use keyboard shortcuts to transform them, 
such as by rotating, scaling (vertically, horizontally, or both), or nudging (repositioning one 
pixel at a time). For a list of these shortcuts, see the “Shortcuts Appendix” chapter in either 
the online Help or the printed guide.

Editing your paint work (Pro only)
Use the following tools on the Vector Paint toolbar in the Composition window to revise 
your paint work:

Undo button  Click the Undo button to cancel your last (one) painting action, if it can 
be undone. If the action cannot be undone, this tool is dimmed (not available). You can 
also undo paint actions using the Undo command on the Vector Paint options menu or by 
pressing Control+Z (Windows) or Command+Z (Mac OS).

Note: Do not use the Undo command on the Edit menu to undo Vector Paint actions.

Eyedropper tool  Use the eyedropper to select a color to paint with from a sampling 
anywhere on the desktop. Press the Escape key to cancel the eyedropper.

Note: By default, the eyedropper tool samples a single pixel. Hold down Control 
(Windows) or Command (Mac OS) and click the eyedropper tool to sample a 3-x-3-pixel 
average. Hold down Shift and drag to sample a range of multiple pixels.

Color swatch   Displays the current selection as a solid color. When clicked, it opens 
the Color picker dialog box. If the Opacity setting is less than 100%, the Color Swatch icon 
appears checkered, not solid.

Note: If Color Clone is enabled in the Effect Controls, this swatch represents the sampled 
color.

Shift-click the Color Swatch to open the Set Value dialog box for Opacity without 
turning off Color Clone.

Smoothing a stroke (Pro only)
The Smoother command in the Vector Paint options menu removes points from a selected 
stroke or strokes. This action simplifies stroke paths, smoothing out the curves. By elimi-
nating unneeded points, the Smoother can also dramatically reduce the size of the project 
file when you have complex drawings composed of many strokes.

When you select a path and choose Smoother, a dialog box appears in which you can type 
a Max Error value. This value sets the tolerance for the smoothing. Higher values remove 
more points on the path, resulting in a smoother stroke. Set values within the range 0–
100. The default value, 1.0, removes only redundant points, maintaining details in the 
stroke.

After you click OK in the dialog box, the stroke paths immediately reflect the smoothing in 
the Composition window.

Important: Smoothing cannot be undone. Removing these points may alter the shape of 
the path. If you want to preview the results before you commit, create a duplicate of the 
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layer and apply Smoothing to test the result. If the results are satisfactory, then apply the 
command to the original layer. 

Configuring a stylus for Vector Paint in Windows (Pro only)
You can specify your preferences for your Wacom or Creation Station tablet in several 
areas of the After Effects interface.

Note: Using a tablet with Vector Paint is not supported in Mac OS X. You can, however, use 
a tablet with the Paint tools. For more information, see the “Using Paint Tools” chapter in 
the online Help or printed guide. 

Select the following preferences in the Vector Paint Preferences dialog box by clicking 
Options in the Effects palette:

Stylus Vendor (Mac OS only) Tablets are not supported in Vector Paint in Mac OS X. 
“Unknown” appears. 

Use High Res. Coordinates When this option is checked, data is recorded with high 
resolution (if supported by the stylus). This setting overrides normal mouse coordinates to 
use the higher resolution of the tablet, recording strokes with greater precision and 
subpixel accuracy.

For information about opening the Vector Paint Preferences dialog box, see “Selecting 
viewing options (Pro only)” on page 137.

Note: Wacom® tablets do not support High Res. Coordinates when Proportional mode is 
selected in the Wacom® control panel.

If you experience offset coordinates with your pen, try the following:

• Check that screen resolution and monitor settings haven’t changed.

• If using a Wacom tablet, make sure that your tablet-mapping aspect isn't set to Propor-
tional. Select To Fit mode or One to One mode instead.

• Restart your system.

If all else fails, turn off Use High Res. Coordinates. (Subpixel accuracy will be lost, but 
Pressure and Eraser modes will still be available.)

Using the stylus to affect stroke weight and opacity (Pro only)
Under Brush Settings in the Vector Paint effects, the Stylus Radius option affects stylus 
sensitivity. When you select this option, the pressure of the pen on the tablet changes the 
weight of the stroke as it is drawn. Lighter pressure decreases the radius (creating a 
thinner stroke), and increased pressure increases the radius (creating a wider one). The 
Radius value setting indicates the maximum radius amount. Use the tablet settings to 
adjust the pressure-width sensitivity for the pen.

Use the Effect Controls window to turn this option off and on: Select the Radius option for 
Stylus under Vector Paint. When this option is turned on, an X appears in the Radius check 
box and a checkmark appears by the Stylus Radius command in the Vector Paint options 
menu.

Note: You can choose Stylus Radius even when no tablet is installed. This option affects 
strokes when wiggling is enabled.

The pressure variation of the pen on the tablet alters the opacity of the stroke as you draw. 
Light pressure results in lower opacity values, while increased pressure creates more 
opaque strokes. The Opacity value defines the maximum of the Opacity range.
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As with Stylus Radius, you can select and specify a stylus Opacity. When stylus Opacity is 
active, an X appears in the Stylus Opacity check box in the Effect Controls window, and a 
checkmark appears by the Stylus Opacity command in the Vector Paint options menu.

Playing back your painting (Pro only)
Use the Playback Mode pop-up menu in the Effect Controls window to specify when and 
how quickly your strokes appear in your composition. When you draw strokes, Vector Paint 
records information for the stroke start time and the drawing time of each stroke (in real 
time). The Playback Mode you select determines when a stroke starts and for how long it 
appears. You can set the speed at which the strokes play back using Playback Speed.

Play back your strokes using the Spacebar or RAM Preview, or by viewing the results of a 
rendered Composition.

Note: Regardless of how you record your strokes and which Playback Mode you select 
when recording, you can always switch to another Playback Mode at any time.

While the Playback Mode chosen affects what you see during playback, it also determines 
what you see while you are drawing strokes. Onion Skin mode, for example, is used 
primarily while drawing strokes, and then another mode is selected before rendering.

Important: Notice the position of the current-time indicator when you begin drawing 
strokes. This position affects the appearance of strokes in all modes except All Strokes.

Adjust the following controls to affect the way that strokes appear in the composition:

All Strokes Displays all strokes for the full duration of the layer, regardless of the position 
of the current-time indicator when you drew them.

Past Strokes Displays strokes from the time at which they were recorded until the end of 
the layer (the Out point).

Hold Strokes Displays strokes from the frame on which they were drawn and holds them 
only until the point at which the next stroke was drawn. This treats strokes like Hold 
keyframes; as a stroke appears, it replaces the next, as in a slide show.

Animate Strokes Begins drawing the stroke at the current time (that is, at the frame 
where the current-time indicator is when you draw the stroke). The stroke animates in the 
same way as it was drawn.

Current Frame The default Draw Strokes setting. This control displays the stroke only at 
the frame at which it was painted.

Onion Skin Displays strokes drawn on the current frame plus strokes drawn on the 
surrounding few frames. These additional strokes appear color-coded and at reduced 
opacity, to distinguish them from the strokes on the current frame. Those strokes actually 
exist only on the frames in which they are drawn. Onion-skinning is very useful for 
drawing frame-by-frame animations because it gives you reference points for the stroke 
positions. 

Use the Onion Skinning options in the Vector Paint Preferences dialog box to specify how 
previous and forward strokes appear when Onion Skin is the active Playback Mode. (To 
open Vector Paint Preferences, use the Vector Paint options menu and choose Options.) 
These options include:

• Frames Backward/ Frames Forward. Sets the number of frames backward or forward 
that are displayed. Both backward and forward frames are displayed unless one or both 
of these values is set to 0.
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• Color Backward/Color Forward. Sets the color of the display of backward and forward 
strokes.

• Skin Opacity. Sets the percentage of opacity for onion-skin strokes.

Drawing a three-frame animation in Onion Skin Playback Mode: As you draw on successive frames, 
the strokes you drew on previous (or forward) frames also appear for your reference.

Playback Speed control for the Vector Paint effect (Pro only)
The Playback Speed value in the Effect Controls window can change the timing at which 
painted strokes appear in previews and rendered compositions. Playback Speed affects 
the Vector Paint strokes only when you set the Playback Mode to Past Strokes, Hold 
Strokes, or Animate Strokes.

When you create strokes on a layer, the stroke is tied to the location of the current-time 
indicator in the Timeline when you start drawing. Vector Paint also records the amount of 
time you take to draw the stroke. For example, you might start painting a stroke with the 
current-time indicator set to 0:00 and use 1.5 seconds to draw the stroke. Then, you might 
move the current-time indicator to 2:00 and draw a second stroke (leaving 0.5 seconds 
between the completion of the first stroke and the beginning of the second one). For this 
example, let’s say you use 1.0 second to draw the second stroke. The entire process covers 
3.0 seconds on the timeline.

By changing the playback speed, you can change the timing for stroke appearances in 
previews and rendered compositions.

To adjust the playback speed:

1  In the Effect Controls window under Vector Paint, make sure that the Playback Mode 
option is one of the following: Past Strokes, Hold Strokes, or Animate Strokes.

2  In the Effect Controls window, click the underlined Playback Speed value and type a 
new value, using a number between 0 and 100.

You can also change the playback speed by dragging the value itself or the slider below it: 
left to decrease the speed, right to increase it.

For animations, always begin painting strokes at the layer In point, especially when 
adjusting the Playback Speed. Doing this locks the In point (first stroke’s start time) to 

the In point of the layer, making it easier to locate the beginning of the animation. Then, 
simply place the layer’s In point where you want the animation to begin in the compo-
sition.

The results that your changes produce depend on the Playback Mode setting that you 
select in the Effect Controls window:
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Animate Strokes With the Playback Speed at 1.0, each stroke appears as if drawn by an 
unseen hand, taking the same amount of time as you used to create it. When you increase 
the Playback Speed value, you reduce the time it takes to draw each stroke and the gaps 
between strokes. If you decrease Playback Speed, both the time taken to draw the strokes 
and the length of the gaps between strokes increases.

Using the example described above in this topic, if you increase the Playback Speed value 
to 2.0 (double the speed), the first stroke would be drawn in 0.75 seconds, the gap 
between the two strokes would be shortened to 0.25 seconds, and the second stroke 
would be drawn in 0.5 seconds. The entire animation would be complete after 1.5 seconds 
of playback.

Past Strokes At Playback Speed 1.0, each stroke appears in completed form at the frame 
in which you started drawing and remains visible for the duration of the layer playtime. 
When you increase Playback Speed, each stroke appears at an earlier point in time. If you 
decrease Playback Speed, strokes occur at later points in time.

Hold Strokes Like Past Strokes mode, each stroke appears in completed form at the 
frame in which it was drawn. The difference between this and Past Strokes mode is that in 
Hold Strokes mode, each stroke disappears when the next stroke appears (without any 
gap between the disappearance of the first stroke and the appearance of the second). 
Otherwise, the results of changing Playback Speed are similar to those in Past Strokes 
mode.

Using the Re-timer (Pro only)
The results you get from either using the Re-timer or changing the Playback Speed value 
are similar, but there are several important differences:

• You apply the Re-timer to individual strokes you select before choosing the Re-timer 
option. In comparison, changes in Playback Speed apply to all paint strokes on the 
layer.

• The Re-timer affects only playbacks that use Animate Strokes mode. Playback Speed 
changes can also influence Hold Strokes and Past Strokes modes.

• The Re-timer does not affect the start times of strokes. Changing the Re-timer value 
shortens or lengthens the amount of time previews and rendered versions take to draw 
the stroke. The strokes begin to appear at the same points in time as before, but they 
are drawn more quickly or more slowly.

• The values for Re-timer are percentages of the original time required to draw the stroke. 
The default value is 100%. A higher value causes the drawing time to increase, so that a 
setting of 200% uses twice the time to draw the selected strokes. A lower value draws 
the selected strokes more quickly.

To change playback time with the Re-timer:

1  Using the Vector Paint Selection tool , click or drag to select the strokes.

2  Open the Vector Paint options menu, and choose Re-timer.

3  In the Set Value dialog box, type a value for Relative Duration (%), and click OK.

Note: You cannot use the Undo command to reverse the Re-timer after you apply it. 
However, you can apply the Re-timer again, using the inverse of the value you typed previ-
ously to revert to the original value. For example, if you changed the Re-timer value to 
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200% and then wanted to go back to the earlier setting, choose Re-timer again and type a 
value of 50%.

Painting with Shift-Paint Records (Pro only) 
Ordinarily, when you draw strokes with Vector Paint, those strokes are associated with the 
position of the current-time indicator. After you draw a stroke, you can draw more strokes 
at the same time setting or at different time settings. The results you see when you 
preview or render the composition depend on your Playback Mode setting. The Shift-Paint 
Records controls change the way that strokes associate with time settings. This is called 
QuickPaint mode. One of the advantages of this feature is that you can create fast 
continuous recordings of a sequence of strokes without redraw delays after each one. 

To paint using QuickPaint mode:

1  Choose the Shift-Paint Records control you want before you paint the strokes. These 
controls are available only on the Shift-Paint Records submenu of the Vector Paint options 
menu.

Note: You cannot apply a Shift-Paint Records option to strokes you have already created.

2  Press Shift as you paint. Otherwise, the Shift-Paint Records options will not apply to 
those strokes.

When you draw, the Info palette displays the name of the selected control: Current Frame, 
Sequential Frames, Realtime, or Continuously. 

Controls for Shift-Paint Records
Adjust the following controls for the Vector Paint effect

To Current Frame Specifies all strokes to start at the current frame (the current-time 
indicator position when you draw the strokes). This is similar to ordinary painting mode 
except that Shift-Paint Records has no redraw delays.

To Sequential Frames Specifies that all stroke start times are offset by one frame. The 
next frame is calculated according to the composition frame rate at the time of drawing.

For example, if the current-time indicator is at 0:00 when you draw three strokes, then the 
start point is 0:00 for the first stroke, 00:01 for the second stroke, and 00:02 for the third 
stroke.

In Realtime Specifies that stroke start times are determined by how they are drawn. The 
strokes are recorded and played back in real time even if you lift the brush while drawing. 
Strokes play back exactly as they were recorded, including any time that elapsed (gaps) 
between the creation of the strokes (provided that you continued to hold down Shift 
during the time gap).

Continuously Specifies that stroke start times follow one another, without any gaps. 
When one stroke is finished drawing, the next one begins immediately. Otherwise, this is 
similar to the In Realtime option.

Wiggle Controls for the Vector Paint effect (Pro only)
Adjust the following Wiggle controls for the Vector Paint effect:

Enable Wiggling When Enable Wiggling is selected, all strokes on that layer are set to 
wiggle using the Wiggle Control values set in the Effect Controls window.
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Wiggles/sec Determines the number of Wiggles per second of Composition time. 
Wiggling is spline-based morphing of paint strokes. Wiggles/sec controls the speed at 
which the morph completely shifts shape. For example, in a 30-fps composition, setting 
the Wiggle/sec value to 30 creates one wiggle per frame. Lower values result in a smooth 
animation of morphing strokes. Higher values create more rapid wiggling.

Displacement Variation Determines how far the stroke moves from its original position 
while wiggling. The greater the value, the greater the deviation in shape.

No Displacement Variation (left), Medium Displacement Variation (center), and High Displacement 
Variation (right)

Displacement Detail Determines how much the original shape of the path is altered 
while wiggling. Greater values increase the detail of displacement (or change in shape) in 
the stroke. Lower values produce less displacement, leaving the path closer to its original 
shape.

When Displacement Detail values are set very high, the stroke may not resemble its 
original shape at all. This is useful in creating randomly animated strokes.

Low Displacement Detail (left), Medium Displacement Detail (center), and High Displacement Detail 
(right)

Set the Displacement Detail value by using the slider in the Effect Controls window (preset 
to values between 0 and 100) or by clicking the underlined Displacement Detail value and 
typing a number between 0 and 1000.
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Pressure Variation Determines how much the Radius and Opacity values of the stroke 
vary while wiggling. For strokes that have Stylus Radius enabled, the Radius wiggles. For 
strokes that have Stylus Opacity enabled, the Opacity wiggles. The amount of variation in 
either the Radius or Opacity value while wiggling depends on the value specified for 
Pressure Variation. The Radius and Opacity settings in the Brush Settings act as maximum 
amounts, not to be exceeded while wiggling.

Note: Strokes that do not have either Stylus Radius or Stylus Opacity options selected are 
not affected by the Wiggle Pressure Settings. However, these options can be enabled even 
when a tablet is not installed.

No Pressure Variation (left), Low Pressure Variation (center), and High Pressure Variation (right)

In the Effect Controls window, set the Pressure Variation value by clicking the underlined 
Pressure Variation value and typing a number between -30,000 and 30,000, or by dragging 
the Pressure Variation slider.

Pressure Detail Determines how tight the pressure variation appears along the stroke. 
Higher values create more dense variations.

Low Pressure Detail (left), Medium Pressure Detail (center), and High Pressure Detail (right)

Individual Stroke Seeds When selected, this option creates a different random wiggle 
seed for each stroke on a layer.

Because the Wiggle Controls apply to all strokes on a layer, the wiggle parameters are 
always the same. To randomize the wiggling of the individual strokes, select the Individual 
Stroke Seeds option.
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If Individual Stroke Seeds is not selected, all strokes use the same wiggle seed, so they all 
have the same spatial wiggle values. For example, two strokes exactly on top of each other 
will wiggle equally. By setting individual seeds for each stroke, you avoid identical strokes 
wiggling in the same way.

Original (left), Individual Stroke Seeds Off (center), and Individual Stroke Seeds On (right)

Selecting Composite Paint options (Pro only)
Various options control the way Vector Paint composites strokes on a layer. Select the 
option you want in the Effect Controls window for a layer, in the Composite Paint pop-up 
menu under Vector Paint. These options control two things: what you see in the Compo-
sition window as you work, and what aspects of the layer the strokes affect, including 
what happens when you preview and render the composition.

As you paint and erase, you can either hide or display the footage image. You have similar 
viewing options when you paint using matte and alpha-channel options.

As you work, painting and erasing can block pixels in an original image, such as a footage 
file or solid. You can also paint on a virtual layer above or below that image (although this 
does not appear as a separate layer in the Timeline window). You can paint and erase to 
adjust mattes and alpha channels for the original image. You can restrict Vector Paint 
strokes to the areas inside or outside the original alpha channel.

Each Composite Paint option specifies a unique combination of work view, layer type 
(image, matte, or alpha channel), and placement of strokes relative to the original image. 
You can select strokes later and change the Composite Paint option, but it is a good idea 
to understand what results each option produces before you start painting.
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The following illustrations use the same basic example of an imported image. A paint 
stroke has been applied, followed by an erasure stroke. The original image is the green 
layer, including an alpha channel that reveals the background layer. For these examples, 
the Transparency Grid is turned on. (Click the Transparency Grid button  at the bottom of 
the Composition window).

A. In Original (default setting), before painting The imported image is visible.

B. In Original, with paint stroke The paint strokes appear above the original image.

C. In Original, with paint stroke and erasure stroke An erasure stroke removes under-
lying portions of both the paint stroke and the original image.

D. Only The original image on the layer does not appear in the working view; only paint 
strokes are shown. Erasures remove only paint, not the original image.

E. Over Original The original image is visible in the working view, similar to the In 
Original option. Painting and erasing occur as with the Only option: Erasing removes 
pixels from underlying paint strokes but does not alter the original image.

F. Under Original The layer image is visible in the working view. Painting does not alter 
the original image; it affects only areas of the layer that are outside the original image. 
Erasures remove only paint pixels, not the original image.

G. Track Original Matte The original image is not visible in the working view. Paint 
strokes are visible. Painting affects only the area within the original image alpha channel 
(that is, paint applied within the original circle area). Erasures remove only existing paint 
pixels.

H. Track Original Matte Visible The original image is visible in the working view. 
Otherwise, Vector Paint strokes behave exactly as with Track Original Matte, so erasures do 
not affect the original image.

I. As Matte Before you paint, nothing is visible in working view. Paint strokes affect only 
the matte, revealing the underlying original image. Erasures add back areas of opacity, so 
that they appear to erase the underlying image again. Both types of strokes are restricted 
to the area of the original alpha channel.

A B C D

E F G H

I J K L
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J. As Inverse Matte Before you paint, the original image is visible in the working view. 
Painting affects only areas within the original image alpha channel. Paint strokes block 
(rather than reveal) the original image, appearing to erase the original image. Erasures 
remove only painting strokes, (that is, they re-reveal the underlying image within the 
alpha channel).

K. In Original Alpha Only The original image appears within its alpha channel in 
working view. Strokes affect the alpha channel itself. Painting adds areas of opacity. 
Erasures add areas of transparency.

Note: You do not need to switch colors when you paint in the alpha channel, even if you 
paint with gray. The changes to the opacity of the painted area are determined by the 
values shown for Opacity and Feather under Brush Settings in the Effect Controls window, 
not by the color of paint.

L. Under Original Alpha Only The original image appears within its alpha channel in 
working view. Strokes do not affect the original image alpha channel, only areas outside of 
it. Painting adds areas of opacity; erasing restores transparency to painted areas only.

Note: The difference between using Under Original and Under Original Alpha Only is that 
in the latter, strokes affect only the alpha channel; RGB is unchanged.

Selecting viewing options (Pro only)
Use the Vector Paint Preferences dialog box to customize the way you view your work in 
Vector Paint.Unlike most other effects, the options you select as Vector Paint preferences 
apply to all your Vector Paint work, both on the current layer and on other layers. Your 
current preferences are also used for subsequent sessions of Vector Paint.

To select Vector Paint Preference options:

1  Select Vector Paint in the Effect Controls window and open the Vector Paint Preferences 
dialog box in any of the following ways:

• Click the menu button  in the Vector Paint toolbar in the Composition window, and 
choose Options.

• Right-click (Windows) or Control-click (Mac OS) anywhere in the Composition window, 
and choose Options.

• In the Effect Controls window, click the word Options next to the name Vector Paint. 

2  Choose the appropriate options. 

Note: Better Preview While Drawing is temporarily disabled in low-memory situations, 
and Draft quality is used instead. Also, if your preview doesn’t drawing correctly, you may 
have an incompatible graphics card.
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Perspective effects

Basic 3D
If you are working on a project that was created in an older version of After Effects and the 
Basic 3D effect is applied to one or more layers, you can continue to use the Basic 3D 
effect; otherwise, use the 3D layer option instead. 

A text layer (left) is manipulated to create the illusion of perspective (center and right).

The Basic 3D effect manipulates a layer in an imaginary 3D space. You can rotate your 
image around horizontal and vertical axes and move it toward or away from you. With 
Basic 3D, you can also create a specular highlight to give the appearance of light reflecting 
off a rotated surface. The light source for the specular highlight is always above, behind, 
and to the left of the viewer. Because the light comes from above, the image must be tilted 
backward to see this reflection. This can enhance the realism of the 3D appearance. The 
specular highlight can be viewed only at Best quality. 

Note: You can use the 3D layer features instead of this effect to create 3D effects.

The layer’s quality setting affects Basic 3D. Draft quality calculates pixel location to the 
nearest integer value; Best quality calculates pixel location to the subpixel level.

Basic 3D controls
Adjust the following controls for the Basic 3D effect:

Swivel Controls horizontal rotation (rotation around a vertical axis). You can rotate past 
90˚ to see the back side of the image, which is the mirror image of the front.

Tilt Controls vertical rotation (rotation around a horizontal axis).

Distance to Image Specifies the image’s distance from the viewer. As the distance gets 
larger, the rotated image recedes.

Specular Highlight Adds a glint of light that reflects off the surface of the rotated layer, 
as if an overhead light were shining on the surface. In Preview mode, the specular 
highlight is indicated by a red + if it is not visible on the layer (that is, if the center of the 
highlight does not intersect the layer) and a green + if the highlight is visible.
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Preview Draws a wireframe outline of the 3D image. Because manipulating an image in 
3D space can be time-consuming, the wireframe renders quickly so you can manipulate 
the controls to get the rotation you want. Deselect the Preview control when you finish 
manipulating the wireframe image to see your final results. As a safety precaution, the 
preview wireframe is drawn only at Draft quality; when you switch to Best quality, the 
image content is drawn. This way, you won’t accidentally render a Best quality movie in 
Preview mode.

Bevel Alpha
The Bevel Alpha effect gives a chiseled and lighted appearance to the alpha boundaries of 
an image, often giving 2D elements a 3D appearance. (If the layer’s alpha channel is 
completely opaque, the effect is applied to the bounding box of the layer.) The edge 
created in this effect is somewhat softer than that of the Bevel Edges effect. This effect 
works especially well for elements with text in the alpha channel.

Original (left) and with Bevel Alpha applied to alpha edges, giving the 2D layer the appearance of 
substance (center and right) 

Bevel Edges
The Bevel Edges effect gives a chiseled and lighted 3D appearance to the edges of an 
image. Edge locations are determined by the alpha channel of the source image. Unlike 
Bevel Alpha, the edges created in this effect are always rectangular, so images with 
nonrectangular alpha channels do not produce the proper appearance. All edges have the 
same thickness. Best quality calculates the thickness of the chiseled area; the edge 
thickness is interpolated with smooth visual results.

Original (left), with moderate bevel settings to create framing effect (center), and with high bevel 
settings to create spatial effect (right)



Using Help | Contents | Index Back 140  

Adobe After Effects Help Perspective effects 

Using Help | Contents | Index Back 140  

Drop Shadow
The Drop Shadow effect adds a shadow that appears behind the layer. The shape of the 
shadow is determined by the layer’s alpha channel. Drop Shadow can create a shadow 
outside the bounds of the layer; however, memory requirements for this effect grow as the 
distance setting increases. The layer’s quality setting affects the subpixel positioning of the 
shadow and the smoothness of the shadow’s soft edges. It works well with 32-bit footage 
files from 3D rendering programs and drawing programs that support the alpha channel. 
If you want to render the shadow without the image, select Shadow only.

Note: To apply a drop shadow to a layer that rotates, rotate the layer using the Transform 
effect and then apply the Drop Shadow effect. You can also use nesting, precomposing, or 
an adjustment layer to achieve this effect. If you do not use one of these methods, the 
shadow rotates with the layer.

Original (left) and with variations of Drop Shadow applied (center and right)

Radial Shadow
The Radial Shadow effect creates a shadow from a point light source over the layer it’s 
applied to, rather than from an infinite light source (as with the Drop Shadow effect). The 
shadow is cast from the alpha channel of the source layer, allowing the color of that layer 
to influence the color of the shadow as light passes through semi-transparent areas. You 
can use this effect to make a 3D layer appear to cast a shadow onto a 2D layer.

Original (left) and with Radial Shadow casting semi-transparent lights or shadows using the layer’s 
alpha channel options (center and right)

Radial Shadow controls
Adjust the following controls for the Radial Shadow effect:

Shadow Color Specifies the color of the shadow.

Note: The color(s) of the layer may override this option if you choose the Glass Edges 
option from the Render control. See the Render and Color Influence controls for more 
information.

Opacity Specifies the transparency of the shadow.
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Light Source Specifies the point from which light is cast over the layer to create the 
shadow. 

Copy and paste position keyframes from another effect’s control point (for example, 
Lens Flare) to quickly create a shadow that matches another effect’s light source.

Projection Distance Specifies the distance of the surface on which the shadow falls from 
the layer and the light source. This value affects the size of the shadow. By default, the 
distance between the light source and the layer remains fixed. So, use the Projection 
Distance control to move the background closer or farther away from the light source and 
the layer, thereby making the shadow smaller or larger respectively. 

Softness Specifies the softness or sharpness of the shadow’s edges. 

Render Specifies the type of shadow the effect creates. Regular creates a shadow based 
on the Shadow Color and Opacity values, regardless of semi-transparent pixels in the 
original layer. (If Regular is chosen, the Color Influence control is disabled.) Glass Edge 
creates a colored shadow based on the color and opacity of the original layer. If there are 
semi-transparent pixels in the source layer, the shadow uses both the color and trans-
parency of the original layer. This creates the appearance, for example, of sun shining 
through stained glass. The more transparent the pixels in the original layer are, the closer 
the shadow color matches the colors of the original layer. The Shadow Color value more 
influences the less transparent areas of the original layer. If there are no semi-transparent 
pixels in the source layer, Glass Edge has little effect on the layer.

Note: Anti-aliased edges produce colors in a shadow edge when you choose Glass Edge, 
even if the original layer is fully opaque. The layer’s original colors shine through these 
anti-aliased edges, while the Shadow Color fills the center of the shadow.

Color Influence Specifies the amount of the source layer’s color values that appear in the 
shadow. At a value of 100%, the shadow takes on the color of any semi-transparent pixels 
in the layer. If this layer contains no semi-transparent pixels, Color Influence has little or no 
effect, and the Shadow Color value determines the shadow’s color. Decreasing the Color 
Influence value blends the colors of the original layer in the shadow with the color chosen 
for the Shadow Color. Increasing Color Influence reduces the influence of the Shadow 
Color.

Animate Color Influence to reduce or increase the blending of the original layer’s colors 
with the Shadow Color over time.

Shadow Only Specifies whether the original layer is visible. If this box is checked, the 
original layer appears over the shadow. If this box is not checked, only the shadow 
appears.

Resize Layer Specifies whether or not the effect considers the original layer’s bounding 
box as the edge of the layer. If the box is checked, the shadow can extend beyond the layer 
boundaries. If the box is not checked, any area of the shadow falling outside the original 
layer’s bounding box is cropped by the layer’s original boundaries. This option is not useful 
for shadows that fall outside the composition boundaries.
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Render effects

4-Color Gradient
The 4-Color Gradient effect produces a four-color gradient. Each color is controlled by one 
of four individual effect points, which can be animated. Use 4-Color Gradient to create 
color backgrounds, mix color palettes, and generate color gradients.

Adjust the following controls for 4-Color Gradient:

Points Adjusts the positioning of each color within the four-color gradient, based on x, y 
coordinate values.

Original (left) and with two variations of 4-Color Gradient applied (center and right)

Colors Specifies the RGB color values for each of the four points. Color 1 sets the color of 
Point 1, Color 2 sets the color of Point 2, and so on.

Blend Specifies the blending of the gradient. The gradient is actually composed of four 
circles, each blending with one another as the result of a calculation between one circle’s 
radius and that of the other surrounding circles. The amount of blending depends on the 
location of the effect points.

Jitter Specifies the amount of “jitter” (noise) in the gradient when blending is applied. 
Jitter uses a controlled noise type to change pixel values in the gradient, in order to reduce 
banding. The jitter noise affects only those areas where banding could occur.

Opacity Specifies the transparency of the gradient. The lower the value, the more trans-
parent the gradient. The original source layer’s opacity value represents 100% opacity in 
the effect. 

Blending Mode Specifies how the gradient colors interact with the original layer colors. 
These Blending Modes are identical to the ones in the Timeline Modes panel.

Advanced Lightning (Pro only)
The Advanced Lightning effect creates simulations of electrical discharges. Unlike the 
Lightning effect, Advanced Lightning doesn't self-animate and includes the Alpha 
Obstacle feature, which lets you move the lightning around designated objects in the 
frame. Use Advanced Lightning when you want more control over the lightning than is 
available using the Lightning effect.
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Controls for the Advanced Lightning effect
Adjust the following controls for Advanced Lightning:

Conductivity State Changes the path of the lightning. One unit equals a complete shift 
in the lightning’s shape. 

Core Settings These controls adjust various characteristics of the lightning’s core.

Glow Settings These controls adjust the lightning’s glow.

Note: To disable the glow, set Glow Opacity to 0. This setting can speed up rendering time 
significantly. 

Alpha Obstacle Specifies the influence of the original layer's alpha channel on the path 
of the lightning. The lightning attempts to wrap itself around opaque areas of the layer's 
alpha channel, seeing them as an “obstacle.” 

Note: If Alpha Obstacles is set to a value other than 0, it's not always possible to preview 
the correct result in less than full resolution; full resolution may reveal new obstacles. Be 
sure to check the result in full resolution before final rendering.

Original (left), with breaking lightning type (center), and with bouncy lightning type (right)

Turbulence Specifies the amount of turbulence in the lightning path. Higher values 
result in a more complex strike containing more branches and forks, and lower values 
produce simpler strikes with fewer branches.

Forking Specifies what percentage of a branch is forked. Its value is influenced by Turbu-
lence and Alpha Obstacle settings.

Decay Specifies the amount of continuous decay or dissipation of the lightning strength 
and influences where the opacity of the forks begins to fade.

Decay Main Core Decays the main core along with its forks.

Add to Original Composites the lightning with the original layer using the Add blending 
mode. When deselected, only the lightning is visible.

Type, Origin, and Direction See “Type, Origin, and Direction controls for the Advanced 
Lightning effect” on page 143

Expert Settings See “Expert Settings controls for the Advanced Lightning effect” on 
page 144

Type, Origin, and Direction controls for the Advanced Lightning 
effect
Adjust the following type, origin, and direction controls for Advanced Lightning:
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Lightning Type Specifies the characteristics of the lightning. 

Note: The type determines the nature of the Direction/Outer Radius contextual control. 
(See Direction/Outer Radius control description for more information.) 

Note: In the Breaking type, the branches are focused toward the Direction point as the 
distance between Origin and Direction increases.

Origin Specifies the point of origin for the lightning. 

Direction, Outer Radius This control changes depending on the Lightning Type:

• Not in Use is available only when Vertical isn’t selected. 

• Direction specifies the direction that the lightning will travel. It is enabled when any of 
the following lightning types are selected: Direction, Strike, Breaking, Bouncy, and Two-
Way Strike.

• Outer Radius specifies the distance that the lightning travels from its origin. It is 
enabled when Omni or Anywhere is selected as the lightning type. Use this control to 
terminate the lightning at a defined distance from the origin.

Expert Settings controls for the Advanced Lightning effect
Advanced Lightning includes several options for more detailed control of the lightning 
strike. Adjust the following controls:

Complexity Specifies the complexity of the turbulence in the lightning.

Min. Fork distance Specifies the minimum pixel distance between new forks. Lower 
values create more forks in the lightning. Higher values result in fewer forks. 

Termination Threshold Specifies the level at which a path terminates, based on resis-
tance in the atmosphere and possible alpha collision. At lower values, the path terminates 
more easily when encountering resistance or alpha obstacles. At higher values, the path 
more persistently moves around alpha obstacles.

Note: Increasing Turbulence or Complexity values causes resistance to increase in some 
areas. These areas change as conductivity changes. Increasing the Alpha Obstacle value 
causes resistance to increase at alpha edges.

Main Core Collision Only Calculates collisions only on the main core. The forks are not 
affected. This control is relevant only when you select Alpha Obstacle.

Fractal Type Specifies the type of fractal turbulence used to create the lightning. The 
results appear as pictured below:

Core Drain Specifies the percentage by which the core strength is drained when creating 
a new fork. Increasing this value reduces the opacity of the core where new forks appear. 
Because forks draw their strength from the main core, decreasing this value reduces the 
opacity of the forks as well.

Fork Strength Specifies the opacity of the new fork. This amount is measured as a 
percentage of the Core Drain value.

Fork Variation Specifies the amount of variation in the opacity of the fork and deter-
mines how much the fork opacity will deviate from the amount set for Fork Strength.
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Audio Spectrum
The Audio Spectrum effect displays the spectrum of an audio layer. It displays the 
magnitude of frequencies in the range you define using Start Frequency and End 
Frequency. This effect can display the audio spectrum in a number of different ways, 
including along a Bezier path of a layer. Apply the effect to a layer that contains a solid or 
an image, and that may contain audio. 

Audio is applied to an image layer using display options of analog dots (center) and digital with a 
Polar path (right).

Note: This effect is a visual effect, not an audio effect, and it must be applied to a video 
layer. 

Audio Spectrum controls
Adjust the following controls for the Audio Spectrum effect: 

Audio Layer Specifies the audio layer you want to display as a spectrum. 

Note: Audio Spectrum uses the audio source footage without time-remapping, effects, 
stretch, or levels. To graph this information, pre-compose the audio layer before applying 
the effect. 

Start Point, End Point Specifies the position at which the spectrum starts or ends if Path 
is set to None.

Path The audio spectrum is displayed along the path of the layer, unless None is chosen.

Use Polar Path Specifies the path to start from a single point and displays as a radial 
graph.

Start Frequency, End Frequency Specify the first and last frequency, in hertz, of the 
range of frequencies being displayed.

Frequency Bands  Specifies the number of frequencies displayed.

Maximum Height Specifies the maximum height, in pixels, of a displayed frequency.

Audio Duration Specifies the duration of audio, in milliseconds, used to calculate the 
spectrum.

Audio Offset Specifies the time offset in milliseconds used to retrieve the audio.

Thickness Specifies the thickness of the bands.

Softness Specifies how feathered or blurry the bands appear.

Inside Color, Outside Color Specifies the inside and outside colors of the bands.

Blend Overlapping Colors Specifies that overlapping spectrums are blended.

Hue Interpolation If value is greater than 0, the frequencies displayed rotate through the 
hue color space.
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Dynamic Hue Phase When selected, and the Hue Interpolation is greater than 0, the 
Start color shifts to the maximum frequency in the range of displayed frequencies. This 
allows the hue to follow the fundamental frequency of the spectrum displayed as it 
changes.

Color Symmetry When selected, and the Hue Interpolation is greater than 0, the start 
and end colors are the same. This allows color continuity on closed paths.

Display Options Specifies whether to display frequency as Digital, Analog Lines, or 
Analog Dots. 

Side Options Specifies whether to display the spectrum above the path (Side A), below 
the path (Side B), or both (Side A and B).

Duration Averaging Specifies that audio frequencies are averaged to reduce 
randomness. 

Composite on Original  When selected, displays the original layer with the effect.

Audio Waveform
The Audio Waveform effect displays the waveform amplitude of an audio layer. You can 
display the audio waveform in a number of different ways, including along a Bezier path 
created by an open or closed mask of a layer. Apply the effect to a layer that contains a 
solid or an image, and that may contain audio. 

Displaying audio waveforms as analog lines (center) and analog dots (rights).

Note: This effect is a visual effect, not an audio effect, and it must be applied to a video 
layer. 

Audio Waveform controls
Adjust the following controls for the Audio Waveform effect:

Audio Layer Specifies the audio layer you want to display as a waveform. 

Note: Audio Spectrum uses the audio source footage without time-remapping, effects, 
stretch, or levels. To graph this information, pre-compose the audio layer before applying 
the effect.

Start Point, End Point Specifies the position at which the waveform starts and ends, if 
Path is set to None.

Path If set to None, the audio waveform is displayed along the path of the layer.

Displayed Samples Specifies the number of samples to display in the waveform.

Maximum Height Specifies the maximum height, in pixels, of a displayed frequency.

Audio Duration Specifies the duration of audio, in milliseconds, used to calculate the 
waveform.
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Audio Offset Specifies the time offset in milliseconds used to retrieve the audio.

Thickness Specifies the thickness of the waveform.

Softness Specifies how feathered or blurry the waveform appears.

Random Seed (Analog) Specifies a starting point for randomizing the effect. Random 
Seed starts the randomizing at a different point, changing the appearance of the 
waveform.

Inside Color, Outside Color Specifies the inside and outside colors of the waveform.

Waveform Options Specifies how to display a stereo audio waveform. Mono combines 
the left and right channels of the audio layer. Non-stereo audio layers play as Mono.

Display Options Specifies how to display the audio waveform. Digital displays each 
sample as a single vertical line connecting the minimum and maximum source sample. 
This option simulates the display used on digital equipment. Analog Lines displays each 
sample as a line connecting the previous and next sample from either the minimum or 
maximum audio source sample. This option simulates the retrace seen in the display of an 
analog oscilloscope. Analog Dots displays each sample as a dot representing either the 
minimum or maximum audio source sample. 

Beam
The Beam effect animates the movement of a laser beam. You can make the laser shoot, or 
you can create a wand-like laser with stationary start and end points. This effect uses a 3D 
perspective based on the change in Starting Thickness and Ending Thickness. The beam 
looks best when motion blur is enabled and the shutter angle is set to 360.

Original (left) and with a simulated laser beam (right)

The Length control specifies the length of the beam based on a percent of the Time 
specified. For example, a setting of 100% means that the visible beam length is at its 
maximum when the Time control is 50%. Time specifies the time of the beam’s travel from 
start to end as a percent. The 3D Perspective control uses 3D perspective when animating 
Time.

Cell Pattern
The Cell Pattern effect generates cellular patterns based on cellular noise. Use it to create 
static or moving background textures and patterns. The patterns can be used in turn as 
textured mattes, as transition maps, or as a source for displacement maps.

Controls for the Cell Pattern effect
Adjust the following controls for the Cell Pattern effect:
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Cell Pattern Choose a pattern from the menu. “HQ” denotes patterns that render with 
more definition than their unmarked counterparts. Mixed Crystals is available only as a 
high-quality option. The patterns appear as pictured below:

The crystal cell pattern creates a displacement map (center) that is used with the Displacement Map 
effect (right).

Note: The Static Plates option is identical in appearance to the Plates option. However, 
when evolving, the static plates retain a uniform lightness value, while the plates shift the 
lightness of the cell pattern.

Invert Inverts the cell pattern. Black areas become white, and white areas become black.

Contrast/Sharpness Specifies the contrast of the cell pattern layer when you use the 
Bubbles, Crystal, Pillow, Mixed Crystals, or Tubular cell pattern. The control specifies 
sharpness for any of the Plate or Crystallize options.

Note: The layer’s contrast is affected by the option chosen in the Overflow menu.

Overflow Specifies the method used to remap values that fall outside the grayscale 
range of 0–255. Overflow is not available when sharpness-based cell patterns are chosen. 

• Clip specifies values above 255 as pure white, and values below 0 as pure black. 
Contrast amount controls how much of the image falls outside this range; higher 
contrast amounts result in a mostly black or white image, with less gray. Therefore, less 
subtle cellular detail appears at higher contrast settings. 

• Soft Clamp remaps grayscale values to fall inside the 0–255 range. As a result, contrast 
appears reduced; the cells are mostly gray with very few areas of pure black or white. 

• Wrap Back changes overflow values to the 0-255 range by “folding” values back in the 
other direction. For example, if the maximum value allowed is 255 and the actual value 
is 285 (255 + 30), the resulting value is 225 (255 - 30). As a result, more defined subtle 
detail appears when Contrast is set above 100. 

Disperse Specifies how randomly the pattern is drawn, thus affecting the angle of the 
cells relative to each other. Lower values result in more uniform or grid-like cell patterns.

Note: If you set the Disperse value above 1.0, set the layer to Best quality to avoid artifacts.

Size Specifies the size of the cell shapes. The default size is 60.

Offset Specifies the portion of the cell pattern visible in the Composition window. This 
control is useful when animating the cell pattern across the composition frame.

Tiling Options Choose one of the following options to control tiling:

• Enable Tiling renders the cell patterns in seamless tiles. The shape and number of tiles 
are determined by the Cells Horizontal and Cells Vertical values.
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• Cells Horizontal and Cells Vertical specify the number of horizontal or vertical cells on a 
tile.

Note: To determine the size of your tiles, use the following calculations: tile width=Cells 
Horizontal x Size; tile height=Cells Vertical x Size. For example, to create a tile size of 
256x256 pixels, set Size, Cells Horizontal, and Cells Vertical to 16.

Evolution, Evolution Options  See “Evolution and Evolutions Options controls for the Cell 
Pattern effect” on page 149.

Evolution and Evolutions Options controls for the Cell Pattern 
effect
Adjust the following controls for the Cell Pattern effect:

Evolution Creates subtle changes in the shape of the cell pattern. Animating this control 
results in smooth changes of cell shapes over time. Set keyframes for Evolution to 
determine how much the cell shapes “evolve” over the period of time allowed between 
keyframes. The more revolutions in a given amount of time, the more rapidly the cell 
shape changes. Higher Evolution values may result in less smooth changes in the cell 
shapes.

Note: Although the Evolution value is set in units called “revolutions,” it is important to 
realize that these revolutions are progressive. The Evolution state continues to progress 
infinitely at each new value. Use Cycle Evolution (under Evolution Options) to return the 
Evolution setting to its original state at each revolution.

Evolution Options Because of the complexity of the cell shapes that generate the cell 
patterns, render time can be great. For this reason, Evolution Options provide controls that 
render the effect for one short cycle and loop it for the duration of your project. Use the 
controls below to create a smooth, progressive loop segment.

• Cycle Evolution creates a loop that forces the evolution state to return to its starting 
point.

• Cycle is available if Cycle Evolution is selected. Cycle specifies the number of revolutions 
(of the Evolution setting) that the cell pattern cycles through before it repeats. For 
example, if you set the evolution to occur over five revolutions and you set the Cycle 
value to 2, the evolution loops twice. The timing or speed of these Evolution cycles is 
determined by the amount of time allowed between Evolution keyframes.

Note: The Cycle control affects only the state of the cell pattern, not geometrics or other 
controls. For example, two identical states of the cell pattern don’t appear the same if 
viewed with different Size or Offset settings.

• Random Seed specifies a unique random value from which to generate the pattern. 
Animating this control results in flashing from one set of cell shapes to another of the 
same cell pattern type. For smooth transition of the cell pattern, use the Evolution 
control.

Note: Create new cell pattern animations by reusing previously created Evolution cycles 
and changing only the Random Seed value. Typing a new Random Seed value alters the 
cell pattern without disturbing the evolution animation.
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Checkerboard (formerly Checker)
The Checkerboard effect creates a checkerboard pattern. 

A matching color produces a subtle effect (center); using red with high Width and low Height 
settings (right) creates a striped effect.

Adjust the following controls for the Checkerboard effect:

Anchor Specifies the point of origin, or anchor point, of the Checkerboard pattern. 
Moving the anchor point offsets the pattern.

Size From  Specifies how the effect defines the size of the squares. Choose one of the 
following options from the menu:

• Corner Point specifies that the spatial relationship between the corner point and 
anchor point controls determines the checkerboard size.

• Width Slider specifies that the Width value determines the checkerboard pattern size 
and shape. The individual checkered shape remains square because the Width value 
determines both width and height of the checkers.

• Width & Height Sliders specifies that the Width and Height values determine the check-
erboard pattern size and shape. Choose this option to set the width and height of the 
checkered shapes independently.

Corner Specifies the spatial relationship between the corner point and the anchor point. 
The effect uses the position of these two points to define the size of the checkerboard 
pattern if you choose Corner Point in the Size From menu.

Width Specifies the horizontal width of the checkerboard pattern. If you choose Width 
Slider in the Size From menu, this value determines both the width and height of the 
checkerboard pattern. If you choose Width & Height Sliders in the Size From menu, this 
value determines the width only.

Height Determines the vertical height of the checkerboard squares when you choose 
Width & Height Sliders in the Size From menu.

Feather Specifies the size of the edge feather of the checkerboard pattern. Expand this 
control to reveal the Width and Height sliders. Set Width and Height values independently, 
or set them both to the same value for a uniform feather.

Color Specifies the color of one set of the checkerboard squares. The other set of squares 
is always transparent.

Opacity Specifies the transparency of the checkerboard pattern.

Blending Mode Specifies the blending mode the effect uses to create an interaction 
between the checkerboard pattern and the original layer. All of these blending modes 
work identically to the ones in the Timeline window, except the default None mode, which 
renders the checkerboard pattern only. 
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Circle
The Circle effect creates either a customizable solid circle or ring. 

Original image (left), circle with no edge (center), circle specifying a Thickness & Feather *Radius 
edge

Adjust the following controls for the Circle effect:

Center Specifies the center point of the circle. 

Radius Specifies the size of the radius, in pixels. (If you set the radius to be larger than 
your original source layer, either portions or all of the circle’s edge may fall outside the 
composition frame, depending upon the location of the circle’s center point.)

Edge Specifies the shape and edge treatment of the circle. Depending upon the option, 
the slider changes its name to correspond to the option. Choose one of the following 
options from the menu, and use the slider to adjust the option:

• None creates a solid circle.

• Edge Radius creates a ring. The difference in the values set for this control and Radius 
determines the ring’s width.

• Thickness creates a ring with a specified thickness. The corresponding slider measures 
the ring thickness in pixels.

• Thickness * Radius creates a ring that uses the Radius value to determine the Thickness 
value. As you increase the Radius value of the ring, the Thickness value increases 
proportionally.

• Thickness & Feather * Radius creates a ring that uses the Radius value to determine 
both the Thickness and Feather values. As you increase the Radius value, the Thickness 
and Feather values scale proportionally.

Feather Specifies the amount of feather applied to the edge of the circle. Increasing this 
amount softens the edges of the circle, blending it with whatever appears behind it. 
Decreasing this amount sharpens the edge of the circle. 

Note: Feather Inner Edge is disabled when Edge is set to None, since there is no inner edge 
on a solid circle.

Invert Circle Specifies that the circle matte is inverted, if this box is checked. 

Color Specifies the color that fills the circle.

Opacity Specifies the transparency of the circle. 

Blending Mode Specifies the blending mode that the effect uses to combine the circle 
and the original layer. All of these blending modes behave like those in the Timeline 
window, except for None, which displays only the circle, without the original layer.
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Ellipse
The Ellipse effect draws an ellipse based on the dimensions you specify in the Effect 
Controls window. In addition to width and height, you can specify the thickness, softness, 
and color of the ellipse. 

The Width and Height controls specify the width and height of the ellipse in pixels. Values 
range from 0 to 2000 pixels. Thickness specifies the thickness of the arc forming the 
ellipse. Values range from 0 to 1000 pixels. Softness specifies the softness or degree of blur 
of the ellipse’s arc.

Ellipse is applied to the background once (center) and then applied multiple times (right).

Eyedropper Fill (formerly Color Picker)
The Eyedropper Fill effect applies a sampled color to the source layer. This effect is useful 
for quickly picking a solid color from a sample point on the original layer or picking a color 
value from one layer and using blending modes to apply this color to a second layer. 

Original (left), and with two different color samples applied (center and right)

Adjust the following controls for the Eyedropper Fill effect:

Sample Point Specifies the sampled pixel colors.

Sample Radius Specifies the size of the sample area. 

Average Pixel Color  Specifies which color values the effect samples within the area 
defined by the sample point and sample radius. Skip Empty samples the average RGB 
color values, excluding those of transparent pixels. All samples the average of all RGB color 
values, including those of transparent pixels. All Premultiplied samples the average of all 
RGB color values, premultiplied with the alpha channel. Including Alpha samples the 
average of all RGB color and alpha channel values. This results in the sampled color also 
containing the average transparency of the sampled pixels.

Maintain Original Alpha When selected, the effect maintains the original layer’s alpha 
channel. If you choose Including Alpha in the Average Pixel Color menu, the original alpha 
is stenciled over the sampled color.

Blend with Original Specifies the amount of blending between the new solid color and 
the original layer.
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Fill
The Fill effect is used to fill a mask with a specified color. The Fill Mask menu displays the 
available masks. If you want to add both a stroke and a fill to a closed path, the order in 
which you apply the stroke and fill determines the visible width of the stroke. If the fill is 
applied before the stroke, the full stroke brush size is visible. If the stroke is applied before 
the fill, the fill appears on top of the stroke, obscuring the half of the stroke that falls inside 
the path. See “Scribble” on page 163.

An inverted mask (left) is filled with black (center); a mask of a spaceship is filled with black and 
feathered (right).

The Fill effect includes an All Masks option that fills all the layer’s closed mask paths with 
the chosen color. Activating this option also fills the mask path of a mask that has None 
chosen as its mode. To fill each layer mask, make sure that All Masks is selected in the 
Effect Controls window.

Fractal
The Fractal effect renders the Mandelbrot or Julia set, creating colorful textures. When you 
first apply the effect, the picture you see is the classic sample of the Mandelbrot set (the 
“set” is the area that is colored black). Any pixel outside the set is colorized, depending on 
how close it is to the set. Pixels near the border appear chaotic (noisy), but as you zoom in, 
a quite startling and beautiful structure is revealed. 

A Mandelbrot fractal with a Lightness Gradient palette (center), and a Julia fractal (right)

Controls for the Fractal effect
Adjust the following controls for the Fractal effect:

Set Choice Specifies the set used. Mandelbrot is the typical Mandelbrot set. Mandelbrot 
Inverse is the Mandelbrot set mathematically inverted. Julia always changes depending on 
the center point from the Mandelbrot set and can produce the set of all possible Julia sets. 
Julia Inverse is the inverse of the Julia set. To see a Julia set, you may want to set the magni-
fication to a negative value, because these sets tend to fill up the complex plane outside 
the normal boundary. Mandelbrot over Julia is the same as Mandelbrot, except that it does 
change when the Julia center point changes. Mandelbrot Inverse over Julia is the same as 
Mandelbrot Inverse, except that it does change when the Julia center point changes.
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Mandelbrot, Julia Specify the settings for the specified set. X (Real) and Y (Imaginary) 
specify the pixels at the center of the image for either the Mandelbrot or Julia set. Magnifi-
cation specifies the magnification of the effect. Escape Limit specifies how many times the 
calculation looks for a color for a given pixel before it assigns the color black. This is also 
the maximum number of line segments the arrow tool can use when tracing the path of a 
point. Higher numbers require longer render times. 

Color Specifies the color of the effect. 

• Overlay displays a ghosted version of the opposite set. For example, when viewing the 
Julia set, use this control to display a ghosted version of the Mandelbrot set. When you 
select Overlay, a white cross hair with a black drop shadow appears so you can see the 
exact point at the center of the opposite set. This control is useful because the Julia set 
depends on the center point of the Mandelbrot set.

• Transparency specifies whether black pixels are transparent. If you choose Solid Color 
from the Palette menu, this control specifies whether everything inside or outside the 
set is transparent.

• Palette specifies the palette to use when drawing the set. Lightness Gradient creates a 
gradient from black, through the hue specified by the Hue control to white. Then it 
applies the same gradient eight more times, each time using the hue 45˚ away on the 
color wheel. The number of colors in the gradient is specified by the Cycle Steps 
control. Hue Wheel uses all the color from the Hue color wheel, with maximum 
brightness and saturation. Black and White uses alternating bands of black and white. 
Solid Color turns everything transparent except the inside of the set, which uses the 
color specified by the Hue control. Select Transparent to get the opposite result. 

• Hue specifies the hue for solid colors and the starting hue for color gradients. This 
control works well for creating smooth color changes or for cycling through the palette. 
Cycle Steps specifies the number of bands of different color that appear before the 
cycle starts over. Cycle Offset specifies where, other than the beginning, a cycle starts.

• Edge Hilight highlights the edges between color bands. This control requires low-
quality mode. If you want to use high-quality edge highlighting, use the Find Edges 
effect instead.

High Quality Settings Specify the oversampling settings for the effect.

• Oversample Method specifies the method used to oversample the effect: Edge Detect-
Fast-May Miss Pixels performs a simple edge detection and oversamples only those 
pixels. This is the fastest option, especially in areas with a lot of solid color, such as black, 
and generally produces results indistinguishable from Brute Force. Brute Force-Slow-
Every Pixel oversamples every pixel in the image. It is slow but precise.

• Oversample specifies the amount of oversampling to perform. For example, a value of 4 
specifies that each pixel is sampled 16 times (4x4=16) and that the average color is 
used. Higher values produce better quality output but require longer render times.

Using tools with the Fractal effect
When the Fractal effect is selected in the Effect Controls window, you can use After Effects 
tools in the following way. (If you don’t want the Fractal tools active, deselect the effect 
before using tools.)

• Drag the arrow tool to see if a point’s path lies within the set. If the path leads out of the 
bounded rectangle (-2, -2, 2, 2), it has gone into infinity; in such a case, the starting-
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point color is based on how many line segments it takes to reach infinity. If the path 
ends within the rectangle, it is colored black. 

• Use the magnifying tool to zoom in or out on a particular point, or hold down Control 
(Windows) or Command (Mac OS), click and hold the magnifying tool over the center of 
the image, and navigate from the center. For example, to zoom straight in, stay in the 
center; to move up, drag up just a little and then quickly move back to the center.

• Use the hand tool to pan the image. Press Control (Windows) or Command (Mac OS) to 
pan the opposite fractal. For example, when viewing the Julia set, press Control 
(Windows) or Command (Mac OS) to pan the Mandelbrot set and see how the Julia set 
depends on the center point of the Mandelbrot set.

• Use the arrow keys to pan the center point by 1 pixel. Press Shift as you press an arrow 
key to adjust the point by 10 pixels. Press Control (Windows) or Command (Mac OS) as 
you press an arrow key to adjust the center point of the opposite set.

Grid
Use the Grid effect to create a customizable grid. Render this grid in a solid color or as a 
mask in the alpha channel of the source layer. This effect is good for generating design 
elements and mattes within which other effects can be applied. 

Original (left) and with variations of Grid applied (center and right)

Use Grid with the Advanced Lightning effect to create lightning forks that follow a 
grid pattern. 

Adjust the following controls for Grid:

Anchor Specifies the point of origin of the Grid, based on x, y coordinates.

Size From Specifies the grid size. Each option enables the corresponding effect controls.

• Corner Point determines the spatial relationship between the Corner point and Anchor 
point controls.

• Width Slider determines the value set for the Width control. The Grid cells will be 
square, as the Width value is used to determine both width and height of the Grid cells.

• Width & Height Sliders determines the values set for the Width and Height controls. Use 
this option to set the width and height of the Grid cells independently.

Corner Specifies the size of the grid cells, based on the spatial relationship between the 
Corner point and the Anchor point.

Width Specifies the horizontal width of the grid cells. If you choose Width Slider in the 
Size From menu, this value specifies both the width and height of the grid cells. If you 
choose Width & Height Sliders in the Size From menu, this value specifies the width only.
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Height Specifies the height of the Grid cells when you choose Width & Height Sliders in 
the Size From menu.

Border Specifies the border thickness of the grid. A Border value of 0 causes the grid to 
disappear.

Note: The anti-aliasing of the grid borders may cause the visible thickness to vary by one 
pixel.

Feather Specifies the softness of the grid. You can set Width and Height amounts individ-
ually, or set both to the same amount for a uniform feather on all edges. The maximum 
width value is 20 pixels; the maximum height value is 400 pixels.

Invert Grid Inverts the transparent and opaque areas of the grid. 

Color Specifies the RGB color values of the grid.

Opacity Specifies the opacity of the grid. 

Blending Mode Specifies how the grid interacts with the original layer. These blending 
modes are identical to those in the Timeline Modes panel.

Lens Flare (Pro only)
The Lens Flare effect simulates the refraction caused by shining a bright light into the 
camera lens. Specify a location for the center of the flare by clicking anywhere inside the 
image thumbnail or by dragging its crosshair. 

A single lens flare (center) and multiple lens flares (right)

Lightning
The Lightning effect creates lightning bolts and other electrical effects, including a “Jacob’s 
Ladder” effect (as seen in old horror movies) between two specified points in a layer. This 
effect is automatically animated without keyframes across the time range. Use The 
Wiggler to add randomness to the lightning bolt. 

Variations in thickness, color, and number of branches (center and right)

Segment and Branching controls for the Lightning effect
Adjust the following controls for the Lightning effect:
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Start Point, End Point Specify where the lightning begins and ends.

Segments Specifies the number of segments that form the main lightning bolt. Higher 
values produce more detail but reduce the smoothness of motion.

Amplitude Specifies the size of undulations in the lightning bolt as a percentage of the 
layer width.

Detail Level, Detail Amplitude Specify how much detail is added to the lightning bolt 
and any branches. For Detail Level, typical values are between 2 and 3. For Detail 
Amplitude, a typical value is 0.3. Higher values for either control are best for still images 
but tend to obscure animation.

Branching Specifies the amount of forking that appears at the ends of bolt segments. A 
value of 0 produces no branching; a value of 1.0 produces branching at every segment.

Rebranching Specifies the amount of branching from branches. Higher values produce 
tree-like lightning bolts.

Branch Angle Specifies the size of the angle between a branch and the main lightning 
bolt.

Branch Seg. Length Specifies the length of each branch segment as a fraction of the 
average length of the segments in the lightning bolt.

Branch Segments Specifies the maximum number of segments for each branch. To 
produce long branches, specify higher values for both the branch segment length and the 
branch segments. 

Branch Width  Specifies the average width of each branch as a fraction of the width of 
the lightning bolt.

Other controls for the Lightning effect
Adjust the following controls for the Lightning effect:

Speed Specifies how fast the lightning bolt undulates. 

Stability Determines how closely the lightning undulates along the line defined by the 
start and end points. Lower values keep the lightning bolt close to the line; higher values 
create significant bouncing. Use Stability with Pull Force to simulate a “Jacob’s Ladder” 
effect and cause the lightning bolt to snap back to a position along the start line after it 
has been pulled in the Pull Force direction. A Stability value that is too low does not allow 
the lightning to be stretched into an arc before it snaps back; a value that is too high lets 
the lightning bolt bounce around.

Fixed Endpoint Determines whether the end point of the lightning bolt remains fixed in 
place. If this control is not selected, the end of the bolt undulates around the end point. 

Width, Width Variation Specify the width of the main lightning bolt and how much the 
width of different segments can vary. Width changes are randomized. A value of 0 
produces no width changes; a value of 1 produces the maximum width changes.

Core Width Specifies the width of the inner glow, as specified by the Inside Color value. 
The Core Width is relative to the total width of the lightning bolt.
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Outside Color, Inside Color Specify the colors used for the lightning bolt’s outer and 
inner glows. Because the Lightning effect adds these colors on top of existing colors in the 
composition, primary colors often produce the best results. Bright colors often become 
much lighter, sometimes becoming white, depending on the brightness of colors 
beneath.

Pull Force, Pull Direction Specify the strength and direction of a force that pulls the 
lightning bolt. Use the Pull Force value with the Stability value to create a “Jacob’s Ladder” 
appearance.

Random Seed Specifies a starting point for randomizing the lightning effects you have 
specified. Because random movement of the lightning may interfere with another image 
or layer, typing another value for the Random Seed starts the randomizing at a different 
point, changing the movement of the lightning bolt.

Blending Mode Specifies how the lightning is added to the layer. These modes behave 
the same as layer blending modes. 

Rerun at Each Frame Controls the frame-by-frame generation of the lightning. Selecting 
this control regenerates the lightning at each frame. To make the lightning behave the 
same way at the same frame every time you run it, do not select this control. Selecting this 
control may increase rendering time.

Paint Bucket (formerly Basic Fill)
The Paint Bucket effect is a non-destructive paint tool that fills a selected area with a solid 
color. It works much like the paint bucket tool in Adobe Photoshop. Use Paint Bucket for 
colorizing cartoon-type outlined drawings or replacing selected areas of color in an 
image. 

Colors fill spiral-shaped alpha channels on separate layers (left and center); Paint Bucket is applied to 
the saucer with the Color blending mode (right).

Paint Bucket controls
Adjust the following controls for the Paint Bucket effect:

Note: Paint Bucket has minimal impact on a solid layer.

Fill Point Specifies the area of the image the effect fills with the new color. Depending 
upon where you place the effect point, the control samples between 1 and 4 pixels’ RGB 
and alpha values and calculates an average value. This value determines which pixels to fill 
with the new color. How far the fill color spreads depends upon the specified Tolerance 
setting, as well as the option you choose in the Fill Selector menu.

Fill Selector Specifies the channels to fill with the new color.

• Color & Alpha specifies that the effect fills the fill point’s RGB and alpha channels with 
the new color.
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• Straight Color specifies that the effect fills only the fill point area’s RGB channel with the 
new color. 

• Transparency specifies that the effect fills only the transparent areas near the fill point. 
You must set a fill point in a transparent area for this option to work. 

• Opacity specifies that the effect fills only the opaque areas near the fill point. You must 
set a fill point in an opaque area for this option to work. 

• Alpha Channel specifies that the effect fills either the opaque or transparent areas in the 
whole image, depending upon the alpha channel value at the point you set the fill 
point.

Tolerance Specifies the range of pixels that the effect fills with the new color. This value is 
based upon the option chosen in the Fill Selector menu. Higher values expand the range 
of similar pixel values that the effect fills. Lower tolerance values restrict that range.

View Threshold Causes the effect to display the threshold values in black and white 
(based on the tolerance value) in the Composition window. The white areas within the 
tolerance range fill with the selected fill color. This is especially useful in tracking leaks. 
When there is a small gap, the color can flow over and fill areas not intended to be filled. If 
a leak is found, try reducing the Tolerance value or retouching your image, either by using 
the Paint effect or by editing the image in the application in which you created it.

Stroke  Specifies how the effect treats the edges of the filled area. 

• Antialias anti-aliases the edges of the filled area. 

• Feather creates a feathered edge for the filled area. Feather Softness values create a 
more gradually disappearing edge. 

• Spread expands the area of the fill color. The Spread Radius value indicates the number 
of pixels the fill color extends beyond the edge of the fill area. 

• Choke contracts the area of the fill color. The Spread Radius value indicates the number 
of pixels the fill color shrinks from the edge of the fill area. 

• Stroke confines the fill to just the border of the selected area. The Stroke Width value 
indicates the width of the stroke, in pixels.

Each of the options has a corresponding slider except for Antialias.

Invert Fill Reverts all currently filled pixels to their original colors and transparency, and 
fills the previously unfilled pixels using the current settings.

Color Specifies the color to use as the fill color.

Opacity Specifies the transparency of the filled area.

Blending Mode Specifies the blending mode the effect uses to create the operation 
between the new fill color and the original layer. All of these blending modes appear in 
the Mode menu in the Timeline window, except for Fill Only. Use Fill Only if you don’t wish 
to composite the fill with the original image. Only the fill remains visible.

Note: If you apply multiple instances of Paint Bucket to a layer, be sure not to set more 
than one to use the Fill Only blending mode. If you set more than one instance to use this 
blending mode, only the first application of the filter is displayed. The blending mode 
drops out the original image, thereby changing the fill point selection for the following 
applications of the filter.
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Radio Waves
The Radio Waves effect creates radiating waves from a stationary or animated effect point. 
You can use this effect to generate pond ripples, sound waves, or intricate geometric 
patterns. You can control the emitted waves’ shape, width, color, speed, rotation, life span, 
fade rate, and other properties. Use the Reflection control to make the shapes bounce off 
the sides of the layer. You can also use Radio Waves to create realistic wave displacement 
maps that work well with the Caustics effect.

Polygon wave type with a square stroke profile (center) and Image Contour wave type with Sine 
stroke profile (right)

Controls for the Radio Waves effect
Adjust the following controls for the Radio Waves effect: 

Producer Point Specifies the point from which the waves appear.

Parameters are Set At Specifies whether parameters can be animated for individual 
waves. Birth specifies that each wave maintains the same parameter settings over time. 
Each Frame specifies that the waves change as the parameters change. For example, if you 
create a star wave with an animated rotation property, select Birth to offset each star from 
the previous one to create a twisting tunnel effect, or select Each Frame to make all the 
stars rotate in unison as the rotation property changes.

Render Quality Controls the quality of the output. Radio Waves renders a smooth, anti-
aliased shape for every shape by rendering a high-resolution version of the shape and 
then scaling it down in a process called oversampling. For example, to create a 100x100-
pixel image, it may first generate a 400x400-pixel image and then scale it down using 4x 
oversampling. Oversampling provides high-quality results but result in long render times. 
This option works only when in Best quality mode.

Wave Type Specifies the type of wave you want to create.

Polygon Specifies the appearance of the polygon shape used for the wave. This control is 
available when Polygon is chosen for Wave Type.

• Sides specifies the type of polygonal shape you want to produce. Three sides create a 
triangle, four create a square, and so on. Size values above 64 result in a smooth circle. 
You can also create a circle by setting Sides to 3, Curve Size to 1, and Curvyness to about 
.62.

• Curve Size specifies how much of each side is curved at each point. 

• Curvyness specifies how extreme the curve is at each point of the wave. 

• Star specifies that the polygon is shaped like a star. To change the number of points on 
the star, change the number of sides. 

• Star Depth specifies the star’s angles by controlling the distance between inner points 
and the star’s center.
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Image Contour See “Image Contour controls for the Radio Waves effect” on page 161.

Mask Specifies the mask used to create a wave. This control is available when you choose 
Mask from the Wave Type pop-up menu.

Wave Motion See “Wave Motion controls for the Radio Waves effect” on page 161.

Stroke See “Stroke controls for the Radio Wave effect” on page 162.

Image Contour controls for the Radio Waves effect
Image Contour controls specify the image you want to use as the wave and controls how 
the image appears. These controls are available when Image Contours is chosen for Wave 
Type. Adjust the following controls for the Radio Waves effect:

Source Layer  Specifies the layer you want to use as the shape of the wave. Select an 
animated layer to emit moving shapes. A well-defined outline, high-contrast grayscale 
layer, or alpha channel works well as a source. The Radio Waves effect detects edges and 
converts sources into outlines. 

Source Center  Specifies the center point of the shape, relative to the source layer. For 
example, if you isolate a shape that is positioned in the left half of the frame, the shape 
radiates to the left by default; you can move the source center anywhere on the layer.

Value Channel  Specifies the channel of the layer that defines the wave shape.

Invert Input  Inverts the chosen value channel option. 

Value Threshold  Specifies the threshold for the chosen value channel. It determines the 
percentage value at which everything below it or above it is mapped to either white or 
black. This control can make a big difference in the shape of the wave.

Pre-Blur  Smooths out the value channel before the value threshold is sampled. If you 
have a high-contrast image, such as white on black, and you want the wave to follow the 
edges very closely, set this to 0.

Tolerance  Defines how tightly the wave conforms to the layer. A very high setting results 
in sharp corners; a very low value can make the wave shape more sensitive to noise.

Contour  Specifies the shape in the source layer that you want to use as the emitted 
wave. Contour numbers the shapes by their order in the frame from top to bottom, left to 
right. The shape in the top left corner is number 1.

Wave Motion controls for the Radio Waves effect
Wave Motion controls specify how the wave emits from the center point. Adjust the 
following controls:

Frequency  Specifies the number of waves per second flowing out of the producer point. 

Expansion  Specifies the speed at which the wave travels from the producer point once it 
is born. This does not affect the number of waves per second.

Orientation  Specifies the rotation of the shape at birth around its center point. To 
animate the rotation, use the Spin control.

Direction  Specifies the wave’s initial direction when Velocity is greater than 0. By default, 
particles are emitted from the producer point in an expanding radial pattern. 

Velocity  Specifies the speed at which the wave moves in the specified direction. 

Spin  Controls the continued rotation of a shape after it is born. 
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Lifespan (sec)  Specifies the time, in seconds (including the fade-in and fade-out times), 
that the wave exists. 

To prevent waves from abruptly disappearing when their lifetime ends, use the Fade 
Out Time control.

Reflection  Specifies whether the waves bounce off the edges of the layer and back into 
the scene. This is effective for generating displacement maps for use as water ripples.

Stroke controls for the Radio Wave effect
Stroke controls specify the appearance of the wave’s stroke. Adjust the following controls 
for the Radio Wave effect: 

Profile  Controls the appearance of the stroke that defines the shape. The outline of the 
shape is animated in the wave that emanates from the effect point. The quality of the 
stroke is defined as a 3D wave type.

Color  Specifies the color of the stroke. 

Opacity  Specifies the maximum possible opacity of the stroke. The actual opacity of the 
stroke takes into account this setting in conjunction with the Fade-in Time and Fade-out 
Time controls.

Fade-in Time  Specifies the amount of time it takes the wave to fade into view. Fade-in 
Time is measured in seconds and begins with 0 opacity at birth. For example, if the 
Lifespan is 3 seconds and Fade-in Time is 1 second, the stroke is completely transparent at 
birth and fades smoothly to full opacity at 1 second.

Fade-out Time  Specifies the amount of time it takes the wave to fade out of view. Fade-
out Time is measured backward in time from the end of the Lifespan. If the Lifespan is 3 
seconds and Fade-out Time is 1 second, the wave begins to fade out at 2 seconds. If the 
sum of Fade-in Time and Fade-out Time is greater than the Lifespan value, the intersection 
point of the two fades is calculated so that the wave does not reach full transparency. If 
either Fade-in Time or Fade-out Time is longer than the Lifespan, that amount is truncated 
to equal the Lifespan. 

Start Width  Specifies the width of the shape at its birth. End Width specifies the width of 
the shape at the end of its lifespan.
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Ramp
The Ramp effect creates a color gradient, blending it with the original image contents. 
Create linear or radial ramps, and vary the position and colors of the ramp over time. Use 
the Start and End of Ramp controls to specify the start and end positions. Use the Ramp 
Scatter control to disperse the ramp colors and eliminate banding, or use Ramp in 16-bit 
mode.

Original (left), Linear ramp with red at 30% opacity (center), and radial ramp with black at 30% 
opacity (right) 

Note: Traditionally, ramps do not broadcast well; serious banding occurs because the 
broadcast chrominance signal does not contain sufficient resolution to reproduce the 
ramp smoothly. The Ramp Scatter control disperses the ramp colors, eliminating the 
banding apparent to the human eye.

Scribble
The Scribble effect creates a hand-drawn artwork appearance by replacing a closed mask 
shape with strokes. For example, Scribble can simulate fills that look like marker, cross-
hatching, or textiles. Scribble replaces a mask shape with a single zigzagging line that 
criss-crosses the path. Some paths, because of their geometry, cannot be filled with a 
single line. Scribble breaks these paths into several simpler paths, each of which it then fills 
with a zigzagged stroke. 

Masks (left), Scribble applied to outside edges (center), and Scribble applied to inside edges with 
Composite on Original (right)

Mask, Fill, and Edge controls for the Scribble effect
Adjust the following controls for the Scribble effect:

Scribble Specifies the mask you want to use for the Scribble effect. Single Mask scribbles 
a specified mask on the layer; All Masks scribbles all masks on the layer; All Masks Using 
Modes combines the masks using their modes and then scribbles the resulting shape.

Mask Specifies the mask to use for the effect. It is enabled if Scribble is set to Single Mask. 
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Fill Type Controls whether the fill is drawn inside the path or creates a scribble along the 
path. Inside draws the fill inside the path. Centered Edge draws the fill along the edge 
from the center out. Inside Edge draws the fill along the path from the inside. Outside 
Edge draws the fill along the path from the outside. Inside Edge and Outside Edge have no 
effect if used with an open path.

Edge Options Specify the options for the edge of the scribble. It is enabled if Fill Type is 
set to an edge.

• Edge Width controls the width of the edge.

• End Cap controls the ends of scribble lines. Use Round for stroked lines with semicir-
cular ends; use Butt for stroked lines with squared ends; and use Projecting for stroked 
lines with squared ends that extend half the line width beyond the end of the line, 
making the weight of the line extend equally in all directions around the line. This 
option is enabled only if Fill Type is set to Centered Edge.

• Join specifies how the corners of a scribble line appear. Use Round for stroked lines with 
rounded corners; use Bevel for stroked lines with squared corners; and use Miter for 
stroked lines with pointed corners.

• Miter Limit controls when the effect switches from a miter (pointed) join to a bevel 
(squared-off ) join. Specify a value between 1 and 500. For example, if the value is set to 
the default value of 4, the effect switches from a miter to a bevel join when the length 
of the point reaches four times the stroke weight. A miter value of 1 results in a bevel 
join. It is enabled if Join is set to the Miter option. 

Color Specifies Scribble color. 

Opacity Specifies the opacity of the lines in the scribble. 

Angle and Stroke controls for the Scribble effect
Adjust the following controls for the Scribble effect:

Angle  Specifies the angle of the scribbled stroke.

Stroke Width Specifies the width of the stroke. Specify a value from 0.1 to 50.

Stroke Options Specify the curviness, spacing, and overlap of the scribbled line. 

• Curviness controls the amount of curve at the end of each scribbled stroke. Specify a 
value between 0 and 100 degrees.

• Curviness Variation determines the amount of variance the curviness values can have at 
each end point. Specify a value between 0 and 100 percent. A value of 0 gives the 
scribble sharp corneres, while a value of 100 makes the scribble loopy.

• Spacing and Spacing Variation, specified in pixels, control the amount of space 
between lines and zigzags. Specify a value between 0 and 50 percent. Setting a value 
equal to the stroke width value makes the lines fall next to each other. 

• Path Overlap determines whether the scribble ends at the path, inside the path, or 
outside the path. Specify 0 to make it end at the path, negative values to make it end 
inside, and positive values to make it end outside. Path Overlap Variation determines 
how much each stroke can vary from the value specified for Path Overlap.

Start, End Control the point along the stroke where the stroke starts and ends. 
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Fill Paths Sequentially It is enabled when Scribble is set to All Masks. When this control 
is selected, the start and end values apply to the combined length of the scribbles for all 
masks. When it is not selected, the start and end values apply independently to the 
scribble for each mask.

Wiggle Type Specifies an animation style: Static keeps the scribble constant over time; 
Jumpy changes from one scribble to the next abruptly; and Smooth changes from one 
scribble to the next smoothly.

Wiggles/Second Controls how frequently a new scribble is generated when the Wiggle 
Type control is set to Smooth or Jumpy.

Random Seed Generates random scribbles. This control is most useful when the Wiggle 
Type control is set to Static. 

Composite Controls the composition of the effect on the original layer.

Stroke
The Stroke effect creates a stroke or border around a mask or along a Bezier path. You can 
also specify stroke color, opacity, and spacing, as well as brush characteristics. Specify 
whether the stroke appears on top of the image, on a transparent image, or if it reveals the 
original alpha channel. To use a path created in Illustrator, copy the path and paste it into a 
layer in After Effects. 

Brush Hardness  Specifies the edge quality of the stroke, between hard and soft. 

Spacing  Specifies the spacing between stroke segments. 

Paint On  Specifies whether the stroke is applied to the original layer or to a transparent 
layer. 

Original (left), with mask (center), and with Stroke applied (right)

Vegas
The Vegas effect generates running lights and other path-based pulse animations around 
an object. You can outline just about anything, surround it with a number of lights or 
longer pulses, and then animate it to create the effect of lights chasing around the object. 

Image contours of the spaceship are used to create animations on a transparent background (right).
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Controls for the Vegas effect
Adjust the following controls for the Vegas effect:

Stroke Specifies what you want to use to create a stroke: Image Contours or Mask/Path.

Image Contours Specifies the area where the lights will appear. Vegas sets thresholds for 
the image and then creates contours around the edges of the resulting shapes.

• Input Layer specifies where the strokes appear. High-contrast, grayscale layers, and 
alpha channels work well and are easy to work with. 

• Invert Input inverts the input layer prior to creating the stroke.

• If Layer Sizes Differ determines how to adjust the layers if the size of the input layer 
differs from that of the layer to which Vegas is applied. Center centers the input layer in 
the composition at its original size. Stretch to Fit scales the input layer to match the 
layer to which Vegas is applied. 

• Channel specifies the channel or property of the input layer used to define the 
contours. 

• Threshold sets the threshold for the selected channel. The threshold is the percentage 
value at which everything below or above is mapped to either white or black. For 
example, if a grayscale file were an altitude map with white high and black low; the 
Threshold value moves the contour up or down the terrain. This is an important factor 
in determining the location of the edges that Vegas strokes.

• Pre-Blur smooths out the input layer before the threshold is sampled. Set this to 0 if you 
have a high-contrast image and want the stroke to follow the edges very closely.

• Tolerance defines how tightly the stroke conforms to the input layer. A very high setting 
results in sharp corners, while very low values can make the stroking sensitive to noise.

• Render specifies whether to apply Vegas to a selected contour or to all contours in the 
layer.

• Selected Contours specifies the contour to use when Selected Contour is selected in the 
Render menu. Contours are numbered from left top to bottom right; the contour with 
the highest point is number 1, the second highest point is number 2, and so on. 

• Shorter Contours Have specifies whether shorter contours have fewer segments. By 
default, Vegas breaks each contour into the same number of segments. For example, if 
you apply Vegas to the letter R, the outside contour may look fine with 32 segments, 
but the inside contour may be almost solid. To resolve this, select Fewer Segments.

Mask/Path Specifies the path to use for the stroke. Select the mask from the Path menu. 
You can use either closed or open masks.

Segments See “Segments controls for the Vegas effect” on page 166.

Rendering See “Rendering controls for the Vegas effect” on page 167.

Segments controls for the Vegas effect
The Segments controls specify the number and appearance of the contours’ segments. 
Adjust the following controls for the Vegas effect:

Segments  Specifies the number of segments used to create each stroked contour. For 
example, if Vegas is applied to the word Vegas and Segments is set to 10, the outline of 
each of the letters, plus the inner contours of e, g, and a, are broken into 10 segments.
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Length  Determines the length of a segment’s stroke in relation to its maximum possible 
length. For example, if Segments is set to 1, the maximum length of a stroke is one 
complete trip around the object outline. If Segments is set to 3, the maximum length of a 
segment is 1/3 of the total outline, and so on.

Segment Distribution  Determines the spacing of the segments. Bunched puts the 
segments together like boxcars in a train: the shorter the segment length, the shorter the 
overall length of the train. Even spaces the segments evenly around the contour. 

Rotation  Animates the segments around the contour. For example, to create the 
appearance of running lights, start with a large number of segments set to 50% of their 
length, and then animate Rotation to move the lights around the shapes.

Random Phase  Specifies that the stroke starting point is different for each contour. By 
default, Vegas strokes a contour beginning at its highest point on the screen. In the event 
of a tie, it starts at the leftmost highest point. 

Random Seed  Gives different stroke origins to two identical contours with identical 
settings on a layer. A random seed is a number that is inserted into the calculation to 
generate a unique result. By using a different Random Seed setting, you can make things 
appear different, while still using the same settings. 

Rendering controls for the Vegas effect
Rendering controls specify how Vegas renders the strokes. Adjust the following controls 
for the Vegas effect:

Blending Mode  Determines how the stroke is applied to the layer. Transparent creates 
the effect of Vegas on a transparent background. Over places the stroke over the existing 
layer. Under places the stroke behind the existing layer. Stencil uses the stroke as an alpha 
channel mask, filling the stroke with the pixels of the original layer.

Color  Specifies the color of the stroke, unless Stencil is chosen for Blend Mode.

Width  Specifies the width of the stroke in pixels. Fractional values are supported. 

Hardness  Determines how sharp or blurry the edges of the stroke are. A value of 1 
creates a slight blur; a value of 0.0 blurs the line so that few solid areas of color remain. 

Start, End Opacity  Specify the opacity at the beginning or end of the stroke. 

Mid-point Opacity  Specifies the opacity of the midpoint of the stroke. This works in 
terms of relative opacity, not absolute opacity. Setting this to 0 makes the change in 
opacity smooth from the start point to the end point, as if there were no midpoint at all.

Mid-point Position  Specifies the location of the midpoint within a segment: Lower 
values move the midpoint closer to the beginning; higher values move the midpoint 
closer to the end. Use this control to move the midpoint opacity from the center of the 
stroke.



Using Help | Contents | Index Back 168  

Adobe After Effects Help Simulation effects 

Using Help | Contents | Index Back 168  

Simulation effects

Card Dance
The Card Dance effect is available from the Adobe Web site (www.adobe.com) after you 
register your copy of After Effects. This effect creates the appearance of card choreography 
by segmenting layers into numerous cards and then controlling all geometric aspects of 
the cards by using a second layer. For example, Card Dance can simulate an extruded pin 
sculpture, a crowd “doing the wave,” or letters floating on the surface of a pond. 

Original (left) and rotation adjusted using Camera Position controls (center) and Corner Pin controls 
(right)

Original (left), gradient layer (center), and with Card Dance applied (right)

Apply Card Dance to the layer you want to use for the front of the cards. To set the view, 
use the rotation or perspective controls, or match the perspective of the effect in any 
scene by corner-pinning.

Rows & Columns through Transformation Order controls for the 
Card Dance effect
Adjust the following controls for the Card Dance effect:

Rows & Columns Specifies the interaction of the numbers of rows and columns. When 
you choose Columns Follow Rows, the number of columns is always the same as the 
number of rows. 

Rows, Columns Define the number of rows or columns up to 1,000.

Note: Rows and columns are always evenly distributed across a layer, so odd-shaped 
rectangular tiles don’t appear along the edges of a layer, unless you are using an alpha 
channel.
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Back Layer Defines what appears on the back sides of the cards when they rotate into 
view, or when the camera rotates around to the back of the layer. You can use any image 
file in the composition; its visibility can be turned off.

Gradient Layer 1 Specifies the first gradient that you want to use to make the cards 
“dance.” You can use any grayscale (grayscale produces the most predictable results) or 
color image, movie, or composition. The gradient layer acts as a displacement map for 
animating the cards. The pixel luminance of the gradient layer directly controls the 
geometrics of the Card Dance tiles. 

Gradient Layer 2 Specifies a second gradient, which you can use to add another level of 
animation to the card dance. 

Rotation Order Determines the order in which the cards rotate around multiple axes, 
when using more than one axis for rotation. This control can greatly affect the appearance 
of the animation.

Transformation Order Determines the order in which the transformational properties 
occur (scale, rotation, and position). This control can also greatly affect the appearance of 
the animation.

Position, Rotation, and Scale controls for the Card Dance effect
Position (X, Y, Z), Rotation (X, Y, Z), and Scale (X, Y) specify the transformation properties 
you want to adjust. Because Card Dance is a 3D effect, you can control these properties 
separately for each axis of the cards. However, because the cards themselves are still 2D, 
they have no inherent depth—hence the absence of z scaling.

Adjust the following Position, Rotation, and Scale controls for the Card Dance effect:

Source Specifies the gradient layer channel you want to use to control the transfor-
mation. For example, select Intensity 2 to use the Intensity from Gradient Layer 2.

Multiplier Specifies the amount of transformation applied to the cards.

Offset Specifies the value at which the transformation begins. It is added to the transfor-
mation value (a card’s center pixel value times the Multiplier amount) so that you can start 
the transformation from some place other than 0. 

Camera System control for the Card Dance effect
Camera System specifies whether to use the Camera Position, Corner Pins, or Comp 
Camera controls. Comp Camera tracks the composition's camera and light positions and 
renders a 3D image on the layer. See the Adobe After Effects user guide for more infor-
mation.

Camera Position controls for the Card Dance effect
Adjust the following Camera Position controls to specify the camera position:

X Rotation, Y Rotation, Z Rotation Rotate the camera around the corresponding axis. 
Use these controls to look at the layer from the top, side, back, or any other angle. 

X, Y Position Specifies where the camera is positioned in x,y space. 

Z Position Specifies where the camera is positioned in z space. Smaller numbers move 
the camera closer to the layer, and larger numbers move the camera away from the layer. 

Focal Length Specifies the zoom factor and is like a camera’s zoom lens. Smaller numbers 
zoom the camera lens out, and larger numbers zoom the camera lens in. 
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Transform Order Specifies the order in which the camera rotates around its three axes, 
and whether the camera rotates before or after it is positioned by using the other Camera 
Position controls. 

Corner Pins controls for the Card Dance effect
Corner pinning is an alternative camera control system. Use it as an aid for compositing 
your layer into a scene. Adjust the following Corner Pins controls:

Upper Left Corner, Upper Right Corner, Lower Left Corner, Lower Right Corner 
Specify the location of each of the four corners of your layer. 

Auto Focal Length Specifies the perspective of the effect during the animation. When 
Auto Focal Length is off, the Focal Length you specify is used to find a camera position and 
orientation that positions the corners of the layer at the corner pins. If this isn’t possible, 
the layer is replaced by its outline, drawn between the pins. When Auto Focal Length is on, 
the Focal Length required to match the corner points is used, if possible. If not, it interpo-
lates the correct value from nearby frames. 

Focal Length Overrides the other settings if the results you’ve obtained aren’t what you 
need. If you set Focal Length to something that doesn’t correspond to what the focal 
length would be if the pins were actually in that configuration, the image may look odd 
(strangely sheared, for example). But if you know the focal length that you are trying to 
match, the Focal Length control is the easiest way to get correct results.

Lighting controls for the Card Dance effect
Adjust the following Lighting controls to specify the lighting for the effect:

Light Type Specifies the type of light you want to use. When a light is at a great distance 
from an object, all the light rays strike the object from virtually the same angle. Sun rays, 
for example, are parallel by the time they reach the earth. As a light source moves closer to 
the object, the rays strike the object from an increasing number of angles. Distant Source 
is similar to sunlight and casts shadows in the one direction. Point Source is similar to a 
light bulb and casts shadows in all directions. First Comp Light uses the composition’s first 
light layer, which can use a variety of settings.

Light Intensity Specifies the power of the light. The higher the value, the brighter the 
layer. Other lighting settings affect the overall light intensity as well. 

Light Color  Specifies the color of light.

Light Position Specifies the position of the light in x, y space. 

Light Depth  Specifies the position of the light in z space. Negative numbers move the 
light behind the layer.

Ambient Light Distributes light over the layer. Increasing it adds an even illumination to 
all objects and prevents shadows from being totally black. Turning Ambient Light all the 
way to pure white and setting all other light controls to 0 makes the object fully lit and 
eliminates any 3D shading from the scene.

Material controls for the Card Dance effect
Adjust the following Material controls to specify the reflection values of the cards:

Diffuse Reflection Gives objects form-defining shading. Shading depends on the angle 
at which the light strikes the surface and is independent of the viewer’s position.
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Specular Reflection Takes into account the position of the viewer. It models the 
reflection of the light source back to the viewer. It can create the illusion of shininess. For 
realistic effects, you can animate this control by using higher and higher values to mask 
the transition from filtered to nonfiltered versions of the layer.

Highlight Sharpness Controls shininess. Very shiny surfaces produce small tight reflec-
tions, while duller surfaces spread the highlight out into a larger region. Specular 
highlights are the color of the incoming light. Because light is typically white or off-white, 
broad highlights can desaturate an image by adding white to the surface color. 

In general, use the following process to adjust lighting: Set Light Position and Diffuse 
Reflection to control the overall light level and shading in a scene. Then adjust 

Specular Reflection and Highlight Sharpness to control the strength and spread of 
highlights. Finally, adjust Ambient Light to fill in the shadows. 

Understanding Card Dance
Consider the following example: If you select a vertical grayscale gradient (black on top, 
white on bottom) from the Gradient Layer 1 menu and then select Intensity 1 from the X 
Rotation Source menu, Card Dance uses the intensity of the gradient to animate the x-axis 
rotation of the cards. It assigns a numeric value to the center pixel of each card on the 
gradient layer, based on the pixel’s intensity. Pure white equals 1, pure black equals –1, and 
50% gray equals 0. Card Dance then multiplies that value by the X Rotation Multiplier 
value and rotates each card that amount.

If X Rotation Multiplier is set to 90, the cards in the top row rotate almost 90˚ backward, 
the cards in the bottom row rotate almost 90˚ forward, and cards in middle rows rotate by 
lesser amounts. Cards in the 50% gray area don’t rotate at all. 

If you want half of the cards in a layer to come in from the right, and the other half to come 
in from the left, create a gradient layer that is half black and half white. Set the gradient as 
the source for X Position, and set X Position Multiplier to 5, and animate it to 0. The cards in 
the black area initially appear at the left, and the cards in the white area initially appear at 
the right. 
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Caustics
The Caustics effect is available from the Adobe Web site (www.adobe.com) after you 
register your copy of After Effects. This effect simulates caustics—reflections of light at the 
bottom of a body of water, created by light refracting through the water’s surface. The 
Caustics effect generates this reflection and creates realistic water surfaces when used 
with Wave World and Radio Waves.

Original (left) and with Bottom set to the text layer and Water Surface set to the whirl layer with 
Surface Opacity set to 0% (right)

To get the most realistic results from Caustics, render the Bottom layer separately, with 
Render Caustics enabled and Surface Opacity at 0. Then precompose, and use the 

resulting layer as the Bottom layer for another Caustics effect with Render Caustics off. 
With this process you can offset, scale, or otherwise manipulate the Bottom layer in the 
precomposed composition, and thus simulate lighting that doesn’t come from straight 
overhead.

Bottom controls for the Caustics effect
Adjust the following Bottom controls to specify the appearance of the bottom of the body 
of water:

Bottom Specifies the layer at the bottom of the body of water. This layer is the image that 
is distorted by the effect (unless Surface Opacity is 100%).

Scaling Makes the bottom layer larger or smaller. If the edges of the bottom layer show, 
because of the refraction of the light through the waves, scale up the bottom layer. Scaling 
down is useful for tiling a layer to make a complex pattern. 

Repeat Mode Specifies how a scaled-down bottom layer is tiled. Once uses only one tile, 
basically turning tiling off. Tiles uses the traditional tiling method of abutting the right 
edge of one bottom layer tile to the left edge of another bottom layer tile. This option 
works well if the bottom layer contains a repeating pattern, like a logo, that needs to read 
a certain way. Reflected abuts each edge of a bottom layer tile to a mirrored copy of the 
tile. This option can eliminate a hard edge where the two tiles meet.

If Layer Size Differs Specifies how to handle the bottom layer when it is smaller than the 
composition. 

Blur Specifies the amount of blur applied to the bottom layer. To make the bottom totally 
sharp, set this control to 0. Higher values make the bottom appear increasingly blurry, 
especially where the water is deeper.

Water controls for the Caustics effect
Adjust the following Water controls to specify the characteristics of the water:
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Water Surface Specifies the layer to use as the water’s surface. Caustics uses the 
luminance of this layer as a height map for generating a 3D water surface. Light pixels are 
high, and dark pixels are low. You can use a layer created by using the Wave World or Radio 
Waves effect (precompose the layer before using it with Caustics).

Wave Height Adjusts the relative height of the waves. Higher values make the waves 
steeper and the surface displacement more dramatic. Lower values smooth the Caustics 
surface.

Smoothing Specifies the roundness of the waves by blurring the water surface layer. Very 
high values eliminate detail. Very low values show imperfections from the water surface 
layer. 

Water Depth Specifies depth. A small disturbance in shallow water moderately distorts 
the view of the bottom, but the same disturbance in deep water distorts the view signifi-
cantly. 

Refractive Index Affects the way the light bends as it passes through the liquid. A value 
of 1 does not distort the bottom. The default value of 1.2 accurately simulates water. To 
add distortion, increase the value. 

Surface Color Specifies the color of the water. 

Surface Opacity Controls how much of the bottom layer is visible through the water. If 
you want a milky effect, increase the Surface Opacity and Light Intensity values; a value of 
0 results in a clear liquid.

Set Surface Opacity to 1.0 to perfectly reflect a “sky” later. With a suitable texture map, 
you can use this technique to create the effect of liquid mercury.

Caustics Strength Displays the caustics (the concentrations of light on the bottom 
surface, caused by the lensing effect of the water waves). This control changes the way 
everything looks: The waves’ dark spots get much darker, and the light spots get much 
lighter. If you don’t set a value for this control, the effect distorts the bottom layer when 
the waves pass over it, but it doesn’t render the lighting effect.

Sky controls for the Caustics effect
Adjust the following Sky controls to specify the appearance of the sky:

Sky Specifies the layer above the water. Scaling makes the sky layer larger or smaller. If 
the edges of the sky layer show, scale up the layer. Scaling down is useful for tiling a layer 
to make a complex pattern. 

Repeat Mode Specifies how a scaled-down sky layer is tiled. Once uses only one tile, 
basically turning tiling off. Tiles uses the traditional tiling method of abutting the right 
edge of one layer tile to the left edge of another layer tile. This option works well if the 
layer contains a repeating pattern, like a logo, that needs to read a certain way. Reflected 
abuts each edge of a layer tile to a mirrored copy of the tile. This option can eliminate a 
hard edge where the two tiles meet.

If Layer Size Differs Specifies how to handle the layer when it is smaller than the compo-
sition. Intensity specifies the opacity of the sky layer. Convergence specifies how close the 
sky and the bottom or water layer appear, controlling the extent to which the waves 
distort the sky.
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Lighting controls for the Caustics effect
Adjust the following Lighting controls to specify the lighting for the effect:

Light Type Specifies which type of light you want to use. Distant Source simulates 
sunlight and casts shadows in one direction, where all the light rays strike the object from 
virtually the same angle. Point Source is similar to a light bulb and casts shadows in all 
directions. First Comp Light uses the composition’s first light layer, which can use a variety 
of settings. 

Light Intensity Specifies the power of the light. The higher the value, the brighter the 
layer. Other lighting settings affect the overall light intensity as well.

Light Color Specifies the color of light. 

Light Position Specifies the position of the light in x,y space. To position the light interac-
tively, hold down Alt (Windows) or Option (Mac OS) and drag the light’s effect point.

Light Depth Specifies the position of the light in z space. Negative numbers move the 
light behind the layer. 

Ambient Light Distributes light over the layer. Increasing it adds an even illumination to 
all objects and prevents shadows from being totally black. Turning Ambient Light all the 
way to pure white and setting all other light controls to 0 makes the object fully lit and 
eliminates any 3D shading from the scene.

Material controls for the Caustics effect
Adjust the following Material controls to specify the reflection values of the cards:

Diffuse Reflection Gives objects form-defining shading. Shading depends on the angle 
at which the light strikes the surface and is independent of the viewer’s position.

Specular Reflection Takes into account the position of the viewer. It models the 
reflection of the light source back to the viewer. It can create the illusion of shininess. For 
realistic effects, you can animate this control by using higher and higher values to mask 
the transition from filtered to nonfiltered versions of the layer.

Highlight Sharpness  Controls shininess. Very shiny surfaces produce small tight reflec-
tions, while duller surfaces spread the highlight out into a larger region. Specular 
highlights are the color of the incoming light. Because light is typically white or off-white, 
broad highlights can desaturate an image by adding white to the surface color. 

In general, use the following process to adjust lighting: Set Light Position and Diffuse 
Reflection to control the overall light level and shading in a scene. Then adjust 

Specular Reflection and Highlight Sharpness to control the strength and spread of 
highlights. Finally, adjust Ambient Light to fill in the shadows. 
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Foam
The Foam effect is available from the Adobe Web site (www.adobe.com) after you register 
your copy of After Effects. This effect generates bubbles that flow, cling, and pop. Use the 
effect’s controls to adjust attributes for the bubbles such as stickiness, viscosity, life span, 
and bubble strength. You can control exactly how the foam particles interact with each 
other and with their environment, and specify a separate layer to act as a map, controlling 
precisely where the foam flows. For example, you can have particles flow around a logo or 
fill up a logo with bubbles.

Original (left), with Foam applied (center), and with a robot layer used as the Bubble Texture Layer 
(right)

You can also substitute any image or movie for bubbles. For example, you can create 
swarms of ants, flocks of birds, or crowds of people.

Note: Foam is an intensely powerful simulation. On a frame-by-frame basis, it renders 
quickly, but the slightest adjustment in the initial settings is likely to result in very different 
output a few seconds into the simulation. When making adjustments to Physics controls, 
the farther into the simulation you are, the longer the adjustments take to render, because 
each adjustment results in the simulation being recalculated all the way back to the 
beginning. Not every frame takes this long to calculate; once Foam adjusts to the change, 
rendering speeds up again. 

View controls for the Foam effect
Choose one of the following views to specify the display of the bubbles:

Draft Displays the bubbles without fully rendering them. This is a fast way to preview the 
behavior of the bubbles. Draft mode is the only way to preview the universe edges, the 
Flow Map alignment, and the Producer location, orientation, and size. Bubbles are repre-
sented by blue ellipses. The Producer Point is represented by a red ellipse. The bubble 
universe is represented by a red rectangle.

Draft + Flow Map Displays the Draft view wireframe superimposed over a grayscale 
representation of the flow map, if selected. 

Rendered Displays the final output of the animation.

Producer controls for the Foam effect
Adjust the following Producer controls to specify the location from where the bubbles 
originate, as well as the speed at which the bubbles are generated:

Producer Point Positions the ellipse from which all your bubbles appear. This “point” can 
be much larger than a point. In fact it can cover the entire screen. Producer Point defines 
the center of the area from which the bubbles can be produced.

Producer X Size, Producer Y Size Adjust the width and height of the Producer. 



Using Help | Contents | Index Back 176  

Adobe After Effects Help Simulation effects 

Using Help | Contents | Index Back 176  

Producer Orientation Adjusts the rotation or “orientation” of the Producer. Producer 
Orientation has no noticeable effect when Producer X Size and Producer Y Size are 
identical.

Zoom Producer Point Specifies whether the producer point and all of its associated 
keyframes remain relative to the universe (selected) or to the screen (deselected) when 
you zoom in or out on it. For example, if you set a position for Producer Point in the upper 
left corner of the layer and then zoom out on that layer, the producer point stays in the 
upper left corner of the screen if you don’t select Zoom Producer Point. If you select Zoom 
Producer Point, the point moves with the universe as it is zoomed, and it ends up closer to 
the center of the screen.

Production Rate Determines the rate at which bubbles are generated. This control does 
not affect the number of bubbles per frame. Rather, the rate is the average number of 
bubbles generated every 30th of a second. Higher numbers yield more bubbles.

If a large number of bubbles appear in the same point at the same time, some may 
pop. If you want a lot of foam, increase the values for Producer X Size and Producer Y 

Size so that the bubbles don’t immediately pop each other.

Bubbles controls for the Foam effect
Adjust the following Bubbles controls to specify the size and appearance of the bubbles:

Size Specifies the average size for adult bubbles. Size Variance, Bubble Growth Speed, 
and Random Seed also affect the size of a bubble in any particular frame.

Size Variance Specifies the range of possible bubble sizes. This control uses the Size 
value as the average and creates smaller-than-average and larger-than average-bubbles 
by using the range you specify here. For example, a default bubble Size of 0.5 and default 
Size Variance of 0.5 generate bubble sizes ranging from 0 to 1 (0.5 –.5 = 0 and 0.5 + 0.5 = 1).

Lifespan Specifies the maximum life of a bubble. This value is not absolute; if it were, the 
bubbles would all pop after the same lifespan, as if they were hitting a wall. Rather, this 
value is a target lifespan; some bubbles pop early, and others last until the end. 

Bubble Growth Speed Specifies how fast a bubble reaches full size. When a bubble is 
released from the producer point, it generally starts out rather small. If you set this value 
too high and you specify a small producer area, the bubbles pop each other, and the effect 
generates fewer bubbles than expected. 

Strength Influences how likely a bubble is to pop before it reaches its Lifespan limit. 
Lowering a bubble’s Strength makes it more likely to pop early in its life, when forces like 
wind and flow maps act upon it. Lower values are good for soap bubbles. The highest 
value is recommended for flocking animations. 

Set this value low, and set Pop Velocity high to create chain reactions of popping 
bubbles. 

Physics controls for the Foam effect
Adjust the following Physics controls to specify the motion and behavior of the bubbles:
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Initial Speed Sets the speed of the bubble as it is emitted by the producer point. This 
speed is affected by the other Physics parameters.

Low Initial Speed values in conjunction with the default producer size don’t affect the 
results much because the bubbles bounce off each other. For more control over initial 

speed, increase the values for Producer X Size and Producer Y Size.

Initial Direction Sets the initial direction that the bubble moves as it emerges from the 
producer point. This is affected by other bubbles and other Physics controls.

Wind Speed Sets the speed of the wind that pushes the bubbles in the direction 
specified by Wind Direction.

Wind Direction Sets the direction that the bubbles blow. Animate this control to create 
turbulent wind effects. Bubbles are affected by wind as long as Wind Speed is greater than 
0.

Turbulence Applies small random forces to the bubbles, making them behave chaoti-
cally. 

Wobble Amount Randomly changes the shape of bubbles from perfectly round to a 
more natural elliptical shape. 

Repulsion Controls whether bubbles bounce off each other, stick to each other, or pass 
through each other. With a value of 0, bubbles don’t collide; they pass through each other. 
The higher the Repulsion value, the more likely bubbles are to interact with each other 
when they collide.

Pop Velocity Controls how popping bubbles affect each other. When a bubble pops, it 
affects other bubbles around it by leaving a hole that other bubbles can fill, pushing other 
bubbles away, or popping other bubbles. The higher the value, the more popping bubbles 
affect one another.

Viscosity Specifies the rate at which bubbles decelerate after being released from the 
producer point, and controls the speed of the flow of the bubbles. A high Viscosity value 
creates resistance as the bubbles get farther away from the producer point, causing them 
to slow down. If Viscosity is set high enough, the bubbles stop. The thicker the substance, 
the higher the Viscosity. For example, if you want to create the effect of bubbles traveling 
through oil, set Viscosity fairly high, so that the bubbles meet resistance as they travel. To 
create the effect of bubbles floating in air, set Viscosity fairly low.

Stickiness Causes bubbles to clump together and makes them less vulnerable to other 
Physics controls like Wind Direction. The higher the Stickiness, the more likely the bubbles 
are to form clusters and cling. Use Stickiness and Viscosity to create a bubble cluster.

Zoom and Universe Size controls for the Foam effect
Adjust the following controls to specify the zoom and universe size:

Zoom Zooms in or out around the center of the bubble universe. To create really large 
bubbles, increase the Zoom value instead of the Size value because large bubble sizes can 
be unstable.
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Universe Size Sets the boundaries of the bubble universe. When bubbles completely 
leave the universe, they pop and are gone forever. By default, the universe is the size of the 
layer. Values greater than 1 create a universe that stretches beyond the borders of the 
layer. Use higher values to make bubbles flow in from off-screen, or make it possible to 
zoom out and bring them back into the picture. Using a value lower than 1 clips the 
bubbles before they reach the edge of the layer. For example, when you want to confine 
bubbles to a specific area, such as inside a mask shape, set Universe Size a little larger than 
the mask size to remove all the extra bubbles and speed up the rendering process.

Rendering controls for the Foam effect
Adjust the following Rendering controls to specify the appearance of the bubbles, 
including their texture and reflection:

Blend Mode Specifies the relative transparency of bubbles as they intersect. Transparent 
blends the bubbles smoothly together, allowing you to see the bubbles through each 
other. Solid Old on Top makes a younger bubble appear to be underneath an older bubble 
and eliminates transparency. Use this setting to simulate bubbles flowing toward you. 
Solid New on Top makes younger bubbles appear to be on top of older bubbles and also 
eliminates transparency. Use this setting to make bubbles appear as if they are flowing 
downhill.

Bubble Texture Specifies the bubble texture. Use a preset texture, or create your own. To 
see the texture, make sure that View is set to Rendered. To create your own texture, select 
User Defined, and then from the Bubble Texture Layer menu choose the layer you want to 
use as the bubble.

Note: The preset bubble textures are prerendered 64 x 64 images. If you zoom in above 64 
x 64, the bubble appears blurry. To avoid this, use a higher-resolution custom bubble.

Bubble Texture Layer Specifies the layer you want to use as the bubble image. To use 
this control, choose User Defined from the Bubble Texture menu. If you want the layer to 
appear only as a bubble, turn off the video switch for the layer in the Timeline window.

Note: You can use any file type that After Effects supports. If you plan on zooming in or 
using a large bubble size, make sure that the resolution of the layer is high enough to 
avoid blurring. Remember, this doesn’t have to be a normal bubble. You can make blood 
cells, starfish, bugs, space aliens, or flying monkeys. If it’s a layer in your composition, it 
can be a bubble. 

Bubble Orientation Determines the direction that the bubble rotates. Fixed releases the 
bubble from the producer right side up and keeps it that way. Use this control if the 
bubble has built-in highlights and shading, as all of the preset bubbles do. Physical Orien-
tation buffets and spins bubbles around by the forces on them, creating a chaotic scene. 
Bubble Velocity faces the bubble in the direction of its motion. This is the most useful 
setting for flocking-style animations.

Environment Map Specifies the layer that is reflected in the bubbles. If you want to use 
this layer only for the reflection, turn off the layer’s video switch. 

Reflection Strength Controls how much of the selected Environment Map is reflected in 
the bubbles. The higher the value, the more the reflection obscures the original bubble 
texture. Reflections appear only on opaque pixels, so bubbles with high degrees of trans-
parency, such as the Spit preset, don’t reflect much.
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Reflection Convergence Controls how much your Environment Map is distorted as it is 
mapped onto the bubbles. A value of 0 projects the map flat on top of all of the bubbles in 
the scene. As the value increases, the reflection distorts to account for the spherical shape 
of each bubble.

Flow Map controls for the Foam effect
Adjust the following Flow Map controls to specify the map that the flow of the foam 
follows:

Flow Map Specifies the layer used to control the direction and speed of the bubbles. Use 
a still image layer; if you select a movie as the flow map layer, only the first frame is used. A 
flow map is a height map based on luminance: White is high, and black is low. White is not 
infinitely high; if a bubble travels fast enough, it can travel past a white obstacle. Make sure 
that the map is a little blurry; sharp edges can create unpredictable results. For example, 
to make bubbles flow through a canyon, create a flow map with a white canyon rim, a 
black canyon, and blurry gray walls. Use wind to blow the bubbles in the direction you 
want them to flow, and the walls of the canyon contain them. You can also use a gentle 
gradient on the floor of the canyon to control the flow direction, but this is somewhat 
more difficult to set up. 

Note: If the bubbles don’t follow the map, use the Simulation Quality control. Also, try 
blurring the flow map a little to make sure that it does not have excessively abrupt edges.

Flow Map Steepness  Controls the difference between white and black as they are used 
to determine steepness. If the bubbles are ricocheting randomly off the flow map, 
decrease this value.

Flow Map Fits Specifies whether the flow map is relative to the layer or to the universe. 
The flow map resizes itself to fit whichever you specify. This control is useful when you 
want to enlarge the universe but the flow map is designed for a particular layer, or when 
you want the bubbles to start off-screen and be affected by the flow map as they arrive 
on-screen.

Simulation Quality Increases the accuracy, and therefore the realism, of the simulation. 
However, the higher the value, the longer the composition takes to render. Normal 
generally produces good results and takes the least amount of time to render. High 
returns better results but takes longer to render. Intense increases the rendering time but 
produces more predictable bubble behavior. Use this option if the bubbles aren’t 
following the flow map. It often solves problems of erratic behavior that can occur with 
small bubbles, high bubble speeds, and steep slopes.

Random Seed control for the Foam effect
The Random Seed control affects all parameters that have any randomized elements in 
them. If the settings are the same, any given random-based parameter looks exactly the 
same every time you apply it. That is, you get predetermined randomness. Using a 
different Random Seed value makes things appear different while still using the same 
settings. Changing the Random Seed value doesn’t make things more or less random; it 
only makes them random in a different way. 
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Particle Playground (Pro only) 

Particles shooting out of the spacecraft layer (left) and text characters used as particles shooting out 
of a ray gun (center) and Layer Exploder used on spacecraft layer (right)

The Particle Playground effect lets you animate a large number of similar objects indepen-
dently, such as a swarm of bees or a snow storm. Use the Cannon to create a stream of 
particles from a specific point on the layer, or use the Grid to generate a plane of particles. 
The Layer Exploder and Particle Exploder can create new particles from existing layers or 
particles. You can use any combination of particle generators on the same layer.

Particle Playground is a complex effect. See the links below to find information on tasks 
associated with specific controls.

Note: Because of the complexity of Particle Playground, you may experience long compu-
tation, preview, and render times.

Overview of Particle Playground workflow (Pro only)
Start by creating a stream or plane of particles, or by “exploding” an existing layer into 
particles. Once you have a layer of particles, you can control their properties, such as 
speed, size, and color. However, the possibilities available in Particle Playground go 
beyond the obvious. For example, you can replace the default dot particles with the 
footage from an existing layer and create an entire snowstorm from a single snowflake 
layer. You can also use text characters as particles. For example, you can shoot words 
across the screen, or you can create a sea of text in which a few letters change color, 
revealing a message.

Using Particle Playground: 

1  Select the layer on which you want particles to exist, or create a new solid layer.

2  Choose Effect > Simulation > Particle Playground. The layer becomes an invisible layer 
in which only the particles are visible. Animating the layer in the Timeline window 
animates the entire layer of particles.

3  Set up a particle generator to determine how particles are created. You can shoot a 
stream of particles from the Cannon, generate a flat plane full of particles from the Grid, or 
use the Layer Exploder to create particles from an existing layer. If you’ve already created 
particles, you can apply the Particle Exploder to explode them into more new particles.

4  Select your particles. By default, Particle Playground creates dot particles. You can 
replace the dots with footage from a layer already in the composition or with text 
characters you specify.

Note: If you want to use footage from a layer as particles, see “Replacing default particles 
with layers using the Layer Map (Pro only)” on page 185. If you want to use text as 
particles, see “Replacing default particles with text (Pro only)” on page 186.
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5  Specify the overall behavior of some or all particles. Use Gravity to pull particles in a 
specified direction, Repel to push particles apart from or toward one another, or Wall to 
contain or exclude particles from a certain area.

6  Use an image to specify the behavior of individual particles. You can modify controls 
that change particle motion, such as speed and force, and controls that change particle 
appearance, such as color, opacity, and size.

For more information, see “Influencing the behavior of existing particles (Pro only)” on 
page 187, and “About Property Mappers (Pro only)” on page 190.

Particle Playground controls A. Use to generate particles. B. Use to specify footage from a layer in 
place of each default dot particle. C. Use to influence overall particle behavior. D. Use to influence 
particle properties. E. Use to set options, including those for substituting text characters in place of 
dots.

The Particle Playground effect renders with anti-aliasing when the layer to which it is 
applied is set to Best quality. It also applies motion blur to moving particles when both the 
Motion Blur switch and the Enable Motion Blur option are enabled. When you use Best 
quality and motion blur, the layer takes longer to render.

When you use another layer as a source for particles, Particle Playground ignores any 
property or keyframe changes you made to that layer within that composition, such as 
changing the Position values. Instead it uses the layer in its original state. To keep property 
or keyframe changes for a layer when you use it as a particle source, precompose the layer.

Particle content (Pro only)
Particle Playground can generate three kinds of particles—dots, footage from a layer, or 
text characters. You can specify only one kind of particle per particle generator. (See 
“Replacing default particles with layers using the Layer Map (Pro only)” on page 185 and 
“Replacing default particles with text (Pro only)” on page 186.)

The particle generators set the attributes of particles at the moment they are created. 
After that, particle behavior is influenced by the Gravity, Repel, Wall, Exploder, and 
Property Mapper controls. For example, if you want particles to stick to grid intersections, 
you might use the Static Friction option in the Persistent Property Mapper to hold 
particles in place. Otherwise, as soon as particles are created, they begin moving away 
from their original grid positions.

A

B

C

D

E
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Creating particles using Cannon, Grid, and Layer Exploder 
controls (Pro only)
Create particles by using the Cannon, the Grid, the Layer Exploder, and the Particle 
Exploder. The Grid creates particles in an organized grid format with straight rows and 
columns. The exploders create particles randomly, like firecracker sparks.

Cannon controls for the Particle Playground effect (Pro only)
The Cannon is on by default (to use a different method to create particles, first turn off the 
Cannon by setting Particles Per Second to zero). It creates particles in a continuous stream, 
as though they were shot out of a cannon. 

You can adjust the following Cannon controls:

Position Specifies the x, y coordinates from which particles are created.

Barrel Radius Sets the size of the Cannon’s barrel radius. Negative values create a circular 
barrel, and positive values create a square barrel. For a narrow source such as a ray gun, 
specify a low value. For a wide source such as a school of fish, specify a high value. 

Particles Per Second Specifies how often particles are created. A value of 0 creates no 
particles. A high value increases the density of the particle stream. If you don’t want the 
Cannon to fire continuously during the composition, set keyframes for this control so that 
the value is 0 at the times when you don’t want to create any particles.

Direction Sets the angle at which particles are fired.

Direction Random Spread Specifies how much each particle’s direction deviates 
randomly from the cannon direction. For example, specifying a 10-degree spread sprays 
particles in random directions within +/–5 degrees of the cannon direction. For a highly 
focused stream such as a ray gun, specify a low value. For a stream that widens quickly, 
specify a high value. You can specify up to 360 degrees.

Velocity Specifies the initial speed of particles in pixels per second as they emanate from 
the Cannon.

Velocity Random Spread Specifies the amount of random velocity of particles. A higher 
value results in more variation in the velocity of particles. For example, if you set Velocity 
to 20 and Velocity Random Spread to 10, particles leave the Cannon at velocities ranging 
from 15 to 25 pixels per second.

Color Sets the color of dots or text characters. This control has no effect if you use a layer 
as the particle source.

Particle Radius Sets the radius of dots, in pixels, or the size of text characters in points. 
This control has no effect if you use a layer as the particle source.

Grid controls for the Particle Playground effect (Pro only)
The Grid creates a continuous plane of particles from a set of grid intersections. The 
movement of Grid particles is completely determined by the Gravity, Repel, Wall, and 
Property Mapper settings. By default, the Force control of Gravity is on, so Grid particles 
fall toward the bottom of the frame.
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With the Grid, a new particle appears on every frame at each grid intersection. You can’t 
adjust this frequency, but if you want to turn off the Grid or make the Grid stop generating 
particles at specific times, set the Particle Radius/Font Size control to 0, or use keyframes to 
animate the value of the Particles Across and Particles Down controls. To make more 
particles appear each frame, increase the values for Particles Across and Particles Down.

Note: By default, the Cannon is on and the Grid is off. If you are using the Grid and want to 
stop the Cannon from generating particles, turn off the Cannon by setting its Particles Per 
Second value to 0.

You can adjust the following Grid controls: 

Position Specifies the x, y coordinates of the grid center. When a grid particle is created, it 
is centered over its grid intersection, regardless of whether it is a dot, a layer, or a text 
character. If you’re using text characters as particles, the Use Grid option in the Edit Grid 
Text dialog box is on by default, placing each character on its own grid intersection, so 
normal character spacing, word spacing, and kerning do not apply. If you want text 
characters to appear at the grid position with normal spacing, use a text alignment other 
than the Use Grid option. (See “Replacing default particles with text (Pro only)” on 
page 186.)

Width, Height Specify the dimensions of the grid, in pixels.

Particles Across, Particles Down Specify the number of particles to distribute horizon-
tally and vertically across the grid area. Particles are generated only when the value is 1 or 
more.

Note: If the Width, Height, Particles Across, and Particles Down controls are not available, 
the Use Grid option has been turned off in the Edit Grid Text dialog box. (See “Replacing 
default particles with text (Pro only)” on page 186.)

Color Sets the color of dots or text characters. This control has no effect if you use a layer 
as the particle source.

Particle Radius/Font Size Sets the radius of dots in pixels or the size of text characters in 
points. This control has no effect if you use a layer as the particle source. (See “Replacing 
default particles with text (Pro only)” on page 186.)

Using the Layer Exploder and Particle Exploder (Pro only)
The Layer Exploder explodes a layer into new particles, and the Particle Exploder explodes 
a particle into more new particles. In addition to explosion effects, the exploders are also 
handy for simulating fireworks or for rapidly increasing the number of particles.

The following guidelines can help you control particles resulting from an explosion:

• A layer is exploded once for each frame. By default, this creates a continuous shower of 
particles for the duration of the composition. If you want to start or stop a layer 
explosion, animate the Radius of New Particles control by using keyframes so that its 
value is zero at times when you don’t want particles to be created.

• If the source of the layer is a nested composition, you can set different Opacity values or 
In and Out points for the layers within the nested composition to make the exploding 
layer transparent at different points in time. The Layer Exploder does not create 
particles where the source of the layer is transparent.
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• To change the position of the exploding layer, precompose the layer with its new 
position (use the Move All Attributes into The New Composition option), and then use 
the precomposed layer as the exploding layer.

• When you explode particles, the new particles inherit the position, velocity, opacity, 
scale, and rotation of the original particles.

• After you explode layers or particles, the movement of particles is influenced by the 
Gravity, Repel, Wall, and Property Mapper controls.

Some Persistent Property Mapper and Ephemeral Property Mapper options can make 
explosions more realistic. For example, change Opacity to make the resulting particles 

fade out, or change the Red, Green, and Blue color channels to make resulting particles 
change color as they appear to cool. (See “About Property Mappers (Pro only)” on 
page 190.)

Layer Exploder and Particle Exploder controls (Pro only)
You can adjust the following controls for the Layer Exploder and Particle Exploder:

Explode Layer (Layer Exploder only) Specifies the layer you want to explode. To make the 
video disappear the moment the particles appear, either turn off the video for the layer or 
trim the layer’s Out point.

Radius of New Particles Specifies the radius of the particles resulting from the 
explosion. This value must be smaller than the radius of the original layer or particle.

Velocity Dispersion Specifies, in pixels per second, the maximum speed of the range 
within which Particle Playground varies the velocity of the resulting particles. High values 
create a more dispersed or cloudlike explosion. Low values keep the new particles closer 
together and can make the exploded particles resemble a halo or shock wave.

Affects Specifies which particles are affected by the Layer Exploder and Particle Exploder. 
(See “Affects controls for Particle Playground (Pro only)” on page 184.)

Affects controls for Particle Playground (Pro only)
Many Particle Playground controls include Affects controls. Affects controls specify which 
particles are affected by the encompassing control. For example, the Affects controls 
within the Particle Exploder controls specify which particles the Particle Exploder affects.

You can adjust the following Affects controls:

Particles From Specifies the particle generator or combination of particle generators 
whose particles you want affect.

Selection Map Specifies the layer map that influences which particles are affected. (See 
“About layer maps (Pro only)” on page 195.)

Note: The simulation space is not bounded by the dimensions of the layer to which 
Particle Playground is applied. You may need to use a selection map that is larger than the 
Particle Playground layer so that dots that are not visible are still affected by Selection 
Map.

Characters Specifies the characters you want to affect. This control applies only if you are 
using text characters as the particle type.
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Older/Younger Than Specifies the age threshold, in seconds, above or below which you 
want to affect a particle. Positive values affect older particles, and negative values affect 
younger particles. For example, a value of 10 means that as soon as a particle reaches 10 
seconds, it changes to the new value.

Age Feather Specifies the age range in seconds within which the Older/Younger Than 
value is feathered, or softened. Feathering creates a gradual, rather than abrupt, change. 
For example, if you set Older/Younger Than to 10 and Age Feather to 4, about 20% of 
particles start changing when they’re 8 seconds old, 50% change when they’re 10 seconds 
old (the Older/Younger Than value), and the remainder change by the time they’re 12 
seconds old.

Replacing default particles with layers using the Layer Map (Pro 
only)
By default, the Cannon, Grid, Layer Exploder, and Particle Exploder create dot particles. To 
replace the dots with a layer in the composition, use the Layer Map. For example, if you use 
a movie of a single bird flapping wings as a particle source layer, After Effects replaces all 
dots with an instance of the bird movie, creating a flock of birds. A particle source layer can 
be a still image, a solid, or a nested After Effects composition.

A multiframe layer is any layer with a source that varies over time, such as a movie or a 
composition. When you map new particles to a multiframe layer, use the Time Offset Type 
control to specify how you want to use the layer’s frames. For example, use Absolute to 
map an unchanging image onto a particle, or use Relative to map an animating sequence 
of frames onto a particle. You can randomize both Absolute and Relative across particles.

Note: When you choose a layer for Layer Map, Particle Playground ignores any property or 
keyframe changes that you made to that layer within that composition. Instead, it uses the 
layer in its original state. To keep transformations, effects, masks, rasterization options, or 
keyframe changes for a layer when you use it as a particle source, precompose the layer.

Layer Map controls for Particle Playground (Pro only)
You can adjust the following Layer Map controls:

Use Layer Specifies the layer you want to use as the particles.

Time Offset Type Specifies how you want to use a multiframe layer’s frames. For 
example, if you are using a layer of a bird flapping its wings and you choose Relative for 
Time Offset Type with a Time Offset of 0, the flapping wings for all the instances of the bird 
are synchronized. While this might be realistic for a marching band, it is not realistic for a 
flock of birds. To make each bird start flapping its wings from a different frame in the layer, 
use Relative Random. For more information, see “Time Offset Type control for Particle 
Playground (Pro only)” on page 185.

Time Offset Specifies the frame from which to start playing sequential frames from the 
layer. 

Affects Specifies which particles are affected by the Layer Map controls. (See “Affects 
controls for Particle Playground (Pro only)” on page 184.)

Time Offset Type control for Particle Playground (Pro only)
You can choose to use any of the following Time Offset Type options when using the Layer 
Map controls:
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Relative Starts playing the layer at a frame based on the Time Offset you specify, relative 
to the effect layer’s current time; then advances in step with the Particle Playground layer’s 
current time. If you specify a Time Offset of 0, all particles show the frame that corresponds 
to the effect layer's current time. If you choose a Time Offset of 0.1 (and your composition 
is set to 30 fps), each new particle displays the frame that is 0.1 seconds after the previous 
particle’s frame. Regardless of the Time Offset you specify, the first particle always displays 
the frame of the source layer that corresponds to the effect layer’s current time.

Absolute Displays a frame from the layer based on the Time Offset you specify, regardless 
of the current time. Choose Absolute when you want a particle to show the same frame of 
a multiframe source layer for its entire lifespan, instead of cycling through different frames 
as the effect layer advances in time. For example, if you choose Absolute and specify a 
Time Offset of 0, every particle shows the first frame of the source layer for its entire 
lifespan. If you want to show a frame other than the first frame, move the layer earlier in 
time until the frame you want to show corresponds to the In point of the Particle 
Playground layer. If you specify a Time Offset of 0.1, for example, each new particle 
displays a frame that is 0.1 second after that of the previous particle (or every third frame 
of a 30-fps animation).

Relative Random Starts playing the layer from a frame chosen at random, within the 
range between the effect layer’s current time and the Random Time Max you specify. For 
example, if you choose Relative Random and specify a Random Time Max of 1, each 
particle starts playing from a layer frame chosen at random from between the current 
time and 1 second after the current time. If, for another example, you specify a negative 
Random Time Max value of - 1, the Random Time Max is before the current time, so that 
the range within which new particles start playing advances as the current time advances. 
However, the range is always between the current time and one second earlier than the 
current time.

Absolute Random Takes a frame at random from the layer, by using a time between 0 
and the Random Time Max you specify. Choose Absolute Random when you want each 
particle to represent a different single frame of a multiframe layer. For example, if you 
choose Absolute Random and specify a Random Time Max of 1, each particle shows a 
layer frame from a random time between 0 and 1 second into the layer’s duration.

Replacing default particles with text (Pro only)
You can use text characters as particles. For example, you can type a message that the 
Cannon shoots across the frame. You can also change the attributes of any three sets of 
characters. For example, you can make some of the characters larger or brighter than 
others. (See “Affects controls for Particle Playground (Pro only)” on page 184.)

To replace default Cannon particles with text:

1  In the Effect Controls window, click Options.

2  Click Edit Cannon Text.

3  Type text in the text box, and then set the following options:

• For Font/Style, choose the font and style for Cannon characters.

• For Order, click to specify the sequence in which characters exit the Cannon. The 
sequence is relative to the character order typed in the text box. For example, if the 
Cannon Direction is set to 90 degrees (making it point to the right), English text must 
exit the Cannon last letter first to be in readable order. Therefore, select Right to Left.
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• For Loop Text, select to continuously generate the characters you typed. Deselect to 
generate only one instance of the characters.

4  Click OK to close the Edit Cannon Text dialog box, and then click OK to close the Particle 
Playground dialog box. 

5  Click the right-facing triangle next to Cannon so that it points downward.

6  Click the Font Size value, type a value of 10 or greater, and press Enter (Windows) or 
Return (Mac OS).

To replace default Grid particles with text:

1  In the Effect Controls window, click Options, and then click Edit Grid Text.

2  Set the following options:

• For Font/Style, choose the font and style for Grid characters.

• For Alignment, click Left, Center, or Right to position text in the text box at the Position 
specified in the Grid control, or click Use Grid to position each letter in the text on 
consecutive grid intersections.

• For Loop Text, select to repeat the characters you typed until all the grid intersections 
contain one character. Grid intersections are specified by the Particle Across and 
Particle Down controls. (See “Grid controls for the Particle Playground effect (Pro only)” 
on page 182.) Deselect to generate only one instance of the text. (This option is 
available only if you select Use Grid alignment.)

3  Type text in the text box. If Use Grid alignment is selected and you want to skip a grid 
intersection, type a space. To force the next character down to the next grid row, press 
Enter (Windows) or Return (Mac OS).

4  Click OK to close the Edit Grid Text window, and then click OK to close the Particle 
Playground dialog box.

5  Click the right-facing triangle next to Grid so that it points downward.

6  Click the Font Size value, type a value of 10 or greater, and press Enter (Windows) or 
Return (Mac OS).

To stop replacing default particles with text:

1  In the Effect Controls window, click Options.

2  Click Edit Cannon Text or Edit Grid Text, delete all text from the text box, and click OK.

Influencing the behavior of existing particles (Pro only)
After you create particles by using the Cannon, Grid, Layer Exploder, or Particle Exploder, 
you can influence the physical behavior of those particles in the following ways:

• Gravity pulls objects in a specific direction. Apply in a vertical direction to create falling 
particles such as rain or snow, or rising particles such as champagne bubbles. Apply in a 
horizontal direction to simulate wind.

• Repel prevents collisions between particles. Use Repel to push particles apart, such as 
after applying the Layer Exploder. To make particles attract, type a negative value.

• Wall contains particles within an area. Use Wall for ping-pong effects.
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Particle behavior works in conjunction with other Particle Playground controls. For 
example, if you set a Cannon particle velocity that fires particles across the frame and out 
the opposite side, you can increase the force of the Gravity control until it pulls those 
particles down before they exit the frame.

Changing a particle over its lifespan (Pro only)
Some controls affect the particle from birth: Cannon, Grid, Layer Exploder, and Particle 
Exploder. Others affect the particle after birth and over the course of its lifespan: Gravity, 
Repel, Wall, Persistent Property Mapper, and Ephemeral Property Mapper. To have full 
control over particle movement and appearance, you must balance these controls.

For example, if you want to use the Cannon to shoot sparks that fade over time, it may 
seem that you need only animate the Cannon’s Color control. However, using this method, 
you change only the color of each new particle as it’s created. To control the color for the 
lifespan of particles, you must create a layer map and use one of the Property Mappers to 
alter the particles’ color channels.

The following list covers common particle behavior and how you can influence it. (See 
“About Property Mappers (Pro only)” on page 190.)

Speed At particle creation, particle velocity is set by the Cannon and the exploders; Grid 
particles have no initial speed. After particle creation, use the Force control in the Gravity 
and Repel control groups. You can also influence the speed of individual particles by using 
a layer map to set values for the Speed, Kinetic Friction, Force, and Mass properties in the 
Property Mappers.

Direction At particle creation, the Cannon includes particle direction, the Layer Exploder 
and Particle Exploder send new particles in all directions, and Grid particles have no initial 
direction. After particle creation, direction can be influenced by the Direction control in 
the Gravity control group or by specifying a Boundary (mask) in the Wall control group. 
You can also influence the direction of individual particles by using a layer map to set 
values for the Gradient Force, X Speed, and Y Speed properties in the Property Mappers.

Area Use a Wall mask to contain particles to a different area or to remove all barriers. You 
can also restrict particles to an area by using a layer map to set values for the Gradient 
Force property in the Property Mappers.

Appearance At particle creation, the Cannon, Grid, Layer Exploder, and Particle Exploder 
set particle size unless you replace the default dots with a layer map. The Cannon and Grid 
set the initial color, while the Layer Exploder and Particle Exploder take color from the 
exploded dot, layer, or character. The Options dialog box affects the initial appearance of 
text. After particle creation, you can use the Property Mappers to set values for Red, Green, 
Blue, Scale, Opacity, and Font Size.

Rotation At particle creation, the Cannon and Grid set no rotation; the Particle Exploder 
takes rotation from the exploded dot, layer, or character. Use Auto-Orient Rotation to 
make particles rotate automatically along their respective trajectories. For instance, a 
particle can point up as it climbs an arc, and point down as it descends. Rotation isn’t 
easily visible for a dot particle. It is easier to observe only when you replace the dot 
particle with text characters or a layer. After particle creation, use a layer map to set values 
for the Angle, Angular Velocity, and Torque property in the Property Mappers. 

Note: The appearance and rotation of a layer map particle changes in relation to the 
mapped layer’s original appearance and rotation. For instance, if you replace the default 
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dot particles with a movie of a spinning wheel, the spinning-wheel particles appear to 
spin when no particle rotation is applied.

To rotate particles automatically along their trajectories:

1  In the Effect Controls window under Particle Playground, click Options.

2  Select Auto-Orient Rotation, and click OK.

Gravity controls for Particle Playground (Pro only)
Use Gravity controls to pull existing particles in a direction you specify. Particles accelerate 
in the direction of gravity.

You can adjust the following Gravity controls:

Force Specifies the force of gravity. Positive values increase the force, pulling particles 
more strongly. Negative values reduce the force.

Force Random Spread Specifies a range of randomness for the Force. At zero, all 
particles fall at the same rate. At a higher value, particles fall at slightly different rates. 
Although pure gravity accelerates all objects equally, increasing the Force Random Spread 
value can produce more realistic results with subjects such as leaves falling through air, 
where there is enough air resistance to vary the leaves’ rates of descent.

Direction Specifies the angle along which gravity pulls. The default is 180 degrees, which 
simulates the real world by pulling particles toward the bottom of the frame.

Affects Specifies a subset of the layer’s particles to which Gravity applies. (See “Affects 
controls for Particle Playground (Pro only)” on page 184.)

Repel controls for Particle Playground (Pro only)
Repel controls specify how nearby particles repel or attract each other. This feature 
simulates adding a positive or negative magnetic charge to each particle. You can specify 
which particles, layers, or characters are the repelling force and which are repelled.

Note: If you want to repel an entire layer of particles away from a specific area, use the 
Property Mapper controls, Wall or Gradient Force. (See “Wall controls for Particle 
Playground (Pro only)” on page 190 and “About Property Mappers (Pro only)” on 
page 190.)

You can adjust the following Repel controls:

Force Specifies the repel force. Greater values repel particles with more force. Negative 
values result in particle attraction.

Force Radius Specifies the radius (measured in pixels) within which particles are repelled. 
Another particle must be within this radius to be repelled.

Repeller Specifies which particles act as the repellers or attractors to another subset you 
specify by using the Affects control. (See “Affects controls for Particle Playground (Pro 
only)” on page 184.)

Affects Specifies a subset of the layer’s particles to which repulsion or attraction applies. 
(See “Affects controls for Particle Playground (Pro only)” on page 184.)
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Wall controls for Particle Playground (Pro only)
Wall controls contain particles, limiting the area within which particles can move. A wall is 
a closed mask that you create by using a mask tool, such as the pen tool. When a particle 
hits the wall, it bounces off at a velocity based on the force with which it hit.

Boundary Specifies the mask to use as the wall. You can create a new mask by drawing 
one on the effect layer.

About Property Mappers (Pro only)
You can control specific properties of individual particles by using a layer map and either 
the Persistent Property Mapper or the Ephemeral Property Mapper. You can’t alter a 
specific particle directly, but you can use a layer map to specify what happens to any 
particle that passes over a specific pixel in the layer. Particle Playground interprets the 
brightness of each layer map pixel as a specific value. (See “About layer maps (Pro only)” 
on page 195.) The Property Mapper associates a specific layer map channel (Red, Green, or 
Blue) with a specific property, so that as a particle passes over a certain pixel, the 
brightness value at that pixel modifies the property.

Persistent and Ephemeral Property Mappers (Pro only)
A particle property can be modified in either a persistent or an ephemeral way:

• A persistent change to a particle property retains the most recent value set by a layer 
map for the remaining lifespan of the particle, unless the particle is modified by 
another control such as Repel, Gravity, or Wall. For example, if you use a layer map to 
modify particle size and you animate the layer map so it exits the frame, the particles 
keep the last size value set by the layer map after it exits the frame.

• An ephemeral change to a particle property causes the property to revert to its original 
value after each frame. For example, if you use a layer map to modify particle size and 
you animate the layer map so that it exits the frame, each particle returns to its original 
size value as soon as no layer map pixels correspond to it. Similarly, if you apply an 
operator such as Add, each time a particle passes over a different layer map pixel, the 
value of the layer map pixel is added to the original value of the particle.

For more information, see “Using the Property Mappers (Pro only)” on page 190.

Using the Property Mappers (Pro only)
In combination with keyframes, the Property Mappers provide complete control over 
individual particle properties in space and time. Using layer maps, you can change particle 
properties at any location within a frame. By applying keyframes to Property Mapper 
options and animating a layer map, you can control how particle properties change. 

To use Property Mapper controls:

1  For Use Layer as Map, choose a layer map to use as the source for values that modify 
particle values. The layer map must be part of the composition. (See “About layer maps 
(Pro only)” on page 195.)

2  To apply the effect to a subset of particles, specify the Affects controls as necessary. (See 
“Affects controls for Particle Playground (Pro only)” on page 184.)
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3  Choose a property for each of the Map Red To, Map Green To, and Map Blue To controls. 
You don’t have to map properties to all of the color channels. For example, if you want to 
change scale over an image map, you can map the color red to scale without setting other 
properties.

4  Specify the minimum and maximum values you want the layer map to produce for each 
Map To group. Min is the value to which a black pixel is mapped, and Max is the value to 
which a white pixel is mapped. The complete tonal distribution between Min and Max is 
then scaled proportionally. (See “Min and Max controls for Property Mappers (Pro only)” 
on page 191.)

5  If using the Ephemeral Property Mapper, you can apply an operator the value of a 
particle property and the value of the corresponding layer map pixel. (See “Operator 
controls for the Ephemeral Property Mapper (Pro only)” on page 192.)

Note: Because particle properties use many kinds of units, such as pixels, degrees, and 
seconds, you may want to compress or expand the range of values from the layer map so 
that all the resulting values are usable in the measurement system of a specific particle 
property. First, use the Min and Max controls, which define the range of values to use from 
the layer map. If further adjustment is necessary and you’re using the Ephemeral Property 
Mapper, use the Operator control and choose a mathematical operator to amplify, 
attenuate, or limit the effect of a layer map. 

Min and Max controls for Property Mappers (Pro only)
When the overall range of layer map brightness values is too wide or narrow, use Min and 
Max to stretch, compress, or shift the range of values produced by the layer map. The 
following examples describe when you might want to adjust Min and Max:

• You want to set the smallest font size for your text to 10 points and the largest size to 96 
points. Set the Min value to 10 and the Max value to 96.

• You set the initial color of a particle and then use a layer map to change particle colors. 
If you find that the color changes aren’t dramatic enough, you can lower the Min value 
and raise the Max value to increase the contrast of the color changes.

• You set the initial velocity of a particle and then use a layer map to affect the X Speed 
value. However, you find that the difference between the fastest and slowest particles is 
too great. By raising the Min value and lowering the Max value for the layer map 
channel that is mapped to the X Speed value, you narrow the resulting range of particle 
speeds.

• You use a layer map to affect the Scale property of particles and find that the smallest 
particles aren’t small enough while the largest resulting particles are too large. In this 
case the entire output range needs to be shifted down; lower both the Min and 
Max values. 

• You have a layer map that modifies particles in the opposite direction from the one you 
want. Swap the Min and Max values, which has the same result as inverting the layer 
map.

Note: The alpha channel of the layer map is used as the selection map for the Persistent 
and Ephemeral Property Mappers. (See “Affects controls for Particle Playground (Pro only)” 
on page 184.)
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Operator controls for the Ephemeral Property Mapper (Pro only)
When you use the Ephemeral Property Mapper controls, Particle Playground replaces the 
value of a particle’s property with the value represented by the layer map pixel at the 
particle’s current location. You can also amplify, attenuate, or limit the resulting values by 
specifying a mathematical operator and then using both the value of a particle’s property 
and its corresponding layer map pixel value. 

You can choose from the following operators:

Set Replaces the value of a particle property by the value of the corresponding layer map 
pixel. This is the default operator.

Add Uses the sum of the value of a particle property and the value of the corresponding 
layer map pixel. 

Difference Uses the absolute value of the difference of the value of a particle property 
and the brightness value of the corresponding pixel on the layer map. Because it takes the 
absolute value of the difference, the resulting value is always positive. This operator is 
useful when you want to limit values to only positive values. If you’re trying to model 
realistic behavior, the Difference operator may not be ideal.

Subtract Starts with the value of a particle property and subtracts the value of the 
brightness value of the corresponding pixel on the layer map.

Multiply Multiplies the value of a particle property by the brightness value of the corre-
sponding pixel on the layer map and uses the result.

Min Compares the brightness value of the layer map to the value of the particle property 
and uses the lower value.

Max Compares the brightness value of the layer map to the value of the particle property 
and uses the higher value.

About mathematical operators (Pro only)
The following guidelines can help you decide whether you should use a mathematical 
operator: 

• To simply replace the value of a particle property with the brightness value of the corre-
sponding pixel on the layer map, use Set. This is the most predictable operator and is 
the default.

• To amplify existing values of properties, try applying the Add operator with positive 
values or the Multiply operator with values above 1.0.

• To attenuate (tone down) property value changes, try applying the Multiply operator 
using values between 0 and 1.0.

• To limit a particle property so it is less than or equal to a value, use the Min operator and 
set both the Min and Max controls to that value. If you use a white solid as a layer map, 
you need only set the Max control to that value.

Property Mapper controls (Pro only) 
In both the Persistent and Ephemeral Property Mappers, you can use a layer map’s alpha 
channel to make more subtle changes to the value of a particle property. For example, 
particles over a layer-map pixel in which the alpha channel value is 255 are fully affected, 
while lower values affect particles less. Layer-map pixels that are completely transparent 
have no effect on particle properties. (See “About layer maps (Pro only)” on page 195.)
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When you choose any of the following properties, Particle Playground copies the value 
from the layer map (that is, the layer selected in the Use Layer as a Map menu) and applies 
it to the particle.

None Modifies no particle property.

Red, Green, Blue Copy the value of the particle’s red, green, or blue channel within a 
range of 0.0–1.0.

Kinetic Friction Copies the amount of resisting force against a moving object, typically 
within a range of 0.0–1.0. Increase this value to slow down or stop moving particles as if 
braking.

Static Friction Copies the amount of inertia that holds a stationary particle in place, 
typically within a range of 0.0–1.0. At zero, a particle moves when any other force, such as 
gravity, is present. If you increase this value, a stationary particle requires more of another 
force to start moving.

Angle Copies the direction in which the particle points, in degrees relative to the 
particle’s original angle. The angle is easily observable when a particle is a text character or 
a layer without radial symmetry.

Angular Velocity Copies the velocity of particle rotation in degrees per second. This 
determines how fast a particle rotates around its own axis. 

Torque Copies the force of particle rotation. The angular velocity of a particle is increased 
by a positive torque and is increased more slowly for particles of greater mass. Brighter 
pixels affect angular velocity more forcefully; if enough torque is applied against angular 
velocity, the particle starts spinning in the opposite direction.

Scale Copies the scale value of a particle along both the x and y axes. Use this to stretch a 
particle proportionally. A value of 1.0 scales the particle to its full size; a value of 2.0 scales 
it 200%, and so on.

X Scale, Y Scale Copy the scale value of a particle along the x or y axis. Use these to 
stretch a particle horizontally or vertically.

X, Y Copy the position of a particle along the x or y axis in the frame, in pixels. A value of 
zero specifies a position at the left of the frame (for X) or at the top of the frame (for Y).

Gradient Velocity Copies the velocity adjustment based on areas of a layer map on both 
the x and y planes of motion.

X Speed, Y Speed Copy the horizontal speed (x-axis velocity) or vertical speed (y-axis 
velocity) of a particle in pixels per second.

Gradient Force Copies the force adjustment based on areas of a layer map on both the x 
and y planes of motion. The pixel brightness values in the color channel define the resis-
tance to particle force at each pixel, so the color channel acts like a layer map of hills and 
valleys that decrease or increase particle force. In the layer map, areas of equal brightness 
result in no adjustment, similar to flat land. Lower pixel values represent less resistance to 
a particle’s force, similar to a downhill grade. Higher pixel values represent more resistance 
to a particle’s force, similar to an uphill grade. For best results, use a soft-edged layer map 
image.

 If you are using a layer map for Gradient Force where flat areas equal no adjustment, 
and you are using the Min and Max controls (not the Min or Max operators) to set the 

range of values for Gradient Force, set them to positive and negative values of the same 
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number (for example, –30 and +30). This ensures that the middle of the range remains 
centered at zero.

X Force Copies the coercion along the x axis of motion. Positive values push a particle to 
the right.

Y Force Copies the coercion along the y axis of motion. Positive values push a particle 
down.

Opacity Copies the transparency of a particle, where zero is invisible, and 1 is solid. Adjust 
this value to fade particles in or out.

Mass Copies the particle mass, which interacts with all properties that adjust force, such 
as Gravity, Static Friction, Kinetic Friction, Torque, and Angular Velocity. It takes greater 
force to move particles with a larger mass.

Lifespan Copies the elapsed length of time a particle exists, in seconds. At the end of its 
lifespan, the particle is removed from the layer. The default lifespan is effectively immortal.

Character Copies the value that corresponds to an ASCII text character, making it replace 
the current particle. Applies only if you’re using text characters as particles. You can specify 
which text characters appear by painting or drawing shades of gray on the layer map that 
correspond to the ASCII characters you want. A value of zero produces no character. For 
U.S. English characters, use values between 32 and 127. The range of possible values can 
accommodate Japanese characters. For more information about the ASCII character 
values for a font you’re using, see the documentation for the font, use a utility such as 
Character Map (Windows), or contact the font manufacturer.

Note: If you simply want to make certain characters spell a message, it’s much easier to 
type the text directly in the Options dialog box. The Character property is more useful as a 
secret message effect in which you scramble text characters. (See “Replacing default 
particles with text (Pro only)” on page 186.)

Font Size Copies the point size of characters. Applies only if you’re using text characters 
as particles. Increase this value to make characters larger.

Time Offset Copies the Time Offset value used by the Layer Map. Applies only if you used 
the Layer Map control to specify a multiframe layer (such as a movie) as a particle source. 
(See “Replacing default particles with layers using the Layer Map (Pro only)” on page 185.)

Scale Speed Copies the scale of a particle. Positive values expand the particle, and 
negative values shrink the particle. Particles expand or shrink by a percent per second. 

Using layer-map RGB channels to alter multiple properties 
independently (Pro only)
In both the Persistent and Ephemeral Property Mappers, you can control up to three 
particle properties independently by using a single RGB image as a layer map. Particle 
Playground achieves this by extracting brightness values separately from the red, green, 
and blue channels in the image. You don’t have to use all three channels if you want to 
modify just one property. To change just one property or change up to three properties 
using the same values, use a grayscale image as the layer map because the RGB channels 
are identical. (See “Creating an RGB layer map (Pro only)” on page 196.)
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About layer maps (Pro only)
A layer map is an image in which each pixel’s brightness value is used by an effect in a 
calculation. Particle Playground uses a layer map to exercise precise control of a particle 
property such as opacity. In this way, After Effects doesn’t use a layer map as a picture but 
as a matrix of numbers. In many cases, you never see the actual layer map in the final 
movie—you see only the result of an effect applying the layer map’s pixel values to the 
corresponding pixels in a destination layer.

Regardless of the color depth of the image that you use as a layer map, After Effects always 
uses its red, green, and blue channels as if each were an 8-bit grayscale image. If you 
create a layer map using colors, the Property Mappers in Particle Playground can extract 
the brightness values from each RGB color channel separately. (See “Using layer-map RGB 
channels to alter multiple properties independently (Pro only)” on page 194.)

Creating a layer map (Pro only)
Layer maps are often created by painting in an image-editing program such as Adobe 
Photoshop, although you can use any program that can save an image compatible with 
After Effects. The key to creating a good layer map is to remember that the brightness 
value of each pixel influences an effect property. Here are some hints and tips for creating 
layer maps:

• If you want a layer map to match the shape of an image that already exists, simply use 
that image. For best results, create a layer map that has the same dimensions as the 
layer containing the image.

• You can create a layer map by precomposing a white solid layer, a black solid layer, and 
a mask on the top layer that determines which areas are white and black. Increasing the 
mask’s feather softens the transition between black and white values. 

• In Photoshop, an easy way to create a layer map is to create a layer with a black or white 
background, draw a selection, and fill the selection with the opposite color. Blurring the 
entire layer softens the transition between black and white values.

• You can set layer map values more precisely by painting shades of gray within a range 
from 0 (black) to 255 (white). This is the tonal range of an 8-bit channel. To simplify 
painting or drawing, see if your image-editing program provides or allows you to create 
a palette of 256 gray shades.

Note: While images created for use as displacement maps (in other effects or programs) 
often map tones to values on a scale from –127 to +127, Particle Playground interprets 
tones of gray as values on a scale from 0.0 (black) to 1.0 (white). If you’re using images 
created as displacement maps, use the Min and Max controls to modify the range of tones 
produced by the layer map. (See “Min and Max controls for Property Mappers (Pro only)” 
on page 191.)

• The alpha channel in a layer map modifies the value before it’s applied to the desti-
nation layer. Areas where the alpha channel is completely off (transparent areas of a 
layer map) don’t affect on particle values. Areas where the alpha channel has a partial 
value (semitransparent areas of a layer map) partially affect the particle value. For 
example, if a layer-map pixel has a value of 10 and the layer-map alpha channel has a 
value of 127 (50%), the layer-map pixel is affected by 50%, and its true value is 5. When 
you use the Persistent and Ephemeral Property Mappers, the actual value applied to a 
particle is also affected by the range set for the Min and Max controls. (See “Min and 
Max controls for Property Mappers (Pro only)” on page 191.)
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• If you want to change any of the layer map’s layer properties (Masks, Effects, or 
Transform), change them, precompose the layer, and then use the resulting compo-
sition as the layer map. Otherwise, Particle Playground ignores any property settings.

• The contrast between adjacent pixel values determines how smoothly the values 
change across the surface of the layer map. To create smooth changes, paint using a 
soft or anti-aliased brush, or apply gradients. To create abrupt changes, avoid interme-
diate shades, using just a few widely spaced shades such as 50% gray, black, and white.

• You can adjust overall edge contrast with blur or sharpen filters, if your painting or 
drawing program provides them.

Note: If you want to edit individual pixels, open the layer map in the program you used to 
create it and make the change.

Creating an RGB layer map (Pro only)
Particle Playground can extract brightness values separately from the red, green, and blue 
channels in an image. If you want to create different layer maps for each channel, use a 
program that can edit individual color channels, such as Adobe Photoshop, and then paint 
or paste each layer map into its own channel. Save the layer map as an RGB image in a 
format After Effects can import. The image may look unusual when viewed in RGB mode 
because it’s intended to be used as a single hidden layer containing three different layer 
maps, not as a visible color layer.

When you apply an effect that can use each color channel as a separate layer map, you can 
still use a grayscale image; the RGB channels will be identical.

If you already have three separate images, you can combine them into a single RGB 
file by using the Set Channels effect. Set Channels can load each image into its own 

channel in a combined file, making it suitable for use as an RGB layer map. 

Setting up a layer map in a composition (Pro only)
Before you apply a layer map to a particle layer, the layer map and the particle layer must 
be contained within the same composition, in a stacking order that produces the results 
you want.

To set up a layer map:

1  Add the layer map to the composition.

2  Do one of the following:

• If you want particles to be visible in front of the layer map, make sure that the layer with 
Particle Playground applied is in front of the layer map.

• If you don’t want the layer map to be visible, hide it by clicking the layer’s eye icon  in 
the Timeline window.

Animating a layer map (Pro only)
A layer map is often used as a stationary layer of the same dimensions as its destination 
layer. The value of each pixel in the layer map applies only to one specific pixel at the corre-
sponding position in the destination layer. However, when you animate a layer, the 
appearance of the pixels in the destination layer changes depending on which layer-map 
pixel corresponds to it at a particular point in time. Layer maps are often animated so that 
the layer map effect appears to sweep through the destination layer.
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Improving performance with Particle Playground (Pro only)
You can animate a large number of similar objects so that they move independently but 
produce a consistent group behavior overall, such as falling snow, swarming bees, or 
exploding fireworks. The following guidelines can help you work more efficiently:

• When you’re generating a Particle Playground effect, keep an eye on the Info palette to 
see how many particles are being produced. If an effect contains more than 10,000 
particles, it can significantly slow rendering.

• The Grid and Layer Exploder generate particles on every frame, which may generate too 
many particles for the effect you’re creating and slow down rendering. To avoid 
continuous particle generation, animate these controls to decline to zero over time: 
Layer Exploder, Radius of New Particles, Grid Width and Height, Particle Radius, and 
Font Size. Then Particle Playground generates new particles only at the start of a 
sequence.

• When you apply a Particle Playground effect to a layer, the particle positions aren’t 
limited to the bounds of that layer. To control particles that you can't see or that appear 
near the edge of the image, use a Selection or Property Map that’s larger than the area 
of the Particle Playground layer. Also, note that After Effects takes an image map’s alpha 
channel into account. If you want transparent areas of your map to affect the particles, 
precompose the map layer with a black solid behind it.

To specify field-rendering with a Particle Playground effect, select Enable Field Rendering 
in the Particle Playground options dialog box. Then Particle Playground calculates the 
simulation at double the frame rate of the current composition, which is what field 
rendering requires.

Shatter 
The Shatter effect explodes graphic images. Use the effect’s controls to set explosion 
points and adjust the strength and radius. Anything outside the radius doesn’t explode, 
leaving portions of the layer unaltered. You can choose from a variety of shapes for the 
shattered pieces and extrude the pieces to give them bulk and depth. You can even use a 
gradient layer to precisely control the order of an explosion. For example, if you import a 
logo, use Shatter to blow a logo-shaped hole in a layer. 

Original (left) and as Shatter is applied over time to reveal another layer (center and right)

The View control for the Shatter effect
The View control specifies exactly how a scene appears in the Composition window by 
using the following views:

Rendered Displays the pieces with textures and lighting—as it will look at final output. 
Use this view when rendering the animation.
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Wireframe Front View Displays the layer from a full-screen, straight-on camera angle 
with no perspective. Use this view to adjust effect points and other parameters that are 
hard to see from an angle. In addition, the outlines of the shatter map are visible so you 
can precisely position, rotate, and scale the shatter pattern. It’s handy to toggle between 
this view and the perspective view you use for the scene. 

Wireframe Displays the correct perspective of the scene, so you can quickly set up the 
camera the way you like it and fine-tune the Extrusion Depth. 

Wireframe Front View + Forces Displays the wireframe front-view representation of the 
layer, plus a blue representation of each force sphere. 

Wireframe + Forces Displays the wireframe view, plus a blue representation of the force 
spheres. This view includes camera controls, so you can position everything accurately in 
3D space.

The Render control for the Shatter effect
The Render control renders the whole scene (the default), the unshattered layer, or the 
shattered pieces independently. For example, if you want to apply the Glow effect only to 
shattered pieces and not to the portions of the layer that remain intact, create the 
explosion and duplicate the layer. Next, for the back layer, choose Layer from the Render 
menu, and for the front layer, choose Pieces. Then apply the Glow effect to the front layer.

Shape controls for the Shatter effect
Shape controls specify the shape and appearance of the shattered pieces. Adjust the 
following Shape controls for the Shatter effect: 

Pattern Specifies the preset pattern to use for the exploded pieces.

Custom Shatter Map Specifies the layer you want to use as the shape of the exploded 
pieces. See “Creating a custom shatter map” on page 204.

White Tiles Fixed Prevents pure white tiles in a custom shatter map from being 
exploded. You can use this control to force certain parts of a layer to remain intact.

Use this control when your shatter map uses images or letters such as O: Set the 
portion you don’t want to blow out, such as the centers of the O and the background, 

to pure white and set the rest to another pure color. 

Repetitions Specifies the scale of the tile pattern. This control works only in conjunction 
with the preset shatter maps, which all seamlessly tile. Increasing this value increases the 
number of pieces on the screen by scaling down the size of the shatter map. Conse-
quently, the layer breaks into more and smaller pieces. Animating this control is not 
recommended, as it can cause sudden jumps in the number and size of shatter pieces. 

Direction Rotates the orientation of a preset shatter map, relative to the layer. As with 
Repetitions, animating this control results in sudden jumps in the animation and is not 
recommended.

Origin Precisely positions a preset shatter map on the layer. This is useful if you want to 
line up portions of an image with specific shattered pieces. Animating this control results 
in sudden jumps in the animation and is not recommended.
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Extrusion Depth Adds a third dimension to the exploded pieces. The higher the value, 
the thicker the pieces. In Rendered view, this effect isn’t visible until you start the shatter 
or rotate the camera. As you set this control higher, the pieces may actually pass through 
each other. While this is generally not a problem in full-speed animations, it may become 
visible when the pieces grow very thick and move slower.

Force 1 and Force 2 controls for the Shatter effect
Force 1 and Force 2 controls define the blast areas by using two different Forces. Adjust 
the following Force controls for the Shatter effect:

Position Specifies the current center point of the blast in x,y space. 

Depth Specifies the current center point in z space, or how far in front of or behind the 
layer the blast point is. Adjust Depth to determine how much of the blast radius is applied 
to the layer. The blast radius is a sphere, and the layer is basically a plane; therefore, only a 
circular slice of the sphere intersects the plane. The farther away the layer is from the 
center of the blast, the smaller the circular slice. When pieces explode, they fly away from 
the force center. Depth determines which way the pieces fly: Positive values cause the 
pieces to explode forward, toward the camera (assuming the default camera settings of 0, 
0, 0); negative values cause pieces to blow backward, away from the camera. To see the 
result of the Depth setting, use the Wireframe + Force Sphere view.

Radius Defines the size of the blast sphere. The radius is the distance from the center of a 
circle (or sphere) to the edge. By adjusting this value, you can fine-tune exactly which 
pieces explode. Changing this value can vary the speed and completeness of the 
explosion. Animating it from small to large generates an expanding, shockwave explosion.

Note: To determine when the pieces shatter, animate the Radius control, not the Strength 
control. Pieces inside the force sphere are pulled off-screen by gravity even if Strength is set 
to 0.

Strength Specifies the speed at which the exploded pieces travel—how hard they are 
blown away from or sucked back into the blast point. A positive value blows the pieces 
away from the blast point; a negative value sucks the pieces into the blast point. The 
greater the positive value, the faster and farther they fly away from the center point. The 
greater the negative value, the faster the pieces launch themselves toward the center of 
the force sphere. Once the pieces are launched, however, they are no longer affected by 
the force sphere; the Physics settings take over. A negative Strength value does not suck 
the pieces into a black hole; instead, the pieces fly through each other and back out the 
other side of the sphere. Setting Strength very low causes the pieces to break up into 
shapes, creating cracks in the layer, but it doesn’t actually blow the pieces apart. If gravity 
is set to anything other than 0, the pieces are pulled in the direction of gravity after they 
break up.

Note: A shatter piece is made up of vertices (points or dots that define the corners of the 
shape), edges (lines that connect the dots), and planes (walls of the shape). Shatter deter-
mines when a shape has come in contact with a force sphere based on when a vertex 
comes in contact with the sphere.

Gradient controls for the Shatter effect
Gradient controls specify the gradient layer used to control the timing of an explosion and 
the pieces that are affected by the blast. Adjust the following Gradient controls for the 
Shatter effect:
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Shatter Threshold Specifies which pieces in the force sphere shatter according to the 
corresponding luminance of the specified gradient layer. If Shatter Threshold is set to 0%, 
no pieces in the force sphere shatter. If it is set to 1%, only the pieces in the force sphere 
corresponding to white (or very-nearly-white) areas on the gradient layer shatter. If it is set 
to 50%, all the pieces in the force sphere corresponding to white-to-50%-gray areas on the 
gradient layer shatter. If it is set to 100%, all pieces in the force sphere shatter. Because 
there are 256 shades of gray (including black and white), each percentage point repre-
sents approximately 2.5 shades of gray.

Animating Shatter Threshold influences the timing of the explosion. If you leave it set to 
0%, the layer never explodes. However, if you set a Shatter Threshold keyframe at 50%, the 
pieces of your layer in the force field that correspond to areas of your gradient layer that 
range from white to 50% gray explode. If you then animate Shatter Threshold up to 100%, 
the remaining pieces in the force sphere explode. 

Gradient Layer Specifies the layer to use to determine when specific areas of the target 
layer shatter. White areas shatter first; black areas shatter last. Shatter determines which 
pixels correspond to which pieces by subdividing the layer into pieces, each with a center 
point or balance point. If you superimpose the shatter map over the gradient layer, the 
gradient layer pixels that are precisely under each balance point control the explosion.

Note: Some shapes have a balance point that falls outside the actual area of the shape—
for example, the letters C and U. When designing a gradient layer in such a situation, avoid 
using grayscale versions of letters. Instead, use larger shapes that cover the balance point 
of each character.

Invert Gradient Inverts the pixel values in the gradient. White becomes black, and black 
becomes white. 

Physics controls for the Shatter effect
Physics controls specify the way the pieces move and fall through space. Adjust the 
following Physics controls for the Shatter effect:

Rotation Speed Specifies the speed at which pieces rotate around the axis set by the 
Tumble Axis control, allowing you to simulate different rotation speeds for different 
materials. In nature, similarly shaped pieces spin at different speeds based on their mass 
and air friction. For example, a brick spins faster than styrofoam.

Tumble Axis Specifies the axis that the pieces spin around. Free spins the pieces in any 
direction. None eliminates all rotation. X, Y, and Z spin the pieces only around the selected 
axis. XY, XZ, and YZ spin the pieces only around the selected combination of axes.

Note: Any application of z-axis rotation appears only when a second force hits the layer. 
The pieces do not rotate from the first blast if only z-axis rotation is selected.

Randomness Affects the initial velocities and spins generated by the force sphere.When 
this control is set to 0, pieces fly directly away from the center point of a blast (assuming a 
positive force). Since real explosions are rarely this orderly, Randomness allows you to vary 
things a little bit. 

Viscosity Specifies how fast pieces decelerate after being blown apart. The higher the 
Viscosity value, the more resistance the pieces encounter as they move and spin. If 
Viscosity is set high enough, the pieces quickly come to a stop. To replicate an explosion in 
water or sludge, set Viscosity to a high value. In air, set it to a medium value, and for an 
explosion in space, set it very low, or to 0.
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Mass Variance Specifies the theoretical weight of the pieces as they explode. For 
example, a large piece is heavier than a small piece and therefore does not fly as far or as 
fast when it encounters the blast. Mass Variance’s default setting of 30% gives a realistic 
approximation of this law of physics. Setting Mass Variance to 100% greatly exaggerates 
the difference between the behavior of large versus small pieces. Setting it to 0% makes all 
pieces behave the same, regardless of their size.

Gravity Determines what happens to the pieces after they break up and blow apart. The 
higher the gravity setting, the faster the pieces are sucked in the direction set by Gravity 
Direction and Gravity Inclination.

Gravity Direction Defines the direction in x,y space that the pieces travel when affected 
by gravity. The direction is relative to the layer. If Gravity Inclination is set to -90 or 90, 
Gravity Direction has no effect.

Gravity Inclination Determines the direction in z space that the pieces travel once they 
explode. A value of 90 explodes the pieces forward, relative to the layer. A value of -90 
explodes them backward, relative to the layer.

Textures controls for the Shatter effect
Textures controls specify the texture of the pieces. Adjust the following controls for the 
Shatter effect:

Color Specifies the color of the piece as defined by the Front Mode, Side Mode, and Back 
Mode menus. This color may or may not be visible depending on the Mode settings: When 
a Mode setting is Color, Tinted Layer, Color + Opacity, or Tinted Layer + Opacity, the 
selected color is factored into the appearance of the piece.

Opacity Controls the opacity of the corresponding Mode setting. A Mode setting must 
be Color + Opacity, Layer + Opacity, or Tinted Layer + Opacity for the opacity to affect the 
appearance of the piece. You can use the Opacity control in conjunction with texture 
maps to create the look of semitransparent materials.

Front Mode, Side Mode, Back Mode Determine the appearance of the front, sides, and 
back of the pieces. Color applies the selected Color to the applicable side of the piece. 
Layer takes the layer chosen in the corresponding Layer menu and maps it to the appli-
cable side of the piece. Tinted Layer blends the chosen layer with the selected Color; the 
effect is similar to viewing the layer through a colored filter. Color + Opacity combines the 
selected Color and the Opacity amount. With Opacity at 1, the applicable side is given the 
selected Color. With Opacity at 0, the applicable side is transparent. Layer + Opacity 
combines the chosen layer and the Opacity amount. With Opacity at 1, the chosen layer is 
mapped to the applicable side. With Opacity at 0, the applicable side is transparent. Tinted 
Layer + Opacity combines the tinted chosen layer and the Opacity amount. With Opacity 
at 1, the tinted chosen layer is mapped to the applicable side. With Opacity at 0, the appli-
cable side is transparent.

Note: If you apply Shatter to a layer containing an alpha channel that you want to use for 
transparency, use the same texture (or at least another layer with an identical alpha 
channel) for the front, sides, and back of the pieces to make all sides transparent. 
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Front Layer, Side Layer, Back Layer Specify the layer to be mapped onto the corre-
sponding side of the piece. Front Layer maps the chosen layer to the front of the piece. 
Back Layer maps the chosen layer backward to the layer. If Layer is chosen for both Front 
Mode and Back Mode, and the same layer is specified for each, each shattered piece has 
the same pixel information on both sides. Side Layer maps an extrusion of the chosen 
layer to the extruded sides of the piece, as if the chosen layer is also mapped to the front 
and back, and the layer has been sliced through.

Note: If you choose a layer with an effect applied, the effect does not show up in the 
texture unless you precompose the layer. However, if you select None, the layer to which 
you have applied Shatter, along with any effects that occur before Shatter, is used as the 
texture map, with no precomposing required. 

Camera System control for the Shatter effect
The Camera System control specifies whether to use Camera Position, Corner Pins, or 
Comp Camera. Comp Camera tracks the composition's camera and light positions and 
renders a 3D image on the layer. 

Camera Position controls for the Shatter effect
Camera Position controls specify the camera position. Adjust the following Camera 
Position controls for the Shatter effect: 

X Rotation, Y Rotation, Z Rotation Rotate the camera around the corresponding axis. 
Use these controls to look at the layer from the top, side, back, or any other angle.

X, Y Position Specifies where the camera is positioned in x,y space.

Z Position Specifies where the camera is positioned in z space. Smaller numbers move 
the camera closer to the layer, and larger numbers move the camera away from the layer. 

Focal Length Specifies the zoom factor and is like a camera’s zoom lens. Smaller numbers 
zoom the camera lens out, and larger numbers zoom the camera lens in. 

Transform Order Specifies the order in which the camera rotates around its three axes 
and whether the camera rotates before or after it is positioned using the other Camera 
Position controls. 

Corner Pins controls for the Shatter effect
Corner pinning is an alternative camera control system. Use it as an aid for compositing 
your layer into a scene. Adjust the following Corner Pins controls for the Shatter effect:

Upper Left Corner, Upper Right Corner, Lower Left Corner, Lower Right Corner  
Specify the location of each of the four corners of your layer. 

Auto Focal Length Controls the perspective of the effect during the animation. When 
Auto Focal Length is off, the focal length you specify is used to find a camera position and 
orientation that positions the corners of the layer at the corner pins. If this isn’t possible, 
the layer is replaced by its outline, drawn between the pins. When Auto Focal Length is on, 
the focal length required to match the corner points is used, if possible. If not, Focal 
Length interpolates the correct value from nearby frames. 
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Focal Length Overrides the other settings if the results you’ve obtained aren’t what you 
need. If you set Focal Length to something that doesn’t correspond to what the focal 
length would be if the pins were actually in that configuration, the image may look odd 
(strangely sheared, for example). But if you know the focal length that you are trying to 
match, Focal Length is the easiest way to get correct results.

Lighting controls for the Shatter effect
Lighting controls specify the lighting for the Shatter effect. Adjust the following Lighting 
controls:

Light Type Specifies which type of light you want to use. Distant Source simulates 
sunlight and casts shadows in one direction, where all the light rays strike the object from 
virtually the same angle. Point Source is similar to a light bulb and casts shadows in all 
directions. First Comp Light uses the composition’s first light layer, which can use a variety 
of settings. 

Light Intensity Specifies the power of the light. The higher the value, the brighter the 
layer. Other lighting settings affect the overall light intensity as well.

Light Color Specifies the color of light. 

Light Position Specifies the position of the light in x,y space. 

Light Depth Specifies the position of the light in z space. Negative numbers move the 
light behind the layer. 

Ambient Light Distributes light over the layer. Increasing it adds an even illumination to 
all objects and prevents shadows from being totally black. Turning Ambient Light all the 
way to pure white, and setting all other light controls to 0, makes the object fully lit and 
eliminates any 3D shading from the scene.

Material controls for the Shatter effect
Material controls specify the reflection values of the pieces. Adjust the following Material 
controls:

Diffuse Reflection Gives objects form-defining shading. Shading depends on the angle 
at which the light strikes the surface, and is independent of the viewer’s position.

Specular Reflection Takes into account the position of the viewer. It models the 
reflection of the light source back to the viewer. It can create the illusion of shininess. For 
realistic effects, you can animate this control by using higher and higher values to mask 
the transition from filtered to nonfiltered versions of the layer.

Highlight Sharpness Controls shininess. Very shiny surfaces produce small tight reflec-
tions, while duller surfaces spread the highlight out into a larger region. Specular 
highlights are the color of the incoming light. Because light is typically white or off-white, 
broad highlights can desaturate an image by adding white to the surface color. 

In general, use the following process to adjust lighting: Set the Light Position and 
Diffuse Reflection to control the overall light level and shading in a scene. Then, adjust 

Specular Reflection and Highlight Sharpness to control the strength and spread of 
highlights. Finally, adjust Ambient Light to fill in the shadows. 
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Creating a custom shatter map
All layers in After Effects are represented as an RGBA image (even black-and-white 
images). The Shatter effect calculates the luminance threshold of each channel to create a 
custom shatter map. Shatter calculates the 50% luminance threshold of each channel, 
creating an image composed of only eight colors: red, green, blue, yellow, magenta, cyan, 
white, and black. These eight colors become possible combinations of the channels set 
either all the way on (255) or all the way off (0). The shatter layer splits along the edges of 
these different colored sections.

When designing custom shatter maps, it can be useful to manually set a threshold for each 
channel of the image at 50% (you can use the Curves effect to do this). When you set the 
threshold you can see how the image will be broken into pieces. Alternatively, you can 
create custom shatter maps by drawing an image using only the eight colors listed above, 
with no intermediate shades or anti-aliasing.

The alpha channel determines whether or not a shattered piece exists. A white alpha 
channel value results in a shattered piece, and a black alpha channel value results in no 
piece. Using an alpha channel, you can make a tile map with holes in it or generate simple 
3D models like extruded text. 

Note: The custom shatter map determines the shapes of the pieces your layer shatters 
into, but not when the pieces shatter. The timing is determined by the Force controls and 
can be further controlled by a gradient layer.

Wave World 
The Wave World effect is available from the Adobe Web site (www.adobe.com) after you 
register your copy of After Effects. Use this effect to create a grayscale displacement map 
for use with other effects such as Colorama or Caustics. This effect creates physics-based 
liquid waves. Waves emanate from an effect point, interact with each other, and realisti-
cally reflect off their environment. Use Wave World to create a top-down view of a logo, 
with waves reflecting off the logo and the sides of the layer. 

Wireframe view (left), Height Map view (center), and resulting image (right). The result is used as the 
Water Surface source for the Caustics effect example.

Wireframe view (left), Height Map view (center), and resulting image (right). The result is used as the 
Input Phase for the Colorama effect example.
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To understand how this effect works, consider the following information about the physics 
of waves: A wave consists of a peak and a trough. The amplitude of a wave is the height, or 
distance, between the peak and trough. The wavelength is the distance from one peak to 
the next. Frequency is the number of waves per second passing a fixed point. 

View controls for the Wave World effect
View controls specify the method used to preview the Wave World effect. Choose one of 
the following views:

Height Map Is a grayscale image that displays the highest points as bright pixels and the 
lowest points as dark pixels. Use this view when creating a displacement map.

Wireframe Preview  Provides a visual depiction of how the wave is being created. The 
grayscale output represents a height map: White represents the highest possible wave, 
and black represents the lowest. The two rectangular outlines represent these two 
extremes: The cyan rectangle represents pure white, and the violet rectangle represents 
pure black. The green grid represents the ground layer; it is flat by default but can be 
distorted by using a grayscale image. The white grid represents the surface of the water.

Wireframe Controls for the Wave World effect
Wireframe Controls fine-tune the appearance of the wireframe model. These controls do 
not affect the grayscale output. Horizontal Rotation rotates the wireframe preview around 
the horizontal axis (right and left). As you adjust this control, the distortion of the 
wireframe model keeps the entire wireframe model in full view. Vertical Rotation rotates 
the wireframe preview around the vertical axis (up and down). Vertical Scale distorts the 
wireframe preview vertically so that you can see heights more easily. It does not affect the 
grayscale output.

Height Map controls for the Wave World effect
Height Map controls specify the appearance of the height map.

Note: While adjusting Brightness and Contrast, keep the wave surface layer between the 
cyan and violet rectangles. If a peak pokes through the cyan rectangle, it clips at pure 
white. If a trough pokes through the bottom of the violet rectangle, it clips at pure black. If 
you want to create a displacement map, try to avoid clipping because it shows up as flat 
peaks and valleys, which look unnatural.

Adjust the following Height Map controls:

Brightness Adjusts the overall height of the water surface. Adjusting it brightens or 
darkens the overall grayscale output. When you use Wave World for displacement, this 
control moves the surface of the water up or down.

Contrast Changes the difference between the grays of the peaks and troughs, making 
the difference more or less extreme. Lower values even out the grays, and higher values 
create a wider range from black to white (until clipping occurs). 

Gamma Adjustment Controls the slope of the waves in relation to the Brightness. 
Results are visible only in Height Map view. Higher values result in rounder peaks and 
narrower valleys, while lower values result in smoother valleys and pointier peaks.

Render Dry Areas As Specifies how the water surface is rendered when a dry area exists. 
Dry areas are created when a portion of the ground layer rises above the surface of the 
water. You can manipulate the dry area by using the Steepness control.
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This control is useful for compositing a Wave World effect into a scene. For example, you 
can use a precomposed Wave World scene with transparency as a displacement map for 
the Caustics effect, and as a track matte for the effect layer.

Transparency Controls the clarity of the water by adjusting how opaque the alpha 
channel is in shallower areas. For example, you can easily see to the bottom of a pool filled 
with fresh water, but you can see only an inch or two into a pool filled with coffee. This 
control is most useful when compositing a Wave World effect into another scene. For 
example, you can use a Wave World composition as a source layer for Caustics, and also as 
a track matte for the effect layer.

Simulation controls for the Wave World effect
Adjust the following Simulation controls to specify the resolution of the water surface and 
ground grids:

Grid Resolution Specifies the number of horizontal and vertical divisions that make up 
the wave surface and ground grids. Higher values greatly increase the accuracy of the 
simulation but require more memory and increase rendering time. 

Grid Res Downsamples Reduces the internal simulation resolution when the output 
resolution decreases, increasing the rendering speed. However, this may cause the output 
to look significantly different.

Wave Speed Specifies how fast waves travel away from their starting point.

Damping Specifies how quickly a wave’s energy is absorbed by the liquid it is travelling 
through. The higher the value, the quicker the wave energy is absorbed, and the shorter 
the distance the wave travels.

Wave Speed, Damping Specify the apparent viscosity of the liquid, and the apparent size 
of the body of liquid. For example, waves in water move faster and farther than waves in 
honey; waves in a sink move much faster and fade out much more quickly than waves in a 
lake.

Note: Wave World is optimized for small-to-medium-sized bodies of water—anything 
from a teacup to a small lake. Large bodies of water, like an ocean, include swells, or wide, 
stable waves with no apparent slowdown. Even at the lowest settings, Wave World cannot 
generate swells because the waves fade out relatively quickly. 

Reflect Edges Specifies how waves bounce off the edges of the layer and back into the 
scene.

Pre-roll (seconds) Specifies when the waves start moving. By default, the effect starts 
with a still surface without waves or ripples. Use this control to start the waves moving 
before the layer begins. The settings at the first frame of the effect are applied to the layer 
during the Pre-roll.

Ground controls for the Wave World effect
Adjust the following Ground controls to specify the appearance of the ground layer:

Ground Specifies the layer that appears at the bottom of the water. If you use an 
animated layer for the ground, Wave World samples only the first frame. Wave World deter-
mines the intersection of the water’s surface with the edge of the ground, computes the 
waves bouncing off the shore, and properly adjusts the speed of the waves depending on 
the depth. The ground surface is determined by the layer’s brightness: White represents 
higher elevation, and black represents lower elevation.
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Steepness Adjusts the steepness of the ground by expanding and contracting the height 
of the displaced wireframe. The mesh is locked at the black level, so it always grows up 
from the bottom—in other words, you cannot adjust the bottom of a canyon to be 
deeper; you can only adjust the rim to be higher. To make the canyon deeper, combine a 
higher Steepness setting with a lower Height setting.

Height Controls the distance between the water surface and the ground’s deepest 
possible point. Use this control to make the body of water deeper or shallower. When you 
change the depth of the water, the waves behave accordingly: They move faster in deep 
water and slower in shallow water. (Adjusting the Height control when using the 
wireframe preview may appear to lower the ground level, but the wireframe camera 
always moves with the water level.)

Wave Strength Controls how big the resulting waves are when the ground height or 
steepness is animated. A value of 0 results in no waves. 

Note: You can create a pulsing wave effect by animating the ground’s steepness so that 
the ground pokes through the water, producing waves. Then use the Wave Strength 
control to intensify the effect.

Producer 1 and Producer 2 controls for the Wave World effect
Adjust the Producer controls to specify the point at which the waves begin:

Type Specifies the type of producer. Ring creates a wave as if a stone were dropped into a 
pond; waves radiate outward in circles (or ovals, depending on the size settings of the 
effect point). Line creates waves that emanate from the producer’s position in a line 
instead of an oval. This is useful for creating waves that look as though they were 
generated from much farther away. The waves are produced perpendicular to the edges 
of the line. The length of the line is based on the Height/Length setting.

Position Specifies the location of the center of the wave producer.

Height/Length Specifies the (vertical) height of a Ring producer and adjusts the length 
of a Line producer.

Width Specifies the (horizontal) width of the producer area. 

Angle  Specifies the angle of the wave producer area for the Line and Ring types. This 
control sets the orientation of the line and thus controls the initial direction of the waves, 
which emanate from either side of the line, perpendicular to its length.

Amplitude Controls the height of the produced wave. Higher values create more 
dramatic waves but may result in clipping, which you can repair by using the Brightness 
and Contrast controls.

Frequency Controls how many waves are produced per second. A value of 1 has the 
effect of waves surfacing once every second.

Phase Specifies where in the wave phase the wave actually begins. For example, with the 
default setting of 0˚, the first disturbance in the liquid is a convex wave (projecting upward 
from the surface of the water). With Phase set to 180˚, the first disturbance in the liquid is a 
concave wave.
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Stylize effects

Brush Strokes
The Brush Strokes effect applies a rough painted look to an image. You can also use this 
effect to achieve a pointillist style by setting the length of the brush strokes to 0 and 
increasing the stroke density. Although you specify the direction of strokes, they are 
scattered randomly by a small amount to give a more natural effect. This effect alters the 
alpha channel, as well as the color channels; if you have masked out a portion of the 
image, the brush strokes “paint” over the edges of the mask.

Original (left) and after applying the Brush Strokes effect (center) and adjusting Brush Size and 
Length (right)

Brush Strokes controls
Adjust the following controls for the Brush Strokes effect:

Stroke Angle Specifies the direction in which the strokes are made. The image is effec-
tively shifted in this direction, which may cause some clipping at the layer boundaries. To 
avoid this, place the layer you want to brush into a larger composition, and then apply the 
Brush Strokes effect to the composition.

Brush Size Specifies the size of the brush in pixels.

Stroke Length  Indicates the maximum length of each stroke, in pixels. If Stroke 
Randomness is not 0, the actual length of any given stroke may be slightly less than this 
maximum length.

Stroke Density Higher densities result in overlapping brush strokes and interesting 
visual effects.

Stroke Randomness Creates non-uniform strokes. The more randomness, the more the 
strokes vary from the brush and stroke settings you’ve specified.

Paint Surface Specifies where brush strokes are applied. Paint on Original Image puts the 
strokes on top of the unmodified layer. This is the default setting. Paint on Transparent 
causes only the strokes themselves to appear, leaving the layer transparent between the 
strokes. Paint on White and Paint on Black let you apply your strokes over a white or black 
background.
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Blend With Original Specifies the percentage of effect applied—the higher you set this 
value, the more of the original layer you can see in the background. For example, if you set 
this value to 50%, 50% of the original layer shows through the effect; if you set this value 
to 100%, the effect has no affect on the layer. If you want to create an affect of a rainstorm, 
set this value to about 50%.

Color Emboss
The Color Emboss effect works like the Emboss effect, without suppressing the image’s 
original colors.

Original (left) and after applying the Color Emboss effect (center) and adjusting the Direction (right)

Emboss
The Emboss effect sharpens the edges of objects in the image and suppresses colors. The 
effect also highlights the edges from a specified angle. The layer’s quality setting influ-
ences the Emboss effect by controlling the Relief setting. Relief is calculated at the 
subpixel level in Best quality and rounded off to the pixel level in Draft quality.

The Direction control specifies the apparent direction from which the highlight source is 
shining, in degrees. A setting of 45˚ causes the shadow to be cast from the northeast 
direction. Relief specifies the apparent height of the embossing, in pixels. The Relief 
setting actually controls the maximum width of highlighted edges. Contrast specifies the 
sharpness of the image content’s edges. At lower settings, only distinct edges show the 
effect. As you increase the setting, the highlight becomes more extreme. Blend With 
Original specifies the total amount of effect applied to the layer.

Original (left) and after applying the Emboss effect (center) and decreasing the Blend With Original 
value (right)

Find Edges
The Find Edges effect identifies the areas of the image that have significant transitions and 
emphasizes the edges. Edges can appear as dark lines against a white background or 
colored lines against a black background. When the Find Edges effect is applied, images 
often look like sketches or photographic negatives of the original.
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The Invert option inverts the image after the edges are found. When selected, edges 
appear as bright lines on a black background; when not selected, edges appear as dark 
lines on a white background. Blend With Original specifies the total amount of effect 
applied to the layer.

Original (left) and after applying the Find Edges effect with Invert selected (center) and with Invert 
unselected and Blend with Original value adjusted (right)

Glow (Pro only)
The Glow effect finds the brighter parts of an image and then brightens those and 
surrounding pixels to create a diffuse, glowing halo. The Glow effect can also simulate 
overexposure of brightly lit objects. You can base the glow on either the original colors of 
the image or on its alpha channel. Glows based on alpha channels produce diffuse 
brightness only at the edges of the image, between the opaque and transparent regions. 
You can also use the Glow effect to create a gradient glow between two colors and to 
create multicolor effects with looping.

Rendering the Glow effect at Best quality can change the appearance of the layer. This is 
especially true if you are using Adobe Photoshop arbitrary maps to color your glows. Be 
sure to preview your Glow effect at Best quality before you render it.

Original (left) and with Composite Original set to Behind and Glow Colors set to Original Colors 
(center) and with Composite Original set to On Top and Glow Colors set to A & B colors (right) 

Glow controls
Adjust the following controls for the Glow effect:

Glow Based On Specifies the properties on which you want to apply the glow.

Glow Threshold  Sets a threshold as a percentage brightness to which the glow is not 
applied. A lower percentage produces more glow; a higher percentage produces less.

Glow Radius Specifies the radius, in pixels, that the glow extends out from the bright 
areas of the image. Larger values produce diffuse glows; smaller values produce glows 
with sharp edges.

Glow Intensity Sets the brightness of the glow. Higher values produce brighter glows.
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Composite Original Specifies how to composite the effect with the layer. On Top places 
the glow on top of the image, using the blending method selected for Glow Operation. 
Behind places the glow behind the image, creating a backlighting effect. None separates 
the glow from the image.

To reduce the layer to the glow only, choose None for Composite Original and None 
for Glow Operation. To achieve a glow effect for text that knocks out (blocks) all layers 

below it, choose Silhouette Alpha for Glow Operation. These glow effects are more 
noticeable when the image has a feathered edge.

Glow Colors Specifies the colors that glow. A & B Colors creates a gradient glow using the 
colors specified by using the Color A and Color B controls. Arbitrary Map creates a gradient 
glow using colors specified in an arbitrary map file created using the Curves dialog box in 
Adobe Photoshop. Selecting this option displays a standard Open dialog box for locating 
the arbitrary map file. For information about arbitrary maps, see the Adobe Photoshop 
online Help topic “Using the Curves command.”

Color Looping Specifies the beginning and ending colors for the glow, if A & B Colors is 
selected for Glow Colors. The Sawtooth options begin with one color and end with the 
second color. The Triangle options begin with one color, move to another, and then end 
with the first.

Color Loops Creates multicolor ringing in the glow, when you select two or more loops. A 
single loop cycles through the gradient (or arbitrary map) specified for Glow Colors.

Color Phase Begins color loops at a specific point in the cycle. Specify a phase angle in 
the Color Phase control. By default, color loops begin at the origin of the first loop.

A & B Midpoint Specifies the midpoint of the gradient if you’ve selected A & B Colors for 
Glow Colors. The midpoint specifies the balance between the two colors used in the 
gradient. Lower percentages use less of the A color. Higher percentages use less of the B 
color. 

Color A, Color B Specify the colors that glow.You can choose to use these colors by 
choosing them from the Glow Colors menu.

Glow Dimensions Specifies whether the glow is horizontal, vertical, or both.

Using the Glow effect
The following procedures provide a basic overview of how to use this effect. 

To apply a basic glow using original colors:

1  Select the layer, and choose Effect > Stylize > Glow.

2  In the Effect Controls window, choose Glow Based On > Color Channels.

3  Adjust the Glow controls as desired.

4  For Composite Original, choose On Top.

5  For Glow Operation, choose Add.

6  For Glow Colors, choose Original Colors.

To apply a basic glow based on the alpha channel:

1  Select the layer, and choose Effect > Stylize > Glow.

2  In the Effect Controls window, choose Glow Colors > A & B Colors.
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3  For Glow Based On, choose Alpha Channel. 

4  Choose an option for Composite Original.

Leave Color
The Leave Color effect removes all the colors from a layer except those similar to a given 
color. For example, a movie of a basketball game could be decolored except for the orange 
of the ball itself. The layer’s quality setting does not affect Leave Color.

Original (left) and after applying the Leave Color effect (center and right)

Adjust the following controls for the Leave Color effect:

Amount to Decolor Specifies how much color is removed from the layer. A setting of 
100% causes the areas of the image dissimilar to the selected color to appear as shades of 
gray. At 50%, those areas lose half of their color saturation.

Color to Leave Specifies the color that is to be left untouched.

Tolerance Specifies how closely the effect matches colors. A value of 0% decolors all 
areas of the image except those that match the Color to Leave exactly. A value of 100% 
causes no color change.

Edge Softness Specifies the sharpness of the color boundaries. High values smooth the 
transition from color to gray.

Match Colors Specifies the color model to use for similarity. RGB uses the RGB color space 
to determine which areas are decolored. Match Colors is a strict matching technique and 
usually decolors more of the image than Hue. Hue uses hue (color) to determine which 
areas are decolored. In other words, choosing light blue as the Color to Leave also leaves 
dark blue, since both colors have the same hue.

Mosaic
The Mosaic effect fills a layer with solid color rectangles. It is useful for simulating low-
resolution displays and for obscuring faces. You can also animate it for a transition. At Best 
quality, the edges of the mosaic are anti-aliased.



Using Help | Contents | Index Back 213  

Adobe After Effects Help Stylize effects 

Using Help | Contents | Index Back 213  

The Horizontal/Vertical Blocks options specify the number of mosaic divisions in each 
direction. Use the Sharp Colors option to give each tile the color of the pixel in its center in 
the unaffected layer; otherwise, the tiles are colored with the average color of the corre-
sponding region in the unaffected layer.

Original (left) and after applying the Mosaic effect (center and right)

Motion Tile
The Motion Tile effect replicates the source image across the output image. It is called 
Motion Tile because, when changing the placement of the tiles, it uses motion blur to 
accentuate the movement if motion blur is enabled. Tile Center controls the position of 
the main tile. 

Original (left), with Motion Tile applied to the saucer layer (center), and with Motion Tile applied to 
the background layer (right)

Adjust the following controls for the Motion Tile effect:

Tile Center Specifies the area on the layer that becomes the center of the tile.

Tile Width, Tile Height Specify the size of the tiles as a percentage of the input.

Output Width, Output Height Specify the size of the output image, or modified layer, as 
a percentage of the input.

Mirror Edges When Phase is set to 0, selecting this causes the edges of the layer to be 
mirrored with the surrounding tiles.

Phase Controls the horizontal or vertical shift of the tiles that are adjacent to the main 
tile.

Horizontal Phase Shift Applies horizontal shifting to the tiles instead of vertical shifting.
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Roughen Edges
The Roughen Edges effect roughs up the edges of a layer’s alpha channel by using calcula-
tions. It gives rasterized text or graphics a naturally rough look, like that of eroded metal or 
typewriter text. 

Original (left) and Edge Type set to Roughen (center) and Rusty Color (right) with all controls set to 
maximum values

Roughen Edges controls 
Adjust the following controls for the Roughen Edges effect:

Edge Type Specifies how the effect is applied to the alpha channel. If you choose an 
option that uses color, such as Photocopy Color, specify the color using the Edge Color 
control.

Edge Color  Fills the effect areas with this color when you choose an Edge Type that uses 
color, such as Roughen Color.

Border Specifies how far from an alpha channel edge the effect extends.

Edge Sharpness Specifies how sharp or soft the roughened edge appears. Low values 
create softer edges, and high values create sharper edges.

Fractal Influence Specifies how much of the introduced roughness is influenced by 
fractal calculations.

Scale Specifies the scale of the fractal used to calculate the roughness.

Stretch Width or Height Specifies the width or height of the fractal used to calculate the 
roughness.

Offset (Turbulence) Specifies the portion of the fractal shape that is present in the 
Composition window, altering the shape of the distortion or roughness applied to your 
layer. Because the fractal shapes generated by this effect are infinite in all directions, the 
result that appears on the layer is only a small portion of the entire fractal. Animating the 
Offset control repositions the fractal, bringing a different portion of it into view. This alters 
the shape and texture of the roughness.

Complexity Specifies the level of detail in the roughness. Higher Complexity values 
increase the detailed definition in the texture of the roughness. Lower Complexity values 
reduce the definition.

Note: Increasing complexity results in longer rendering times. Reduce the Scale value 
rather than increasing Complexity to achieve similar results.

Evolution See “Evolution controls for the Roughen Edges effect” on page 214.

Evolution controls for the Roughen Edges effect
You can adjust the following Evolution controls:
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Evolution Creates subtle changes in the shape of the roughness. Animating this setting 
results in smooth changes or “evolution” of the roughness over time. Set keyframes for 
Evolution to determine how much the roughness will “evolve” over the period of time 
between keyframes. The more revolutions in a given amount of time, the more rapidly the 
roughness changes. Higher Evolution values may result in less smooth changes in the 
roughness.

Note: Although the Evolution value is set in units called “revolutions,” it is important to 
realize that these revolutions are progressive. The Evolution state continues to progress 
infinitely at each new value. Use the Cycle Evolution option (explained below) to return the 
Evolution setting to its original state at each revolution.

Evolution Options Evolution Options provide controls that render the effect for one 
short cycle and then loop it for the duration of your project. Use these controls to 
prerender your roughen elements into loops, and thus speed up rendering time.Use the 
following controls to create a smooth, progressive, nonrepeating loop:

• Cycle Evolution creates a loop that forces the evolution state to return to its starting 
point.

• Cycle is available only when you select Cycle Evolution. It specifies the number of 
revolutions (of the Evolution setting) that the fractal noise cycles through before it 
repeats. For example, if you set the evolution to occur over five revolutions and you set 
the Cycle value to 2, then the evolution loops twice. The timing or speed of these 
Evolution cycles is determined by the amount of time allowed between Evolution 
keyframes.

Note: The Cycle control affects only the state of the fractal, not geometrics or other 
controls. For example, two identical states of the fractal will not appear the same if viewed 
with different Size or Offset settings.

• Random Seed specifies a unique random value from which to generate the roughness 
texture. Animating this property results in flashing from one set of fractal shapes to 
another within the same fractal type. For smooth transition of the roughness, use the 
Evolution control.

Note: Create new roughness animations by re-using previously created Evolution cycles 
and changing only the Random Seed value. Typing a new Random Seed value alters the 
noise pattern without disturbing the evolution animation.
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Scatter (Pro only)
The Scatter effect scatters the pixels in a layer, creating a blurry or smeared appearance. 
Without changing the color of each individual pixel, the Scatter effect redistributes the 
pixels randomly, but in the same general area as their original positions. You can automat-
ically animate the Scatter effect over the time range without keyframes by randomizing 
every frame.

Original (left), after applying Scatter (center), and then applying the Noise effect (right)

Adjust the following controls for the Scatter effect:

Scatter Amount Specifies the amount of scattering. Higher values produce more blur.

Grain Specifies the direction in which to scatter the pixels—horizontally or vertically. 
Select None to scatter pixels in all directions.

Scatter Randomness Specifies whether scattering changes at each frame. To animate 
scattering without keyframes, select the Randomize Every Frame option. If this option is 
not selected, scattering remains the same at each frame unless keyframes are created for 
the Scatter Amount and Grain properties.

Strobe Light
The Strobe Light effect performs an arithmetic operation on a layer at periodic or random 
intervals. For example, every five seconds the layer could appear completely white for 
one-tenth of a second, or a layer’s colors could invert at random intervals. The layer’s 
quality setting does not affect Strobe Light.

Adjust the following controls for the Strobe Light effect:

Strobe Color Specifies the color of the light.

Blend With Original Specifies the percentage of the entire effect that is applied to the 
layer. 

Strobe Duration Specifies in seconds how long a strobe effect lasts.

Strobe Period Specifies in seconds the duration between the start of subsequent 
strobes. For example, if the Strobe Duration is set to 0.1 second and the Strobe Period is 
set to 1.0 second, the layer will have the effect for 0.1 second and then be without the 
effect for 0.9 seconds. If this value is set lower than the Strobe Duration, the strobe effect is 
constant.

Random Strobe Probability Specifies the probability that any given frame of the layer 
will have the strobe effect, giving the appearance of a random effect.

Strobe Specifies how the effect is applied. Operates on Color Only performs the strobe 
operation on all color channels. Make Layer Transparent makes the layer transparent when 
a strobe effect occurs.
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Strobe Operator Specifies the arithmetic operator to use when Operates on Color Only is 
selected from the Strobe menu. The default setting is Copy.

Texturize
The Texturize effect gives a layer the appearance of having the texture of another layer. For 
example, you could make the image of a tree appear as if it had the texture of bricks, and 
control the depth of the texture and the apparent light source. At Best quality, the texture 
layer is positioned and scaled with subpixel accuracy.

Original layers (left and center) and with center applied as the texture (right)

Adjust the following controls for the Texturize effect:

Texture Layer Specifies the layer you want to use as the texture.

Light Direction Specifies the angle at which light hits the texture. This setting affects 
where shadows appear.

Texture Contrast Specifies how distinct the texture appears on the effect layer.

Texture Placement Specifies how the effect is applied. Tile Texture applies the texture 
repeatedly over the layer. Center Texture positions the texture in the middle of the layer. 
Stretch Texture to Fit stretches the texture to the dimensions of the selected layer.

Write-on 
The Write-on effect animates strokes on a layer. For example, you can simulate the writing 
of cursive text or create snakelike movement for a stroke. Using the Write-on effect, you 
can animate the brush size, color, hardness, and opacity of a stroke. 

Animating the Write-on effect

Other methods of animating paint strokes and text are also available. For example, you 
can animate text by using the text tool and text animators (see “Animating text” in the 
After Effects online Help), and you can animate paint strokes by using either of the paint 
effects: Paint and Vector Paint (see “Vector Paint (Pro only)” on page 123 and the “Using 
Paint Tools” chapter in the After Effects online Help).
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Write-on effect controls
Adjust the following controls for the Write-on effect:

Brush Position Specifies where the stroke begins.

Color, Brush Size, Brush Hardness, and Brush Opacity Specify the size and appearance 
of the stroke.

Stroke Length Specifies the length, in seconds, of the stroke at any moment. If this value 
is 0, the stroke has unlimited length. Use a single stroke length (not 0) for all keyframes to 
create a snakelike movement of the stroke across the layer. Change the stroke length at 
keyframes to make the length of the stroke expand and contract as it is drawn.

Brush Spacing Specifies the time interval, in seconds, between dabs of color as the 
stroke is drawn. Smaller values produce smoother paint strokes but take more time to 
render.

Paint Time Properties Specifies whether paint properties (color and opacity) are applied 
to each stroke segment or to the entire stroke. None applies color and opacity specified at 
each keyframe to the entire stroke. Color applies the color specified at a keyframe to the 
stroke starting at that keyframe until it is changed at a later keyframe. The opacity 
specified at each keyframe is applied to the entire stroke. Opacity applies the opacity 
specified at a keyframe to the stroke starting at that keyframe until it is changed at a later 
keyframe. The color specified at each keyframe is applied to the entire stroke.

Brush Time Properties Specifies whether brush properties (size and hardness) are 
applied to each stroke segment or to the entire stroke. None applies the brush size and 
hardness specified at each keyframe to the entire stroke. Size applies the brush size 
specified at a keyframe to the stroke starting at that keyframe until it is changed at a later 
keyframe. The hardness specified at each keyframe is applied to the entire stroke. 
Hardness applies the hardness specified at a keyframe to the stroke starting at 
that keyframe until it is changed at a later keyframe. The size specified at each keyframe 
is applied to the entire stroke. Size & Hardness applies both the brush size and hardness 
specified at a keyframe to the stroke starting at that keyframe until they are changed at a 
later keyframe.

Paint Style Specifies whether the stroke is applied to the original layer or to a transparent 
layer. 
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Text effects

Basic Text
Using the Basic Text effect, you can create text and text animation. You can specify font, 
style, and alignment of text, as well as select horizontal or vertical text orientation. 
Animation is created by changing the Position point over time. Basic Text also gives you 
the choice of either compositing the text over the layer image or using the text by itself. 
Best quality creates anti-aliased text that animates smoothly.

Original (left) and after applying Basic Text (center) and selecting Composite on Original (right)

The Basic Text effect places text on an existing layer (unlike imported text created in 
Adobe Photoshop or Adobe Illustrator, which becomes its own layer). This effect can be 
used for basic title text; for more flexibility in working with text, import text created in an 
illustration or imaging program. The font you select when creating text must be available 
on the system you use to render the composition. If the font is not available, an available 
font is substituted. After Effects creates an alpha channel for text it creates. You can use a 
text effect’s alpha channel with features such as track matte. 

Note: The width and height of text are not constrained by the dimensions of the layer; the 
layer dimensions merely define the visible region of the text. This feature makes it simple to 
scroll text over a layer.

Basic Text controls
The following options and values are available in the Basic Text dialog box, which opens 
automatically when you apply the effect: Font, Style, Direction, Alignment, and Show Font. 
To edit the text after you close this dialog box, click Edit Text in the Effect Controls window. 
Adjust the following controls after you close the Basic Text dialog box: 

Position Specifies the position of the text in the composition.

Note: The behavior of the Position point is affected by the Alignment setting in the Basic 
Text dialog box. The point always positions the vertical center of the text relative to the 
layer. However, if the text is left-aligned, the point positions the left edge; if the text is 
center-aligned, the point positions the center; and if the text is right-aligned, the point 
positions the right edge.
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Fill and Stroke Specifies the color and width of the text. Display Options specifies the use 
of a fill or stroke or a combination of both on the text. Fill Only fills the characters with a 
color. Stroke Only strokes the edges of the characters with a color. Fill Over Stroke overlaps 
the fill color onto the stroke color. Stroke Over Fill overlaps the stroke color onto the fill 
color. Fill Color specifies the color you want to use to fill the characters. Stroke Color 
specifies the color you want to use to outline the characters. Stroke Width specifies the 
size of the outline around each character.

Size Specifies the size of the characters.

Tracking Specifies the average distance between characters.

Line Spacing Specifies the space between lines of characters.

Composite on Original Specifies that the text is composited on the layer to which the 
effect is applied. When Composite on Original is not selected, the layer is not visible. 

Numbers
The Numbers effect generates random and sequential numbers in different formats. You 
can use it to display random times and dates or timecodes, or to print the current date and 
time on a layer whenever it’s rendered.

Note: Leap years are taken into consideration. Note that on some Mac OS systems, the 
clock starts on January 1, 1904, and does not go beyond February 6, 2040.

Original (left); after applying the Numbers effect (center); and after setting Type to Numbers, Time, 
and Hexidecimal on three different layers (right)

The following options and values are available in the Font Style dialog box: Font, Style, 
Direction, and Alignment. To open this dialog box again, click Edit Text at the top of the 
Effect Controls window. 

Format controls for the Numbers effect
Adjust the following format controls for the Numbers effect after you close the Font Style 
dialog box:

Type Specifies the type of numeric string used, such as time, timecode, date, or 
hexadecimal. 

• Number specifies a decimal number. If you select Random and Number, the number is 
bounded by 0 and the slider value. 

• Number [Leading Zeros] specifies a decimal number with 5 digits to the left of the 
decimal place at all times. 

• Timecode [30], Timecode [25], and Timecode [24] specify the standard timecode 
formats (XX:XX:XX:XX) using the stated frame rate. The timecode types use the layer’s 
current time. 
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• Time specifies the number of minutes since midnight. If you also select Current Time/
Date, the Value/Offset/Random Max value is ignored. If you select Random, the time is 
bounded by 0 (12:00 AM) and the slider value.

• Numerical Date, Short Date, and Long Date specify the date and are determined by 
other Number settings. If you do not also select Current Time/Date, the Value/Offset/
Random Max is the number of days since January 1, 1995 (0 on the slider corresponds 
to January 1, 1995). If you do select Current Time/Date, Value/Offset/Random Max is the 
number of days since the current date (0 on the slider corresponds to the current date). 
If you select Random, the date is bounded by 0 (either the current date or January 1, 
1995) and the slider value. If you use more than one system to render a composition 
that uses the date or time types, make sure that the format specified in the Date & Time 
system control is the same on all systems.

• Hexadecimal is a base-16 value (digits from 0 to F). Hexadecimal corresponds to the 
Value/Offset/Random Max value displayed. It increments by 0x1 for every 0.0000125 
that the slider increases, and increments by 0x10000 for every 1.0 that the slider 
increases. If you select Random, the number is bounded by 0 and the slider value.

Random Values Generates random values limited by the Value/Offset/Random Max 
setting. If Value/Offset/Random Max is 0, values are random across their maximum 
possible range. 

Value/Offset/Random Max Varies based on the chosen type and whether or not 
Random Values is selected.

Decimal Places Specifies the number of places to the right of the decimal point. 

Current Time/Date Specifies whether you will enter a specific time and date (not 
selected) or whether After Effects will enter the current time and date (selected). 

Fill and Stroke controls for the Numbers effect
Fill and Stroke controls specify the color and width of the text. 

Position Specifies the position of the numbers in the composition. 

Display Options Specifies the use of a fill or stroke or a combination of both on the text. 
Fill Only fills the characters with a color. Stroke Only strokes the edges of the characters 
with a color. Fill Over Stroke overlaps the fill color onto the stroke color. Stroke Over Fill 
overlaps the stroke color onto the fill color. 

Fill Color Specifies the color you want to use to fill the characters. 

Stroke Color Specifies the color you want to use to outline the characters. 

Stroke Width Specifies the size of the outline around each character.

Size and tracking controls for the Numbers effect
Adjust the following controls to specify size and tracking:

Size Specifies the size of the characters.

Tracking Specifies the average distance between characters.

Proportional Spacing Specifies that numbers use proportional spacing instead of 
monospacing.

Composite on Original Specifies that the text is composited on the layer to which the 
effect is applied. When Composite on Original is not selected, the layer is not visible. 
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Path Text
The Path Text effect lets you animate text along a path. You can define a path as a straight 
line, a circle of any diameter, or a Bezier curve. You can also import a path created in 
another application, such as Adobe Photoshop or Adobe Illustrator. The Path Text effect 
works with nonsquare pixels, adjusting both character shape and path shape accordingly. 

Original (left), after Path Text effect is applied (center), and with Shape Type set to Bezier and Baseline 
Jitter and Scale Jitter values increased (right)

You can animate text on an existing layer or, for additional control over placement of text, 
create a solid and animate the text on it. The layer on which you animate text is trans-
parent, unless you specify compositing. To modify and animate text, type the text using a 
specified font, define the path, and then create keyframes for the text properties you want 
to change over time. To move text along a path, create keyframes for the left margin or 
right margin.To change the text after closing the Path Text dialog box, click Edit Text in the 
Effect Controls window.

Note: If you are using Adobe Type Manager (ATM) and large text looks blocky or does not 
otherwise render properly, increase the Character Cache Size in the ATM control column.

Animating text with Text effects
When changing the shape of a Bezier path over time, make sure to create initial keyframes 
for all four path control points; moving a control point without an initial keyframe does 
not move it over time. You may find it easier to animate a path by modifying the motion 
paths of individual control points in the Layer window.

Note: Handles appear in the Composition window only if the effect is selected in the Effect 
Controls window and if you are not animating text along a mask or path. 

If you want to move a Bezier path across the composition but you don’t want to change its 
shape, animate the layer rather than the path. If you want to stretch, shrink, or “wag” one 
side of the Bezier path while keeping the other half in the same position, move a tangent-
vertex pair together. To do this, create keyframes for both by dragging the outer circle of 
the appropriate vertex.

Note: When animating the control points of a Bezier path, don’t confuse the Bezier path 
shape with the Bezier spatial interpolation of the keyframes. Like keyframes for other 
position controls, those for the vertex or tangent of a Bezier path can be set to either linear 
or Bezier. The default spatial interpolation is specified in General Preferences. Spatial inter-
polation can be selected for individual keyframes by choosing Layer > Keyframe Interpo-
lation.

You can apply motion blur to motion that you create with the Path Text effect. Blurring 
occurs on each character. Like motion blur for layers, blurring for characters is more visible 
when movement is quick. For example, blurring is quite pronounced when you choose 
negative jitter values, which produce jumpy motion. 
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Path Options controls for the Path Text effect
You can adjust the following Path Options controls to specify the shape of the path:

Shape Type Defines the shape of the path. The Path Text effect name must be selected in 
the Effect Controls window to make the path visible in the Composition window. 

• Bezier shapes text along a Bezier curve, defined by four control points (Vertex 1/Circle 
Center, Tangent 1/Circle Point, Tangent 2, and Vertex 2). Characters that don’t fit on the 
path are placed off the end in a straight line. 

• Circle shapes text around the circumference of a circle, defined by two control points 
(Tangent 1/Circle Point, and Vertex 1/Circle Center). If the text is longer than the circum-
ference of the circle, the text overlaps itself. If an arbitrary path is chosen and if the path 
is closed, this property forms the text around the path, as opposed to looping it.

• Loop shapes text around the circumference of the circle, defined by two control points 
(Vertex 1/Circle Center, and Tangent 1/Circle Point). If text is longer than the circum-
ference of the circle, it flows off the Tangent 1 point in a straight line. You can also use 
margin controls to make text enter or exit a circle in a straight line. 

• Line shapes text in a straight line, defined by two control points (Vertex 1/Circle Center, 
and Vertex 2). Note that, as with the Bezier path, the distance between the two control 
points does not affect the spacing of the text, unless alignment is set to Force (see 
“Paragraph controls for the Path Text effect” on page 224).

Control Points Specify the points on the path. 

• Tangent 1/Circle Point specifies the following points: starting tangent for a Bezier curve, 
diameter of a circle and starting or ending point of text (depending on specified 
alignment), and diameter of a loop and the point where text enters.

• Vertex 1/Circle Center specifies the starting vertex for a Bezier curve, center of a circle or 
loop, and starting or ending point for text on a line (depending on specified 
alignment). 

• Tangent 2 specifies the ending tangent of the Bezier curve. The line between Tangent 2 
and Vertex 2 specifies the slope of the curve at its ending point. For circles or loops, 
Tangent 2 is ignored. 

• Vertex 2 specifies the ending vertex of a Bezier curve and the angle of a line. For circles 
or loops, Vertex 2 is ignored.

Custom Path Specifies an arbitrary path. You can use a mask created in the Layer window 
or in Adobe Illustrator. 

Reverse Path Reverses the path.

Fill and Stroke controls for the Path Text effect
You can adjust the following Fill and Stroke controls to specify the color and width of the 
text:

Options Specifies the use of a fill or stroke or a combination of both on the text. Fill Only 
fills the characters with a color. Stroke Only strokes the edges of the characters with a 
color. Fill Over Stroke overlaps the fill color onto the stroke color. Stroke Over Fill overlaps 
the stroke color onto the fill color.

Fill Color Specifies the color you want to use to fill the characters.

Stroke Color Specifies the color you want to use to outline the characters.
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Stroke Width Specifies the size of the outline around each character.

Character controls for the Path Text effect
You can specify the size and kerning of letters by using the following controls:

Size Specifies the size of the characters.

Tracking Specifies the average distance between characters.

Kerning Controls the horizontal distance between two characters. If you change the text, 
specified kerning is preserved for all unchanged character pairs. You cannot use the Undo 
command to undo kerning changes. To change horizontal spacing between characters 
over time, use Kerning Jitter Max (see “Advanced controls for the Path Text effect” on 
page 225) or create keyframes for Tracking. 

• Kerning Pair specifies the pair of character you want to kern. Click the arrow to move 
among the pairs. 

• Kerning Value specifies the amount of kerning you want to apply to the specified pair.

Orientation Specifies the orientation or rotation values of each character. 

• Character Rotation specifies the rotation of all characters. Each character is rotated by 
the specified number of degrees from its current angle. The center of rotation is on the 
point where the character intersects the path. Note that Perpendicular to Path changes 
the initial angle of the characters. 

• Perpendicular to Path rotates each character so that it is perpendicular to the path. If 
Perpendicular to Path is deselected, characters always remain upright (unless rotated 
by Character Rotation). 

• Vertical Writing rotates each character so it is vertical along the path. 

• Rotate Roman Characters rotates Roman characters vertically along the path; when 
Rotate Roman Characters is deselected, only non-Roman characters are rotated.

Horizontal Shear Slants characters left or right, similar to italics. The slant is based on the 
point where the character intersects the path. To slant characters from their centers, set 
Baseline Shift to make the path go through the centers of the characters.

Horizontal Scale, Vertical Scale Resize the characters by the specified percentage in the 
horizontal and vertical directions. Text is scaled from the initial rasterization size, specified 
for Size. Setting the scaling percentage greater than 100 may result in blurred edges. For 
best results, set Size to a point size that does not require scaling beyond 100% to achieve 
the largest desired text size. For example, to increase the size text from 48 to 88 points, set 
Size at 88 and specify a starting value for both Vertical and Horizontal Scale at 55%; then 
increase both scale values to 100% when you want the text displayed at 88 points.

Paragraph controls for the Path Text effect
You can specify the alignment and appearance of the paragraph using the following 
controls:

Alignment Specifies the horizontal alignment of the text on the specified path.

• Left places the first character at the position specified by Left Margin; all other 
characters are drawn relative to it. Right Margin is ignored. 

• Right places the last character at the position specified by Right Margin; all other 
characters are drawn relative to it. Left Margin is ignored. 
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• Center centers the text between Left Margin and Right Margin. 

• Force places the first character at the position specified by Left Margin and the last 
character at the position specified by Right Margin, spacing all other characters evenly 
between. Tracking is ignored.

Left Margin, Right Margin Specify the margins. Left Margin specifies the position of the 
first character in pixels, relative to the starting point; Right Margin specifies the position of 
the last character, relative to the ending point. In path shapes, the starting point for Bezier 
curves and lines is Vertex 1, and the starting point for circles and loops is Tangent 1. The 
ending point for Bezier curves and lines is Vertex 2, and the ending point for circles and 
loops is Tangent 1. To move text across the path shape that you’ve defined, create 
keyframes for the Left or Right margins (depending on the specified alignment). Positive 
values move the text to the right; negative values move it to the left.

Line Spacing Specifies the space between lines of characters.

Baseline Shift Specifies the distance in pixels between the path and the bottom of the 
characters. Depending on the path shape, text may appear to be better spaced when the 
path passes through the centers of the characters. To do this, set Baseline Shift to a 
negative value so that the centers of characters lie on the path.

Advanced controls for the Path Text effect
Use the following controls to specify the appearance of the characters:

Visible Characters Specifies the number of characters that appear at the current time. By 
creating keyframes, you can use Visible Characters to display one or more characters at a 
time to create the appearance of typing characters. Positive values specify the number of 
visible characters from the beginning of the text to the end. Negative values specify the 
number of visible characters from the end of the text to the beginning. Remember that 
spaces are characters, too.

You can also use this control with Fade Time to fade in characters. When Fade Time is 0, the 
next character appears when the value of Visible Characters is halfway to the next whole 
number. For example, the second character appears when the value of Visible Characters 
is 1.5, the third character appears when the value is 2.5, and so on. A Fade Time value of 0 
produces the appearance of typing characters. For other Fade Time values, see Fade Time.

Note: Visible Characters does not alter the positions of characters defined by the path and 
other controls.

Fade Time Specifies a range of time over which a particular character is partially visible. 
Fade Time works in conjunction with Visible Characters. When Fade Time is 0, each letter 
appears fully opaque at the appropriate Visible Characters value. When Fade Time is 100%, 
a particular character is displayed with greater and greater opacity as the value of Visible 
Characters increases between whole numbers. The exact opacity of the character is equal 
to the fractional part of the Visible Characters value. For example, the eighth character is 
displayed at 10% opacity when the value of Visible Characters is 7.10 and Fade Time is 
100%; the same character is displayed at 60% opacity when the value of Visible Characters 
is 7.60, and so on.
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For Fade Time values between 0 and 100%, the opacity of the character is defined as a 
range across the halfway point between whole-number values of Visible Characters. For 
example, when Fade Time is 20%, the eighth character begins to appear at a Visible 
Character value of 7.40 and is fully opaque at 7.60. If Fade Time is set to 60%, the same 
character begins to appear at a value of 7.20 and is fully opaque at 7.80.

Mode Specifies the transfer mode used when characters overlap each other. The 
specified mode is applied only to the parts of characters that overlap. When Mode is set to 
Difference, overlapping parts of characters appear in black. When Mode is set to Normal, 
overlapping parts appear in the specified Text color.

Jitter Settings Specify maximum amount of deviation added randomly to baseline, 
kerning, rotation, or scale. Higher values produce greater deviations. Positive values 
produce smooth motion; negative values produce jumpy motion. Movement is created 
without keyframes, although you can use keyframes to change the maximum values.

A specific jitter value generates the same seemingly random motion for identical text and 
settings. If your composition contains duplicate animated text, you can generate different 
motion for each instance of the text by changing a setting but making the change 
invisible. For example, you could add a space to a second instance of text, and then adjust 
the kerning so that the space is not visible. This creates an invisible change that will 
generate different motion.

You can specify the following Jitter options:

• Baseline Jitter Max sets a maximum distance, in pixels, that characters are randomly 
moved above or below the path after Baseline Shift is applied.

• Kerning Jitter Max sets a maximum distance, in pixels, that characters are randomly 
moved apart from one another along the horizontal axis after kerning and tracking are 
applied.

• Rotation Jitter Max sets a maximum amount, in degrees, that characters are randomly 
rotated after Character Rotation is applied.

• Scale Jitter Max sets a maximum amount, as a percentage, that characters are randomly 
scaled after Horizontal Scale and Vertical Scale are applied. For best results, characters 
should not scale greater than 100%.

Using the Path Text effect
The following procedure provides an overview of how to animate path text.

Note: Path text is animated primarily on the location of the path control points. Text 
moves with the position of these points or on a closed path that can be selected from the 
Path Control Points control. You can also animate text by creating keyframes for margin, 
kerning, tracking, and size.

To animate path text:

1  In the Timeline window, select the layer that has the Path Text effect applied. Display 
the properties for Path Text, and expand the controls under Path Options and Control 
Points.

2  Move the current-time indicator to a point where you want to add a keyframe.

3  Adjust the path control points so that the text is displayed as desired. 

4  Repeat steps 2 and 3 until you have created the keyframes needed to animate the text.
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5  Click the stopwatch next to the control points or other properties for which you will 
create keyframes. 

Adjusting vertex and tangent controls
The following procedures provide information on working with vertex and tangent 
controls in the Path Text effect.

To specify the location of the vertices and tangents: 

Do one of the following:

• Drag the points in the Composition or Layer window. Dragging the outer circle of a 
point dynamically updates the shape of the curve in the Composition window. To 
constrain the point to its current vertical or horizontal coordinate, press Shift while 
dragging its cross hair.

• Click the cross hair for the point in the Effect Controls window, and then click in the 
Composition window.

• Click the coordinates for the point in the Effect Controls window, and then specify new 
coordinates.

Note: If you have animated the position of one or more points over time, you can modify 
their individual motion paths in the Layer window when you select Path Text in the Layer 
window menu.

To move the Vertex 1/Circle Center and the Tangent 1/Circle Point together:

Drag the outer circle of the Vertex 1/Circle Center. 

To move only the Vertex 1/Circle Center: 

Drag its cross hair. 

To automatically snap the Tangent 1/Circle Point on top of the Vertex 1/ Circle 
Center:

(Windows) Select the pen tool, and then click the outer circle of Tangent 1. 

(Mac OS) Command-click the outer circle (not the cross hair) of Tangent 1. 

To snap the Tangent 1/Circle Point to increments of 45˚ from the Vertex 1/Circle 
Center:

Shift-drag the outer circle of Tangent 1. 

To move Vertex 2 and Tangent 2 together:

Drag the outer circle of Vertex 2. 

To move only Vertex 2:

Drag its cross hair. 
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Time effects

Echo 
The Echo effect combines frames from many different times in a layer. It has a variety of 
uses, from a simple visual echo to streaking and smearing effects. This effect is visible only 
when there is motion in the layer. By default, a layer’s mask and any previously applied 
effects are ignored when you apply the Echo effect. If you do not want them ignored, 
precompose the layer with other effects before applying the Echo effect. This creates a 
new composition with the mask already applied. Whenever Echo needs to retrieve a 
frame, it can do so from that composition.

Three frames with Echo applied

Echo controls 
Adjust the following controls for the Echo effect:

Echo Time (seconds) Specifies the time, in seconds, between echoes. Negative values 
seek backward in time; positive values echo forward in time. 

Number of Echoes Specifies the number of frames to combine for the Echo effect. For 
example, if two echoes are specified, Echo makes a new image out of (current time), 
(current time + Echo Time), and (current time + 2 * Echo Time). 

Starting Intensity Specifies the intensity of the starting frame in the echo sequence. For 
example, if this is set to 1, the first frame is combined at its full intensity. If this is set to 0.5, 
the first frame is combined at half intensity. 

Decay Specifies the ratio of intensities of subsequent echoes. For example, if the decay is 
set to 0.5, the first echo will be half the strength of the Starting Intensity. The second echo 
will then be half that, or 0.25 times the Starting Intensity.

Echo Operator Specifies the operations to be performed between the echoes. Add 
combines the echoes by adding their pixel values. If the starting intensity is too high, this 
mode can quickly overload and produce streaks of white. Maximum combines the echoes 
by taking the maximum pixel value from all the echoes. Minimum combines the echoes by 
taking the minimum pixel value from all the echoes. Screen emulates combining the 
echoes by sandwiching them optically. This is similar to Add, but it will not overload as 
quickly. Composite in Back uses the echoes’ alpha channels to composite them back to 
front. Composite in Front uses the echoes’ alpha channels to composite them front to 
back. Blend averages the echoes together evenly.
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Using the Echo effect
The following procedures provide a basic overview of how to use this effect. 

To incorporate a layer’s motion into the Echo effect:

1  Set up your motion before applying the Echo effect.

2  Precompose the layer with any additional effects. This creates a new composition 
containing only that layer and its motion keyframes.

3  Choose Effects > Time > Echo.

Note: Use a large Number of Echoes and a short Echo Time to get smooth streaking and 
smooth trail effects.

4  Set controls as needed. 

To create an image trail using the Echo effect:

1  Choose File > Import > Footage File, select the source footage file, and then click OK.

2  Drag the source footage from the Project window into the Composition window.

3  Highlight the source footage layer in the Timeline window, and create a motion path 
using position keyframes. 

4  Highlight the source footage layer in the Timeline window, and choose Layer > 
Pre-compose.

5  Type a name for the precomposed composition in the Pre-compose dialog box, select 
Move All Attributes into the New Composition, and then click OK.

6  Select the name of the precomposed composition in the Timeline window.

7  Choose Effect > Time > Echo. 

8  Change the effect controls to these values:

• Echo Time: –0.10

• Number of Echoes: 10

• Starting intensity: 1.00

• Decay: 0.68

• Echo Operator: Composite in Front

9  Press the spacebar to preview the trail effect, use RAM Preview for a quicker preview, or 
render the composition to view the effect in real time.

Posterize Time
The Posterize Time effect locks a layer to a specific frame rate. It is useful on its own as a 
special effect, but it also has more subtle uses. For example, 60-field video footage can be 
locked to 24 fps (and then field rendered at 60 fps) to give a film-like look. Also, nested 
compositions can be locked to a given frame rate. This effect is sometimes called Strobe in 
hardware devices.

A layer’s mask and any previously applied effects are ignored when the Posterize Time 
effect is applied. To posterize the time of a masked layer, create the mask in another 
composition or precompose the layer with other effects before applying the Posterize 
Time effect.
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Animating the value of the Frame Rate slider can give unpredictable results. For this 
reason, the only interpolation of the frame rate allowed is Hold. 

Time Difference
The Time Difference effect calculates the color difference between two layers and is a 
useful aid in color correction; use it to extract color differences when matching a clean 
background plate with foreground footage. It is also good for creating mattes to be used 
to apply trails of smoke, fire, or echoing effects. Once you’ve applied Time Difference to 
locate color differences in your footage, use color and levels controls to apply the color 
corrections.

Use Time Difference with Particle Playground to shed particles only from moving 
sections.

Time Difference controls
Adjust the following controls for the Time Difference effect:

Target Specifies the layer to be compared to the effect layer. The comparison layer’s video 
does not need to be on (unless you select the source layer as the Target).

Time Offset Specifies the point in time in the comparison layer, in seconds, where the 
layers are compared. If this control is set to 0.00, the comparison occurs at the current 
time. To compare the effect layer to a point 3 seconds into the comparison layer, for 
example, change the Time Offset value to 3. When you select the underlined offset value, 
you can type the specific frame offset value in the format “frames/framerate.” After Effects 
automatically calculates the value. For example, type 3/30 to offset three frames forward 
in a 30-fps composition. The calculated value is 0.1, or 10% of the total time. 

Contrast Adjusts the comparison result. This control can be especially helpful in fine-
tuning color corrections.

Absolute Difference Displays the result of the comparison as an absolute value. Any area 
of the comparison layer that is not different from the effect layer is represented by black, 
and any amount of difference is represented as brighter than black. When this option is 
unselected, compared areas with no difference are represented as gray.

Alpha Channel Specifies how the alpha channel is calculated.

• Original uses the effect layer’s alpha channel.

• Target uses the target layer’s alpha channel.

• Blend blends the effect and target layers’ alpha channels.

• Max uses the most opaque of the original source and Target layers’ alpha channels.

• Full On sets the alpha channel to completely opaque.

• Lightness of Result uses the lightness of the RGB difference as alpha.

• Max of Result uses the highest values of the RGB difference as alpha.

• Alpha Difference calculates differences in the effect and target layers’ alpha channels 
the same way RGB difference is calculated.

• Alpha Difference Only calculates only the differences in the alpha channels. RGB is set to 
white.
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Time Displacement (Pro only)
The Time Displacement effect distorts the image by shifting pixels across time, producing 
a wide variety of effects. For example, the traditional slit-scan technique, which captures 
different stages of a moving image across time, can be simulated using the Time 
Displacement effect.

Original layers (left and center) and after applying the Time Displacement effect (right)

Like the Displacement Map effect, the Time Displacement effect uses a displacement map, 
but it bases the movement of pixels in the layer on luminance values in the map. Pixels in 
the layer that correspond to bright areas in the displacement map are replaced by pixels in 
the same position but at a specified number of seconds forward in time. Likewise, pixels in 
the layer that correspond to dark areas in the displacement map are replaced by pixels at a 
specified number of seconds backward in time. You can use any layer as a displacement 
map, though using a grayscale image lets you more easily see brightness levels and 
predict how pixels will be displaced.

Understanding Time Displacement
To better understand how pixels are displaced in time, think of the displacement 
occurring in steps, as follows: 

1  After Effects overlays the displacement map layer on top of the effect layer (the layer 
you are distorting). If the dimensions of the displacement map are different from those of 
the effect layer, you can specify whether the map is centered or stretched to fit.

2  You specify a maximum displacement amount, in seconds.

3  After Effect uses the luminance value of each pixel in the displacement map to calculate 
the displacement of the corresponding pixel in the effect layer based on the maximum 
displacement amount.

In grayscale images, the luminance value range extends from 0 to 255, which is converted 
into a scale ranging from -1 to 1. A luminance value of 0 produces maximum backward 
displacement, meaning that pixels at the current time are replaced by pixels from a 
previous time. A luminance value of 255 produces maximum positive displacement, 
meaning that pixels at the current time are replaced by those at a future time. A luminance 
value of 128 produces no displacement. For other values in grayscale displacement maps, 
you can calculate the displacement amount, in seconds, using the following equation:

Displacement amount in seconds = maximum_displacement_time * (2 * (luminance value 
– 128)/256)

4  After Effects displaces each pixel in the image by replacing a pixel in the image at the 
current time with the pixel in the same position at another time. The other time is the 
displacement amount in seconds for the pixel, calculated in step 3. 
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Time Displacement controls 
Adjust the following controls for the Time Displacement effect:

Time Displacement Layer  Specifies the layer to use as the displacement map.

Max Displacement Time (sec) Sets the maximum time, in seconds, from which pixels are 
replaced, before or after the current time. Note that only luminance values of 0 or 255 
(maximum darkness and maximum brightness) produce the maximum time. All other 
luminance values produce times less than the maximum time. 

Time Resolution (fps) Sets the number of frames per second in which to replace pixels. 
Typically, this value should not be greater than the frame rate of the affected layer. 
Increasing Time Resolution can significantly increase rendering time.

Stretch Map to Fit Resizes the Time Displacement Layer to match the dimensions of the 
layer you are distorting. If this option is not selected, the time displacement layer is 
centered in the composition.

Animating time displacement
The Time Displacement effect automatically replaces pixels across time without 
keyframes. However, you can also set keyframes for other controls to vary the effect over 
time.

To apply the Time Displacement effect:

1  In the Composition window, display both the layer you want to distort and the 
displacement map layer.

2  Hide the displacement map layer by clicking the Video switch in the Timeline window.

3  In the Composition window, select the layer you want to distort.

4  Choose Effect > Time > Time Displacement.

5  Choose a displacement map from the Time Displacement Layer menu, which lists all 
layers in the composition. Grayscale maps are recommended.

Note: After Effects uses the layer you select in its original form, without any masking, 
effects, or transformations you may have applied. If you want to use the layer with those 
alterations included in the displacement map, precompose that layer using the Move All 
Attributes into the New Composition option.

6  Adjust the Time Displacement controls.

An example of time displacement
Suppose you specified 2 seconds as the maximum time displacement. After Effects finds 
the luminance value of each pixel in the displacement map, and then replaces the corre-
sponding pixels at the current time with pixels from another time based on the maximum 
time of 2 seconds. Using the equation in “Understanding Time Displacement” on 
page 231, a luminance value of 255 in the displacement map replaces that pixel with the 
pixel 2 seconds ahead in the same position. A luminance value of 42 replaces that pixel 
with the pixel 1.34 seconds behind in the same position. 
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Using masks with time displacement
Any mask you apply to the original layer is ignored by the Time Displacement effect. To 
use a mask with time displacement in the same layer, precompose the layer as a separate 
composition, and then apply the mask inside the new composition. This method, however, 
can significantly increase rendering time.

To apply a mask and a time displacement to the same layer:

1  In the Composition window, select the layer you want to distort.

2  Apply the Time Displacement effect.

3  Choose Layer > Pre-compose.

4  Select the Leave All Attributes in “Comp [composition number]” option, specify a name 
for the new composition or accept the default name, and then click OK.

5  In the new composition, double-click the layer you are distorting. In the Layer window, 
apply the mask.
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Transition effects

Block Dissolve
The Block Dissolve effect makes a layer disappear in random blocks. The width and height 
of the blocks, in pixels, can be set independently. At Draft quality, the blocks are placed 
with pixel accuracy and have sharply defined edges; at Best quality, the blocks can be 
positioned with subpixel accuracy and have soft edges.

Original (left) and after applying the Block Dissolve effect (center and right)

Card Wipe
The Card Wipe effect is available from the Adobe Web site (www.adobe.com) after you 
register your copy of After Effects. This effect simulates a group of cards displaying a 
picture and then flipping to display another picture. Card Wipe provides control over the 
number of rows and columns of cards, the flip direction, and the transition direction 
(including the ability to use a gradient to determine flip order). You can also control 
randomness and jitter to make the effect appear more realistic. By varying the rows and 
columns, you can also create venetian blind and Chinese lantern effects.

Original (left) and after applying the Card Wipe effect (center and right)

Controls for the Card Wipe effect
Adjust the following controls for the Card Wipe effect:

Transition Completion  Specifies how far along you are in the transition. A setting of 
100% displays the new image revealed by the transition; a setting of 0% displays the 
original image.

To create an animated transition, animate this value from 0% to 100%.
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Transition Width Specifies the width of the area that is actively changing from the 
original to the new image. 

Back Layer Specifies the image to be revealed by the transition. You can use any file in 
the composition (its visibility can be turned off ). If the image has an effect or mask 
applied, precompose the layer first.

Rows & Columns Specifies the interaction of the numbers of rows and columns. 
Independent makes both the Rows and Columns sliders active. Columns Follow Rows 
makes only the Rows slider active. When you choose this option, the number of columns is 
always the same as the number of rows. 

Rows Defines the number of rows up to 1,000.

Columns Determines the number of columns up to 1,000, unless Columns Follows Rows 
is selected. 

Note: Rows and columns are always evenly distributed across a layer, so odd-shaped 
rectangular tiles don’t appear along the edges of a layer, unless you are using an alpha 
channel.

Card Scale Specifies the size of the cards. A value smaller than 1 scales down the cards, 
causing transparent grid lines to appear between them. A value greater than 1 scales up 
the cards. Oversized cards create a blocky mosaic effect as they overlap each other from 
lower left to upper right. During the transition, the jumbo cards actually pass through one 
another.

Flip Axis Specifies the axis around which each card flips. Choose an axis for precision 
flipping, or Random for a more realistic effect.

Flip Direction Specifies the direction in which the cards flip around their axes. With the x 
axis selected, Positive flips the cards up and Negative flips them down; with the y axis 
selected, Positive flips the cards to the right, and Negative flips them to the left. Selecting 
Random randomly flips positively or negatively. 

Flip Order Specifies the direction the transition occurs. For example, Left to Right starts 
the cards flipping on the left and proceeds to the right. You can also use a gradient to 
define a custom flip order: Cards flip first where the gradient is black and last where the 
gradient is white.

Gradient Layer Specifies the gradient layer you want to use for the Flip Order. You can 
use any file in the composition (visibility can be turned off ).

Timing Randomness Randomizes the timing of the transition. When this control is set to 
0, the cards flip with precision. The higher the value, the more randomly the cards flip and 
the more realistic the effect.

Random Seed Generates a unique result for random effects. True randomness is not 
repeatable; if effects were genuinely random, you couldn’t go back and fine-tune part of 
an effect without rerendering. However, two random effects running next to each other 
may look noticeably alike. To avoid this, use a random seed. A random seed is a number 
that is inserted into the calculation to generate a unique result. By changing the Random 
Seed setting, you can make effects using the same settings appear different. 
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Camera System Specifies whether to use Camera Position, Corner Pins, or Comp Camera. 
Comp Camera tracks the composition's camera and light positions and renders a 3D 
image on the layer. For more information on Comp Camera, see “Using Comp Camera 
effects” in the After Effects online Help. 

Camera Position  See “Camera Position controls for the Card Wipe effect” on page 236.

Corner Pins  See “Corner Pins controls for the Card Wipe effect” on page 236.

Lighting  See “Lighting controls for the Card Wipe effect” on page 236.

Material  See “Material controls for the Card Wipe effect” on page 237.

Jitter  See “Jitter controls for the Card Wipe effect” on page 237.

Camera Position controls for the Card Wipe effect
You can adjust the following Camera Position controls for Card Wipe:

X Rotation, Y Rotation, Z Rotation Rotate the camera around the corresponding axis. 
Use these controls to look at the layer from the top, side, back, or any other angle.

X, Y Position Specifies where the camera is positioned in x, y space.

Z Position Specifies where the camera is positioned in z space. Smaller numbers move 
the camera closer to the layer, and larger numbers move the camera away from the layer. 

Focal Length Specifies the zoom factor. It is like a camera’s zoom lens. Smaller numbers 
zoom the camera lens out, and larger numbers zoom the camera lens in. 

Transform Order Specifies the order in which the camera rotates around its three axes, 
and whether the camera rotates before or after it is positioned using the other Camera 
Position controls. 

Corner Pins controls for the Card Wipe effect
Corner Pinning is an alternative camera control system. Use it as an aid for compositing 
your layer into a scene. You can adjust the following Corner Pins controls:

Upper Left Corner, Upper Right Corner, Lower Left Corner, Lower Right Corner 
Specify the location of each of the four corners of your layer. 

Auto Focal Length Controls the perspective of the effect during the animation. When 
Auto Focal Length is deselected, the focal length you specify is used to find a camera 
position and orientation that positions the corners of the layer at the corner pins. If this 
isn’t possible, the layer is replaced by its outline, drawn between the pins. When Auto 
Focal Length is selected, the focal length required to match the corner points is used, if 
possible. If not, it interpolates the correct value from nearby frames. 

Focal Length Overrides the other settings if the results you’ve obtained aren’t what you 
need. If you set the Focal Length to something that doesn’t correspond to what the focal 
length would be if the pins were actually in that configuration, the image may look odd 
(strangely sheared, for example). But if you know the focal length that you are trying to 
match, this is the easiest way to get correct results.

Lighting controls for the Card Wipe effect
You can adjust the following Lighting controls for Card Wipe:
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Light Type Specifies which type of light you want to use. When a light is at a great 
distance from an object, all the light rays strike the object from virtually the same angle. 
Sun rays, for example, are parallel by the time they reach the earth. As a light source moves 
closer to the object, the rays strike the object from an increasing number of angles. Distant 
Source is similar to sunlight and casts shadows in the one direction. Point Source is similar 
to a light bulb and casts shadows in all directions. First Comp Light uses the composition’s 
first light layer, which can use a variety of settings.

Light Intensity Specifies the power of the light. The higher the value, the brighter the 
layer. Other lighting settings affect the overall light intensity as well.

Light Color Specifies the color of light. 

Light Position Specifies the position of the light in x, y space. To position the light interac-
tively, hold down Alt (Windows) or Option (Mac OS), and drag the light’s effect point.

Light Depth Specifies the position of the light in z space. Negative numbers move the 
light behind the layer. 

Ambient Light Distributes light over the layer. Increasing it adds an even illumination to 
all objects and prevents shadows from being totally black. Turning Ambient Light all the 
way to pure white and setting all other light properties to 0 makes the object fully lit and 
eliminates any 3D shading from the scene.

Material controls for the Card Wipe effect
Adjust the following Material controls to specify the reflection values of the cards:

Diffuse Reflection Gives objects form-defining shading. Shading depends on the angle 
at which the light strikes the surface and is independent of the viewer’s position.

Specular Reflection Takes into account the position of the viewer. It models the 
reflection of the light source back to the viewer. It can create the illusion of shininess. For 
realistic effects, you can animate this control using higher and higher values to mask the 
transition from filtered to nonfiltered versions of the layer.

Highlight Sharpness Controls shininess. Very shiny surfaces produce small tight reflec-
tions, while duller surfaces spread the highlight out into a larger region. Specular 
highlights are the color of the incoming light. Because light is typically white or off-white, 
broad highlights can desaturate an image by adding white to the surface color. 

The total lighting process can be thought of in this way: Set the Light Position and 
Diffuse Reflection to control the overall light level and shading in a scene. Then adjust 

Specular Reflection and Highlight Sharpness to control the strength and spread of 
highlights. Finally, adjust Ambient Light to fill in the shadows. 

Jitter controls for the Card Wipe effect
Adding jitter (Position and Rotation Jitter) makes this transition more realistic. Jitter works 
on the cards before, during, and after the transition occurs. If you want the jitter to happen 
only during the transition, start with the Jitter Amount at 0, animate it up to the desired 
amount during the transition, and then animate it back down to 0 at the completion of the 
transition. 

You can adjust the following Jitter controls:
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Position Jitter Specifies the amount and speed of jitter at the x, y, and z axis. X, Y, Z Jitter 
Amount specifies the amount of extraneous movement. Increasing X Jitter Amount makes 
the cards jitter from side to side; increasing Y Jitter Amount makes the cards jitter up and 
down; increasing Z Jitter Amount makes the cards jitter in z space (closer or farther away). 
X, Y, Z Jitter Speed controls the speed of jitter for each Jitter Amount option. 

Rotation Jitter Specifies the amount and speed of rotation jitter at the x, y, and z axis. X, Y, 
Z Rotation Jitter Amount specifies the amount of rotational jitter along an axis. A value of 
90˚ makes it possible for a card to rotate up to 90˚ in either direction. X, Y, Z Rot Jitter 
Speed controls the speed of rotational jitter.

Gradient Wipe
The Gradient Wipe effect creates transitions based on the luminance values of a second 
layer, called the gradient layer. The luminance of a pixel in the gradient determines the 
time at which the corresponding pixel in the first layer becomes transparent. Dark areas of 
the gradient layer represent those areas which become transparent first, followed by 
lighter areas.

Original (left) and after applying the Gradient Wipe effect (center and right)

For example, a simple grayscale gradient from left to right produces a left-to-right wipe. 
The gradient layer need not be a still image; you can use any layer in After Effects as a 
gradient for unusual wipe effects. You can create more interesting wipes in a variety of 
ways. The Ramp effect is a good starting point because it can generate a variety of 
grayscale gradients. To make completely custom gradients, paint them in a program such 
as Adobe Photoshop, or draw them in a program such as Adobe Illustrator.

Adjust the following controls for the Gradient Wipe effect:

Transition Completion Specifies the percentage of the transition applied to the layer.

Transition Softness Specifies the amount of softness applied to the transition’s edge.

Gradient Layer Specifies the layer used as the gradient. The gradient layer must be in the 
same composition as the layer to which you apply Gradient Wipe.

Gradient Placement Specifies how the gradient is positioned and sized in the layer. Tile 
Gradient creates multiple tiled copies of the gradient. Center Gradient places a single 
gradient in the center of the layer. Stretch Gradient to Fit resizes the gradient layer 
horizontally and vertically to fit the entire area of the layer. 

Invert Gradient Inverts the position of the gradient layer and the layer affected by the 
gradient transition. 
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Iris Wipe
The Iris Wipe effect creates a radial transition that reveals an underlying layer. Specify the 
number of points used to create the iris using a range of 6 to 32 points, and specify 
whether an inner radius is used. When Use Inner Radius is selected, you can specify values 
for both Inner Radius and Outer Radius; the iris is not visible when Outer Radius, Inner 
Radius, or both are set to 0. The iris is roundest when both Outer Radius and Inner Radius 
are set to the same value.

Original (left) and after applying the Iris Wipe effect (center and right)

Linear Wipe
The Linear Wipe effect performs a simple linear wipe of a layer in a specified direction. At 
Draft quality, the edge of the wipe is not anti-aliased; at Best quality, the edge of the wipe 
is anti-aliased and the feather is smooth.

The Wipe Angle control specifies the direction that the wipe travels. For example, at 90˚ 
the wipe travels from left to right.

Original (left) and after applying the Linear Wipe effect (center and right)

Radial Wipe
The Radial Wipe effect reveals an underlying layer using a wipe that circles around a 
specified point. At Best quality, the edges of the wipe are anti-aliased.

The Start Angle control specifies the position or angle at which the transition starts. With a 
start angle of 0˚, the transition starts at the top of the layer. Wipe specifies whether the 
transition moves clockwise or counterclockwise, or alternates between the two. 

Original (left) and after applying the Radial Wipe effect (center and right)
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Venetian Blinds
The Venetian Blinds effect reveals an underlying layer using strips of specified direction 
and width. At Draft quality, the strips are animated with pixel accuracy; at Best quality the 
strips are animated with subpixel accuracy.

Original (left) and after applying the Venetian Blinds effect (center and right)
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Video effects

Broadcast Colors
The Broadcast Colors effect alters pixel color values so that the layer can be accurately 
represented in a television broadcast. Computers represent colors as combinations of red, 
green, and blue. Consumer video equipment represents colors using different composite 
signals. Home video equipment cannot reproduce signals above a certain amplitude, and 
computer-generated colors can easily exceed this limit. (Signal amplitude is measured in 
IRE units; 120 IRE units is the maximum possible transmission amplitude.) Use the 
Broadcast Colors effect to reduce luminance or saturation to a safe level. The layer’s quality 
setting does not affect the Broadcast Colors effect.

Reducing saturation requires greater amplitude modification than reducing luminance to 
achieve the same IRE unit level, which alters the appearance of your image more. Key Out 
Unsafe and Key Out Safe are intended to make it easy for you to determine which portions 
of the layer will be affected by the Broadcast Colors effect at the current settings. If you 
make your background a contrasting color and temporarily select Key Out Unsafe or Key 
Out Safe, the background will be visible through affected or unaffected areas of the layer, 
respectively.

An unsafe level merely means that if some portions of your movie exceed the safe level, 
they will not look as you intended when viewed on a television monitor. Here are some 
guidelines for using color in movies intended for broadcast:

• Avoid using highly saturated colors. For example, a red value of 255 used with green 
and blue values of 0 will cause red to smear on an NTSC monitor. 

• Render a test of your movie and play it back on an NTSC monitor to ensure that colors 
are represented accurately. 

• Avoid pure black and white values. Commonly used values for black and white are 235 
and 16, respectively.

Note: The output you are creating should determine whether you use this effect. Many 
video systems alter colors for broadcast during the encoding process.

Broadcast Colors controls
You can adjust the following controls for the Broadcast Colors effect:

Broadcast Locale Specifies the type of broadcast standard you intend to use. NTSC 
(National Television Systems Committee) is the North American standard. It is also used in 
Japan. PAL (Phase Alternating Line) is used in most of Western Europe and South America.

How to Make Color Safe Specifies the method of reducing the signal amplitude. Reduce 
Luminance reduces a pixel’s brightness by moving it towards black. This is the default 
setting. Reduce Saturation moves the pixel toward a gray of similar brightness, making it 
less colorful. Key Out Unsafe makes unsafe pixels transparent and Key Out Safe makes safe 
pixels transparent.
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Maximum Signal Specifies the IRE unit level above which your layer’s pixels are altered. 
The range is Amplitude (IRE) from 100 to 120 IRE. A level of 100 can affect a layer 
noticeably; a level of 120 is the maximum possible IRE and is risky. The default, 110 IRE 
units, is conservative.

Reduce Interlace Flicker
The Reduce Interlace Flicker effect reduces high vertical frequencies to make images more 
suitable for use in an interlaced medium (such as NTSC video). For example, images with 
very thin horizontal lines can flicker annoyingly when broadcast. Reduce Interlace Flicker 
softens horizontal edges to reduce the flickering.

Note: Flicker may result from fields that have not been separated. 

Timecode
The Timecode effect displays timecode or frame number information within a layer. You 
can render movies containing visible timecode. It can also encode the timecode infor-
mation into the layer for later display within After Effects. This effect cannot modify 
timecode embedded from external sources, such as QuickTime. 

Original (left), with SMPTE HH:MM:SS:FF timecode applied (center), and with Feet + Frames (35mm) 
timecode applied (right) 

You can adjust the following controls for the Timecode effect:

Display Format Specifies whether timecode is displayed in the SMPTE format of 
HH:MM:SS:FF, in frame numbers, in Feet + Frames (35mm), or Feet + Frames (16mm). 

Time Units Use Time Units to mark each frame of a layer for variable composition frame 
rates. The Time Units control determines the frame rate in frames per second (fps) for a 
specific layer in the composition. For example, a value of 60 changes the timecode for a 
specific layer to match the composition’s 60-fps rate. This control affects how After Effects 
counts the layer’s frames, not how the footage plays. 

Drop Frame Select Drop Frame to calculate drop frame timecode or deselect it to 
calculate nondrop frame timecode.

Starting Frame Specifies the timecode count at the beginning of the layer. You can set 
the Starting Frame slider to correspond to the layer’s In point or, if you combine a layer 
with another composition and need to match the timecode at a frame other than the In 
point, you can set the Starting Frame accordingly. 

Text Position Specifies the position of the timecode.

Text Size Specifies the size of text.

Text Color Specifies the text color.
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Legal Notices

Copyright
© 2003 Adobe Systems Incorporated. All rights reserved.

Adobe® After Effects® 6.0 User Guide for Windows® and Macintosh.

If this guide is distributed with software that includes an end-user agreement, this guide, as well as the software described in it, is furnished 
under license and may be used or copied only in accordance with the terms of such license. Except as permitted by any such license, no part of 
this guide may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or 
otherwise, without the prior written permission of Adobe Systems Incorporated. Please note that the content in this guide is protected under 
copyright law even if it is not distributed with software that includes an end-user license agreement.

The content of this guide is furnished for informational use only, is subject to change without notice, and should not be construed as a 
commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or liability for any errors or inaccuracies 
that may appear in the informational content contained in this guide.

Please remember that existing artwork or images that you may want to include in your project may be protected under copyright law. The 
unauthorized incorporation of such material into your new work could be a violation of the rights of the copyright owner. Please be sure to 
obtain any permission required from the copyright owner.

Any references to company names in sample templates are for demonstration purposes only and are not intended to refer to any actual 
organization.

Adobe, the Adobe logo, Adobe Acrobat, Adobe Premiere, After Effects, Illustrator, Photoshop, and PostScript are either registered trademarks 
or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple, Macintosh, and Mac OS are trademarks of 
Apple Computer, Inc., registered in the U. S. and other countries. Microsoft, Windows, and Windows NT are registered trademarks of Microsoft 
Corporation in the U.S. and/or other countries. Macromedia and Flash are trademarks of Macromedia Inc. MPEG Layer 3 audio compression 
technology is licensed by Fraunhofer IIS and Thompson. All other trademarks are the property of their respective owners. The procedures 
zroots and laguer are based on routines in Numerical Recipes: The Art of Scientific Computing, published by Cambridge University Press, and 
are used by permission. 

Contains an implementation of the LZW algorithm licensed under U.S. Patent 4,558,302.

Notice to U.S. government end users. The software and documentation are “Commercial Items,” as that term is defined at 48 C.F.R. §2.101, 
consisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. 
§12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R.. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, 
the Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government end users (a) 
only as Commercial items and (b) with only those rights as are granted to all other end users pursuant to the terms and conditions herein. 
Unpublished-rights reserved under the copyright laws of the United States. Adobe Systems Incorporated, 345 Park Avenue, San Jose, CA 
94110-2704, USA. For U.S. Government End Users, Adobe agrees to comply with all applicable equal opportunity laws including, if appropriate, 
the provisions of Executive Order 11246, as amended, Section 402 of the Vietnam Era Veterans Readjustment Assistance Act of 1974 (38 USC 
4212), and Section 503 of the Rehabilitation Act of 1973, as amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 60-250 ,and 60-
741. The affirmative action clause and regulations contained in the preceding sentence shall be incorporated by reference.
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Checkerboard effect and 150

Circle effect and 151

Color Link effect and 93

Fractal Noise and 118

Grid effect and 156

Lightning effect and 158

Magnify effect and 74
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Paint Bucket effect and 159

Solid Composite effect and 67

using with Eyedropper Fill effect 152

Vegas effect and 167

Block Dissolve effect 234

Blur and Sharpen effects category 51

Channel Blur 51

Compound Blur 51

Directional Blur 52

Fast Blur 52

Gaussian Blur 53

Radial Blur 53

Sharpen 53

Unsharp Mask 54

bounce

in sound 46

Brightness & Contrast effect 39

Broadcast Colors effect 241

Brush Strokes effect 208

brush tool. See paint tools

brushes

changing 125

feather setting 126

radius 125

types of 126

bubbles, creating with Cell Pattern 147

Bulge effect 69

C
Calculations effect 59

cannon 182

disable particle generation 183

Card Dance effect 168

Card Wipe effect 234

Caustics effect 172

Cell Pattern effect 147

Change Color (HLS)

See Change to Color effect

Change Color effect 90

Change to Color effect 91

Channel Blur effect 51

Channel Combiner effect 60

Channel effects category

3D Glasses 55

Alpha Levels 57

Arithmetic 58

Blend 58

Calculations 59

Channel Combiner 60

Cineon Converter 61

Compound Arithmetic 62

Invert 63

Minimax 64

Remove Color Matting 64

Set Channels 65

Set Matte 66

Shift Channels 67

Solid Composite 67

Channel Mixer effect 39

channels

mixing 50

setting 65

shifting 67

Checker. See Checkerboard effect

Checkerboard effect 150

checkerboard, display option 135

checkered, color swatch 127

choking mattes 114

Cineon Converter effect 61

Circle effect 151

closing

brush strokes 123

color

adjusting 39

adjusting shadows, midtones, highlights 40

correcting contrast 39

remapping levels 44, 45

selecting (Vector Paint) 126

Color Balance (HLS) effect 92

Color Balance effect 40

Color Clone control 126

Color Difference Key effect 101

Color Emboss effect 209

Color Key effect 103
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Color Link effect 92

Color Picker. See Eyedropper Fill

Color Range Key effect 104

Color Stabilizer effect 40

color swatch

checkered 127

Colorama effect 94

Colorize control 42

Composite Paint options 135

Compound Arithmetic effect 62

Compound Blur effect 51

containing particles within an area 190

contrasting colors, removing with Luma Key 
110

controlling

property output 191

property persistence 190

Corner Pin effect 70

creating particles

exploding a layer or particle 183, 184

replacing dots with a layer 185

using Cannon 182

using exploders 183, 184

using Grid 182

Creation Station tablet, using with Paint 
effects 124

crystals, creating with Cell Pattern 147

Curves effect 41

D
Delay effect 46

Depth Matte effect 36

Depth of Field effect 36

Difference Matte effect 105

Directional Blur effect 52

Distort effects category 68

Bezier Warp 68

Bulge effect 69

Corner Pin 70

Displacement Map 70

Liquify 71

Magnify 73

Mesh Warp 74

Mirror 75

Offset 75

Optics Compensation 76

Polar Coordinates 77

Reshape 78

Ripple effect 80

Smear 81

Spherize 83

Transform 83

Turbulent Displace 84

Twirl 86

Warp 87

Wave Warp 87

dots

disable generation of from Cannon 183

replacing with a layer 185

replacing with text 186, 187

Drop Shadow effect 140

Dust & Scratches effect 115

E
Echo effect 228

effects

 See individual effect names

included with Professional edition 34

Ellipse effect 152

Emboss effect 209

ephemeral property change, defined 190

Equalize effect 98

eraser tool (Vector Paint) 125

erasing

radius 125

exploding a layer or particle 183, 184

Expression Controls effects 89

Extract effect 106

Eyedropper Fill effect 152

eyedropper tool (Vector Paint) 127

eyedroppers, for keying effects 101

F
Fast Blur effect 52

Feather control 125
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Field of View controls 76

Fill effect 153

Find Edges effect 209

Flange & Chorus effect 47

Foam effect 175

focal plane, specifying 36

Fog 3D effect 37

footage

showing or hiding (Vector Paint) 135

4-Color Gradient effect 142

Fractal effect 153

Fractal Noise effect 115

Fractal Noise, looping the effect 118

G
Gamma/Pedestal/Gain effect 98

Gaussian Blur effect 53

Glow effect 210

Gradient Wipe effect 238

gradient, using Ramp effect to create 163

graphics tablet and Vector Paint 124

Gravity controls 189

grayscale images

converting to 39

converting to black-and-white 45

Grid effect 155

grids

controlling direction of particles 182

controls for 183

enabling 183

Grow Bounds effect 99

H
halos in images 64

hand-tinted images 39

High-Low Pass effect 47

histogram 106

Hue/Saturation effect 42

I
ID Matte effect 38

Image Control effects category 90

Change Color 90

Change to Color 91

Color Balance (HLS) 92

Color Link 92

Colorama 94

Equalize 98

Gamma/Pedestal/Gain 98

Grow Bounds 99

PS Arbitrary Map 99

Tint 100

images

blurring and sharpening 51

reshaping 68

Inner Outer Key effect 34

Invert effect 63

Iris Wipe effect 239

K
key color

removing traces of 111

keying

removing color spill 111

static background 105

Keying effects category

Color Difference Key 101

Color Key 103

Color Range 104

Difference Matte 105

Extract 106

Inner/Outer Key 107

Linear Color Key 108

Luma Key 110

Spill Suppressor 111

L
laser, using Beam to create 147

Layer Exploder controls 184

layer map

animating 196

creating 195

modifying particle properties 193, 194

using RGB channels 196
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using the alpha channel 195

layers

dissolving 183

exploding 183

painting 124

Leave Color effect 212

Lens Flare effect 156

Levels (Individual Controls) effect 45

Levels effect 44

Lightning effect 156

Linear Color Key effect 108

Linear Wipe effect 239

Liquify effect 71

looping

Fractal Noise effect 118

Turbulent Displace effect 85

Luma Key effect 110

luminance values, removing with Luma Key 
110

M
margins (paint). See  Feather control

Matte Choker effect 113

Matte options (Vector Paint) 135

Matte Tools effects category

Matte Choker 113

Simple Choker 114

mattes

removing 64

spreading 114

Median effect 119

Mesh Warp effect 74

Minimax effect 64

Mirror effect 75

mixing audio 50

Modulator effect 48

Monochrome control 39

Mosaic effect 212

motion blur 52

Motion Tile effect 213

multiframe source layers, randomizing 185

N
Noise Alpha effect 120

Noise effect 120

Noise effects category

Dust & Scratches 115

Fractal Noise 115

Median 119

Noise 120

Noise Alpha 120

Noise HLS 121

Noise HLS Auto 121

Noise HLS Auto effect 121

Noise HLS effect 121

Numbers effect 220

O
Offset effect 75

offsetting in unison 185

Onion Skin control in Vector Paint 129

opacity

increasing 125

Optics Compensation effect 76

option menu

Vector Paint 124

P
paint

See also the After Effects online Help

color swatch 127

tools for Vector Paint 124

Undo button 127

Paint effect 123

Paint effects category

See also  the After Effects online Help

Paint 123

Vector Paint 123

paint strokes

applying with Paint effects 123

blending 123

editing 127

selecting 125

smoothing 127
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using current-time indicator with 132

paint tool

changing shape of 125

in Vector Paint 125

painting

applying Vector Paint effect 124

color selection 126

footage 135

toolbar 124

panning

audio 50

Parametric EQ effect 49

Particle Playground effect 180

particle properties

modifying with a layer map 193

modifying with RGB channels 194

particle source layer, defined 185

particles

adjusting behavior 187

adjusting behavior of 181

Cannon and 182

containing 190

controlling direction and velocity 182

dissolving or exploding 183

generating a continuous stream 182

gravity and 189

Grid and 182

layer maps and 195

masking 190

offsetting 186

replacing with a layer 185

replacing with text 186

rotating along trajectories 189

types of 181

patches, defined 74

Path Text effect 222

persistent property change, defined 190

Perspective effects category

Basic 3D 138

Bevel Alpha 139

Bevel Edges 139

Drop Shadow 140

Radial Shadow 140

playback speed

adjusting for paint strokes 130

adjusting with Re-timer 131

Re-timer control vs 131

plug-ins

effects 34

Polar Coordinates effect 77

Posterize effect 45

Posterize Time effect 229

precomposing a layer 185

preserving color, using Linear Color Key 110

properties

setting for particles 190

property mapping

controls for 190

defined 190

property output 192

property persistence 190

PS Arbitrary Map effect 99

Q
QuickPaint mode 132

R
Radial Blur effect 53

Radial Shadow effect 140

Radial Wipe effect 239

Radio Waves effect 160

Ramp effect 163

Reduce Interlace Flicker effect 242

Remove Color Matting effect 64

Render effects category

4-Color Gradient 142

Advanced Lightning 142

Audio Spectrum 145

Audio Waveform 146

Beam 147

Cell Pattern 147

Checkerboard 150

Circle 151

Ellipse 152



Using Help | Contents | Index Back 250  

Adobe After Effects Help Index 

Using Help | Contents | Index Back 250  

A  B  C  D  E  F  G  H   I   J  K  L  M  N  O  P  Q  R  S  T  U  V  W  X  Y  Z

Eyedropper Fill 152

Fill 153

Fractal 153

Grid 155

Lens Flare 156

Lightning 156

Paint Bucket 158

Radio Waves 160

Ramp 163

Scribble 163

Stroke 165

Vegas 165

Repel controls 189

replacing default particles

with a layer 185

with text 186

Reshape effect 78

reshaping images 68

Re-timer controls 131

Reverb effect 49

reversing audio 46

Ripple effect 80

Roughen Edges effect 214

S
Scatter effect 216

Scribble effect 163

selecting

paint strokes 125

selection tool (Vector Paint) 125

sepia-tone images 39

Set Channels effect 65

Set Matte effect 66

setting

particle properties 190

shapes

brush types 125

Sharpen effect 53

sharpening images 51

Shatter effect 197

Shift Channels effect 67

Shift-Paint Records control (Vector Paint) 132

Simple Choker effect 114

simplifying stroke paths 127

Simulation effects category

Card Dance 168

Caustics 172

Foam 175

Particle Playground 180

Shatter 197

Wave World 204

skin, onion skin controls in Vector Paint 129

Smear effect 81

Smoother command (Vector Paint) 127

smoothing

paint strokes 127

Solid Composite effect 67

sound effects. See Audio effects category

Spherize effect 83

Spill Suppressor effect 111

spreading mattes 114

square brush tool 125

Stereo Mixer effect 50

Strobe Light effect 216

Stroke effect 165

strokes. See paint strokes

Stylize effects category 208

Brush Strokes 208

Color Emboss 209

Emboss 209

Find Edges 209

Glow 210

Leave Color 212

Mosaic 212

Motion Tile 213

Roughen Edges 214

Scatter 216

Strobe Light 216

Texturize 217

Write-on 217

stylus

configuring for Vector Paint 128, 137
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T
tangents

using in Bezier Warp 68

using in Mesh Warp 74

text

animating 222

as particles 186

Text effects category 219

Basic Text 219

Numbers 220

Path Text 222

Texturize effect 217

Three-dimensional (3D) Channel effects 
category

3D Channel Extract 35

Depth Matte 36

Depth of Field 36

Fog 3D 37

ID Matte 38

Three-dimensional (3D) Channel Extract effect 
35

Threshold effect 45

Time Difference effect 230

Time Displacement effect 231

Time effects category 228

Echo 228

Posterize Time 229

Time Difference 230

Time Displacement 231

Time Offset control 186

Timecode effect 242

Tint effect 100

tinted images 39

tonal levels, posterizing 44, 45

tonal range

adjusting 41

Tone effect 50

toolbar, for Vector Paint 124

Transform effect 83

Transition effects category 234

Block Dissolve 234

Gradient Wipe 238

Iris Wipe 239

Linear Wipe 239

Radial Wipe 239

Venetian Blinds 240

Twirl effect 86

U
Undo button for paint strokes 127

Unsharp Mask effect 54

V
Vector Paint effect 124

Vector Paint Preferences 137

Vector Paint toolbar 127

Vegas effect 165

Venetian Blinds effect 240

Video effects category

Broadcast Colors 241

Reduce Interlace Flicker 242

Timecode 242

W
Wacom tablet, using with Paint effects 124

Warp effect 87

Wave Warp effect 87

Wave World effect 204

waveform

animating with Audio Spectrum 145

animating with Audio Waveform 146

white, removing with Luma Key 110

Write-on effect 217

See also the After Effects online Help
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